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nanoCAD Mechanica 

Intro 

This manual describes work in  nanoCAD Mechanica 25 

Legend 

Important! Information on actions that may lead to work difficulties 

 

Note: Useful information on the topic 

 

Example: Link to the internal manual page or file 

 

Link: Link to a resource on the Internet   

 

Video: Link to the video instruction   

Abbreviations 
LBM - left button mouse. 

RBM - right button mouse. 

Main sections 
Procedure - The section describes the user actions for constructing the object being 
described. 
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Edit dialog - This section describes the commands and parameters of the object editing 
dialog. As a rule, the editing dialog is invoked by double-clicking on the object. 

Properties - the section describes the parameters on the functional panel "Properties", 
referring directly to the object being described. 

Grips - the section describes the intelligent design handles of the object being described. 
Handles appear when selecting an object in the drawing. 

Features of the team - the section describes special techniques for working with the 
called team. 

Basic knowledge 

About the program 
nanoCAD Mechanica – this is an integrating software solution for the nanoCAD platform, 
designed to speed up and simplify the design of units, development, design and editing 
of design documentation, management of design data, aimed at the domestic user, 
made on the basis of regulatory recommendations. 

nanoCAD Mechanica 25 provides everything for engineering design objects: design 
projections of drawings on ISO using algorithms automated control, unique design 
technology systems of hydropneumatic elements, gear parts, engineering analysis with 
mapping the result of the calculation on the model, the calculation of dimensional 
chains, gearing, shafts, creating custom libraries of intellectual objects and more. 
Powerful multivariate design tool unites planners of flat and three-dimensional design. 

The tools nanoCAD Mechanica 25 complement the familiar environment nanoCAD, 
without disabling or reassigning its commands, toolbars, and menu items.   

Technology work nanoCAD Mechanica 25 is based on the use of object-dependent parts 
with assembly and parametric dependencies pre-installed on them. 

Copyrights and Licenses 
No section of the documentation may be changed, adapted or translated into other 
languages without the prior written permission of the firm "Nanosoft". It is not 
permitted to create derivative documents based on material from this publication. 

The  nanoCAD Mechanicasoftware complex described in this manual is distributed in 
accordance with the terms set forth in the License Agreement and cannot be used, 
transferred or sold under any conditions other than those expressly specified in this 
agreement. 
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Licenses: 

WpfTookit - (с) Xceed Software Inc 

Xbim Toolkit by Xbim 

Esent.dll - Copyright (c) Microsoft   

Compatibility 
nanoCAD Mechanica installed together withnanoCAD. 

Important! Drawings must be saved only in *.dwg format. When resaving in other 
formats (for example, *.dxf ), objects nanoCAD Mechanica will be 
permanently converted to proxy graphics and will not be able to be edited. 

 

Important! When resaving a drawing that has proxy objects without an installed 
nanoCAD Mechanica, в другие версии формата *.dwg, объекты 
nanoCAD Mechanica to other versions of the *.dwg format, the objects 
will be converted to proxy graphics and will not be able to be edited. 

When transferring files to a user or customer drawings that do not have nanoCAD 
Mechanicaand not having the ability or desire to use nanoCAD Mechanica Enabler, you 
need to convert all the objects nanoCAD Mechanica in the standard system primitives. 

To dismember individual objects nanoCAD Mechanica, use the standard command  
"EXPLODE". 

To dismember all objects nanoCAD Mechanica, use the command "MCEXPLODEALL". 
This command automatically selects all objects nanoCAD Mechanica in the drawing and 
explodes them into primitives. 

nanoCAD integration 
nanoCAD Mechanica integrated into nanoCAD as modules. 

Default file opening setting 

By double-clicking on the drawing file (or by using the "Open" command from the 
context menu), the nanoCAD platform is loaded without loading the nanoCAD 
Mechanica. 

Windows 8 and above 

In order for the nanoCAD Mechanica module to load, it is necessary: 

https://xceedsoftware.github.io/wpftoolkit/
http://docs.xbim.net/license/license.html
https://github.com/Microsoft/ManagedEsent/blob/master/LICENSE.md
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1. Open the application selection menu: RMB on the *.dwg file. - Open with - Select 
another application. 

2. Select applications to open and check the box "Always use this application to open 
.dwg files". 

3. Ready. 

 Windows 7 

In order for the module nanoCAD Mechanica to load, you must: 

1. Launch nanoCAD. 

2. Open settings. 

Main menu: Tools - Options.... 

Ribbon: Manage - Castomization - Options. 

3. In the settings window, open the "Current profile" drop-down list. 

4. Select "Mech". Along with the choice of profile, the mode of operation of the 
platform will also change. In the settings tree: Application preferences - Licensing - 
Modules - Platform mode. 

5. Click the "OK" button. 

6. Restart nanoCAD to change settings. 

7. Setting completed. Files will now open with the nanoCAD Mechanica. 

Selected and allotted object 
An object refers to an nanoCAD graphic item as well as an object created by the 
nanoCAD Mechanica. 

Allotted object 

 

An object is considered allotted (indicated) if additional graphic information appears on 
the screen when the mouse cursor is moved to it: 

 the object is highlighted in color; 

 the "rectangle corners" of the object appeared; 
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 the object information tooltip appeared. 

Note: The mouse keys are not pressed in this case - you just hover the cursor over the 
object. 

Scaling to the allotted object 

 Move the mouse pointer over the nanoCAD Mechanica object until "rectangle 

corners" appears, the object color changes, or an info tip appears; 

 Hold down the SHIFT key and press RMB. It will auto scale to the center of the 
screen. 

To scale to the selected object, the user coordinate system (UCS) must be set to * 
WORLD *. 

Selected object 

 

An object is considered selected after it has been clicked with LMB: 

 the image becomes dotted or highlighted; 

 the insertion point is displayed; 

 "grips" are displayed. 

Object context menus 
To set additional options for the current command, right-click context menus are widely 
used when invoking commands. The content of the context menu depends on whether 
the editable object is selected or allotted. 

Workspace 

Menu 
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All tools nanoCAD Mechanica 25 located in the ribbon (in the main menu) tab  
"Mechanica" and "MechWizard". 

Commands nanoCAD Mechanica 25 grouped by purpose and organized hierarchically. 
When you select a menu item marked with a black triangle, the corresponding drop-
down menu is activated. This way you can access all the tools  nanoCAD Mechanica 25. 

Menu nanoCAD Mechanica 25 also serves for loading / unloading individual functional 
panels nanoCAD Mechanica 25, call dialogue "nanoCAD Mechanica 25 - Settings" and to 
access some common features  nanoCAD Mechanica 25. 

Toolbars 
You can access the nanoCAD Mechanica 25 tools through the toolbars. Toolbars are 
divided by purpose. The user can place on the screen those panels that contain the most 
frequently used groups of tools. 

There is also a universal toolbar "Mechanical Main" - instrumental two-level panel on 
which groups of tools are located for working with symbols and graphical constructions 
defined by standards  nanoCAD Mechanica 25. 

 

Tools are grouped by purpose (group of callouts, group of commands for setting level 
marks, etc.). 

Click the LMB user to select the first in order tool of the group. If you click and hold the 
corresponding button on the panel with the mouse, a sub-panel opens, containing the 
rest of the tools in this group. Without releasing the LMB, you need to move the cursor 
to another command of this group, and then release the button. As a result, the 
selected command will be launched. 

Functional panels 
On the left side of the screen are added functional panels, such as: 

Objects - displays all objects nanoCAD Mechanica 25 created in the drawing. Directly 
from this palette you can perform a series of actions with objects: edit, delete, hide and 
search for them. 
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Library - contains a database of objects nanoCAD Mechanica 25 used for design. 

 

IFC - works with IFC objects in the drawing. 

 

Dimension chains - calculates the size of the chain. 
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Help system 
Background information is available to the user at any time. The help system has two 
access modes - general and contextual. 

General mode provides access to the help content in the absence of a command being 
executed. 

Contextual mode automatically provides access to reference information that 
corresponds to the command being executed. 

Scale 

Option 1. Making projections in model space 
Suppose the principal species in the model space are performed one by one. 

Additional types, sections are made with scale factors other than the main species. 

Features insert frame 

When placing a border with a title stamp in model space given its scale relative to the 
principal species. Frame increases or decreases. 
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Features design drawings 

When dimensioning must take into account the scale factor drawing (the value of the 
dimension text, the value of the arrow, spacing, etc.) and numerical designations for 
each species. 

Assume frame is increased with respect to the main sight 10 times. In this case the 
arrowheads, dimension text height and other text labels should be increased by 10 
times. A nominal size of the text for the main species should be marked on a scale of 
1:1. 

When applied to the kinds of sizes, made in a different scale (in our example, 1:20), 
nominal size must be multiplied by a scaling factor. 

 

Example of projection drawing frame, increased 10 times 

Especially when printing 

In this example, the sheet is printed at 1:10 in order to maintain a standard frame size, 
title block text and symbols. Such technology is not supported Construction Site  25. 

Option 2. Making projections in model space 

Features insert formats 

The frame is inserted into the space pattern in the scale of 1:1. 

Main types, made a scale of one to one in the model space scale when placed on a 
frame with a title block. 
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Particulars of 

The magnitude of arrowheads, dimension text height and other text refer to all types 
are specified in a scale of 1:1. When dimensioning must take into account only the scale 
factor of the form in which they are applied. 

 

Example of drawing. Frame in a 1:1 projection in a given scale 

Especially when printing 

Under this option, registration in model space frame with projections printed at a scale 
of 1:1. This variant of design drawings in model space adopted in Construction Site  25. 

Option 3. Making projections in paper space 
The most convenient way to design drawings projections. All images of objects executed 
in one-to-one scale model space. 

Border and title stamp inserted in 1:1 scale in paper space. 

Scale for each species, cut or section is given in the floating viewport in paper space. No 
need to convert the nominal values of dimensional numbers. Floating viewport - a kind 
of lens with a predetermined magnification (scale) of the portion of the drawing. 
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Border and two floating viewports placed in paper space 

Particulars of 

Scale factor when dimensioning for each species is taken into account automatically. 

Especially when printing 

Frame with projections printed in 1:1. scale in nanoCAD Mechanica 25 frame and title 
block inserted in model space or sheet at a scale of 1:1. 

Paper space commands 
When designing drawing projections in paper space, the context menu is available 
nanoCAD Mechanica 25. To call the menu, place the cursor in the area of the floating 
viewport and press RMB. 



User Guide nanoCAD Mechanica 25 
 

27 

 

Activate viewport - command activates viewport for editing. 

Refresh dimensions - command updates the dimensions in the viewport. 

Cut viewport - command allows you to change the shape of the viewport. 

Lock viewport - command fixes scales (including zoom commands) of viewport. 

Zoom all - command inserts all the graphics from the model space into the viewport. 

   Scale - a drop-down spikok allows you to select a viewport scale. 

Example of design drawings of extended objects 
Especially useful when you make a paper space drawings of extended objects. A small 
example. In model space, one to one (in real terms) has been drawn projection with 
dimensions 500 mm horizontally. 

 

Projection with dimensions of 500 mm horizontally 

Objective: To formalize this projection in paper space on the frame size A3. 
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Result projection design in paper space 

 

We turn to paper space by selecting a bookmark Sheet1 (Layout1). Insert Frame A3 
clicking the icon format in the main toolbar nanoCAD Mechanica 25. 

After placing the frame in paper space is created by default floating viewport 
rectangular shape. Inside it displays all the objects in the model space. Zoom while 
arbitrary and requires further editing. 

Resize a floating screen. To do this by clicking on its contour the left mouse button, 
move the highlight corner points. Part of the projection will then be hidden loop 
viewport. We did a kind of trimming images. 
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Move the corner points of the floating viewport 

 

Result after the transfer of the image projection of the angular points of the contour 
floating viewport 

 

Panel Viewports (Viewports) 
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Once the boundaries of the first viewport defined, define the scale of the image. 
Distinguish the border of the viewport. We define the scale of the image using the 
dashboard Viewports (Viewports) . To get the image on the right part of the projection 
make a copy of the floating screen and move it to the right. 

 

Move the copy right of the screen 

 

Changed the boundary of the right floating viewport 

With a team of pan define the right side projection view inside the right floating 
viewport. To do this, double-click the left mouse button within the contour of the 
viewport. Sign space layout changes to mark the user coordinate system (UCS-UCS). 

     

Especially when printing 

Before printing frame with the projections need to go out of the floating viewport to 
paper space. To do this, double-click the left mouse button outside the boundaries of 
the viewport. Sign appears in paper space. 
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Controls features 

Intelligent controls grips 
Intelligent grips are intended for editing the properties of design elements inserted into 
the drawing without calling the editing dialog. 

Intelligent grips are included in the settings nanoCAD Mechanica: Main options - Edit - 
Enable enchanced grips.  

Descriptions of grip actions are found in the description of the corresponding design 
elements. 

 

The appearance of the grip corresponds to its action (frequently used ones are shown): 

Node move grip 

Graphics move grip 

Grip for adding a new node 

Grip for adding additional graphics 

Direction grip 

Tilt grip 

Text alignment grip 

Grip for selecting a value from a drop-down list 
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Special characters and fonts 
The dialogs remote printing and editing tables are buttons insert special characters by 
which a dialog box in which you presented the symbols used in architectural design.   

For remote printing button "Insert special character". 

To the Editor button table "Insert Character". 

Select the character you want by clicking on it with the left mouse button, after which it 
is automatically inserted at the current cursor editing table. 

 

Buttons  opens a list of uppercase and lowercase letters of the Greek alphabet. 

 

Special characters are correctly displayed only text based on the fonts nanoCAD 
Mechanica (.shx). Displaying characters when pasting in text based on TrueType-font, 
the screen looks incorrect (replaced by question marks, boxes, etc., depending on the 
settings of TrueType-font). 

Parameters hatch 

In the dialogs for editing nanoCAD Mechanica objects, there may be a "Hatch" button, 
which opens the "Hatch" editing dialog other than  nanoCAD. 
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Procedure 

1. Select a hatch type: 

 

 None - hatch will not; 

 Predefined - hatch is selected by abrasive from the list of standard hatches; 

 Custom - hatch is selected by abrasive pattern from the list of custom hatches; 

 User-Defined - hatching is formed in the form of parallel lines with a set interval and 
rotation angle. When you turn on the "Double" switch, the second row of lines will 
be drawn perpendicular to the first. 

2. Select a hatch pattern (if possible). Depending on the selected sample, certain 
parameters will become available. 

 

3. Configure the available options. 
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4. Click the "OK" button. The hatching will be adjusted and added to the appropriate 
location. 

Jobs in the current scale 
The  nanoCAD Mechanica uses the concept of a current scale, which differs from the 
global scale in effect in the platform, expressed in units. 

The current scale - is a setting that automatically scales objects in the drawing up or 
down.   

In the model space, a global scale of 1:1 is allowed - that is, 1 mm of the construction 
object is equal to 1 unit of the platform drawing. 

Changing the current scale affects the following objects: 

 Drawing design objects  nanoCAD Mechanica; 

 platform line types containing breaks or text; 

 library objects; 

 dimensions and text nanoCAD Mechanica. 

There are 2 types of scaling in the application: symbol scale and measurement scale. 

When working with ESKD, measurement scale is more often used. 

Scaling is usually selected during the initial setup of the application and is not changed 
thereafter. 

Symbol scale 
The scale of symbols can be set in two ways: 

1. Set the "Use symbol scale" setting to  "Yes". 

2. Select the "Symbol scale" type on the scale button  in the status bar (in 
this method, the "Use symbol scale" setting will automatically change to "Yes"). 
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Next, you need to select the desired value on the scale button  in the 
status bar. 

 

or in the  "Scale" panel. 

 

The scale of symbols is characterized by (using the m1:5 scale as an example): 

 design elements (dimensions, callouts, etc.) are inserted 5 times larger; 

 standard database parts are inserted at a scale of 1 (i.e. geometry unchanged) with 
a current linetype scale (dash length in dashed lines) of 5 (five times larger); 

 geometry is inserted with a linetype scale (dash length in dashed lines) of 5; 

 the displayed size value is taken as is; 

 the mode is signaled by the letter "m" on the "Scale" toolbar. 
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Measurement scale 
The measurement scale can be set in two ways: 
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1. Set the "Use symbol scale" setting to "No". 

2. Select the "Measurement scale" type on the scale button  in the status 
bar (in this method, the "Use symbol scale" setting will automatically change to "No"). 

Next, you need to select the desired value on the scale button  in the 
status bar. 

 

or in the "Scale" panel. 

 

The following is typical for the measurement scale (using the M1:5 scale as an example): 

 design elements (dimensions, callouts, etc.) are inserted at a scale of 1:1, i.e. they 
will not change; 

 standard database parts are inserted 5 times smaller (geometry) with the current 
linetype scale (dash length in dashed lines) equal to 1, i.e. no changes; 

  geometry is inserted with a linetype scale (dash length in dashed lines) equal to 1, 
i.e. without changes; 

 the displayed value of dimensions (if they are not inside formats and are not 
associated with application objects) takes a scale factor that is inverse to the 
current scale (i.e. it will be 5 times larger than the measured one); 

 the mode is signaled by the letter "M" on the "Scale" toolbar. 
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Working with scales 
The design scale is convenient when drawing in model space at a scale of 1:1, with 
subsequent design in sheet space on a viewport. In this case, the design elements will 
look uniform on viewports with different scales. 

The measurement scale is used when initially drawing the model at a scale other than 
1:1. 

By default, the current scale of symbols is set to m1:1 and the scale of measurements is 
set to M1:1. 

When no objects are selected, changing the scale using the scale bar or the scale button 
changes the current drawing scale. 

If there are selected objects, the scale button and bar display their scale. Changing the 
scale affects only the selected objects, without changing the current drawing scale. 

To change the scale in the current document, you need to do the following:  

1. Set the value of the "Use symbol scale" setting, or select the scale type on the scale 

button  in the status bar (in this case, the "Use symbol scale"  setting will 
take the value automatically); 

 2. Select the desired value on the scale button in the status bar or on the 
"Scale" panel. 

To change the default scale for new documents, you must save the current design 
settings in the Settings - File - Save Settings. 

Interaction with global scales 
Scale dimension feature (VAR:DIMSCALE) - parameter from modify dimension style on 
tab  "Fit". 

Measurement scale (VAR:DIMSCALE) - parameter from modify dimension style on tab  
"Primary units". 

Scale dimension feature (VAR:DIMSCALE) affects the "Symbol scale". Measurement 
scale (VAR:DIMSCALE) affects the  "Measurement scale". 

Changing global scales affects drawing design objects inserted into the drawing with the 
same scale value. For example, if a linear dimension is inserted with a symbol scale of 
1:10 and the scale of the dimension elements is 10, they will be linked, changing the 
scale of the dimension elements will change the scale of the linear dimension symbols. 

When changing the scale of an object manually, the connection with global scales is lost. 

Instrumental panel "Scale" 

Main menu: View - Toolbars - NanoCAD Toolbars - Scale. 
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The scale of standard product database objects and design elements can be set using 
the scale list from the scale panel, see  "Working with scales". 

To move the scale from one object to another, there are buttons: 

"Get Scale" - button repeats the command "Get from the selection" of the scale 
button in the status bar. When selecting, you must specify the object from which the 
scale will be get. The value will be saved in memory. 

"Set scale" - button repeats the command "Set to selection" of the scale button in the 
status bar. When selecting, you must specify the object on which the new scale will be 
set. 

Selecting the direction of drawing 
When drawing some graphics nanoCAD Mechanica may require special functions choice 
of direction of drawing. For example, when constructing Weld seam. 

Functional toolbar "Destination" is automatically activated when a call instruction 
nanoCAD Mechanica, which is available for control of the direction of drawing. 

 

Toolbar commands "Destination": 

 Perpendicular. Construction perpendicular to the selected segment. 

 Free. The choice is arbitrary direction. 

 Along. Construction along the selected segment.  

 Parallel. Parallel to the selected segment. 

When constructing select the desired command and specify the length of the drawing, 
to be followed by leveling (except commands "Free"). 

Special keys 

Key SHIFT 
Key Shift used: 

 Holding down the SHIFT key is used when placing a dimension value. To place a 
dimension value closer to any extension dimension line, move the mouse pointer 
while holding down the SHIFT key. To complete the command, left-click.   
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Key Alt 
 To redefine the parameters of primitives included in standard parts, use the Alt + 

RMB combination, which calls the "Overrides" dialog: 

 

Allowed to override the following properties: color, line thickness, slope and pitch hatch 
of hidden objects. 

Key Ctrl 
 Holding down the Ctrl key is used to set the angle of extension lines when placing 

dimensions. 

 

 Holding down the Ctrl key is used in the Form Editor to select the control type 
when dragging a variable onto a user form. 

 Editing a table at the place (Ctrl + left-click). 

 Ctrl+5 - strikethrough text, works in text input fields (in callouts, sizes, etc.), table 
cells, TC and TP. 

 Ctrl+U - text underline, works in text input fields (in callouts, sizes, etc.), table cells, 
TC and TP. 

 Ctrl+O - overline text, works in text input fields (in callouts, sizes, etc.), table cells, 
TC and TP. 
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Geometric constructions 
Tools nanoCAD Mechanica for the geometric constructions are specific for mechanical 
design. All objects created with their help, made up of primitives nanoCAD, and does 
not require special tools for editing. 

Editing inserted objects in a drawing can be performed using a universal object editor 

nanoCAD Mechanica, called button "Editing". After selecting the object being edited 
is automatically recognized by the type and loads the appropriate dialog box. 

Furthermore, editing objects nanoCAD Mechanica25 it can be made by other means: 

 called the command "Edit" in the context menu; 

 by calling the "Edit" command from the tooltip of the selected object. This method 
is set in the "Editing" section of the design settings  nanoCAD Mechanica; 

 double-clicking the LMB on the object nanoCAD Mechanica. This method is set in 
the "Editing" section of the design settings  nanoCAD Mechanica; 

 use grips of object; 

 on the function panel "Properties"; 

 standard command ERASE, MOVE, COPY, ROTATE, STRETCH. 

Object-dependent parts 
Object-specific details - the details of this database nanoCAD Mechanica with the 
described properties of behavior when they are placed in the context of the assembly. 
With the change in the parameters of one such detail all the related object-specific 
details are automatically changed in accordance with their values in the database. Using 
this technology works, it is important to take into account the order of application of 
object-dependent items. 

When applying standardized object-dependent parts of the image cursor-pointer signals 
the automatic recognition of the insertion point and the direction of the applied 
rendering details. 

Context menu entry fields 
In the context menu the following entry is available. 
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History  - recall last entry. 

Recent - recall the most frequently used values. 

Superscript - insert superscript (a combination of Ctrl+Up). 

Subscript - insert a subscript (a combination of Ctrl+ Down ). 

Insert division - insert shot. 

Pick from drawing - the command allows you to take data from the drawing and the 
properties of a standard part. When you select this command, the panel Select the value 
apperas : 

 

 Measure distance (Z) - to take drawing diamensionally linear or geometric size. 
Command can be selected by pressing Z. 

 Measure angle (X) - take the angular size of the drawing. Command can be selected 
by pressing X. 

 Measure Perimeter (C) - to take drawing the perimeter of a closed polygonal line or 
length. Command can be selected by pressing C. 

Measure area (V) - take the value of the drawing area of the closed loop. Command 
can be called by pressing V. 

 Complex area(Shift+V) - take a few drawing value areas closed loop. 

 Calculator (M) - Calculate the number with built-in calculator in nanoCAD Mechanica 
25. 

 Take from notes (,) - insert text information from the notebook. 

Take from property (B) - allows you to take command of the sub-parameters database 
in Construction Site  25. Parameter is inserted preserving the dynamic link with the 
object. When you change a parameter line items are changed in the input field. 
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Note: To insert static text, hold the Ctrl key while selecting parameter. 

Mark text object (N) - to take the text from the drawing.  

Cancel - stop the command and return to the Previous menu. 

Symbols - inserting special characters 

 

Undo - Undo the last command (the combination of Ctrl+Z). 

Clipboard operations 

Cut  (a combination of Ctrl+X). 

Copy (combination Ctrl+C). 

Paste  (a combination of Ctrl+V). 

Delete  - Delete the entry field. 



User Guide nanoCAD Mechanica 25 
 

45 

Select all - highlight the input field. 

Template 
Templates are used to create objects of the same type with the same properties.   

An example of creating and applying a template based on callouts. 

1. There is a rectangle of arbitrary area. Let's assign a callout to it. Open the callout 
editing dialog. 

 

 2. From the entry field callouts call the context menu and select the command "Pick 
from drawing." The "Value picker" dialog opens. 
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3. In dialogue "Value picker" call command  "Take from property. 

4. Select a rectangle and press the key  "Enter".  

 

5. In dialogue "Properties" selecting "Area" and press "OK".  
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6. The link to the property appeared in the text of the callout, in this case - the area of 
the figure. 

 

7. From the entry field callouts call the context menu and select the command 
"Template - Append".  

 

8. Close the callout editing dialog. 

9. We build another rectangle, different in size from the first. 
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10. Assign him a callout. Open the callout editing dialog. 

 

 11. From the entry field callouts call the context menu and select the command 
"Template - Polyline.Scale".  

 

12. Select the second rectangle to calculate the area. The area will be calculated 
automatically. 
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Such templates can be used not only for callouts, but also for other elements, for 
example: 

 position designation; 

 node designation; 

 note level field; 

 e.t.c. 

Regen 

Main menu: View> Regen. 

Command line: MCREGEN, RE, REGEN. 

 Update objects  nanoCAD Mechanica; 

 It recalculates table; 

 Updates overlapping objects; 

 Updates automatically calculates the attribute values. 

The cursor-pointer 
Depending on the location (over the selected or chosen object) and the command being 
executed, the cursor-pointer takes on a different appearance. 
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Examples: 

 The application of a single object.  

Under a single object we understand insert parts from a database without automatic 
reference to other object-dependent parts. 

 

Mouse pointer is displayed as a standard cross-hair, blue arrows and if there is a 
preview of the items - the item itself displayed. 

Blue arrow indicates the insertion point and the direction of the applied drawing object. 

After you specify the insertion point of the applied object of the cursor, the mouse 
pointer changes, the user is prompted to set the direction of drawing an object, it will 
coincide with the direction of the blue arrow. To confirm the direction you need to left-
click. 

 Recognition of object-dependent parts. 

 

If you insert a part in an assembly before the cursor passes over the inserted workpiece, 
with inserted part can be installed according to the parts over which the cursor is, the 
original item is highlighted, and the position is determined automatically inserted 
details. To confirm the installation of dependencies inserted details, just click the left 
mouse button. 
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After this, a dialog box appears with parameters inserted parts. 

 Application of the bearing on the shaft neck. 

The cursor-pointer indicates that as the insertion point of the bearing end of the bead is 
recognized and given the direction of its rendering (left). 

 

 Recognition of the insertion point in the tapered portion of the pipe bushings. 



User Guide nanoCAD Mechanica 25 
 

52 

 

 Application of standard shaft end. 

 

 Drawing sign of torque. 
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Settings 

Settings 

Main menu: Tools > Design Settings.... 

Main menu: Mechanical> Settings.... 

Toolbar: Settings... (  "Edit"). 

Command line: MCPARAMS, PARAMS. 

Customizing the interface and settings for design elements nanoCAD run in the dialog 
box  nanoCAD Mechanica: 
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The header of the dialog displays the path to the settings file. 

Main menu 

Menu "File" 

Menu "File" contains controls: 

Save settings - saves changes to the current settings file. 

Save settings as... - saves changes in settings to a new settings file. 

Load settings - loads settings from the specified file. 

Types of uploaded files: 

 Configuration files (*.xml) 

 Skin Settings (*.cfg) 

 Interface Settings (*.icf) 

Configuration files *.cfg and *.icf used in nanoCAD Mechanica lower version 25 and 
contain settings that are currently stored in AppOptions.xml. 

Restore start settings - loads settings preinstalled in nanoCAD Mechanica. 
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Important! The function of saving the settings, when the saved file is the same as the 
one already existing, does not overwrite the old file, but complements it. 
When changing the standard, for example, from the ESKD to ISO, both 
standards will be available in the settings file. 

Menu "Organisation" 

Menu "Organisation"manages enterprise standard settings. 

 

Enterprise Standard - a single configuration file (parameters, layers, profiles) for the 
enterprise. All settings are stored in one file.  

In the settings dialog, the profiles table and the "Organisation" settings layers are 
highlighted in light gray. 

Menu "Organisation" contains controls: 

 Create organisation settings - command allows you to create a corporate settings 
file for subsequent transfer to other machines or for location on a shared server. 

Creating the settings file:  

1. After the command is called, a selection field appears next to each parameter and 
section.   

 

2. You must specify (check) which settings will be included in organisation settings. Then 
click the "OK" button. The dialog box prompts you to enter the location and name of the 
corporate settings saving.  

3. Indicate the path, name and confirm. A file with corporate settings will be created. 

 Set settings file... - the assigned organisation settings settings file overrides the 
custom settings file AppOptions.xml. New documents will be created in 
accordance with the values in organisation settings settings file. 

 Flush - command to refuse to use the organisation settings. In this case, the control 
file becomes the user settings file AppOptions.xml. 

 Apply organisation settings to document - the command applies corporate settings to files 
created earlier or in another place that do not have these settings. 
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Important! The user can not delete layers and profiles of organization settings from 
the corresponding tables in the settings dialog. 

When saving settings with new values, they are saved only in the current 
document. 

The configuration settings in the organization settings file and the 
standards within the configuration must strictly correspond to the 
downloaded settings in the application. If there is a mismatch, the 
override of the settings will not work! 

Work area 
Contains: 

1. Tabs with settings settings:  

 Main options 

 Standard elements 

 Symbols 

 Forms 

 Special settings 

2. Graphic window for displaying custom parameters (not editable). 

3. Container "Legend" with the legend of the kind of settings (not editable). 

 

 Symbols - parameters with this background refer to the design parameters. In the 
nanoCAD Mechanica low version 25 settings are stored in the format files *.cfg 

 Interface settings - parameters with this background refer to the interface 
parameters. In the nanoCAD Mechanica low version 25 settings are stored in the 
format files *.icf 

 Organisation settings - parameters with this background indicate that they were 
downloaded from the Organization settings. 

 Redefined value- parameters with this background indicate that they have been 
changed by the user. 



User Guide nanoCAD Mechanica 25 
 

57 

4. The "Standard" container is intended for displaying the default development system 
of the design documentation (the choice is possible if there are more than one 
standards). 

5. The "Save as defaults" container contains configuration items that indicate what will 
be saved by default when you click the "OK" button. Contains the selection field 
"Symbols". 

Main options 
The tab is used to configure the general parameters of the interface nanoCAD 
Mechanica. 
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It contains sections: 

 Common settings 

 Common settings 

 Line types 

 Edit 

 Design 

 Notifications 

 Hot keys 

 Database access 

Common settings 
  

 

 

Current profile 
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Layer profiles are designed to organize the work of different departments of the 
enterprise over a single drawing file. Each user at the same time works with their group 
of layers, controlling their visibility by means  nanoCAD. 

 

Since the design of the drawing depends on the settings of the deployment of 
registration of the layers and the current profile of the drawing, then for each object 
type you want to specify in the settings option to be placed on the appropriate layer (for 
example, callouts given layer "Leaders") 

Depending on the current profile to the layer name prefix will be added. 

 

Thus, it is possible to group layers created by users with similar profiles (for example, 
the objects created by the designer - prefix "D_", and technologists - prefix "T_"). 

When adapting the distribution in the setup.ini file, you can assign a prefix in the 
parameter by default APP_OPTIONS_PROFILE. 

Execute command "Regenerate" on opening document 

The command "Regenerate" whenever you open a document  
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Line Types 

 

Enable option "Use paper space units fo scaling" automatically 

Automatically changes the setting nanoCAD Mechanica "Scale to paper space units" 
("Use paper space units for scaling") for the types of lines. 

Change current linetype scale 

It enables or disables the scaling of line types in the standard objects when you change 
their size. 

Use table of colors and weights 

It enables or disables the use of the table of colors and weights. If enabled, you can use 
the standard colors from the table. "Compatibility Mode" - is used when working with 
documents created in early versions ofnanoCAD Mechanica.  

Standard text weight 

It standardizes the value of the weight of the text for all text in the document. 

Color and line width 

Is to set the standard design elements. 
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Edit 

 

Decimal delimeter correction 

 Do not correct decimal delimeter - does not perform any actions with a separator. 

 Use dot '.' as decimal delimeter - automatically replaces the delimiter with a dot. 

 Use system locale decimal delimeter -in this case, the separator will be replaced 
with the symbol set in the system settings. 

Create an activate standard text and deimension styles in new documents 

Managing the creation of standard styles. The default setting is "Yes". Specifying the 
value "No" allows you to create new documents without predefined standard 
dimensional styles. 
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Yes No 

  

Explode Block References under drawing design elements 

Yes - when overlapping objects nanoCAD Mechanica blocks nanoCAD break up. 

No - when overlapping objects nanoCAD Mechanica blocks nanoCAD masked with the 
command  wipeout. 

Enable enchanced grips 

When this function is enabled, additional handles are displayed on the objects nanoCAD 
Mechanica. 

Set associativity during insertion of object 

By default, the setting is enabled. When you turn off, the binding of the inserted objects 
to the primitives is inactive. 

Example with dimensions. If the setting is enabled, then, when setting the dimensions 
on the line, the size will be associated with the line. When you change the line, the size 
changes. 

 

If the setting is turned off, only the line will change. 
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Use localized abbreviations of command keywords 

Abbreviations for the keywords of the commands are described in the file with the 
extension .pgp and are located in the installation location  nanoCAD Mechanica 

Highlight color 

The color of the highlighting of primitives, when their indication is required. For 
example, the line's highlight when specifying a size for the placement. 

Automatically switch keyboard layout to local language 

When you call dialogs with fields nanoCAD Mechanica automatically turns on the layout 
set in the system settings.  

Show rectangle around objects 

Display control of the frame around objects nanoCAD Mechanica and blocks  nanoCAD. 

 

When this option is enabled, scaling is turned off Shift+RBM. 

Automatically turn of snaps: Nearest, Endpoint, Quadrant, Center 

Temporarily includes bindings when inserting objects  nanoCAD Mechanica. 

With the option disabled, the "Direction" toolbar may not work correctly. 

To show the toolbar  "Direction" automatically 

The "Direction" toolbar control that appears when you insert database objects and a 
number of drawing design teams. 

 

Scale dimensions 

Yes value: 
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1. The measurement scale specified in the "Dimensional Styles" on the "Primary units" 
tab is replaced by the measurement scale specified in the Design Settings - Main 
Options - Design. 

2. The global scale specified in the "Dimension Styles" on the "Fit" tab is replaced by the 
design scale specified in the Design Settings - Main Options - Design. 

The value is "No". The scale is not replaced. 

Scale texts 

The value is "Yes". When you change the scale using the Scale toolbar, the "Height" 
parameter in the "Text Format" dialog for the multi-line text and the command line for 
the single-line text proportionally changes. 

The value is "No". When you zoom in using the Zoom toolbar, the Height option does 
not change. 

Scale hatches 

The value is "Yes". When zooming with the Scale toolbar, the Scale parameter in the 
Hatch dialog is proportionally changed. 

The value is "No". When zooming with the Scale toolbar, the Scale option in the Hatch 
dialog does not change. 

Ignored layers 

Specifies layers nanoCAD, on which primitives will not overlap with objects  nanoCAD 
Mechanica. 

When you click on the ellipsis, the "Excluded Layers" dialog opens to edit the list of 
layers. 

 

The dialog menu allows you to add a layer and enter it manually, delete a row with a 
layer or select a layer from the ones available in the drawing. 

Unplotted layer 
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Specifies which layer the objects will be placed on nanoCAD Mechanica, which will not 
be printed. 

Mini-toolbar for viewports 

The nanoCAD Mechanicatoolbar control that appears when you right-click inside the 
viewport. 

If the option is off, then when you right-click inside the viewport nanoCAD the standard 
menu will be called up  nanoCAD. 

Yes No 

  

Tooltips 

 

Show tooltips 
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Advanced Tooltip Management Tool (with hyperlink "Edit...") for objects nanoCAD 
Mechanica and blocks  nanoCAD. 

 

Show delay, ms 

Tool to control the speed of the appearance of tooltips. 

Hide delay, ms 

Tool for managing the duration of the tooltip display. 

By double-click 

 

Program objects 

Sets the rule that when you double-click on object nanoCAD Mechanica, the editing 
dialog of this object will be called. 

With the option disabled, the properties of the object are called. 

Dimensions, Regular texts, Multi-texts 

With the option enabled, double-clicking the left mouse button on the size brings up the 
editing dialog  nanoCAD Mechanica. 

With the option disabled, the properties of the object nanoCAD or edit dialog  nanoCAD. 
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Design 

 

Use symbol scale 

Changes the type of scaling: 

 Yes - Drawing scale. 

 On - Model scale. 

More details in the description of work with the current scale. 

Drawing scale 

Sets the default scale of design elements and the scale of the types of geometry lines. 

Note: The scale type of the dimension lines is reserved and is always 1 by default. 

Model scale 

Sets the default measurement scale. The displayed value, which is set when 
dimensioning, increases in direct proportion to the scale value. For example, if you set 
the size of a 10 mm section and the measurement scale is 1:10, the displayed value is 
100. 

Text wipeout offset 

Sets the standard indentation of the geometry marking from the text. 

Using the example of a size marker. With a larger size, the square background overlaps 
the geometry. 

0.2 1 

 
 

Cut CAD-platform elements 

"Wipeout" - closes the primitive. 
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"Cut" - cut the portion of the primitive. If you delete or move carved primitive returns its 
status. 

 

"No" - It does not cover the primitive. 

 

Notifications 

 

Enable hints 

Tool tips display control. 

This option does not apply to messages with the status "Error". 
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Avoid mouse pointer 

When this option is enabled the message will be moved around the screen so as not to 
obstruct the selection. 

Hot keys 
Keyboard Assignment Tool for calling the quick settings dialog and the notification 
messages window. 

 

Show <Quick Options> dialogue 

 

Show notification window 

 

Databases access 
The database includes, in addition to standard elements, table and format templates, 
bolt assembly templates, groups and markers, as well as examples and other user 
elements. The choice of a specific database is determined by the configuration of the 
path to the data source. 
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Data Source 

The database nanoCAD Mechanica 25 includes, in addition to standard elements, table 
and format templates, bolt assembly templates, groups and markers, as well as 
examples and other user elements. The choice of a specific database is determined by 
the configuration of the path to the data source. 

When you click on the button  in the "Data source" field, the dialog for specifying the 
data source appears. 

 

nanoCAD Mechanica 25 provides work, both with local databases, and with the 
database on the MSSQL server. 

If you are using an MS SQL database, you must select the "Data Source - MSSQL" radio 
button. In the "Server" field, specify the server name (along with the name of the SQL 
Database Server Instance). For example: SERVER, or SERVER\SQLEXPRESS. In the 
"Database" field, you must specify the name of the database to which you are 
connecting. 

If you are using a local database,you must select the "Data Source - Local Database" 
radio button, and then specify the path to the database file. 

As a local database for computers with the x32 bit capacity, format files *.mcs (MS 
Access). 

As a local database for computers with the x64 bit capacity, format files *.mdf (LocalDB, 
for Windows Vista and higher). 

Required drivers are installed automatically when installed  nanoCAD Mechanica 25. 

By default, with a local installation, the database is located in the folder 
%programdata%\nanosoft\nanoCAD Mechanica257.0\DataRW\. 
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Picture size 

The size of the preview image for the database elements in pixels. 

70 140 

  

Select object in browser 

 Single click 

 Dowble click 

Use only these standarts from the library 

Restricting the used standards filter. 
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Filter of nomenclature 

To limit the selection of parts from the catalog of standard and standardized products 
nanoCAD Mechanica 25 it is possible to automatically filter the database using 
nomenclature filters. 

To enable and configure a nomenclature filter, you must enable this feature in the 
settings  nanoCAD Mechanica 25. 

The filter editor is called by pressing the button with the ellipsis. As a result, the settings 
window of the nomenclature filter appears: 
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In the upper part of the window there are buttons for creating, downloading and saving 
files of the nomenclature filters, as well as a switch for enabling / disabling database 
filtering according to the selected filter. nanoCAD Mechanica 25 allows you to switch 
between different filters and temporarily turn them off. 

The structure of the database is displayed in the left part of the window nanoCAD 
Mechanica 25, the icons of which show the current state of each element of the 
database: 

 - the standard icon of the database element. Indicates that all sizes and the element 
itself are allowed to be used. 

 - prohibition to use icon. Indicates that this element is not allowed to be used. 

 - partial use icon. Indicates that this element is allowed for use with a limited set of 
standard sizes. 

To enable / disable the use of the entire element, use the "Allow part use" switch. To 
disable a specific part size, you must uncheck the column ID of a line of this size in the 
part dimension table. 
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Note: Database access settings are interface settings. 

If you use data compression on a disk, you may experience problems connecting 
to local databases (for x64 versions). 

Standard elements 
The tab is used to configure standard elementsnanoCAD Mechanica. 

 

Standard 
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Color of cursor, plane... 

The control display color selection standard elements when they are selected, the 
automatic installation of dependencies. 

The color display can be selected from a set and the built-in color picker. 

Show invisible lines 

Control the display of invisible (hidden) lines of standard graphic elements. 

Color of invisible lines 

The control display color selection invisible (hidden) lines of standard graphic elements. 

The color display can be selected from a set and the built-in color picker. 

Default layer for parametric objects 

The control layer selection, which by default will be placed standard parts database. 

A layer can be selected from the existing (previously created) or create a new layer in 
the same window. 

Default layer for holes 

The control layer selection, which by default will be placed holes created by the 
operation "Bolting". 

A layer can be selected from the existing (previously created) or create a new layer in 
the same window. 

Hatch step 

How to set the hatching step, is used by default. 

Grid step 

The control is used for the step of asking the values of the diameter and length of the 
shaft sections created using the "Spindles". 

When you insert a section of the shaft the value of its length and diameter will be 
rounded up to a multiple grid spacing. 

Use grid 

Control Using the "spacing". 

If the grid is not used, the values of the diameter and length of the shaft portions are 
not rounded. 

Highlight color for working planes 

Highlight color for working planes 
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Beam calculations 

 

Curve colors travel, bend, torque, force, tension 

Color control diagrams displayed in the calculation of gross. 

The selected color is preserved when exporting diagrams in the drawing. 

The color display can be selected from a standard set and set of built-in your palette. 

Acceleration of gravity OX, OY, OZ 

Set design parameters for the respective axes of acceleration of the shaft. 

Points number on diagram 

Control increments partition diagram plotted in the entire length. 

Calculate bearings as a pair 

Complementing the strength calculation of shaft reactions bearings. 

Show values on plot 

Control the display of numerical values on the diagram exported to the drawing. 

The values are displayed at the critical points of the shaft. 

Equivalient stress theory 

Sets the strength of the theory to calculate the equivalent stresses shafts. 
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Edit shaft 

 

Path to TOOTH-WHEELS group 

It specifies the path to the database that contains the elements of the bookmark 
"Gears" dialogue "Editing shafts". 

Path to USER OBJECTS ...  

It specifies the path to the folder Users. After you specify the folder elements of it will 
be displayed in the dialog "Edit shafts".  

Pipes 

 

Relation of minimum bend radius to diameter of pipe (Rmin/Dn) 

Set the default value of the bending radius of the pipe.  

Relation of length of minimum linear segment to diameter of pipe 
(Lmin/Dn) 

Set the default value of the minimum length of straight pipe. 

Highlight color of edited segments 

Set the backlight color workplanes valves when connecting the pipe to them.  

IFC 

Import 

It allows you to configure the IFC objects disposable layer and color. 
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Symbols 
Tab "Symbols". Designed to customize the display of drawing symbols of nanoCAD 
Mechanica. 
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 Dimensions 

 Notes 

 Views, sections, cuts etc 

 Welds seams 

 Holes 

 Lines of break 

 Joints 

Dimensions 
Setting allows you to change the size of the layer, which is automatically updated with 
new dimensions and copied settings dialogs, etc. 
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Layer 

Allows you to choose the layer,which by default will include new dimensions and 
copied. 

Apply layer when copying 

When this option is copied dimensions will be placed on the drawing layer selected for 
size. When off, dimensions placed on the active layer.  

Show dialog for new dimension 

Control built ordinate dimensions. If the option is used ordinate dimensions standard 
ISO, built-in platform nanoCAD. When this option is used ordinate dimensions nanoCAD 
Mechanica. 
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Open a dialog to automatically 

Control automatic opening dialogue sizes. 

Arrows in chains 

Replaces used in nanoCAD  arrows in dimensional chains. There is a possibility to replace 
the serifs, or replace point at all. 
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Spreadsheet template tolerances 

Allows you to select a table template tolerances available in the database. 

 

Notes 
Settings of notes, such as text, arrows, pointers. 
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Invert oblique arrow 

Allows you to choose the direction of oblique arrow in leader. 
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Show dialog before inserting the object 

When this option is enabled, the dialogue is displayed before inserting note. 

 

Align text line by current UCS 

When this option is on, shelves of leaders are rotated by the User coordinate system. 

Save text in dialogs 

When this option is enabled on inserting the following notes previously entered text 
remains in the input field.  

The remaining options allow you to change the size of text, indexes, thickness, layer 
placement, color, etc. 
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Additional extension lines 
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Mechanical note 

 

Construction note 
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Comb leader note 

 

Chain note 
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Node note 

 

Section note 
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Note for multilayered constructions 

 

Linear aligned note 

 

Views, sections 
Settings of views, sections, detail views. It allow you to choose the layout for placing 
cuts and sections, color of symbols, text, size of text,  lines, arrows. 
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Sort kinds of cuts ... 
Settings menu sorting species profiles, detail views, cross sections. It allows you to 
specify a set of letters to designate and manage automatic sorting of species.   

 

Hole tables 
Settings menu to set the table all sorts of patterns, as well as a way to refer to sets of 
holes. 
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Holes 
Settings of holes that allow you to change the layer for label placement, text style, size 
and color of the text, etc. 

 

Marking and branding 
Settings menu markers and brands. 
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Surface texture 
Setup menu icon, surface roughness, and allows you to specify the path to the directory 
roughness. 

 

Tolerances 
Settings menu icons tolerances of form and mutual arrangement. 

 

Construction lines 
Setup Menu display of auxiliary lines. 
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Line of break 
Settings of break lines,that allow you to change the layer for label placement, color, and 
line sizes, type of fracture lines, etc. 

 

Fixed Joints 
Settings of symbols of permanent connections, that allow you to change the layer, label 
placement, color, size, style, text and lines.  

 

Gradient 
Setup menu icon gradient.  
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Dimension marker 
The setup menu displaying the marker size. 

 

Specification leader 
Setup Menu display leader specification (position). 

 

Welds 
Settings of weld symbols allow you to change the layer for label placement, color, style 
and size of lines and text. 
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Position 
Setup Menu icon designation position. 

 

Forms 
Menu tab "Forms". Designed for setting up the parameters of parts of the text tools to 
create a standard layout elements. 
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It contains the following sections: 

 Table 

 Drawing borders 

 Specification 

 Technical condition 

 Notebook 

 Export specification to MS Office 

Table 
Settings of the tables in nanoCAD Mechanica . 
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Layer 

Specifies layer for placing tables. 

Color 

Sets color of table elements. 

Line thickness 

Allows you to choose the thickness of the lines of text in the table. 

Option "by layer" sets the line width from the layer it is placed (default value). 

Option "By block" sets the line width for by the block in which it is included. 

Option "By object" sets the line width individually using properties palette. 

 Selecting "Default" sets the default line thickness for the table. 

You can also set the line width of a standard set of values.  

Text style 

Sets the default text style in the table 

Text Height 

Allows you to choose the standard text height. 

Text Color 

Control choice of color of text in tables.  

Text weight 

Allows you to choose the thickness of the lines of text in the table.  

Option "by layer" sets the line width from the layer it is placed (default value). 

Option "By block" sets the line width for by the block in which it is included. 
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Option "By object" sets the line width individually using properties palette. 

 Selecting "Default" sets the default line thickness for the table. 

You can also set the line width of a standard set of values.  

Width factor 

Sets width factor for text in table cells. 

Text Indent 

Sets text indent in table cells. 

Drawing borders 
Settings for drawing borders in nanoCAD Mechanica 

 

Layer 

Allows you to select the layer for the drawing border.  

Text style  

Sets the default text style within the drawing border.  

Inventory fields of the next sheets 

Enables placing of inventory title blocks on drawing border. 

Create viewport in paper space 

Creates a viewport when drawing border is inserted on the sheet. 

Specification 
Set of tools for configuring the module specifications nanoCAD Mechanica 25. 

 

Default style 

Allows you to choose the format specification: a simple, group type A (after the constant 
data placed separate sections for each performance), group type B (for each AC-used 
"tion use a separate column of the specification). 
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For more information on setting specifications  here. 

Technical conditions 
It specifies settings of text of the technical requirements of nanoCAD Mechanica. 

 

Line spacing default 

Sets the default line spacing in the text of the technical requirements. 

Font Height 

Sets a default text height. 

Text oblique 

Sets a default value of the slope of the text in degrees. 

Text Color 

Sets color of text in technical requirements 

Text style 

Sets the default text style specifications.  

Header height 

Sets a default value of header height in technical requirements. 

Header oblique 

Sets a default value of the header oblique angle in degrees. 
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Header Color 

Sets color of header 

Header Style  

Sets the default header style.  

Header align 

Aligns the heading of technical requirements for the title block. 

Default Layer 

Sets the standard layer to accommodate the technical requirements. 

Designations indicate areas near to the position 

Automatically inserts lettering area next to the item number. 

Offset from title block(x) 

Sets the value of the indentation from the left edge of the title block horizontally.  

Offset from title block(y) 

Sets the offset value from the main vertical lettering. 

Notepad 
Settings for notebook in nanoCAD Mechanica 25. 

 

Path to the notebook 

Specifies the path to the notebook. 

Additional information on configuring the notebook here. 

Export specification to MS Office 
Setting the path to xml which will be exported specification 
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Special settings 
The tab "Settings" menu. Designed for setting up the parameters of the auxiliary 
functions  nanoCAD Mechanica 25. 

 

It contains the following sections: 

 Cutting surface 

 IDF Convert 

Cutting surface 
Complex tools to customize the display surface to be treated in the drawings  nanoCAD 
Mechanica 25. 

 

Color 

Tool selection control line color, indicating the surface. 
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The color display can be selected from a standard set and set of built-in your palette. 

Line thickness 

Sets the standard thickness of the line marking the surface. Typically, twice the 
thickness of the base line. 

Layer 

Set the layer to accommodate the line marking the surface. 

IDF Convert 
Set of tools for setting the inserted printed circuit boards in the IDF format  nanoCAD 
Mechanica 25. 

  

 

Capacitor, Default, Resistor colors 

Tool selection control color of individual elements of printed circuit boards. 

The color display can be selected from a standard set and set of built-in your palette. 

Draw drilled holes 

Shows or suppresses the holes in the printed circuit boards. 

Convert type 

It allows you to choose the type of the inserted printed circuit board that is displayed in 
the tree object manager (part, subassembly, assembly).   

3D 
The tab is used to configure 3D settings nanoCAD Mechanica. The tab is available with a 
license for 3D. 
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Картинка "Данные штампов по умолчанию" 

 Common settings 

 2D views 

 Pseudo section properties 

 Данные штампов по умолчанию 

file:///D:/svn/mcs47/Flare/Flare_en/Content/html/Decor_params/decor_params_79.htm
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Common settings 

 

Automatically project edges on sketch 

The parameter when adding a new sketch adjusts the display of the projection of the 
edges of a flat face taken as the working plane for the sketch. 

Call command "Add planar sketch". 
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Specify a flat face as a work plane. 

 

Depending on the setting, a projection will be added to the sketch. 
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Yes No 

  

Automatically project the origin point on new sketch 

Controls the projection of the origin point when creating a new sketch. 

Yes No 

  

Automatically correct UCS while editing block references with 2D constraints 

Automatic correction of UCS when editing a block reference with 2D constraints. 

Automatically create 3D constraints for standard objects 

Automatically create 3D constraints when inserting standard objects into parts and 
assemblies. 

Restory viewport's camera while exiting 2D sketch editing mode 

If enabled, the view camera will be in position before the sketch is edited. 

Edit parametric constraint value upon creation 

Controls whether the dependency editing dialog is opened immediately after 
installation. 
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Associativity for new bodies 

The enabled option allows you to build fixed bodies without the possibility of defixation. 
The sketch must be attached to some plane. 

Layer for sketches 

It allows you to customize the name of the layer on which will be placed flat sketches. 

Layer for construction geometry in sketchs 

Allows you to customize the name of the layer on which the design primitives will be 
located. 

Layer for working objects 

It allows you to customize the name of the layer on which the objects will be located. 

Layer for source planes 

Allows you to customize the name of the layer on which the source GCS planes will be 
located. 

Layer for source axis 

Allows you to customize the name of the layer on which the source GCS axis will be 
located. 

Layer for working planes 

Allows you to customize the name of the layer on which the created work planes will be 
located. 

Layer for working axis 

Allows you to customize the name of the layer on which the created work axis will be 
located. 

Layer for working points 

Allows you to customize the name of the layer on which the created work points will be 
located. 

Layer for sections 

It allows you to customize the name of the layer on which section will be located. 

Layer for parametric 3D solids 

Allows you to set the name of the layer on which the parametric 3D bodies will be 
located. 

Layer for nonparametric 3D solids 
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Allows you to customize the name of the layer on which non-parametric 3D parts will be 
located. 

2D sketch visual style 

Visual style of 2D sketch primitives. 

Editing 2D sketch visual style 

Visual style of 2D sketch primitives during editing. 

Show thread helix 

Controls the display of the thread helix. 

Thread helix color 

Thread helix color. 

Thread face color 

Thread face color. 

Mass display accuracy 

Mass display accuracy for inspector properties and part and assembly unit properties. 

Show tolerances in Parameters Manager 

Mass display tolerances in Parameters Manager and properties of parts and assemblies. 

2D views 

 

Automatic update 
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Sets the update mode 2D views 

Layer 

It defines the layer which will be located 2D views 

Visible lines 

Show on sections 

Adjusts the image visible lines on sections 

Line color 

Specifies the color of visible lines 

Linetype 

Specify the type of visible lines 

Lineweight 

It determines the weight of visible lines 

Hidden lines 

Show on sections 

It adjusts the display of invisible lines on 2D views 

Line color 

Specifies the color of hidden lines 

Linetype 

Specify the type of hidden lines 

Lineweight 

It determines the weight of invisible lines 

Section border 

Settings differ from visible 

It determines whether the parameters are different boundary lines of the section visible 
lines 

If not, the next line settings are not valid. 

Line color 

Specifies the color of the boundary line section 

Linetype 

Specifies the type of the boundary line section 

Lineweight 

It determines the weight of the boundary line section 
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Hatch 

Show 

It controls the display of hatching 

Face hatch 

Settings such as shading 

 3D. Pseudo section properties 

 

Hatch 

Show 

It controls the display of hatching. 

Face hatch 

Settings such as shading. 

Surface transparency 

Settings such as shading. Default 0 - full transparency. 

Configuration utility 

Configuration Utility 

C:\Program Files\Nanosoft\nanoCAD Mechanica 25\mg11\ McConfiguration.exe 

The utility is designed to manage a database of parametric objects of  nanoCAD 
Mechanica 25. 

The choice of a particular database depends on the size of the organization and the 
number of licenses used in it. 

If the application is used in a large organization that uses a lot of licenses nanoCAD 
Mechanica, it is advisable to store the database on one server(MSSQL). Any change to 
the database will be immediately available to all users. 

If you have multiple licenses in your organization, or you can not maintain the server, it 
is advisable to use local databases without using a server. The configuration utility 
allows you to connect files *.mcs - for win32 and *.mdf - for win64 (on Windows Vista 
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and higher). Updating the database on different machines will have to be done 
manually. 

 

Creating and restoring the database 

Restore 

Creates the database MS SQL Server from a backup created earlier. File "std.mdf" from 
the distribution as an archive does not fit.  

 For initial creation of a database it is possible to use a file of a backup of a database 
published on spds.ru. 

When you select a command, a dialog appears  "Select Data Source". 
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In this dialog, specify the machine name and the name of the Instance of SQL Server on 
this machine,which is supposed to restore the database. The desired values can be 
entered manually, or choose from a list of SQL Server present on the local subnet. 

Important! 
To restore a database, you have access to it and have sufficient 
rights established by the administration of SQL Server 

In the "Database" must specify a new database name standard nanoCAD Mechanica 25, 
and then click "OK".  

In field "Path to backup file (relative to server):" appears enter the relative path to the 
database. It must be a local path (UNC is not supported). 

Note that when restoring a database on the server (different machine from the one that 
runs the configuration utility), database backup file must also reside on the server. This 
is necessary to ensure that SQL Server account have the right to recover the database 
from the specified file. 

When you click on "OK" to start the recovery process (restore) the database. 

In the menu of the current database, use the following commands: 

Important! 
You should not use administrative tools SQL Server (Enterprise 
Management or SQL Management Studio) to restore the database 
from a file archive created by archiving of the configuration utility 

Current datebase 

The path to the current database. 

 

By clicking on the button  opens a dialog "Select Data Source" to specify the server 
and database. 



User Guide nanoCAD Mechanica 25 
 

113 

 

In the dialog box, you can select the type of data source: 

 MSSQL - The server and database fields are filled in. 

 Local base - The file on the disk is selected. The format of the local database files 
can be mcs(Access) and mdf(LocalDB). 

This field contains the path to the current database in the form of: 

SQL:<Server Name \ Name Instance>:<database name> 

The field to the local database contains the absolute path to the database file. 

Important! After specifying the database, the base control buttons will be available, 
depending on the type of database and access rights. 

Backup 

Creates a file - a copy of the current SQL Server database for subsequent recovery. By 
pressing the button, a dialog appears to specify a relative path to the file archive 
database. 

 

Clicking on "OK" will create an archive file. 

Repair 

Fixes corrupted database. 

Users 

 Allows you to edit user rights (to run, you need to have the appropriate rights). 
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The following templates are right: 

User - sees only system and its objects. Edits only its objects. 

Editor - sees only system and its objects. Edits only its objects. Has the right to publish 
its objects. 

Administrator  - sees all the objects in the database. Has the rights to edit all objects and 
publish them. 

Filter selects from the list of users on the typed letters contained in the user name. The 
list can be sorted by attributes, for this click on the column headings. 

View 

Starts window browser base, where you can modify the database structure: 

 Delete and move folders and objects; 

 Import and export objects (it is possible to import multiple files at once); 

 Publication and editing objects; 

 Create shortcuts; 

 Renaming, editing notes, setting the preview pictures. 
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Synchronize 

Open dialog "Database Management". 

 

This utility is designed to provide an update target databases from the source. Through 
it may be, for example, to update the local database sections or individual users with 
respect to a single central database Company (located, for example, on a server). 

To synchronize the database to choose: 

Target database - this database to be updated; 

Source database - this update source. 

By clicking on the button  opens a dialog "Select Data Source" to specify the server 
and database. 

 

In the dialog box, you can select the type of data source: 
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 MSSQL - The server and database fields are filled in. 

 Local base - The file on the disk is selected. The format of the local database files 
can be mcs(Access) and mdf(LocalDB). 

This field contains the path to the current database in the form of: 

SQL:<Server Name \ Name Instance>:<database name> 

The field to the local database contains the absolute path to the database file. 

Database Synchronization: 

 Synchronize only existing objects -in the target database will be updated only those 
objects that are present in the target database. 

 Synchronize all - in the target database will be updated all the objects present in the 
original database (if the target object does not present, it will be created), object 
paths are set as in the original database. 

 Synchronize and preserve path of existing objects - in the target database will be updated 
all the objects present in the original database (if the target object does not 
present, it will be created), the path to the objects that exist in the target 
database will be stored for no longer exist - will be created. 

Synchronize by list of difference - synchronizes the database objects selected in the 
difference list. 

Rewrite All - overwrites all database objects from the source database to the target 
database. 

Skip 3d Models - do not modify the 3d model found in the database.  

Synchronize GESN and ENIR - for the product "Construction Site": synchronizes the 
tables of the GESN and ENIR. 

Button "Synchronize" synchronizes to the previously configured parameters. When 
synchronizing, it imports from the target database to the source database based on the 
specified synchronization parameters. When you import, only those objects will be 
updated, the modification date of which in the source database is later than the 
modification date in the target database. 

Procedure for updating  nanoCAD Mechanica. 

On the SQL-server there is a database of enterprise details containing user-defined 
elements. The company received an update nanoCAD Mechanica, including an updated 
backup of the database. 

To update the database correctly, you must: 

1. Run the Configuration Utility. 

2. Restore the update database nanoCAD Mechanica from a backup. 

3. Press button "Synchronize", a dialog will open. Analyze the list of differences of 
objects in the current database and in the update, for which in the "Synchronize" dialog 
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it is necessary to click on the button "Diff list". All necessary facilities (concerns standard 
objects nanoCAD Mechanica, change of which is not required) export, and after 
synchronization - import into an already updated database. 

4. In the dialogue "Synchronize" select the type of synchronization "Synchronize all" and 
press button "Synchronize": 

 4.1. User objects created in the database will be saved when they are synchronized. 

4.2. Modified standard objects nanoCAD Mechanica will be merged. When 
synchronizing, each different item will be analyzed - if a new view is added - it will be 
saved, if the script is changed, for example - the date of changes in the current database 
and in the update will be compared, a newer script will remain. Thus, these details 
merge, and if they are present and different in both bases, the new ones are taken. 

Configuration Utility (system data) 
Tab "Computer" is designed to collect data about the hardware of the computer running 
the utility. 

 

To display information simply click  "Read configuration". 
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Transfer settings to another computer 
Custom settings files are located in the folder 

%APPDATA%\Nanosoft\nanoCAD Mechanica 25\ru-RU\AllOptions.xml - configuration 
file  nanoCAD 

To transfer settings, you must copy these files to the appropriate folders, and then in 
the settings nanoCAD Mechanica 25 specify the path to the settings for the design 
elements. 

The application database is located along the following path: 

%programdata%\Nanosoft\nanoCAD Mechanica 25\DataRW\std.mcs 

User objects stored in the local database must be exported or transferred as part of the 
entire database. 

Important! The function of saving the settings, when the saved file is the same as the 
one already existing, does not overwrite the old file, but complements it. 
I.e., when changing the standard, for example, from the ESKD to ISO, both 
standards will be available in the settings file. 

All changes to the profile table must be saved to the configuration file, 
otherwise these changes will only be displayed in the current work 
session. 

Layers and profiles 
Objects nanoCAD Mechanica 25 when inserted, can be placed on a special layer.In this 
case, you do not need to pre-create the desired layer or make it the current one: the 
program will automatically do this regardless of the current layer. 

In the settings of design elements, some objects have a parameter Layer.  

Each time an insert is inserted, the object is placed on the current layer nanoCAD. 

To change the object's insertion layer, select the desired layer in the list or write its 
name in the input field of the drop-down list: 

 

You can also take advantage of Table of Layers, selecting an item in the layer selection 
drop-down list. 
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In the dialog box "Table of Layers" a list of the layers available for use is given. 

 the symbol in the "On driwing" column indicates the layers that are present in the 
current drawing. 

Button " New Layer" adds a new layer to the table. 

Button "  Delete Layer" removes the selected layer from the table. 
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Layer Profiles 
 
Layer Profiles used when working together on drawings. Profiles allow you to 
automatically add a prefix to the names of the layers used to insert objects  nanoCAD 
Mechanica 25.  

To add and edit profiles, use the button  in the parameter line "Current profile" dialog 
box "Settings", tab "Main options". 

 

In the dialog box Table of profiles lists available profiles. 

Button "  Add profile" adds a new profile to the table. 

Button "  Delete profile" removes the selected profile from the table. 

Add a profile, select it in the table and close the dialog with the OK button. Close the 
dialog box  "Settings". 

When inserting objects nanoCAD Mechanica 25to the special layer, a prefix 
corresponding to the current profile will be added to the layer name: 

Important! The function of saving the settings, when the saved file is the same as the 
one already existing, does not overwrite the old file, but complements it. 
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I.e., when changing the standard, for example, from the ESKD to ISO, both 
standards will be available in the settings file. 

All changes to the profile table must be saved to the configuration file, 
otherwise these changes will only be displayed in the current work 
session. 

Overriding styles 

Command line: MCSETGOST. 

This command is required to create (override) dimension style, text style and line types 
in accordance with the standards of environmentnanoCAD Mechanica for further work 
correctly. 

Using this command can take in two cases: 

1. If the file was not created in the environment  nanoCAD Mechanica 

2. Dimension styles, text styles, or types of lines have been changed by hand and 
requires their recovery. 

Quick options 
Shortcuts for calling quick settings are set by setting hotkeys: 

 

The Quick Settings dialog contains the following items:    

 

 Current profile - indicates the current profile. 

 Automatically turn on snaps: Nearest, Endpoint, Quadrant, Center - when you 
insert objects from the binding database, they automatically trigger.  
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 Show invisible lines - displays and hides invisible lines of standard parts hidden 
with the "Alt+RBM". 

 Grid step - step of changing the diameter and length of a section of the shaft with 
its dynamic rendering. 

 Use grid - to use or not to use a grid snap when dynamically rendering a portion of 
a shaft. 

Working with standard elements 

Working with Database Objects 
Parts Library nanoCAD Mechanica25 is a database and stored in a file with the extension 
* .mcs. By default, after installing nanoCAD Mechanica25 used base recorded in a file in 
the folder std.mcs data, housed in the installation directory of the program  nanoCAD 
Mechanica25. 

Select another database possible, specifying the desired file in the "Database 
access"option in the settingsnanoCAD Mechanica25 "The path to the local database". 

Parts of the database can be exported as individual files, or import from external files 
into the current database of standard elements. 

The basic tools for working with database objects 
The basic tools for working with database objects are: 

"Main menu - Mechanica - Standard parts" 

or on the toolbar "Standard parts" 

 

 Tab manager 

 Standard parts library 

 Reinsert object 

 Markers, Groups 

 Insert group 

 Group objects 

 Add marker 

 Template wizard 



User Guide nanoCAD Mechanica 25 
 

123 

 Cover 

 Move up 

 Move down 

 Change hiden mode 

 Regenerate supression contours 

 Part trim 

 Add part trim 

 Remove part trim 

 Add view 

 Change representation 

 Mirrow part 

 Regenerate Std Parts 

 User defined object 

 Add constraint 

 Connect objects 

Tab Manager 

Main menu: Mechanical - Standard parts > Tab manager. 

Ribbon: Mechanical - Standard parts > Tab manager. 

Toolbar: Tab manager (on toolbar  "Standard parts"). 

Command line: MCTABS. 

Object Manager nanoCAD Mechanica 25 includes the following tools: 

 Manager database of standard objects  

 Objects  

 Pruning of standard parts  

 Finding and replacing text  

 Copying properties  

Tab "Library" 
Tab "Library" object manager is a universal means of access to the standard database 
objectsnanoCAD Mechanica25. 
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Details in the database are classified according to their design purpose. 

 

Management and structure the database by using the toolbar and the context menu 
that includes the ability to add, delete, or rename folders. 

Toolbar 

 Del object. Removes the selected item or folder from the database 

 Add folder. Adds a folder to the database 

 Insert object. Performs insert the selected database object in the drawing 

 View. Includes preview of database objects 

 Search panel. It includes search bar facilities on base 

 Refresh. Updates the tree base in the object manager. Press this button after 
making changes to the database   

Context menu 

The context menu has a different structure depending on call. 

In the palette - the object context menu: 
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In the palette - the context menu of a folder: 

 

"Add Folder" - adds the folder to a dedicated subsidiary. If the command was run on 
the selected object, the folder will be added to the parent folder object.  

"Save object in database as dwf block" - This utility allows you to save a single 
database of the drawings in format dwg, including standard items nanoCAD 
Mechanica25, design elements and primitives nanoCAD. 

"Delete object" - This command deletes the selected object. 

"Delete folder" - This command deletes the selected folder with all its contents. 

"Rename" - The command allows you to rename an object (folder). 
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"Import object" - Adding to our previously exported file or folder object database DB. 

To import a database from an external file, use the command "Import object" in the 
context menu invoked by a right-click on any folder or object in the section "Library" 
object manager. This will bring up a dialog box in which you specify the path to the file. 

When importing compares the last modification date of the original (stored in the 
database) and the imported object. At concurrence of the imported content from 
content database objects will be updated only if they have more recent modification 
date. 

If the command "Import object" was called for a standard lens, the outer fragment is 
imported to the folder containing the object. 

 

"Export object" - Save the file to disk or folder object database DB. 

To export any portion of the database you should use the command "Export object". In 
the resulting dialog box, then you need to specify the path and file name for saving the 
captured designated section base. 

Note: 
Import operation into the database or export from the database 
can be made as separate objects, and entire folders with libraries 
of parts. 

"Send by email" - It creates an e-mail with an attachment - Export objects. 
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"Copy" - Stored in a buffer object reference to paste a label on it. 

"Paste shortcut" - Inserts a shortcut to a previously copied object 

"Open with ScriptMaster" - Opens the object in the Object Wizard to edit. 

"Add this folder palette" create a bookmark in the palette manager of the objects of the 
selected folder. 

"Refresh" - Updating of the database (for example, after editing). 

Tab "Objects" 
Tab "Objects" object manager is a universal means of reviewing, monitoring, editing 
facilities nanoCAD Mechanica25, are on the drawing. 

Places on this tab are grouped into sections - for example, standard parts, callout, 
bolted connections, etc. In order to navigate in the drawing the selected object is 
highlighted. 
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Toolbar 

  Edit object.It calls the dialog for editing the selected object 

  Del object. Deletes the selected object 

 Refresh. Updates the list of objects. The button is used when adding or 
removing objects from the drawing 

 sQuick select. Search Tool nanoCAD Mechanica25 objects in the drawing on the 
set parameters, run the command "Quick Pick" 

 Find and Replace. Open dialog boxFind and Replace. 

Context menu 

In addition to the teams that are in the toolbar, the context menu of a selected object 
contains the following items depending on the selected object, and includes a team of 
repeating the context menu of the object on the drawing. Thus the tab "Objects" allows 
you to edit objects without having to search for them saturated drawing regardless of 
layer. 
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For example, for sub-database nanoCAD Mechanica25, further include items "Change 
representation",  "Bring to Front", "Send to Back", and "Change cover mode". 

Option "Hide" makes the selected object invisible in the drawing. 

Standard parts library 

Main menu: Mechanical - Standard objects >Standard parts library. 

Ribbon: Mechanical - Library >Standard parts library. 

Toolbar:  "Standard objects") >Standard parts library . 

Command line: MCSTD. 

Inserting standard parts from the nanoCAD Mechanica 25 database is carried out using 
the database manager, which can be presented in full (dialog) form and in the form of a 
tool palette. 
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Inserting standard parts 
1. Select the insert object. 

2. After selecting the object, specify the insertion point for the object. 

3. Select the insertion direction (not all parts need to specify a direction vector). The 
dialog box for selecting object parameters will open. 

4. Adjust the options in the dialog box. 

The standard dialog contains the following sections (sections are divided into tabs): 

 Table parameters 

 Properties 

 Dependences 

 Calculations 

Important! The composition of the sections (tabs of the insert dialog) is determined 
by the class of the part, its parameters and the environment of the insert. 

The button "Dynamic input" turns on the mode of visual definition of parameters 
when inserting. 
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As you move the mouse cursor, follow the change in the size of the object. LMB click to 
confirm the selection of the parameter value. 

The "Apply" button allows you to apply the selected parameter values to the object 
without closing the dialog box. This deactivates the "Dynamic input" mode. 

Important! The description given here refers to the standard dialog for selecting 
parameters. Some objects of the nanoCAD Mechanica 25 base use special 
dialog boxes. In special dialog boxes, the location of the controls may vary. 

 

Note: If the path to the custom help is specified in the "Help" parameter of the 
standard part form, it will be called if the focus is on the form control. If the 
focus is on the "Cancel" or "OK" buttons, the help for standard items opens. 

5. Click "OK" to complete the dialog. 

Toolbar Commands 
 Add folder - Adds a folder at the specified location in the object tree. 

 Delete - Deletes the selected object or folder. 

 Edit note - Changes the name and note of the selected object. 
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Context menu commands 
 Import - Imports a base object. 

 Export - Exports a base object. 

 Send by email - Exports the object and sends it to the specified mail address. 

 Cut - Cuts an object, folder. 

 Paste - Inserts a previously cut object, folder. 

 Paste shortcut - Inserts a shortcut to a previously cut object, folder. 

 Add folder - Adds a folder at the specified location in the object tree. 

 Delete - Deletes the selected object or folder. 

 Edit note - Changes the name and note of the selected object. 

 Publish- Makes the object visible to other users of the network database. Objects 
can be published by administrators and editors (editors only their own objects). 

 Remove publish - Makes the object invisible to other users of the network database. 
Objects can be unpublished byadministrators and editors (editors only their own 
objects). 

Note: The "Publish" and "Remove publish" commands are only available to editors and 
database administrators.  

The table settings 
On the "table settings" dialog insert standard parts displayed parameters responsible for 
the geometry of the object. These parameters correspond GOST'u (OST'u). 
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Properties 
Properties of the parts that can be changed and described in the script are displayed on 
the "Properties". On this tab located custom and reference parameters, switches 
species details and details of performances. 

 

In the process of inserting parts "Glass" automatically set the relationship between the 
items "Bearing", "End caps" and "Glass" (with parts falling into the aperture). 

For items that have parameters available for manual entry or dynamically change tab 
"Properties" presents additional opportunities. 
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Consider the example of the detail "Glass" features interaction details. 

 

The "Bearing diameter" - gray. This says that this option is not available for editing and 
dependence associated with the diameter of the bearing. 

 

To enable editing of this option, you must go to the tab "Dependencies" and remove the 
dependency between the diameter of the items "Bearing" and an inner diameter of 
workpiece "glass.". 

 

Remove Dependency pressing the "Delete" 

After this option is available for editing. 
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Dependences 
The "Dependences" tab allows editing of dependences set automatically during the 
details allocation on the drawing, and dependences set with the "Dependences control 
dialog" . 

Types of dependencies: 

 

Parametric - settable parameter object equality arithmetic expression object 
parameters, which occurs accession. 

 

 

Calculations 
For rod attachment parts provided estimation during insertion. The result of the 
calculation is the recommended thread diameter for given loading conditions and 
strength class details. 

For some types of rolling bearings estimation is also provided. The result of the 
calculation is the life of the bearing for the given loading conditions. 

Reinsert object 

Main menu: Mechanical - Standard parts > Reinsert object. 

Ribbon: Mechanical - Standard parts > Reinsert object. 

Toolbar: Reinsert object (on toolbar  "Standard parts"). 

Command line: MCPICKPOINT. 
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Serves to re-insert the object in the drawing, combines editing commands properties 
and movement of item. 

1. Click reinsert object .  

2. Select the drawing or pasted object from the database. 

3. Specify the new position of the object and insertion point. 

4. Click OK. 

Markers, groups 

User Groups 
Working with groups in Construction 25 is performed using the following commands: 

 Create custom groups 

 Inserting User Groups 

Create custom groups 

Main menu: Mechanical - Standard parts - Markers, Groups > Group objects. 

Ribbon: Mechanical - Library > Group objects. 

Toolbar: Group objects ( "Standard parts"). 

Command line: MCGROUPOBJECTS. 

Constraints describing the interaction of two or more objects, It is advisable to store 
these in the objects database in a related group. Group nanoCAD Mechanica 25 has the 
following features: 

 Group is stored in the object database, has a pattern preview before pasting. 

 Components of the group in addition to objects nanoCAD Mechanica 25 can be 
primitives and blocks in nanoCAD. 

 Group may be transferred as part of the database file to other users. 

 Group may have additional dependencies with other groups and objects. 

 Components of the group remain together parametric dependence. 

 Components in the group can be specified both individually and in groups. 

Thus, the group is a powerful way of organizing and structuring graphics data in a 
separate local file drawing document. 
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Create a Group  

Button Group objects 

Gather and create database objects in the design position in the drawing. On the 
toolbar, Library objects,click Group objects. 

Select the required objects in the drawing AutoCAD specify the origin of the group. 

In the dialog box New group on the left side is a list of objects in the group. Name 
objects in the list is taken from the string value for the specifications set in the 
properties of objects. 

Button Highlight group objects highlights and centers on the screen objects in the 
group. 

Button Set parameter table. Opens the editor table settings. Table of parameters 
used to select the group attribute values from a predefined list of values. 

Button Show form editor. Opens Form Editor to create a special dialog box. 

Button save changes to database. Saves the base group  Construction Site 25. 

In the right part of the window picture preview and a list of attributes for the group. 

Editing attributes produced in the cells of the table. 

 

Adding attributes produced from the parameter list of objects in the group.  

Expand the selected entry in the list (with the "+" next to the name of the object) and 
double click on the parameter, add an attribute in the table. 

You can install a bidirectional relationship between the group and attribute parameter 
object that is associated with this attribute. The list of attributes in the column Attribute 

Properties , click the left mouse button on the icon . Depending on the mode change 

bidirectional, it will indicate the icon . Thus, when the value of the attribute group, 
and the parameter of the object is changed. 

Save the group of objects in the database by pressing the button save changes to 
database. Choose a location and name for the group (the default group name matches 
the specified value attribute Group Name). Click OK. 

Group created and saved to the database. Now you can insert multiple grouped objects 
in a drawing, resizing and positioning of objects, while preserving established parametric 
and geometric constraints. 
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Important! 

Group objects only retains information about dependencies 
between objects and attributes set. For insertion to be carried out 
correctly, you must have a database of all the objects in this 
group. 

   

When working with a group of attributes of the various available methods for selecting 
values. In the context menu of the column Properties attribute in the attribute list, 
select: 

     

 Add property from object - allows you to set the attribute value by linking it with 
an attribute value of another object in the drawing. 

 Set to unique string - allows you to set the attribute-counter, which will increase 
its value by 1 for each subsequent inserted marker. In the Value column for the 
visible attribute counter must specify a character string - prefix. The drawing will 
be appended to the prefix value of the counter. 

 Set to calculated field - allows you to set the attribute value using a mathematical 
expression, using references to other attributes of the marker and mathematical 
functions. In reference to another attribute marker use the name of the attribute 
recorded in braces. 

 Automatically increment - allows you to set the attribute-counter, which will 
increase its value to 1, compared with the same attribute of the previous insertion 
marker. This attribute allows the counter-repetition of identical values for several 
markers that distinguishes it from the attribute set to a unique value. 

 Set to simple field - sets the attribute type by default. 

Insert group 
Insert group may be carried out as the object manager , and with a tool insert group. 

Button Insert Group toolbar Library objects opens a dialog Box group. 
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In the list of the group and press OK. If you insert a group of objects , you must specify 
the insertion point of the group. If you insert a group of dependencies , you need to 
select the drawing objects that you want to associate with the dependencies. 

In the dialog box Insert group commands are available: 

Create group. Creates a new group. 

Delete group. Deletes the selected group from the database. 

Select items from the drawing for the group. Used to edit an existing or new group. 

Detail groups. Opens a list of groups of items. 

Dependence group. Opens a list of groups dependencies. 

Switch multiple . Enables insertion of multiple groups in the drawing. 

Switch Add group marker. If installed, together with a group of drawing a marker is 
added to the group. 

Marker group is designed for group editing and data to other objects in the drawing 
(see Binding arbitrary graphical and tabular data ). 
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Editing a Group 
After you insert a group of objects in the drawing, or when the command to edit the 
marker group opens the edit dialog group. 

Highlight group objects. Highlights and centers on the screen objects in the group. 

Edit marker Properties. Includes editing mode, where you can change the set of 
objects in the group, add or remove attributes. 

Object tree. Enables and disables the object tree in the left pane. 

Set parameters table. This button is available if the group contains a table of 
parameters. In the dialog box, select the row attribute values, and click OK. 

Group dependencies 
Group dependencies remain parametric description and assembly relationships 
between objects. When you insert such groups they are not added to the drawing 
objects, but only established the relationship between existing objects. 

Consider creating and maintaining relationships between the two cuffs. 

Important! 
Before you create a group, you must place the drawing objects to 
be included in the group and set the dependencies between 
objects. 

Insert the base of the two objects Cuff GOST 8752-79. Set between the geometric co-
directional dependence Combining axis and the plane at a distance obj.B (see 
Constraints between two objects ) and the parametric dependence of the outer 
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diameter. 

 

Select Insert group.  

In the dialog box, click Dependence groups. 

 

Button  Creates group. In the groups list, change the name of the new group (eg, 
"Package cuffs"). To edit, click the left mouse button on the name of the group. 

 

Click Select group details from drawing and select the drawing both cuffs. Press Enter. 

In the dialog box, select the dependent listed in the list established between objects. 
Click OK. 
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Look at the result of the creation of group dependencies. 

 

In the description of the group under the picture preview Set the selection order when 
inserting objects group dependencies. 

Group dependencies are stored in the database automatically. Click Cancel to complete 
the group. 

Insert a drawing of the base of the cuff, which must be applied to create a dependency. 
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Select Insert group , click Group Dependency . In the list of dependence " Package cuffs. 
" Click OK. 
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Select the drawing cuffs to be connected sequentially (in the example need to perform 
steps 10-11 twice). 

 

Automatically set dependence stored in the description of the group. 
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Inserting Groups 

Main menu: Mechanical - Standard parts - Markers, Groups > Insert group. 

Ribbon: Mechanical - Library > Insert group. 

Toolbar: Insert group ( "Standard parts"). 

Command line: MCINSERTGROUP. 

Library: Groups. 

Command Options 

Insert group Box lets you create a set of objects with superimposed parametric and 
geometric constraints. 

 

Create group 

Deleting Group 

Select group details from drawing 

 Switch between groups of objects and dependencies 

The mechanism used in the team group insert , you can insert a group of objects  
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The "Add marker group" enables the group a graphic element - a marker located at the 
insertion point of the group. In marker may include parameters of individual parts group 
that can help you when pasting automatically change the geometry of the group of 
related components. 

"Multiple insert" allows you to create multiple copies of the selected group. 

If a user group has been maintained by the standard in the folder $\MCS\Groups, then 
insert it in the tree by choosing the object manager. 

If a group is defined form, then insert dialogue is as follows: 

 

 The dialog box includes a tree of groups - a list of objects and their parameters 

group. This tree can disable button  
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 The preview window group 

 Form input values group 

When you click on  you can switch to edit mode group settings. 

Universal marker 

Main menu: Mechanical - Standard objects - Markers, groups > Add marker. 

Ribbon: Mechanical - Library > Add marker. 

Toolbar:  "Standard objects"> Add marker. 

Command line: MCCREATEUMARKER. 

The "Marker" tool is designed specifically to create a connection between an arbitrary 
graphic object (primitive) nanoCAD and a spreadsheet-specification. A universal marker 
is a translator of data from drawing objects into the nanoCAD Mechanica 25table by 
means of special means - marker attributes. 

Marker attributes can be visible or hidden. The values of the visible attributes are 
displayed in the drawing as text strings. 

The marker, as an object nanoCAD Mechanica 25, can be saved in the object library and 
used repeatedly. The marker can also be included in the groups of objects nanoCAD 
Mechanica 25, providing the ability to specify the entire functional groups. 

Create marker 

Let's consider creating a marker in the form of a positional leader. 

1. Set the required current scale. 

2. Insert two text lines into the drawing and draw a horizontal line between them. 

 

These objects will form a leader shelf template with two text labels. To use text strings 
as marker attributes, the first character must be "$". 

3. Call the command "Add marker", use a box or crossing box to select the objects 
that made up the marker. 
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4. Snap the base point of the marker. 

 

5. The "Creation of a marker" dialog box appears. The properties table will list the 
attributes entered in the callout text boxes: 

 

Column "Name" contains the working name of the attribute. 

Column "Description" describes the attribute. 

In column "Value" the values of the attribute are entered. Values can be either numeric 
or text. Auxiliary commands are available in the context menu of the "Value" column. 
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Column "Attribute property" is used to indicate the type of the input attribute. Various 
attribute labels are provided to indicate their type. The default is "Set to simple field". 

 

Attribute types: 

 Add property from object - allows you to set an attribute value by associating 
it with the attribute value of another object in the drawing. 

Important! An object is understood as an object from the base of standard products. 

After choosing the type, it is suggested to select the object and the object attribute. 

 

After selecting an attribute, its value falls into the "Value" column, and in the "Attribute 
property" column the name of the selected attribute. 
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After assigning an attribute, you can change the type of relationship with an object 
attribute: 

One-way communication - changing the value in an attribute of an object affects the 
value of the marker. 

Two way communication - changing the value in the marker affects the attribute of 
the object, and vice versa. 

Basic communication - an attribute of an object can only be changed from a marker. If 
the attribute is a table value in a basic relationship, the closest value from the table is 
displayed. The entered value will be displayed in brackets. 

 Set To Unique string - allows you to set a counter attribute that will increase 
its value by 1 for each subsequent inserted marker. In the "Value" column for 
the visible counter attribute, you can specify a character string - a prefix. In 
the drawing, the counter value will be appended to the prefix. 
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 Set to calculated field - allows you to set the value of an attribute using a 
mathematical expression, using references to other marker attributes, 
operators, and mathematical functions. The name of the desired attribute is 
used as a reference to another marker attribute.  

Note: Computed attributes are defined and calculated from top to bottom. 

 

Important! Calculations are performed in curly braces. 

Function: 

 

Result: 

 

 Automatically increment - allows you to set a counter attribute that will 
increase its value by 1 compared to the same attribute of the previous 
inserted marker. Such a counter attribute allows repetition of the same 
values for several markers, which distinguishes it from an attribute set to a 
unique value. 
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 Set to simple field - sets the default attribute type to plain text. 

Note: Attributes included in the block can be included in the marker attribute table  
nanoCAD! 

6. Edit the marker using the marker controls at the bottom of the dialog box. 

 

Include: 

 "Marker draw mode". When you click on this button, a drop-down list of 
rendering modes appears: 

 Simple marker. 

 Draw position line. 

 Linear align. 

When you select the display method with the addition of a leader line, an additional 

button "Arrow Type" appears to select the type of arrow: 

 

Click this button and select the desired extension line arrow type. 

Arrow display parameters are defined in the "Settings - Symbols - Extension - Additional 
extension lines" settings. 
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 "Unploted". When this button is enabled, the marker is placed on a special 
layer that is not displayed when printing. When this mode is activated, the 

icon on the ( ) button changes and the marker is displayed in gray on the 
screen (in accordance with the color of the non-printed layer). 

 "Show form editor"- calls the custom form editor to create a dialog for 
working with marker attributes. 

The following commands are available in the drop-down menu: 

"Edit Form". Open Form Editor. 

"Add Form. Adds additional forms, while the marker can change the appearance of the 
form, by condition or by the user's choice. By default, the marker has one form. 

 

The form editor uses standard Windows form generation technology. The toolkit 
consists of three blocks - the graphic editor area, the toolbar with form objects and the 
properties window of the inserted elements. For inserted fields, the "Field Name" 
("Variable") can be selected from the list of existing marker description fields. In this 
case, the default field value is equal to the field value in the marker description. 

When adding a second form, you are prompted to enter a name for the form. The 
variable Tag - mcFormName is added to the properties table. This variable is responsible 
for the name of the form, it can be set in a calculated field and, for example, made equal 
to execution. Empty or "Main" is considered the main form. 

 

 "Geometry". Used to change the appearance of the generic marker and 
define the insertion point. 
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The following commands are available in the drop-down menu: 

Get new geometry. The button is used to change the appearance of the universal 
marker and define the insertion point. 

Export marker source graphics. Exports marker geometry to a file. 

 Add Implemetnation. Adds additional performances, while the marker can change its 
appearance, by condition or by the user's choice. 

When creating a new implementation, you are prompted to enter its name. When 
adding implementation, the Tag - mcImplementation variable is added to the properties 
table. This variable is responsible for the name of the current marker implementation. It 
can be set to a calculated field or linked to a list on a form. Empty or "Main" is 
considered the main implementation. 

 

 "Set parameters table". Opens the marker parameter table editor. When 
inserting a marker and having a table of values, it is possible to assign a group 
of values to the marker attributes. 

 

In the list, select the parameters whose values will be selected from the table. In the 
right part of the window, enter the required number of lines with values. Close the 
dialog with the "OK" button. 
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 Save changes to odatabase. The button is intended for writing a marker to 
library  nanoCAD Mechanica 25. 

 Apply changes to all markers of this types. Applies changes to all markers 
of this type in the drawing. Serves for changing the marker template for all 
markers made according to this template and inserted into the drawing. 

7. If necessary, add any number of hidden attributes, filling in the rows of the table in 
sequence. The attribute is added in the bottom line of the table, marked with an 
"*" symbol. 

8. For future use of the marker, save it to the database as a named object. 

 

In the "Create element" dialog box, specify the path to save, the name of the object and 
the note (for more information on working with the object base, see the nanoCAD 
Mechanica 25Object Manager). After you save the marker, a message appears 
prompting you to update the existing copies of the marker in the drawing. 

9. nanoCAD Mechanica 25 makes it possible to immediately apply the created 
marker. The command line prompts you to install the generated token. Pick an 
insertion point in the drawing. Identical markers can be simply copied in the 
future. In other cases, the marker is inserted directly from the base. 
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Edit marker 

Editing of a marker is carried out in a dialog box, the title of which corresponds to the 
name of the marker. For example, when you call for editing the "Position_Marker" 
marker, the creation of which was described in the previous paragraph, the dialog box 
will look like this: 

 

Additional commands are located at the bottom of the window: 

 "Marker draw mode". When you click on this button, a drop-down list of rendering 
modes appears: 

 Simple marker. 

 Draw position line. 

 Linear align. 

When you select the display method with the addition of a leader line, an additional 

button "Arrow Type" appears to select the type of arrow: 

 

Click this button and select the desired extension line arrow type. 

Arrow display parameters are defined in the "Settings - Symbols - Extension - Additional 
extension lines" settings. 

  "Unploted". When this button is enabled, the marker is placed on a special layer 
that is not displayed when printing. When this mode is activated, the icon on the 

( ) button changes and the marker is displayed in gray on the screen (in 
accordance with the color of the non-printed layer). 

 "Highlight info source object". Highlights in the drawing the object with which 
the marker is associated (The function is available if the "Add property from 
object" mode is set for one or several attributes and the corresponding object was 
specified when inserting the marker). 
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 "Edit marker properties". Turns on the edit mode, in which you can change the 
appearance of the marker, add or remove attributes. 

System variables in marker 

mcImplementation - Execution management. Empty or "Main" means the main view. 

mcFormName - Form management. Empty or "Main" means the main form. 

mcArrowSize - Arrow size control. 

mcDefLayer - Controls the marker location layer. The "Value" field contains the name of 
the layer. 

mcShowFormOnInsert - Controls the display of the dialog when inserting. If the value is 
0, the dialog is not shown when inserting. The value can be calculated. 

Template Wizard 

Main menu: Mechanical - Standard parts - Markers, Groups > Template wizard. 

Ribbon: Mechanical - Library > Template wizard. 

Toolbar: Template wizard ( "Standard parts"). 

Command line: MCTWIZ. 

Template Wizard is designed to create easy to use tools of commonly used design 
elements drawing. 

Basic rules 

When the command will be asked to select an object to create a template. If the object 
was preselected, then immediately start dialogue Template Wizard. 
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Command Options 

Button Create template - creates a template in the database or applies the changes 
made in the editor. 

Button From - Starts the form template. 

Button Create a new template - Creates a new template in the database based on the 
selected graphics and created form. 

Button Delete form - deletes the created form template. 

Example of creating a template 

Consider the example of creating a template signs of roughness. To do this, the drawing 
shall bear one designation: 
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After you run the Wizard Templates chosen designation roughness. 

To work with the template you must save it in the database that will be invited to do by 

pressing the button . 

 

Then click on the Create a form and create a form using the notation tools online forms. 

For example, we can take two parameters - the first line designations and direction of 
irregularities. Both parameters are added to the form as a combo box (drag while 
holding Ctrl). 
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 >  

After editing, we obtain the form of the following form: 
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Close the form editor, click to update in template. 

 

Template will be saved in the database and will be displayed in the object manager. 
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Now when you insert from the database will be able to also place the designation of 
roughness on the shelf line-outs, but when you edit your form will appear:  

 

Editing blocks nanoCAD 

If the original graphics selected block nanoCAD, its attributes are also displayed in the 
form editor as available variables. 

 >  
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When creating a form in the database and maintaining such a block is inserted into the 
drawing as a block of the same source, only the attributes can be set up via a custom 
form. 

 

Control overlapping objects 

Change hidden mode 

Main menu: Mechanical - Standard parts- Cover > Change hidden mode. 

Toolbar:  "Standard parts"> Change hidden mode. 

Command line: MCCHCOVER. 

The command switches the display mode of hidden lines. 

nanoCAD Mechanica 25 allows you to hide individual graphics elements. The 
overlapping nature of the base object or user block is determined by a special 
parameter - the overlap level ZOrder. ZOrder - this is a numeric parameter whose value 
determines the overlap priority. An object with a large ZOrder value overrides an object 
with a lower value. 

Primitives nanoCAD have the lowest overlapping level and therefore are always 
overlapped by objects from the database. That at an insertion of object nanoCAD 
Mechanica 25 objects nanoCAD did not overlap, it is necessary to disable the switch in 
the object insert dialog "Cover primitives": 
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The area in the drawing that the base object covers nanoCAD Mechanica 25, is called 
"Contour of suppression". An overlap exists within this contour. 

Procedure 

1. Call command. 

 

2. In the context menu, select the desired view of the overlapped objects "Normal", 
"Dotted" or "Switch". 
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Normal Dotted Switch 

  

The 
command 
appends 
the value. 
Those. If a 
normal 
overlap 
has been 
establishe
d, then 
the 
dashed 
line 
becomes, 
and vice 
versa. 

3. Select the secant frame for the objects for which you want to change the 
overlapping mode. 

4. Repeat if necessary items 2 and 3, or complete the command on the key  "Enter". 

Regenerate suppression contours 

Main menu: Mechanical - Standard parts - Cover > Regenerate suppression 
contours. 

Toolbar:  "Standard parts"> Regenerate suppression contours. 

Command line: MCCOVER. 

Regenerate the drawing and redraw the contents of the current viewport. 
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Before After 

  

Move up 

Main menu: Mechanical - Standard parts - Cover > Move up. 

Toolbar:  "Standard parts"> Move up. 

Command line: MCMOVEUP. 

Procedure 

1. Call command; 

 

2. Select the objects you want to move up; 
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3. Select the objects to be compared; 

 

4. After the selection is complete, the objects that need to be moved up will 
automatically increase the overlap level (ZOrder). 
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Move down 

Main menu: Mechanical - Standard parts - Cover > Move down. 

Toolbar:  "Standard parts"> Move down. 

Command line: MCMOVEDOWN. 

Procedure 

1. Call command; 

 

2. Select the objects you want to move down; 

 

3. Select objects to be compared; 
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4. After the selection is complete, the objects that are to be moved down will 
automatically decrease the overlap level (ZOrder). 

 

Part trim 

Add part trim 

Main menu: Mechanical - Standard objects - Part Contour Trim > Add part trim. 

Ribbon: Mechanical - Library > Add part trim. 

Toolbar:  "Standard objects"> Add part trim. 

Command line: MCTRIM. 

The command allows you to trim objects of metal structures. 
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Trimming with contour indication 

1. Call the command  "Add part trim". 

2. Pick an outline. A contour can be a line segment, circle, arc, polyline (closed and 
open). 

 

3. Specify trimming objects.  

If a circle or closed polyline is used as a path, the trimming object is selected within the 
path. 

 

If a linear path is used, the trimming object is selected from one side of the path. 
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4. Press the "Esc" button to end trimming. The object will be trimmed. 

 

Trimming mode "COntour" 

1. Call the command  "Add part trim". 

2. Select trim mode  "COntour". 

3. Draw a closed polyline path. 

 

4. Pick a trimming object within the path. 

 

5. Trimming an object is made. 
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Trimming mode "rectangle by tWO points" 

1. Call the command  "Add part trim". 

2. Select trim mode  "rectangle by tWO points". 

3. Pick the first corner. 

 

4. Pick the second corner. 

 

5. Pick a trimming object inside the rectangle. 

 

6. Trimming an object is made. 

 

Trimming mode "rectangle by thrEE points" 

Allows for trimming at the desired angle. 
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1. Call the command  "Add part trim". 

2. Select trim mode  "rectangle by thrEE points". 

3. Pick the first point. 

 

4. Pick the second point. 

 

5. Pick the size of the outline. 

 

6. Pick a trimming object inside the rectangle. 
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7. Trimming an object is made. 

 

Trimming mode "HOle" 

1. Call the command  "Add part trim". 

2. Select trim mode  "HOle". 

3. Pick the center of the hole. 

 

4. Pick a radius for the hole. 

 

5. Pick a trimming object inside the circle. 
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6. Trimming an object is made. 

 

Remove part trim 

Main menu: Mechanical - Standard parts - Part Contour Trim > Remove part 
trim. 

Ribbon: Mechanical - Library > Remove part trim. 

Toolbar:  "Standard parts"> Remove part trim. 

Command line: MCTRIMDELETE. 

The command removes a previously created trim. 

Procedure 

1. Call the command "Remove part trim". 

 

2. Specify the objects you want to reset and press "Enter" (or press "Spacebar") to select 
all objects. 



User Guide nanoCAD Mechanica 25 
 

176 

 

3. The specified objects will be restored to their original state. 

 

Add View 

Main menu: Mechanical - Standard parts > Add view. 

Ribbon: Mechanical - Standard parts > Add view. 

Toolbar: Add view (on toolbar  "Standard parts"). 

Context menu: Add view (on select object). 

Command line: MCADDVIEW. 

Designed to quickly add a new type of projection from the base of the inserted object to 
the drawing. 

 Select the object to copy. 

 Specify the insertion point of the object. Context menu commands Front / left / 
right / top / bottom standard projection (to insert a particular projection, it is 
necessary that it be recognized in the object). 

 Context menu commands Point, Angle mode selection switch, respectively the 
insertion point or selection mode direction. 

 Complete the cyclic command. 

Adding a projection view to the object database can be done using the Add View from 
the context menu for the selected object. 
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Simplified / Full View 

Main menu: Mechanical - Standard parts > Change representation. 

Ribbon: Mechanical - Standard parts > Change representation. 

Toolbar: Change representation (on toolbar  "Standard parts"). 

Context menu: Change representation (on select object). 

Command line: MCCHANGEREPRESENT. 

 Press the button and select the database object in the drawing. 

 Context menu commands Full, Simplified select the object representation. 

Switching presentation can be accomplished by using the Change view from the context 
menu for the selected object. 

Mirror Part 

Main menu: Mechanical - Standard parts > Mirrow part. 

Ribbon: Mechanical - Standard parts > Mirrow part. 

Toolbar: Mirrow part (on toolbar  "Standard parts"). 

Command line: MCMIRROWSTD. 

 Press the button and select the database object in the drawing. 

 Press Enter. 

Occur along the axis of revolution object X. 

Regenerate STD parts 

Main menu: Mechanical - Standard parts > Regenerate Std Parts. 

Toolbar: Regenerate Std Parts (on toolbar  "Standard parts"). 

Command line: MCREGENSTD. 

The team needed to upgrade the graphics part of the object (s). 

Operation 

1. Call the command "Regenerate STD parts" 
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2. Specify the objects that you need to update or Enter, if you need to update all of 
the objects. 

3. These objects will be updated 

User defined object 

Main menu: Mechanical - Standard parts > User defined object. 

Ribbon: Mechanical - Standard parts > User defined object. 

Toolbar: User defined object (on toolbar  "Standard parts"). 

Command line: MCCUSTOMOBJ. 

Tool User object makes it easy to group in objects nanoCAD and nanoCAD Mechanica25 
into a single object. Custom objects support the ability to overlap other objects in the 
drawing. 

1. Select the objects to create a custom object. 

2. Specify part origin point. 

3. Specify the drawing insertion and direction. 

4. In the dialog box, set the value of the level of overlap of the object (for Level Z). 
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When you create a custom object contour suppression, external contour of the object is 
automatically detected contour suppression external contour of the object. 
Subsequently, the control circuit is used when objects overlap on the drawing.. 

Custom objects support editing with standard tools nanoCAD Mechanica25. 

Managing Dependencies 

Main menu: Mechanical - Standard parts > Add constraint. 

Ribbon: Mechanical - Library > Add constraint. 

Toolbar: Add constraint (  "Standard parts"). 

Command line: MCCONSTRAINT. 

In the dialog box Constraints: 

 

In the dialog box set parametric and assembly (geometric) dependencies between 
database objects. 

The window is divided into two parts: 

Left - The child 

Right - The parent object 

Use 1-selected object and 2 were selected to the choice made in the drawing, 
respectively subsidiary and parent objects. After selecting an object in the 
corresponding half of the window, a list of parameters of the object, which includes: 
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 Property name 

 List surfaces (work surfaces) 

 The list object's parameters 

 List of installed parametric relationships 

 List of installed assembly constraints 

 

On two tabs depending Parametric and Assembly constraints established relationship 
between parent and child objects. 

Parametric dependence connects the parameters of objects. 

Assembly dependence binds workplanes objects. 

Button  New dependency. Allows you to create a new dependency 

Button  Delete dependency. Deletes the selected list dependence 

When adding or editing button is activated depending Save dependence, which 
allows you to save your changes. 

 
 

Installing the parametric dependence 

 
 

When installing the parametric constraints is associated parameters are recorded in the 
corresponding input fields located below the list object's parameters. Selecting the link 
parameters by double-clicking on the corresponding parameters in the list. 
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Installing assembly according 

 
 

To install the switch assembly according to the tab Assembly constraints. 

Choose binding surface by double-clicking on the appropriate working plane from the 
list. 
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Selecting the plane can also be done visually in the drawing by clicking labelled plane 
and the linked marker indicating the working plane of the object. 

 

The choice of method depends overlay using the buttons at the bottom: 

Axial and surface alignment 

Surface alignment 

Combination axis 

Direction 

Choose mutual orientation related planes using the buttons: 

Counter-directional 

Codirectional 

Button  Bidirectional constraint. Enables two-way relationship in which a related 
parameter or surface of the parent object changes with appropriate changes to the child 
object. 

Compound objects 

Main menu: Mechanical - Standard parts > Connect objects. 

Ribbon: Mechanical - Library > Connect objects. 

Toolbar: Connect objects (  "Standard parts"). 

Command line: MCCONNECTTO. 

This command is used to overlay preset assembly and parametric dependencies on 
objects in the drawing. 

After running the command must specify. 

1. Child object - an object that will be joining. 

2. Parent object - the object to which you will attach the child object. 

Upon completion of the command will be imposed on the details of parametric and 
geometric constraints defined in their script.. 

Recognition graphics drawings 

Main menu: Mechanical - Recognition > Symbol block recognition. 
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Ribbon: Mechanical - Utilities > Symbol block recognition. 

Toolbar: Symbol block recognition (on toolbar  "Recognition"). 

Command line: MCRECS. 

Using commands recognition of graphic objects will significantly speed up the process of 
registration as the projections of old drawings and new, but made by hand without the 
use of any application. 

Character Recognition is offered to carry out automatic or semi-automatic mode. 

nanoCAD Mechanica 25 recognizes the following symbols and signs on the drawing: 

 ymbols, text callouts; 

 formats; 

 specification sheets; 

 table. 

Call Team 
By default, the toolbar "Character Recognition" is not displayed. 

To invoke it, place the cursor pointer on the main toolbar nanoCAD Mechanica 25and 
click the right mouse button. In the context menu, click on "Recognition".  

You will see an additional toolbar: 

 

 Character recognition 

 Recognition formats 

 Recognition specifications 

 Table recognition 

Automatic recognition 
To perform automatic recognition of characters in the drawing context menu after 
recognizing any symbol. 

Automatic character recognition requires checking the entire drawing, so it is not 
recommended for use in saturated drawings. 
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Recognize the main frame with the inscription enough to the source drawing contained 
within the Standard size, two contour lines and the title block. 

Entries in the title block recognizable drawing are automatically entered in the dialog 
box title block, add additional fields and zones. 

Recognition forms specifications 
Information in the figure, placed on the forms specifications after recognizing 
transferred to Excel. 

For correct recognition itself form the specification may be a block or drawn objects 
such as "Line". 

The text in the cells of the form specification - an object of type "text". 

Dialog "Overrides" 

Shortcut: ALT+RBM (when you hover over a line or shading standard element). 

It overrides the style of the individual lines in a standard cell. 

Sample call 
1. Insert a standard element, such as I-beams.In the properties, select the rendition of 
"left view" and the type of display "view with a cut". 

 

2. Do not get fooled by the hatch and press ALT+RBM. The "Overrides" dialog box. 
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Options 
Colour -changes the color of the line. 

 

Line width - change the line width. 

 

Hatch angle (degree) - controls the tilt hatch. The parameter is active only for the hatch. 
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Hatch step - changes hatching step. The parameter is active only for the hatch. 

 

Hide object - it makes an invisible line. The other parameters are ignored.   
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If the setting "Show invisible lines" is "Yes", then the line will be displayed with a color 
according to the setting of "Color of invisible lines". 

Override main lines 

Context menu: Override main lines (on the selected object). 

Command line: MCOVERRIDEMAINLT, OVERRIDEMAINLT. 

Users sometimes need to make retrofit drawings that show both new and existing 
objects at the same time. 

That is, for example, welding new fittings into an existing tank. In this case, the main 
lines of existing objects (fittings, hatches, bolts, shells, bottoms and any other elements 
of the base) should be depicted either as thin or dashed lines. 

To change these parameters, use the "Override main lines" command. 

Procedure 
1. Select the standard elements to override. 
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2. Call the "Override main lines" command. The "Overriding the main lines" dialog 
opens. 

 

3. Specify the required parameters. 

 

4. Click the "OK" button. The main lines of the selected objects will be overridden. 

 

Dialog 
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Linetype - the parameter allows you to select the line type from the list: Solid or Dashed 
line. 

Width - the parameter allows you to select the line thickness from the list. 

Color - the parameter allows you to select the color of the lines. 

Button "Clear all redefinitions" - removes all previously made overrides, brings the 
selected objects to the default settings. 

Designing 

Design fasteners 

Threaded fastening 

Main menu: Mechanical - Design > Threaded fastening. 

Ribbon: Mechanical - Design > Threaded fastening. 

Toolbar:  "Design"> Threaded fastening. 

Command line: MCJOINT. 

Tool for inserting a threaded fastening from library nanoCAD Mechanica 25. 

Procedure 

1. Specify the starting point of the threaded fastener in the drawing. 

2. Specify the end point of the threaded fastener, the "Fasteners" dialog will open. 
When inserting, tools are available to select the direction of drawing. Specifying the 
start and end points defines the centerline of the fastener. The intersected lines make 
up the thickness of the part package being fastened. 
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3. In the "Fasteners" dialog box, customize the look of the threaded fastener. 

Note: The thread fastener insert dialog automatically saves the last selected template 
and thread diameter. 

4. Confirm the settings with the "Apply" button, or with the "OK" button if you want to 
close the dialog at the same time. A threaded fastener will be built. 

 

Editing a threaded fastener 

You can edit a threaded fastener by editing the "Threaded fastener" object, or by editing 
individual parts included in the threaded fastener. 
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When editing, you can change the composition, diameter of the threaded fastener, as 
well as the parameters of the individual parts that are included in it. 

To open the threaded fastener setup dialog, apply any of the standard editing tools to 
the centerline of a group of parts. 

If tooltips are enabled in nanoCAD Mechanica 25 settings, then when you hover the 
cursor over the centerline, the "Threaded fastening" tooltip appears. 

Threaded fastener settings dialog box 

 

Template list panel 

It is possible to save a threaded fastener template for later reuse of assemblies with the 
same set of parts. To work with templates, use the buttons at the top of the dialog box, 
and below is a list of available templates: 

 

Button "Create new template" adds a new empty template. When creating a new 
template, the required number of holes is automatically added depending on the 
number of lines crossed in the drawing. 
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Button "Delete template" removes the selected template from the list. "Editing 
template" stores the current setting of the threaded fasteners. It cannot be removed. 

Button "Selecting insertion point" is intended to reselect the insertion point and the 
length of the threaded fastener in the drawing. 

Button "Manually select holes length and placement" opens a window for setting 
parameters of a package of connected parts. 

 

LMB clicking on one of the cells in the "Parts type" column switches the part / gap: 

 

In the "Parts width" column, the thickness of the corresponding part (or gap) is set. 
After setting the parameters of the connection package, close the window with the "OK" 
button. 

The context menu of the list of templates contains the commands: 

 Add folder 

 Delete object 

 Rename 

 Import object 

 Export object 

 Send by email 

 Copy 

 Configuration tool 
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These commands are similar to those used in the  object manager nanoCAD Mechanica 
25. 

Tab "Template" 

The following settings are available on the "Template" tab in the center of the dialog: 

 Fasteners properties 

 Package thickness - thickness of the package of parts to be joined, in mm. 

 View - selection of standard image projection. 

 Small thread pitch - fine pitch switch. 

 Simplified view - simplified / full image switch. 

 Details of the threaded assembly. The components included in the assembly are 
listed here in order. 

 Screw 

 Hole 

 Spot facing 

 Washer 

 Nut 

To select a part of a threaded assembly from the nanoCAD Mechanica 25 base, click in 
the cell of the GOST column of the corresponding element. 

The "Select object" dialog box will open the attachment parts folder. 

 

Additional settings for assembly components are available when expanding the list: 

 

Button "Clear" in the right column of the list table clears the selected position. 

Tab "Preview" 

A preview of the threaded assembly is available on the tab. 
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List of thread diameters 

 

The "lightbulb" icon above the list indicates that the selected diameter value 
can be used for all objects in the assembly: 

    The diameter value does not match one or more parts. Assembly is not 
possible. 

    The diameter value applies to all parts in the assembly. Assembly is 
possible. 

Button "Add part to template" 

Adds a part to the assembly after being selected from the list. The list of details available 
for adding depends on the currently selected object: 
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Button "Remove part from template"  

Removes the selected object from the parts list. 

Button "Dynamic selection"  

Turns on the mode of visual selection of the bolt length after closing the dialog. 

Graphical display type selection list 

When inserting a threaded fastener, 3 display methods are available, selected by the 
"Select fasteners insert part" button on the bottom toolbar of the dialog. The figure on 
the button displays the currently selected display method: 

 

With local out 

 

Normal insert type 

 

Insert hidden fastener 

 
  

Displaying chamfers on holes 

To select the options for displaying chamfers in the drawing, you must correctly place 
the marks in the hole properties. 
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Setting the hole type 

To change the hole type, click on it in the connection part set and select a different type 
in the "Select object" dialog box that opens. 

 

  

  

Rivet joint 

Main menu: Mechanical - Design > Rivet joint. 

Ribbon: Mechanical - Design > Rivet joint. 

Toolbar: Rivet joint ( "Design"). 

Command line: MCRIVET. 

Insertion tool riveted joint parts of the base standard elements nanoCAD Mechanica25. 

1. Specify the starting point for drawing the rivet assembly. 

2. Specify the endpoint of the rivet assembly. When you insert the available tools of 
choice destinations rendering . 

3. In the dialog box mounting parts adjust the view of the rivet connections. 
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To select the type of rivet base nanoCAD Mechanica25 click in the rivet. 

To select the type of base openings nanoCAD Mechanica25 click in the hole for rivets. 

It is possible to save the template riveted joint for later reuse assemblies with the same 
set of items. To work with templates use the buttons at the top of the dialog box, and 
below is a list of available templates: 

 

"Editable Template" stores the current settings bolting. It can not be deleted. 
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Button Create a new template. Adds a new blank template. 

Button Delete template. Deletes the selected template from the list. 

In the context menu templates available commands: 

 Add Folder 

 Delete object 

 Rename 

 Import from file 

 Export to file 

 Send by email 

 Copy 

These commands are similar to those used in in the Object Manager nanoCAD 
Mechanica25. 

Button Select the insertion point and the length of the riveted joint. Designed to re-
select the insertion point and the length of the rivet assembly drawing. 

Button Set package connection manually. Opens setup package of the parts. 

 

Left-click on one of the cells in the column "type items" to switch the item / gap: 

 

In the "Thickness" is set to the thickness of the relevant part (or gap) After configuring 
the package connected, close the window by pressing OK. 
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The right side of the dialog box mounting parts is a list of values diameter rivets. 

    

When you insert the rivet connections are available 3 ways to display selected button 
Insert mode riveted joint at the bottom of the dialog box toolbar. Drawing on the 
button displays the currently selected display method: 

   With a local cutaway 

   Normal Box 

   Insert hidden 

2 types available (front and side) display riveted joint: 

   Front view 

   Left side view 

You can choose the type rivet connections: 

    
The number of types depending on the type of rivet.  

    

Automatic detection of packet connection 

When you insert the rivet connections made automatically recognize the boundaries of 
the parts. If the line crosses the insertion direction perpendicular to a few segments in 
the drawing, they are defined as the boundaries of parts and installs Connection: 
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Insertion point and the length of the rivet assembly are determined automatically based 
on the thickness of the package details. 

 

 
 

Editing riveted joint 

A dialog box settings riveted joint, apply any of the standard editing tools to the 
centerline of the group details. 
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If the settings nanoCAD Mechanica25 included tooltips, then when you move the cursor 
to the center line will show "Rivet connection". 

Remove fasteners 

Main menu: Mechanical - Design > Delete parts. 

Ribbon: Mechanical - Design > Delete parts. 

Toolbar: Design > Delete parts. 

Command line: MCDELSPART. 

Operation 

The function is intended to remove the fastener bolt or rivet connections. Openings by 
bolted or riveted to remain on the drawing and in the object manager. 

 

To remove fasteners bolting need to run the function and choose the item that came 
bolting. 
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The remaining holes. 

 

Details of rotation 

Design details of rotation 

Main menu: Mechanical - Design > Create shaft. 
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Ribbon: Mechanical - Design > Create shaft. 

Toolbar: Create shaft ( "Design"). 

Command line: MCARBOR. 

Basic rules 

After invoking the command, pick an insertion point. 

Set the shaft direction by moving the mouse. 

Left clicking creates a shaft segment.The command remains active and allows additional 
segment to be drawn. 

Construction site  25 auto-detects the insertion point of a graphic element which is to be 
inserted, and acquires its geometry from a standard database.The auto-dected elements 
are highlighted in color.After the insertion command has been invoked, elements are 
highlighted at the mouse movements.Left-click to confirm.  

Dialog box Editg shaft 

 

 Show / Hide section Standard fittings and details sections 
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Add element 

 
Insert Group 

 
Edit Object 

 
Insert design 

 
Add view / section 

 
Scale of details and shaft sections 

Shaft section displays methods 

Composition tab "Standard fittings and details" is defined folder structure in the system 
folder "shafts" Database Construction Site  25.  

 

In addition, in the tabs of the Edit shaft dialog are included 

 Tooth-wheels 

 Efforts 

 User folders 
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Path to these elements are specified in the option  Construction Site  25 (Standard 
Elements >Edit shaft ).  

Editing section of the shaft 

 

Click on the symbol "Plus", a list of components for editing. 

When you specify a string in the column names in the drawing selected component is 
highlighted. 

To modify a standard component, double-click the left mouse button on the name of 
GOST. In introducing the new values for the editable portion of the shaft all the changes 
are immediately displayed in the drawing. 

Purpose size details in the dialog box 

To select the size of the base bearing the dialog window Edit shaft. 

Specifying the column name to GOST bearing, check option; bearing the figure should 
highlight. 

Double click the left mouse button on the designation of the bearing or click once on the 

icon to edit . 

In the dialog box, this bearing sizes choose. Selection window will size bearing. 

Complete the command by pressing OK and close the dialog box. 

Similarly edit all items bearing assembly. 
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Dynamic display sizes details 

The quickest way to selecting the size of parts - a dynamic view of all of its dimensions 
by moving the mouse pointer to the left-right and up-down. 

Specifying the insertion point of the bearing on the shaft, select size bearing. 

 

When you move the pointer of the available bearing sizes select those that meet the 
internal diameter of the shaft and the combination of the bearing width and outer 
diameter correspond to the current cursor position. 

Export shaft to an external file 

For detailing received shafts can be exported to an external file. Double clicking the left 
mouse button on the shaft axis edited activate dialog Editing shaft. 

In the dialog box, display the Edit and select from the drop down list of commands string 
Export to a file. 

Then you want to fill the frame and title block specify the file's location. 

Setting step drawing 

In the settings  select Standard, and set the desired spacing. 
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Setting the stage shaft 

After setting the insertion point of the shaft when rendering, you can use a dialog box to 
set options stage: 

 

After clicking on the shaft , you can choose the types of shaft ends. 

Determining the size of shaft section in the status bar 

When rendering stage shaft in the status bar nanoCAD in the lower left corner of the 
window displays its properties. 

Determining the size of shaft section in the dialog box 

When you specify a dynamic image stage shaft, the right-click context menu and enter 
the D-line dialogue.  

A dialog box shaft , in which you can enter the exact values of the diameter and length 
of the shaft portion. 

How to edit areas of the shaft? 

Edit shaft areas in several ways: 

"Visual Editing": select an editable area and dynamically change its geometrical 
dimensions. 

Specifying the exact plot sizes in the dialog box, double-click on the axis of the shaft left 
mouse button and change the section of the shaft in the dialog box Editing shaft. 
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Another way to call the same dialog box - point to the shaft axis and click the right 
mouse button. 

Placing snap ring groove 
When placing grooves retaining rings for automatic recognition of the diameter of the 
shaft and the insertion point on the shaft must first be placed bearing. 
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To specify the position of the groove snap ring must be attached to the shaft or to the 
end of the bearing. Automatically set the dependence on the position and diameter of 
the retaining ring \ grooves. 
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Placement of the retaining ring 
When placing the retaining rings for the automatic recognition of their size on the shaft 
must be pre-arranged groove. 

 

To indicate the position of the ring is enough when you insert attached to the groove (it 
is highlighted in the appropriate color). 
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Accommodation details "cover" 
For details of accommodation "cover" is necessary to consistently left-clicking on the 
bearing, and then on the shaft portion. Automatically creates a cap with the attached 
parameters of the situation, the diameter of the bearing and the shaft diameter. 

 

Accommodation details "Glass" 
When placing parts "Glass" is necessary to specify the series bearing cap. 

Choose from a glass base nanoCAD Mechanica 25 part, direct the cursor on the bearing - 
he highlighted. Click with the left mouse button. 
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It is further proposed to select the cover - direct the cursor on the cover, it is highlighted 
- click the left mouse button. 
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In the dialog that appears, click OK insertion cup. 
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Templates bearings 
In the design of supports shafts are encouraged to use the mechanism of group insert 
multiple pieces of bearing select the desired template. If no suitable template support, it 
can be created. This technology is similar to technology insertion into a drawing 
fasteners from the selected template. 

The pattern of support may include the following parts: bearings, wear rings, bushings, 
glass retaining ring grooves for them, locking cover, parts of gears and other parts of the 
base of standard parts. 
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Having a set of templates with a single command, you can immediately draw the option 
selected in the drawing of bearing. 

Insert the template bearing support 

Double click the left mouse button on the axis of the shaft of the edited call the 
corresponding dialog box. At the bottom of the window, click on the icon  Insert 

group . 

Design pinion shafts 
In the dialog box, select the folder Editing shaft gears and select a template cylindrical 
gear shaft. 

After selecting the parts "cylindrical gear shaft" mouse pointer is displayed as a standard 
cross-hair, blue arrows and the image of a small green square (standard view). When 
you hover the pointer on the shaft, this area will be highlighted in green and contains 
the insertion point of the ring gear. 

In the dialog box, spur gear option 

Take the rate you need to click on the drop-down list of the calculations and indicate 
which item you want to transfer 

render (or gear wheel). 

The option is available if a calculation has been created. To insert an object into a chain 
of objects, click OK. After applying the gear, the cursor pointer takes the standard form. 
It is further proposed to continue drawing the next part of the engagement. 

Drawing on the results of the calculation of gearing 

Original drawing: 

 



User Guide nanoCAD Mechanica 25 
 

216 

Double click the left mouse button on the axis of the shaft, call the dialog box Editing 
shaft. 

Tab gears. 

Select a template cylindrical gear shaft. 

By clicking the left mouse button, set the insertion point on the lower shaft gear. 

 

Move the cursor pointer to the wheel on the upper shaft (ring gear is highlighted in 
green). Left-click to confirm your choice. 

In the drop-down list of the calculations, specify the desired (in our example - 
calculation with the name of "Example of calculation") and select what should render 
the lower portion of the shaft (in this example - "Gear"). 

Click the OK button. At the request of the "Insert object in the chain of objects?" Answer 
"yes". 

Press ESC to finish drawing commands engage and close the dialog box. 

 

As a result, the drawing rendered pair of gearing with deposited assembly 
dependencies. 

Shaft chamfer 

Main menu: Mechanical - Design - Shafts > Shaft chamfer. 
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Ribbon: Mechanical - Design > Shaft chamfer. 

Toolbar: Shaft chamfer ( "Design"). 

Command line: MCACHAMFER. 

Operating procedure 

To insert a chamfer is necessary to run a command and select the portion of the shaft. 

 

The chamfer is automatically adjusted to the diameter of the shaft portion. Fixing 
chamfer happens when you click the mouse, and then open dialogue Bevel-rounding. 

  

After closing the dialog construct chamfer automatically. 
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Shaft fillet 

Main menu: Mechanical - Design - Shafts > Shaft fillet. 

Ribbon: Mechanical - Design > Shaft fillet. 

Toolbar: Shaft fillet ( "Design"). 

Command line: MCAFILET. 

Operating procedure 

To insert, you must run the command interface and mating portions of the shaft. 

 

Fixing interface brings up a dialog transition. 
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After closing the dialog interface to build automatically. 

 

Design of pipelines for internal and external 
cone 

Library: Pipe fittings. 

For example: 

Pipe fittings - Connections on External Cone - GOST 139xx-74 - Pipes 

Pipe fittings - Connections on Internal Cone - GOST 160xx-70 - Pipes 

... 

Two ways to build a pipe path 
First - automatic connection of two pipe fittings elements. 
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When joining the program selects the shortest distance: pipe length is calculated from 
the minimum values of the linear section and minimum bending radius of the pipe 
diameter. 

The parameters are set in the pipeline  nanoCAD Mechanica 25 (team Settings). 

 

To automatically connect the two valve elements specify the connecting member 
(bushings, elbows, tees, crosses), hold down SHIFT. nanoCAD Mechanica 25 generate 
trajectory tubes and displays the dialog box with the geometric size of the segment of 
the pipeline. If the proposed path will not suit you, it can be edited in the same window. 

Second - step by step construction of the pipeline with a consistent set the direction and 
length of the pipe segment. 

Step task trajectory pipe begins with the first element of the valve. The insertion point 
and pipe diameter are determined automatically. 

Next, follow the prompts on the command line, you can create the path of the pipeline, 
consistently introducing straight and arched portions. 

For automatic connection of the pipe end to an element of reinforcement necessary to 
open the context menu. 

Select option C bonds and provide an element of reinforcement with which to make the 
connection. 

Call the following context menu again by pressing the right mouse button. 

Select it as the pipe sections need render. 

The compound can be performed in three or five sections. 

By clicking the right mouse button to complete the command. 

Sequence of piping design 
Apply hole. 

Insert from a database element "Pipe". 

Choose from a database element "Hole taper thread." 

Specify the coordinates of the conical hole. 

In the opening taper threaded set nominal thread. On the second tab, Properties , set 
the length and diameter of the hole drilling. 

Complete the command by pressing ESC. 

Place details of the reinforcement. 
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Assembly according to angles and taper thread throughs applied automatically. 

Insert from a database element "Pipeline fitting". 

Choose from a database element "Unions". 

Hover your pointer to the hole and click the left mouse button 

Complete the command by pressing ESC. 

For pipelines on external cone 

Insert from a database element "Pipe" in Model. 

Upon completion of the construction will be offered automatically add nipples and nuts 
to the ends of the pipeline. 

 

If nipples and nuts have been added automatically, you need to place them manually. 

Choose from a database element "Pipeline fitting". 

Choose from a database element "Nipples". 

Hover your pointer to the end portion of the pipe and left-click 

Select size and click OK. 

Complete the command by pressing ESC. 

For pipelines on internal cone 

When selecting the pipeline on internal cone selection dialog appears connects 
equipment automatically added to the compounds of the inner cone, depending on the 
type of environment and the type of nipple (spherical or hemispherical). For a spherical 
pin structure parts will be as follows: 

 GOST 16043-70 nipple 

 GOST 16048-70 lock ring 

 GOST 16047-70 Bolting 

For hemispherical pin composition details: 

 GOST 16042-70 nipple 

 GOST 16046-70 Bolting 

Thread the other end of the pipeline construction include: 

 Choose hardware - reappears dialogue "set of equipment." 
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 Building and - at the second end of the conduit parts to be added to set the same 
parameters and composition as the first one. 

 Do not build - further details will not be built. 

Example of construction of the pipeline on external cone 

To the connection details automatically recognize your size and were object-dependent, 
the figure should be placed initially element reinforcement  or opening. 

In our example, we will adhere to the following order: Insert pipe nipple and nut. 

 

Object "pipe" can draw only pointing out any element of reinforcement. 

 

For applying object-dependent connection details on previously placed component is 
enough to point to the workpiece aperture cursor pointer. Base item is highlighted in 
color. 
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Automatic determination of size and pipe insertion point 

 

Automatic determination of size and the insertion point of the pin 

 

Automatic determination of size and the insertion point nuts 

Group inserting objects 

For piping design, you can use a tool group insert objects.  
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Dialog box Insert group and organize the group result. 

To use her group must first create it. To do this, use the following steps: 

 Added to the drawing details of the object manager 

 Through dialogue  Dependency Management, or automatically when you insert 
constrain standard parts are dependencies between components. 

 Group is created through dialogue to create groups. 

The group must be incomplete, ie does not include fittings or pipe.  

Instead, when you insert the missing fittings group will be requested item (items) in the 
drawing. 
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Set the method of overlapping pipelines 

 

We indicate the horizontal pipe as an object to which the selected throughs must be 
higher. 

 

After clicking on the icon Overlapping objects get a new version of the layout. 
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Distinguish compounds and by right-clicking, we show in the context menu line Move 
Up. Horizontal pipe is above all the elements. 

 

Creating a cross-section of a connection 
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Select the nut and invoke the content menu , choose send to back , Then choose the 
object behind which the nut should be placed. 

 

Giving the command overlapping objects, we corrected geometry. 
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Editing pipeline trajectory by Grip Editing 

Select a pipeline and use the grips to move the nodes.If a midpoint node is edited , the 
relocated tube is parallel to its original and its neighbouring segments are adjusted 
automatically. 

 

Nodes located on the endpoints of linear segments may only be relocate along the axis 
of the current segment. 

Editing pipeline dialog 

Double-clicking on a tube to open the edit pipe dialog: 
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To edit a trajectory using the step by step connector , first pick a tube segment. The 
segment will show in different color. 

For linear section given length parameter is set. 

 

For arc sections,the bent radious parameter is set. 

 

The following sections of pipelines alignment options: 

Vertical alignment. 

Horizontal alignment. 

Object perpendicular alignment. 

Object parallel alignment. 

Object parallel alignment by distance. 

Undo last alignment 

In addition, the following editing options: 

Base parameters change. 

Editing properties of pipe 

Editing tube properties , start the base parameters change command to set the material 
and geometry parameters of the tube in the dialog. 

On the Properties You can change the display pipeline (filling, cut). 
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Saving the pipe to an external file 

After selecting this command, a dialog box title block. When information is entered in 
the title block, it is proposed to specify a filename and location. 

Extend pipe 

This function connects the pipe to a fitting or to a free end of another pipe. 

Import PCB format IDF 

Main menu: Mechanical - Design > Import *.idf (*.brd) files. 

Ribbon: Mechanical - Design > Import *.idf (*.brd) files. 

Toolbar: Import *.idf (*.brd) files ( "Design"). 

Command line: MCIDFCONVERT. 

After calling the command, the system asks for a file with the extension *.Emn (export 
file format from the IDF Orcad) or *.Brd (export file format from the IDF PCAD). 

Caution! To import of PCB with components also required a library of components that 
must be maintained with the same name and in the same directory as the file of the 
PCB. PCAD library file has the extension *. Lib, file libraries Orcad - *. Emp. 
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The system reads the information from the file. It is further assumed that the user can 
check and correct it with a dialog box IDF. 

If by reference numerals may determine the type of element, the nanoCAD Mechanica 
25 automatically assigns the appropriate circuit parameters and fill color (can be 
changed in settings). 

Thickness (height) of the element is taken from the import file, and if it is not defined in 
it, the item is automatically assigned to one micron in height. 

The user has the possibility to limit the detail card by disabling generation of the 
individual (or all) of the elements and hiding holes in the board. 
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After clicking the Apply or OK button - automatically generated drawing board. It is 
placed at the origin, and can thereafter be moved by the handles. 

The Apply button allows you to continue editing the appearance and composition of the 
board with a graphical preview of the drawing. 

PCB editing by double-clicking on it and in the same dialog box, change its structure or 
appearance. 
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Engineering analysis 

Calculation wizard 

Main menu: Mechanical - Design - Calculations > Calculations wizard. 

Ribbon: Mechanical - Design > Calculations wizard. 

Toolbar: Calculations wizard (  "Design"). 

Command line: MCCALC. 

Fundamental rules 
1. Calculations wizard allows you to edit all the calculations are available in the file - 

regardless of the graphics platform. To create a new calculation required, 
specifying the desired type, click "New calculation". 

2. The calculation results can be displayed directly in the calculation manager. 

3. The type and number of parameters displayed in the dialog can be edited by the 
user at his discretion. To do this, double-click in the right part of the dialog box 
cause the viewer to edit. 

By default, the dialog box takes the following form: 
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When installing the mouse cursor on the name of the calculation are available 
additional options. 
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Toolbar 

Create - Activates the calculation type depending on the selected window. 

Delete - Removes the created calculation 

Open - Opens previously saved on the disk calculation 

Save - Saves the selected calculation on disk in a file * .mcc 

Edit - This command opens the window for editing the calculation results 

 

Upon activation, the report window, the user can enter their own value and remove 
unnecessary. 

Default report templates for calculating gearing placed in a folder 

C:\Program Files\Nanosoft\nanoCAD Mechanica 25\Reports Templates\ 

Calculation of gears 
The calculation is made on the basis of GOST 21354-87 (hereinafter - the Standard) 
"Cylindrical gears involute external engagement for strength calculation.". The standard 
establishes the basic design according to the definition of the contact strength of the 
active surfaces of the teeth and tooth strength at bending metal cylindrical involute 
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external gear transmission for general industrial applications with source circuit in 
accordance with GOST 13755-81, modulus m / 1 mm, working with lubrication oil at 
peripheral speeds v<=25 m/s. 

   

Methods for rendering the gear 

Designing gear can begin in any sequence. What to do in the first place - the calculation 
or drawing gear - it does not matter. 

The wheels that were drawn without calculation, it is always possible to adjust the 
results of the calculation. All geometry is adjusted automatically. 

Approaches to the design of the gear in  nanoCAD Mechanica 25: 

1. Draw gear without calculation by entering the wheel settings dialog. 

2. To calculate the gear and the results of calculation render mesh. 

3. To calculate the transmission stage and assign the result to the transfer were 
drawn without prior calculation. 

4. Use the template file with the initial data on the calculated transmission gear 
stages and drawn by the circuit of the gearbox. By changing the raw data 
calculation, to update the geometry file template steps gears. 

Drawing wheels (gears) without calculating 

We choose to base parts of the gear pattern. 

 

We define the insertion point and the direction of its rendering. 

You can enter the desired design parameters designed wheels dialog. The default render 
wheel without calculation. 
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 Personal application assembly dependencies on a pair of gearing on the 
calculated spacing. 

Drawing engagement of calculations 

1. We choose to base parts of the gear pattern. 

2. We define the insertion point and the direction of its rendering. 

3. Since the calculation is done, select the desired calculation from the dropdown list. 

4. Specify which element engagement render on the results of the calculation (wheel 
or gear) and click OK.   

5. After drawing one element command remains active. To complete it, click with the 
ESC key. 

 To assemble the wheels and gears on the calculated spacing options use 
gearing and Remove gearing. 

How to set the point of insertion of the gear? 

After selecting a template nanoCAD Mechanica 25 prompts you to specify the insertion 
point and the direction of drawing of the selected type wheel. 

If the drawing already has a shaft portion, which is supposed to place the wheel, the 
insertion point is automatically determined by the aperture of the shaft portion of the 
highlighted cursor pointer. 
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The approach to the calculation of gear 

Gear is regarded as an independent object, for which the specified power and kinematic 
characteristics of the input or output. 

Gear is an element of the designed gear. Pre-selection is carried out of the engine is 
determined by the overall gear ratio is carried out by a breakdown of the gear ratio gear 
stage determined power and kinematic characteristics of the gears of the individual 
stages. 

In the proposed algorithm, the requirements of GOST completely soaked. 

According to the calculation results can be obtained: 

 geometrical characteristics of the gear train designed; 
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 data to monitor the accuracy of the gears; 

 data to estimate the gear strength (allowable and actual voltage as in the contact 
and bending endurance calculation teeth, and the teeth in the calculation of the 
maximum load on the action); 

 degree of loading gear on these kinds of stresses. 

Estimator (a program for calculating the gear) allows you to perform two types of 
calculations: 

 designing new gear for a given load, durability, desired gear ratio and other 
parameters; 

 check the specified gear strength. 

In the first case, the estimator first transfer designs (in our version - on the basis of 
conditions to ensure contact strength), that is, defines all of its geometric 
characteristics, including module and spacing, and then to check on the strength of all 
kinds of stress. 

In the estimator of the second embodiment is not used for design, but only for testing 
the strength of the transmission, the geometric characteristics of which are already 
known or pre-defined. 

For the two types of calculations in the dialog box Calculations toothed cylindrical gear 
are two options provided for data input: 

Each type has its own form of payment report with its source data and its own 
characteristics of presentation of calculation results as well as its report templates. 

Cylindrical Gearing Strength Analysis 

Library: Calculations - Spur gears - Cylindrical Gearing Strength Analysis 

In what follows the parameters and characteristics related to the gear, given the index 
1; relating to the wheel - the index 2. 

The initial data are encouraged to use: 

 typical transmission loading mode (GOST, features 32, p.106.) or load sequence 
diagram (GOST, features 14, p. 63); 

 the torque on the shaft of the wheel gear - T2, N * m (if the load is variable, then 
how current torque accepted most of long-acting); 

 Wheel speed - n2, min. - 1; 

 the gear ratio gear set - u; 

 the type of gears (spur, helical, herringbone); 

 tooth angle - ; 

 offset coefficients source generating circuit - x1 and x2; 
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 transmission type: reversible or irreversible. By reversing or non-reversing gear 
transfer meant a two-way or one-way load application; 

 term transmission service - Lh, h; 

 material and a method of chemical-thermal hardening of gear wheels and 
transmission calculated; 

 the location of the calculated gear in the drive according to the scheme in 
accordance with GOST, p. 58, fig. 13a. 

Enter the initial data for the design of the transmission by means of the dialog box, 
shown in figure: 

 

By clicking on the button "More ..." open additional field data input for the reverse gear, 
the method of machining the tooth flank and its heat treatment. 
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Initial data 

Type of gears 
The drop-down list of the gear types allows you to select one of three options: spur, 
helical, herringbone or wheel: 

 

Angle of teeth inclination 
When choosing a helical or herringbone wheels in the "angle of the teeth" should enter 
a value in degrees of the desired angle of inclination of the tooth line in the 
recommended range (typically 8-22 ° for helical and 25-40 ° for chevron wheels). 

If this field is left blank, the program installs by default a certain angle, which lies within 
the specified limits. Most often, this angle imposed by the previous calculation. It can be 
changed either directly or by subsequent adjustment calculation. 

Ratio of gear transmission 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Rotation frequency of driven gear shaft 
(1/min) 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Torque moment of driven gear shaft (Nm) 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 
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Required resource (hour) 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Divisibly of max moment of motor 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Kinematical scheme 

 

Click on the field with the image of the kinematic scheme reveals nine schemes of gear 
reducers, from which you can choose the layout of the gear pair corresponding to the 
estimated case. Estimate the case highlighted in white. 

Load conditions 
Load conditions is selected from the dropdown list. 

 

Table of values of equivalence ratios for each loading mode: 
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Check "With tooth head modification" 

Check "Reverce transmission" 
It makes active group of source data "" Reverse transmission ". 

Koefficients of initial operating contour 
displacement by gear cutting 

Number of teeth gearings per one revolution 
of gear 

Group "Materials" 
Materials of gears and their characteristics are selected from a drop down list or from 
the database. 

 Go to the database by clicking on the appropriate button to the right of the 
selection grade of steel. 
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Type of material selection group gears and wheels: 

 

For convenience, you can select to see comments to the selected material. 

Group "Reverce transmission" 
The group contains the following fields: 

 Rotation frequenct of driven gear shaft 

 Torque moment of driven gear shaft (Nm) 

 Required resource (hour) 

Check "Transitional surface is polished" 

Check "With tooth root inclusion" 

Grinding of transitional surface conditins 
Activity fields depends on the chosen material 

 

If the transition is made grinding surface of the teeth, the required grinding mode can 
be selected from the corresponding drop-down list. 
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Editing Material Database 

The user can edit any of the selected characteristics of the material, but it should be 
borne in mind that some of them change must be accompanied by a change in the 
other. In particular, the limit of endurance in bending teeth, corresponding to the basic 

number of stress cycles  for normalized, improved nitrided and wheels, as well as 

the base value limit stress teeth flexural maximum load   for normalized and 
improved gear depends on the hardness of the teeth. 

Therefore, changing the hardness of the wheel teeth with a chemical-thermal 
treatment, need to change their performance and durability. If you are not sure of the 
correctness of the total introduced to them changes, to edit the properties of the 
material is better to use filling material properties dialog box (see. below). 

 

The options available in the database, with the following designations are: 

 

Half product making 

 

Units of measurement of hardness. 
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The choice of heat treatment of the material. 

SIGMA_Flimb The limit of endurance in bending teeth, corresponding 
to the basic number of stress cycles MPa. 

Y_g Factor which takes into account the impact of the 
transition surface grinding teeth (GOST, table. 13, p. 
10.4). 

Y_d Factor which takes into account the effect of strain 
hardening or electrochemical treatment of the 
transitional surface of the tooth (GOST, table. 13, p. 
10.5). 

S_F Calculated safety factor based on the bending 
resistance (GOST, table. 13, p. 11). 

SIGMA_Fst The safety factor in the calculation of the teeth on the 
maximum flexural load (GOST, table. 18, n. 2). 

SIGMA_T Yield gear material MPa. 

H_O Surface hardness of the teeth. 

H_K The hardness of the teeth of the core. 

Updating and changing the base made by the three buttons located in the upper left 
Materials: 

New material 

Delete material 

Edit 

For example, click on the New button opens a dialog box material properties of the 
material. For the correct insertion of a new material in the base must be filled in all the 
fields of the window. 
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Entering a new material 

 

In the field of material input parameters are copied to the properties of the previously 
selected metal. Thus, the user is given the opportunity to create its database in relation 
to specific production and technological capabilities of the enterprise. 

All fields of the material properties of a window can be filled by the user immediately. 
However, given that in accordance with GOST limits contact endurance and stamina for 
bending at various thermochemical treatment of steels defined by different 
dependencies, at this stage it is advisable to fill the database go to the next dialog box, 
activating the button Select ... 

 

The corresponding filling material properties dialog box (the button Select ...) allows you 
to select the characteristics of aggregated groups of materials and thermochemical 
treatment (upper left field of the window). 
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These can then be clarified in relation to specific groups of steels (bottom left margin of 
the window) and see the calculated values ??of the respective limits of endurance 
(Recommended field). 

We have already said that strength characteristics of the gears of the normalized and 
improved, as well as nitrided steels depend on the hardness of the teeth. Therefore, in 
determining the strength characteristics of gears exposed to these types of chemical 
and thermal hardening, in advance, before calling the dialog box Filling material 
properties in the Properties dialog box material required hardness of the teeth must be 
installed. 

In this case, the parameters  and  in the "Filling the properties of the 
material" will match hardness adopted. 

Autofill material properties 

If you agree with the results, it sets a flag in the autocomplete field. 
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The calculated parameters are transferred to the corresponding open field 
characteristics of the particular material. These fields can be filled manually, if desired. 

Removing material from the base 

 

Selecting material removal cancel command does not work. To return to the base 
material should be re-entered. 

Edit the properties of the material 

 

When you select the Edit window Materials Database of materials displayed earlier 
submitted Material Properties dialog box. 

In the Comment field user input, one way or another characterizing the material. 

 

The calculation results 

 

This dialog shows all the parameters of how the raw data and calculate results. By 
clicking the Back button, you can return to the dialog box to make changes to the initial 
calculation data. 
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Strength calculation of spur gearing 

Library: Calculations - Spur gears- Strength calculation of spur gearing 

Operation of the second embodiment does not use calculators for design, but only for 
testing the strength of the transmission to the known or predetermined geometrical 
parameters. 

Checking calculations has its own form of the report and data input. In all other respects 
similar to the method described above. 

 

By clicking on the button "More ..." open additional field data input for the reverse gear, 
the method of machining the tooth flank and its heat treatment. 

 

From this window, click on the icon  You can go to the Calculation wizard. If any 
payments were previously carried out, their results can be accessed using the drop 
down menu. 
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If the entered spacing does not match the entered calculation parameters, then when it 
changes you will receive a message which will be offered options: 

 Continue with the correction of the calculation specified center distance 

 Continue with the entered payment data (calculation results may be incorrect) 

 

Initial data 

Type of gears 
The drop-down list of the gear types allows you to select one of three options: spur, 
helical, herringbone or wheel: 

 

Angle of teeth inclination 
When choosing a helical or herringbone wheels in the "angle of the teeth" should enter 
a value in degrees of the desired angle of inclination of the tooth line in the 
recommended range (typically 8-22 ° for helical and 25-40 ° for chevron wheels). 

If this field is left blank, the program installs by default a certain angle, which lies within 
the specified limits. Most often, this angle imposed by the previous calculation. It can be 
changed either directly or by subsequent adjustment calculation. 
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Distance between axes 

Pitch 

Rotation frequency of driven gear shaft 
(1/min) 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Torque moment of driven gear shaft (Nm) 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Required resource (hour) 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 

Divisibly of max moment of motor 
The field is filled in accordance with the terms of reference and the expected 
characteristics of the engine. 
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Degree of accuracy GOST 1643-81 

Kinematical scheme 

 

The two-stage and three-stage gear units can be run on deployed or coaxial. In simple 
circuits deployed, each stage consists of a pair of gears. The disadvantage of such 
schemes - an uneven load distribution between the bearings, so that the resulting 
deformation of shafts occurs the load concentration along the length of the tooth, 
causing the need for a shaft with high rigidity. 

This disadvantage is eliminated by using bifurcated stages. Preferably in the two-stage 
gear as forked use a high-speed, and in the three-stage - the intermediate stage. 

The large width of a low-speed stage in these cases does not cause a significant load 
concentration along the length of the tooth due to the symmetrical arrangement of 
gears with respect to the supports. 

Load conditions 
Load conditions is selected from the dropdown list. 

 

Table of values of equivalence ratios for each loading mode: 
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Group "Materials" 
Materials of gears and their characteristics are selected from a drop down list or from 
the database. 

 Go to the database by clicking on the appropriate button to the right of the 
selection grade of steel. 

 

Type of material selection group gears and wheels: 

 

For convenience, you can select to see comments to the selected material. 

Group "Reverce transmission" 
The group contains the following fields: 

 Rotation frequenct of driven gear shaft 

 Torque moment of driven gear shaft (Nm) 

 Required resource (hour) 
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Check "Transitional surface is polished" 

Check "With tooth root inclusion" 

Grinding of transitional surface conditins 
Activity fields depends on the chosen material 

 

If the transition is made grinding surface of the teeth, the required grinding mode can 
be selected from the corresponding drop-down list. 

Bevel Gearing Strength Analysis 

 Calculation wizard: Bevel Gearing Strength Analysis. 

Library: Calculations - Bevel Gears - Bevel Gearing Strength Analysis 

 

Geometric Calculation of Bevel Gearing 

Calculation wizard: Geometric Calculation of Bevel Gearing. 

Library: Calculations - Bevel gears - Geometric Calculation of Bevel Gearing 
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Calculation of the geometric parameters and the conical gearing elements can be made 
based on user input (checking the strength of finished transmission) or on the basis of 
the strength calculation. 

 

Static beam calculation 

Main menu: Mechanical - Design - Calulations > Static beam calculation. 

Toolbar: Calculation beams (toolbar  "MCS Calculations"). 

Command line: MCBEAM. 

Library: Calculations - Loads - Beam. 

Library: Calculations - Loads - Calculations - Beam calculation (applied to the 
finished beam affixed to the supports, loads and moments, see. Calculation). 

Calculation wizard: Baem calculation (applied to the finished beam affixed to the 
supports, loads and moments, see. Calculation). 

This command is used to calculate the strength of the direct beam of constant cross-
section. 

After selecting the command a dialog box opens beam calculation. 

1. On the left side of the dialog box, select the cross-section of the beam. 
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2. Right set sectional dimensions and length L beams. For visual selection of the 

beam length, click Dynamic input at the bottom of the dialog box. 

3. Enter the physical characteristics of the material and the cut rotation. 

4. Specify moment and the loads acting on the beam. 

Setting section 

There are three ways to specify the section: 

 

 

Standard geometric cross section (e.g., triangle). 

 

Rolled metal base elements of nanoCAD Mechanica 25 (e.g, I-beam 
GOST 8239-89). To use the base when calculating the beams need to 
set a Class 725. 

 

Arbitrary section defined by the user.  

Sizing is carried out in several ways: 

 Click inside the closed area. Automatically determined by the 
outer contour of the closed area and the region is added to the 
set. 

 Clicking on a closed polyline or circle. Added to the area 
bounded by a circle or polyline 

 Reselection area removes it from the set for the calculation of 
the cross section. 

After selection of the drawing section in the dialog box Beam 
calculation appears custom cross-section: 

 

Change the name of the custom section by selecting it and clicking 
the left mouse button on the title. 

Delete a custom section of the list is made by pressing delete. 
 

For the standard section of the database items, choose Type size from the dropdown 
list. 
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Beam Load and moments 

1. In the dialog box, double-click the desired type of load or moment.  

 

2. Select insertion point or the load bearing on the beam. At the time of selecting the 
insertion point move the cursor to the beam to install dependencies.  

 

3. Set the parameters or load bearing in the dialog box.  

 Support 

Point - the distance from the starting point to the point of insertion beam bearing in 
millimeters. Use keys to select the type of support. 

 Concentrated load 

Position - the distance from the starting point to the point of insertion beam load, mm. 

Value - the value component of the load in the selected direction, H. 

Point - the distance from the insertion point to the point of load application of the load 
in the selected direction, mm. 

Diagram on the left side of the dialog box explains the meaning of the input parameter. 
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Tabs on the top of the window are used to select the coordinate system in which the 
values are set: 

   Rectangular 

   Spherical 

   Cylindrical 

 Distributed load 

Position - the distance from the starting point to the point of insertion beam load, mm. 

Length - length of the section, which is attached to a distributed force, KN/mm. 

In input fields, set the value component of the load in the selected direction, H. 

Diagram on the left side of the dialog box explains the meaning of the input parameter. 

Tabs on the top of the window are used to select the coordinate system in which the 
values are set: 

   Rectangular 

   Spherical 

   Cylindrical 

 Moments 

Diagram on the left side of the dialog box explains the meaning of the parameters. 

X, Y, Z - the components of the bending moment , KN*m. 

C - distance from the starting point to the point of insertion beams torque , mm. 

Calculation 

Click Calculate beam at the bottom of the dialog box to perform the calculation. 

 

Table of results of calculating comprises calculating the maximum deflection and stress 
values as well as the distance from the starting point of the beam to a point at which the 
maximum of each parameter. 

To insert a drawing graphs strain and effort to select the desired type of graph for each 
feature: 
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Button Apply adds graphics drawing. 

 

Button  Save Report. Stores the results of the calculation of the beam to an external 
file. 

Button  Calculate value. Opens Meaning, in which parameters are calculated at an 
arbitrary point of the beam. 

 

Button Export diagrams. Sell calculation results in a table in Construction Site 25. 
After selecting the command, specify the insertion point on the drawing table. 

Calculate section characteristics 

Main menu: Mechanical - Design - Calculations > Calculate section 
characteristics. 

Toolbar: Calculate section characteristics (toolbar  "Calculations"). 

Command line: MCGCS. 
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This command is used to calculate the geometric characteristics of the complex cross-
sections with respect to arbitrary axes. 

Calculation procedure 
1. Call command. 

2. In the drawing, then click the area closed by one of the ways: 

 Clicking inside a closed area. Automatically determined by the outer loop of 
the closed area, and the area is added to the set. 

 Clicking on a closed polyline or circle. Adds the area bounded by polyline or 
circle. 

 

Note: Repeated selection of the field deletes it from the set to calculate the cross-
section. 

3. Complete the selection by clicking the right mouse button or the Enter key. 

4. Specify the origin point or [central axis]. If you select the "central axis", the point of 
origin is automatically set in the center of mass of the cross section with an angle 
of rotation equal to 0 (step 5 is skipped). 
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5. Specify the angle of rotation of the coordinate system. 

 

6. In the dialog box "Geometric section properties" Adjust the characteristics 
included in the summary table of the results. 
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For each characteristic, you can customize your format (except weight), and the 
accuracy of the unit. 

 

To calculate the weight you need to open an additional menu "Mass calculation on 
section", which indicate the product density and length. When you specify the length of 
the need to expose the units. When you specify the density, you can use the base 

materials, by clicking on the button  "Material selection". 

Customized settings display characteristics (size, precision, units) stored for later 
calculations sectional characteristics. To return to the default settings, press the button  

"Load default settings". 

7. Click "OK" in the dialog box and enter the drawing an insertion point of the table 
with the calculated parameters. 
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After the calculation is added to the drawing object nanoCAD Mechanica 25, comprising 
a cross-section schematic outline and the main central axis. The lengths of the axes are 
proportional to the values of the corresponding axial moments of inertia. 

Fastening calculation 

Main menu: Mechanical - Design - Calculations > Fastening calculation. 

Ribbon: Mechanical - Design > Fastening calculation. 

Toolbar: Calculations > Fastening calculation. 

Command line: MCBOLTDESIGN. 

Verification calculation to determine the admissibility of the selected thread for the 
specified load conditions. 

The basis, when checking calculations bolts adopted methodology contained in the 
textbook "Kuklin NG, Kuklin GS machines Details - M .: Vyssh.shk., 1987". 

In calculating the user is able to take into account the recommendations of "GOST 
1759.4 - 87 Bolts, screws and studs Mechanical properties and test methods.". 

When you call the command, a dialog box "Calculation check bolt". By controlling the 
arrows in the graphic menu, select the version of the calculation. 

1 variant - The connection is tightened during assembly, there is no external load. 
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2 variant - Compound loaded transverse force. 
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3 variant - Connections are tight and loaded external axial tensile force. 

 

Depending on the options available to calculate the various parameters. 

Note: The result of the calculation is the message in the "Results of calculation" on the 
sufficiency of the bond strength. 

Furthermore, in the "calculation results are" options are displayed: 

Max. valid thread diameter (mm) - inner diameter of the thread selected bolt; 

Current thread diameter (mm) - the calculated internal diameter. 

If the first parameter is greater than the second, the strength is sufficient. 

Dimension chains 
Teams of calculating dimensional chains are located in the Object Manager nanoCAD 
Mechanica. To access it you need to switch to the "Dimension chains" panel object 
manager  nanoCAD Mechanica.  
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 Fundamental rules 

 Calculation methods 

 Icons tree calculation 

 Toolbar 

 The sequence of calculation 

Fundamental rules 
It proposed two methods of calculation: minimum-maximum method and the 
probabilistic method. 

Measures involved in the calculation may be specified as one or several separate 
drawings. 

The project is monitored dynamically link with the size of the drawings. If the size is 
different from the drawing or missing from the drawing, it will be highlighted in bold. 

Calculated closing unit contains the calculated values of the nominal value, the upper ES 
and lower EI deviations. All dimensions are displayed in the 1: 1 scale. 

In edit mode, you can create new master links, remove the entire branch graph, edit 
size, surface combine different branches (the movement of the nodal points "grips"). 

At the end of the table shows the calculation of the calculated deviations closing units. 

It supports only linear dimensional chains. 

Calculation methods 

Maximum / minimum 

Nominal closing link: 

 

n - number of units, except the locking. 

The upper limit deviation of the closing unit: 

 

Lower limit deviation of the closing unit: 
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Probabilistic 

Nominal closing link: 

 

ES - upper deviation; 

EI - lower deviation; 

n - number of units, except the locking. 

The upper and lower deviation of the closing level will be symmetrical: 

 

t - risk ratio. 

 

P - risk percentage; 

?2 - coefficient taking into account the law of distribution of real denominations. 

Adopted 1/9 for the Gaussian distribution, for the distribution of 1/6 and 1/3 Simpson 
for uniform distribution. 

Note:  

When calculating the maximum / minimum denomination of an 
unknown can be set on a single link, the upper deviation of the 
unknown - on the other, the lower - in the third. The probabilistic 
method such chain is not counted. 

Icons tree calculation 
 Project 

Group size may contain several cycles of size. 

 View thumbnails while editing the graph. 

 Drawing 

Group sizes, taken from a drawing. Path Drawing dropped, compared to only a name, 
that is the size of the C: \ Work \ Drawing1.dwg and C: \ Acad \ Drawing1.dwg will be 
placed in the same group "Drawing1". 

 Dimension 

Dimension added to the drawing. 
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Next to the icon indicates the value of the size tolerances. Instead, you can enter any 
name (for example, the width of the bearing). 

The value of the dimension can be viewed in a tooltip. If the dimension of the drawing 
was linked text below the dimension line, its name will be assigned automatically. To 
display the nominal, enter an empty name. 

The dimension can be edited by double-clicking or from the context menu. 

 

  List of adjacent dimensions 

The icon reflects the relative position of a given size (blue rectangle) and the adjacent 
(green rectangle). 

 Unknown closing link 

You can add a calculation for editing or drawing a graph by adding the size in which the 

value and / or deviations are "?". It contains a list of increases  or decreases  
dimensions (presumably). 

 Switching link 

It contains the calculated values of the deviations: 

 face value  ; 

 upper deviation   ES; 

 lower deviation   EI. 

Note:  

When you edit or delete any dimension calculated counting all 
units nulled.In project dynamically tracked due to the size on 
drawings. If dimension different from the drawing or missing from 
the drawing, it will be highlighted in bold fonts. Again take the 
value from the drawing context menu (How drawing). 
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Toolbar 

 Create calculation 

If the button is not available, were selected to be the calculation start or finish editing 
the graph. 

The project can be any number of calculations. They are translated independently. By 
default, a calculation is named "New". 

 Open project 

Projects are stored in a special format SPJ. If an existing project is not saved, it will be 
lost. Warnings are not provided. 

Project files can be transferred to other folders on other machines. The relative path 
from the project file to the file associated drawings should not be modified so as not lost 
contact with the size of the project in the drawings. 

 Save project 

 Save project as… 

 Add dimensions 

From the selected objects based on the current filter will be selected either all or only 
the horizontal or only the vertical dimension. In the column all sizes will be rotated 
horizontally. 

 Change filter 

Setup select the type of dimensions (horizontal, vertical). 

 Start/finish editing 

The beginning and the end of the calculation of dimensional chains. This command 
displays the current drawing on the graph for the current calculation. 

Pressing will clear the graph with the drawing and will in the calculation of the changes. 

In edit mode, you can create new master links, remove the entire branch graph, edit 
size, surface combine different branches (the movement of the "grips"). 

 Set to drawing 

Makes changes made in the current account, the original drawings. Warnings are not 
provided! 

 Get from drawing 

Fixes dimension values to those given in the drawings. 

 Calculate chain 
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Calculates all master links the current calculation. 

 Create report 

It puts the current drawing table the report and the distribution schedule tolerances. 

 Closing link 

Adds closing link. The command is only active during editing of the graph. After pressing 
need to sequentially select two surfaces of one or more branches of the graph (in the 
drawing). 

 Non-specified limiting tolerancies   

 

Sets limiting tolerancies for unspecified tolerances. Limiting tolerancies is selected from 
the drop down menu. 

 Calculation method 

Accurate (high / low) and probabilistic. 

 

Risk - the probability that the real value of size does not provide a closing link in getting 
the calculated border. The possible values are from 32% to 0.001%. Recommended - 
0.01%. 

 

The law of distribution of real values of size. From left to right: a normal distribution 
(Gaussian), triangular (Simpson) and linear (uniform). 

If the law is unknown, it is recommended to take a linear distribution. 

 Help... 

The sequence of calculation 
1. By clicking on the icon "Create calculation" in the browser creates a folder sizes. By 

default, it is named "New". 
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2. After clicking on the icon  "Add dimensions" the drawing must specify 
the dimensions involved in the calculation. 

 

Information on the selected size appears in the browser. 

3. Press  "Start/finish editing". 

4. Becomes available team  "Closing link". Enter the drawing the locking unit 
(multiple master links). 

5. After selecting press the trailing links  "Start/finish editing". The information in 
the browser changes. 

 

6. Calculate chain. The browser displays the results of the calculation. 

 The calculation results are displayed in a table in the drawing by clicking on the icon 
"Create report". 
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Drawing specifications 

Project Manager 

Functional panel:Specification (Project Manager). 

 

To create a new project, click on the link  "Specification". 

 

When creating a project, a head empty assembly unit is created. An assembly unit 
includes default specification sections. 

Toolbar 

Create - the command allows you to create an entry or empty head assembly unit. 

 

Cut - the command cuts an entry for later insertion into another assembly unit. 

Copy - the command copies the entry for subsequent insertion into another assembly 
unit. 

Paste - command inserts a previously cut or copied entry. The insertion is made in the 
same section of the specification from where the entry was cut or copied. 
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Delete - command deletes entry. 

Delete specification - the command opens the specification editing dialog. 

Create position - the team creates a position on the occurrences: Assembly units, 
Details, Standard products, Other products and Materials. 

Creating an empty head assembly unit 

1. On the toolbar, click "Create". 

2. In the drop-down menu, select "Create empty head assembly unit". 

 

3. The head assembly will be created. 

 

The active build is marked with an enabled switch. 

Creating entries 

1. On the toolbar, click  "Create". 

2. In the drop-down menu, select "Create entry". 

 

3. Select entry. 

 

4. In dialogue "Creating entry" fill in the required parameters. Depending on the type 
selected, different fields will be available. 
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5. After entering all the necessary parameters, the "OK" button will be available. 
Confirm your entry. 

6. The entry is added to the project manager tree. 

 

Entry Editing 
1. Select an entry in the tree. 

2. Below the tree will be available options panel for editing. 
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Create position 
1. Select entry: Assembly units, Parts, Standard products, Other products or Materials. 

2. Click the button on the toolbar "Create position". 

3. Insert a position in the drawing and fill in the data in "Position leader edit". 

4. The position field at the entry will be associated with the position in the drawing. 

 

After creating a position, the following commands will be available: 

 Show position - shows the position on the drawing. 

 Edit position - open  "Position leader edit". 

 Reset position number - deletes position number.  

Editing Performances 
If a group type is set in the BOM settings, the sections of the performances will be 
available in the list of sections. 

 

When placing the entry in the execution, the section "Executions" and the entry of the 
execution will be added in the tree of the assembly unit of the project manager. 

 

The occurrence of the performance is called for editing by double-clicking the LMB. The 
dialogue allows you to create in the performance of new entries or copy them from the 
permanent data. 

The dialog box consists of the sections: "Variable data" and "Permanent data". 

In the section "Permanent data" are the occurrences of the specification. When you 
click on the "+" button, the entries are copied into the execution (in the section 
"Variable data"). 

In the section "Variable data" are occurrences of performance. Clicking on the "+" 
button will create an empty entry. 



User Guide nanoCAD Mechanica 25 
 

279 

An empty entry can be edited by changing its Type, Designation, Name and Quantity. 

To remove an entry from a performance, press the "-" button opposite the entry. 

Specification 

Main menu: Mechanical - Part list > Part list. 

Ribbon: Mechanical - Part list > Part list. 

Toolbar: Part list ( "Part list"). 

Command line: MCSPECIFICATION. 

Refresh - refreshes numerals affixed, if they were not put down or changed the rules 
prostanovki item numbers. 

Numbering - replaces characters "x" item numbers. 

 Export the drawing - creates the drawing table nanoCAD Mechanica 25 to output 
specifications for printing means nanoCAD. 

Editing operation positions Specifications: 

Cutting position of editor. 

Copying position in the buffer. 

Paste position. 

Add record. 

Deletes the current record. 

  

 Move up and move down - changes the position of the selected row 
specification. 

Sort - sort position alphabetically within sections. 

 1 

Add balloon - balloon to create the BOM item, if has not been set previously. 

Properties -Setting Specifications. 

Find the drawing - moves the current view and highlights the position of the 
drawing. 
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In the upper left corner of the specification contains the fields relating to the weight of 
the product. 

  

Text field contains the calculated value of the product weight. 

When you turn jackdaws Update estimated value product weight is automatically saved 
to the "weight" of the title block of the drawing. 

  

 Gray shaded box in the column specification section shows that this section does not 
contain any information. 

 Left mouse click on the symbol "Plus" can open (close) the contents of this 
specification section. 

Relocating the entry between partitions 
To transfer the recording details in another section hold down the left mouse on the 
portable recording and release it above the title of the desired topic. 

 

Transferring records to section Assembly Units 

Setting Specifications 

Style setting specifications 

To edit a template specification in the drop-down menu window Editor specifications 
tap Tools. In the drop-down list, select Change type, in the dialog box, select the desired 
template specification. 
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In the same dialog options are available edit and delete the selected template - through 
the configuration dialog specification. 

Specifications Configuration Dialog 

Settings dialog specification includes the following tabs: 

Document tab 

Tab document defines the type of document and marking performances. 

The following types of specifications: 

 Simple 

 Group Type A 

 Group B Type 

When choosing a Type A or Type B list becomes active performances. List of 
performances can be edited (by clicking "Add" or "Delete") 
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Double-clicking on performance causes him to edit. In the editing dialog can associate 
the letter execution. 

  

Tab Sections 

Categories tab allows you to customize the specifications section. 
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The partition table determines which sections and in what sequence will be present in 
the specification, and for which one has a notation of the specification callouts. Double-
click on the field "Has the callout" enables or disables the callout for the corresponding 
section. 

Controlling the placement of sections in the specification is performed using the "Up" 
and "Down." 

 

The "Name Change" Allows you to change the name of the selected partition. 

"Add" button brings up a dialog to add a topic specification. Sections are added one by 
one. You can add a section with the standard name (if not already present in the 
specification) or with an arbitrary name. Galka "Has callout" duplicates the 
corresponding value in the partition table. 
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Tab Title 

Title tab controls the composition and order of the fields used in the construction 
specifications. 

Table fields specification includes the field name, type, and switches the display position 
in the editor and the editor specifications. Use the "Name Change", "Add", "Remove" 
edited list of fields. 
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Button "Add field" brings up a dialog where you can add fields from a predefined list, or 
an arbitrary field, specifying the type and display in the editor position and specification. 

 

Numbering tab 

On this tab, adjusted the numbering of positions in the specification. 

Export tab 

On the Export grouped items export settings in the drawing and specifications in Excel. 
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General settings: 

See sections - controls the display section headings in the exported specification. 

Skip the line after section - includes extra blank line in the specification table between 
sections. 

Must positions without partitions - if enabled, the position is not related to any section 
will be included in the export specification. 

Grouped by GOST - one standard parts will be grouped general heading (for example, 
"nut OST 26-2041-96"). 

Skip the line after group - add a blank line after grouped according to GOST positions. 

  The number of skipped lines between sections - number of blank lines between sections 
of the specification. 

Migrate to the next line - includes transfer to the next line with a long name products. If 
this option is disabled, the item name will be entered into a table cell. 

Skip first and last lines - pass includes the first and last row of the table in the template 
specification. 

Output at the line - each position specifications will be displayed with a space in one 
line. 

Skip the line at break numbering - if the positions do not follow the order, after 
nonconsecutive lines added a line under a missing item. If the drop-down list shows a 
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miss "single line" - that regardless of the number of missing items will be added only 
one empty line. If the drop-down list select a miss "depending on the gap," the number 
of rows to skip will depend on the size of the gap. (For example, if after 6 position 
followed by the position 9, then 2 lines will be skipped). 

Followed by the output settings of the field "Format" field and "Zone" - show them in 
the "Comments", "Format" and "Zone" respectively, or do not show at all. 

Option Rounding weight controls rounding up masses of parts made to specification. If 
nobhodimosti rounding on weight, you should select the required word length. 

Drawing tab 

 

Update specification sheets in the drawing  - Includes automatic update of tables 
exported to the drawing specifications. The update is performed on the export 
specification drawing. Accommodation in this specification is not requested again. 

Specify the insertion point selection rectangle - when this option is enabled the position 
of each sheet exported to the drawing specifications not given an indication of the 
insertion point, but an indication of the rectangular boundary of the placing on the 
drawing sheet. 

  

Export Settings on the drawing table designation include serving template specification 
for the first and subsequent sheets. 
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When you click on  the table selection dialog opens. 

Setting up a custom type specification 
 Go to the drop-down menu Specification type simple.  

 

 Go to the tab "Partitions".  
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 Click on the Delete button and select the sections that you do not need or you do 
not use. In the sections of specifications provided by the State standard, The 
current setting, can be removed but removing them from the system is 
impossible. At any time, you can edit the style specification and return these 
sections. 

 Click on the Add button. At the top of the dialog box, in the "Standard", posted 
sections that are removed from the system. Go to "User Partition" and create your 
profile.  
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The result can be seen in the figure below. 

 

 Go to the tab "Header".  
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Add a new field type. 

 

 On the "Numbering" it is possible to set a rule for the numbering and skip to the 
desired position.  

 



User Guide nanoCAD Mechanica 25 
 

292 

 Tab "Export" link provides specifications and user table that allows you to 
customize the specification of any complexity.  

 

 Tab "drawing." On this tab, click the button . In the dialog box, choose from the 
database tables for the first and subsequent sheets. 

Create a table for a custom specification 
Open Table Editor and create a new table. 

To create a custom specifications in the table must specify the header field specification 
and the field "title block". Export records to be made in the fields below fields defined as 
"Title". 

To set the BOM header must select a table cell and, from the context menu 
"Properties". In the "Value" enter the header field specifications with the prefix $TITLE_. 

For example $TITLE_Name. 
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To limit the filling column specification adjustment must be at the bottom line allowed 
to enter in the "Value" line $END. Otherwise the filling will be made before the end of 
the table or subtable. 

To transfer data from the main drawing caption (for example, the fields of the title block 
specification) must be in the "Value" enter the value with the prefix $SHTAMP_. The cell 
named $SHTAMP_Name be entered value of the "name" of the title block of the 
drawing. 

After registration table accordingly to save it in a database under the appropriate name 
for later use. 

Balloons 

Main menu: Mechanical - Part list > Balloons. 
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Ribbon: Mechanical - Part list > Balloons. 

Toolbar: Part list > Balloons. 

Command line: MCPOSITION. 

Fundamental rules 
When you point to elements of attachment parts for nanoCAD Mechanica 25 recognizes 
the size of parts mounting connections without additional indication of its components. 

When making a specification of the assembly drawing mechanism can be set 
dynamically related to the title block of assembly component external DWG-file. 

All changes in the linked drawing die subassembly (rooms, mass node) will automatically 
be reflected in the general specification. 

Notation of the position of the standard item 
When selecting compounds for a fastening nanoCAD Mechanica25 Auto detects the 
typical preset sizes of fastening elements with no additional input. The construction 
indicators-fit , degree of hardness and the cover for standard parts should be set 
individually, depending on the specific conditions of the assembly operation. 

Additional lables (Precision , modelling procedure, thread tolerance , degree of hardness 
etc , must be entered among the truss symbols. In the ballon editor (or in the part list 
editor), double click the entry field to enter additional information on the modelling 
procedure of a fastening. 

 

The information input on performance of standard details. 

Creating a Balloon 
Pick the start point and the second point , defining the position of the underscore , the 
position leader edit dialog appears. 
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To group balloons according to the type, left click on the partition field.From the drop-
down menu choose the desired option to which the part is referring. 

 

The mark, Name, note and mass fields can be set by the user. 

If the item name is too long, you can enable the forced transfer it to the next line. To do 
this, add a control character \n. 

 

At the specification export, the posiotion name will be broken onto two lines.If the 
format is on the drawing then for the specification table the drawing zone is added 
automatically. 

If a format is present on the drawing for positions on the specifications, the zone of the 
drawing is automatically added. 

The shape of the balloon can be set in the symbol tabof the construction site 4 option 
below. 
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To display the quantity of positions connected with given leader, it is necessary to select 
the mark. 

 

The total of the details of the given position will be displayed on the drawing next to the 
position number within brackets. 
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Going into the editor specifications 

 

Checkboxes for the number of items, click on the icon Specification. This icon is located 
in the dialog editor specifications and in the main toolbar nanoCAD Mechanica 25. 

Blocked Ballon Insertion on the drawing 
If the ballon leader is applied to the item that has already been entered in the part list , 
it is shown in the figure with a vertical extension line. 

 

Repeated leader 

If such repeated ballons are meant to be any reason , double click the red leader. 

In the dialog window, double-click on each of x-symbols in the column used to block 
ballon insertions. 

 

Close the window by clicking x symbol in the upper right corner the part numbers will 
appear in the drawing. 

Adding Construction Indicators to Standard 
Parts 
When you point to elements of attachment parts for nanoCAD Mechanica 25 recognizes 
the size of parts mounting connections without additional indication of its components. 
Design features (landing, strength class, coating) standard parts, depending on the 
specific conditions of the site must be specified separately. 
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Additional notation (class, performance, tolerance thread, class, etc.) must be entered 
instead of a hash sign ("#"). 

Editor position (or BOM editor), double-click on an editable cell to enter additional 
information about the execution of the fastener. 

When selecting components for a fastening, nanoCAD Mechanica auto-detects the 
typical preset sizes of fastening elements with no additional input. The construction 
indicators - fit, degree of hardness and the cover for standard parts should be set 
individually, depending on the specific conditions of the assembly operations. 

Additional labels (precision, modelling procedure, thread tolerance, degree of hardness 
etc.) must be entered among the truss symbols. In the ballon editor (or in the part list 
editor), double-click the entry field to enter additional information on the modelling 
procedure of a fastening. 

 

The information input on performance of standard details 

Creating performance and item positions , before 
inserting into the drawing 
To create an additional position for an item which has already been identified on the 

drawing, use the "Add position/perfomance" option. Click on this icon and the Select 
position record dialog will open. In it, the earlier insertion positions are displayed. 

Note: In the Select position record dialog, only those positions that have been 
identified by number are displayed. 

If the specification editor settings mean that a group view of the document is shown, 
the Select position record dialog contains two parts. The top part of the window displays 
the list defore the inserted positions, and the bottom part of the window - the list of 
position perfomances. If a line is chosen in the top part of a window, the new 
perfomance of the selected line will be added in the position editor. If a line is chosen in 
the bottom part of a window, the selected perfomance will be added. 
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Position Align 

Main menu: Mechanical - Part list > Position align. 

Ribbon: Mechanical - Part list > Position align. 

Toolbar: Position align ( "Part list"). 

Command line: MCPOSALIGN. 

Command allows you to align the numbers callouts specification. To do this, you must 
first select which items will be subject to equalization, then - in the context menu to 
specify alignment options. 

 

Following options are available: 

 Vertically. 

 Horizontally. 

 Line - an indication of the line along which the rooms are arranged 

 Rectangle - specifies a rectangular area around which aligned numerals. 

Recognition specifications 

Command line: MCRECSPEC. 

Master recognition specification enables automatic search and replace specifications 
created from individual primitives nanoCAD, transforming them into an object 
"Specification" nanoCAD Mechanica25. Initial primitives are in the drawing. 
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Drawing design 

Drawing borders 

Working with standard formats 

Main menu: Mechanica - Drawing title/borders - Drawing title/borders. 

Toolbar: Drawing title/borders (  "MCS Drawing title/borders"). 

Command line: MCFORMAT, FORMAT. 

 Filling in the fields of the title block 

 Drawing title/borders recognition 

Fundamental rules 

Each format type is an element of the database nanoCAD Mechanica25, which is located 
in the folder "Drawing border templates" library  nanoCAD Mechanica25. 

emplates major labels and additional fields are located in the subfolder formats "Title 
block templates". Renaming or deleting existing items in the folder "Drawing border 
templates" would make it impossible to insert existing formats. 

Insert the format by clicking on the icon Drawing title/borders. This dialog box 
appears Format: 

 

This window is defined by: 

 Format. 

 Sheet. 

 Autonumerate from. 

 Use zones from. 
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 Center marks. 

After selecting the type of document, as well as the size and orientation of the sheet is 
inserted into the selected format. 

 To edit the frame size, double-click the left mouse button on the contour of the 
frame. 

 To edit the text in the title block, double-click on the text of the left mouse button. 

 To edit entries in the title block, double-click the left mouse button on any line of 
the title block. 

If you remove the first sheet of the scope of its information from the title block is 
automatically transferred to the second sheet. 

To save the settings template attached stamps and their parameters in the database, 

click on the button , then enter the path stored in the database and the template 
name. 

General Principles 

To change the line frames the template files, edit the frames and other fields. 

"Document Type" - Select the document type from the list format template in section 
database. Depending on the document type is changed appearance and availability of 
individual dialog items "Format". 

"Format" - the choice of the size of the sheet on the basis of standard size and 
multiplicity (not available for the types of documents based on the standard ISO, 
because the multiplicity inherent in the choice of format). 

"Leaf" - the choice of template title block for the first or subsequent sheets. 

"Orientation" - select page orientation (vertical or horizontal). 

"Autonumerate from" - Automatic Numbering sheets. It lets you specify the number of 
the first sheet. 

"Use zones from" - avtoprostanovka zones. It lets you specify the number of the first 
zone. 

Edit main stamp 

After you select the document type and size under the proposed set the insertion point 
of the frame. If you press Enter or right mouse button, the lower left corner of the 
frame is aligned with the coordinate 0,0. 

Set default stamps - restores the template format those stamps which were 
overwritten while maintaining format template database. 
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Filling in the fields of the title block 

 

To fill the title block fields and additional graph, double-click on any line of the title 
block. 

The main inscription is filled directly into the dialog box, "Stamp" 

While filling in the title block previously entered information stored in the section 
"History" menu. To open the context menu, place the cursor in an editable field and 
click the right mouse button. 

Recent values can be saved in the section "Recent" menu. 

Automatically fill fields of the title block 

Save as default 

The command saves the current filling of the stamp in the memory. In the following 
fields will be filled automatically stamp 

Load defaults 

The command loads the stored filling. 

Clear 

The team clears stamp field 

Change template 

The command opens a drop-down menu to change the pattern of the stamp. 

Drawing title/borders recognition 

Main menu: Mechanica - Recognition > Drawing title/borders recognition. 

Toolbar: Drawing title/borders recognition (  "MCSRecognition"). 

Command line: MCRECF. 
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Master recognition format enables automatic search and replace formats created from 
individual primitives nanoCAD, transforming them into an object of the "Format" 
nanoCAD Mechanica25. Initial primitives are in the drawing. 

Recognition takes place in two phases: the first searches for the formats in their 
dimensions, the second selected title block. Selection is made by comparing the serial 
patterns of stamps from the library with the existing geometric objects in the drawing. 
The remaining seals are installed by default. After the successful recognition format 
graphs stamps are automatically filled with values from the drawing, and the format is 
placed on the current layer. 

Creating custom formats and stamps 
Before you create a custom size or stamp is necessary to draw a pattern nanoCAD 
means in accordance with the required desired view object being created. When 
drawing templates should adhere to the following rules: 

 The template can contain lines, arcs, and circles, text (single-line and multi-line), 
the objects of the library of standard parts nanoCAD Mechanica25, blocks  
nanoCAD; 

 the thickness of the lines that are assigned to the template thickness is not equal 
to zero, and not "layer" to be adopted in accordance with the thickness of the 
closest standard value; 

 the color lines and text included in the template will be saved according to the 
selected values; 

 multiline text (mtext) is inscribed in the boundaries of the rectangular area of text 
is selected when you create it. 

You can use overhead lines and graphic objects, which are not drawn when inserting 
format or stamp in the drawing. 

To install a drawing object as a service, use the button "Set parameter" toolbar 
MechWizard, select the object, and in the dialog "Object properties" check the box "Is a 
working object": 
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 Use the links in the templates 

 New border wizard 

 New title wizard 

Use the links in the templates 

Stamps in the format template 

Custom format may contain links to templates stamps available in the library. To add a 
stamp in the format used by the relevant rules. 

Stamp Position and orientation when you insert a drawing format will be determined by 
the insertion point and orientation of text links: 

 

the figure shows the format template added referring to stamp basic inscription. When 
you insert a drawing format drawn stamp recorded in the library under the specified 
name. 

the format can be added to any number of references to the stamps from the library. 
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Using text fields 

In the pattern of the stamp may be used special signage text fields. 

Text added to the template and starting with the single character "$", is recognized as a 
reference pointer on the field (the Count) input. In the input field of the dialog box, you 
can edit the stamp to record the text (for example, the name of the developer or check). 
Name field can contain characters of the Latin alphabet and the national or spaces. 
Dimensions of the input fields are defined primitives surrounding the insertion point, 
the reference index. If you found another symbol "$", the text after it considered the 
description field: 

$Field_name [$field definitions]. 

the contents of the text box will be displayed in the list of object properties. 

To limit the size of the input field or eliminate overlapping fields in the dialog, you can 
use the service line. 

To create a stamp based on an existing base in the sample, the sample to be inserted 

into the drawing by setting in the dialog box "Stamp" mode "Display field names" . 
After insertion into the drawing die can be used as the layout of the new stamp. 

Standard fields stamps have a description in Russian (GOST), English (ISO) or German 
(DIN) language, the values of the fields available in the list of object properties. 

 Name   Description   Contact with the 
properties of the 

document Inventor  

 Note:  

 $Designation   Description   +   

 $DrawingName   Name   +   

 $Drawing type   Drawing View    

 $Material   Material   +   

 $Litera 1   Letter 1    

 $Litera 2   Letter 2    

 $Litera 3   Letter 3    

 $Mass   Weight    
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 Name   Description   Contact with the 
properties of the 

document Inventor  

 Note:  

 $DimScale   Scale   +   Sets the size of 
generated within the 
format  

 $Sheet   Sheet   +   Changes in the 
automatic numbering  

 $SheetCount   Sheets   +   Changes in the 
automatic numbering  

 $Add.text   Position the 
additional 
inspection  

  

 $Author   Developed   +   

 $Control   checked   +   

 $TechControl   Technical control   +   

 $Add.subject   Last additionally 
checked  

 +   

 $NormControl   the Regulatory 
Control  

 +   

 $Approve   Approved   +   

 $Author (sign)   Developer 
Signature  

  

 $Control (sign)   the signature 
checking  

  

 $TechControl 
(sign)  

 Signature of the 
technical control  
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 Name   Description   Contact with the 
properties of the 

document Inventor  

 Note:  

 $Add.subject 
(sign)  

 Signature 
additional 
inspection  

  

 $NormControl 
(sign)  

 Text regulatory 
control  

  

 $Approve (sign)   the signature 
approving  

  

 $Author (date)   the date of   +   

 $Control (date)   Date of Inspection   +   

 $TechControl 
(date)  

 Date engineering 
controls  

 +   

 $Add.subject 
(date)  

 Date further 
verification  

 +   

 $NormControl 
(date)  

 Date of regulatory 
control  

 +   

 $Approve (date)   Approval Date   +   

 $Original #   Part Number 
script  

  

 $Sign & date 1   Signed and dated 
1  

  

 $Instead #   Instead, inventory 
number  

  

 $Duplicate #   Inventory number 
duplicate  

  



User Guide nanoCAD Mechanica 25 
 

308 

 Name   Description   Contact with the 
properties of the 

document Inventor  

 Note:  

 $Sign $date 2   Signed and dated 
2  

  

 $Reference #   the reference 
number  

 +   

 $First use   the primary use   +   

 $Format   Format   +   

 $Enterprise   Enterprise   +   

In the pattern of the stamp can be used table nanoCAD Mechanica25. Included in the 
stamp table when you insert a drawing can be edited as regular tables nanoCAD 
Mechanica25 (except that the die table can not be modified in the editing mode screen). 

Additional features 

Converting from previous versions - In file %ProgramData%\Nanosoft\nanoCAD 
Mechanica25\DataRO\ru-RU\settings.xml  defined fields for name mapping formats of 
old and new versions. If an entity applies the custom stamps of previous versions, the 
names of the fields, you can add them into the appropriate section of this file. 

Integration with other objects  nanoCAD Mechanica25 

Tables - Format allows you to use tables as stamps. This preserves virtually all the 
functionality built-in table. 

Universal marker - The values of any fields format can be used in a universal marker. 

Dimensions - When you create within the format size, the size takes out set in the title 
block of the format. 

Legend roughness - The format may be associated with the designation of a roughness 
surfaces unspecified. Icon roughness is automatically transferred to the upper right 
corner of the format. 

Property document - The value of the standard field format is synchronized with the 
attributes of the file in which it was created. 

Technical conditions - Format calculates the coordinates of the columns to 
accommodate the technical requirements. 

Attribute documents TechnologiCS - Exchange values between the fields and the 
format of the document attributes. You can set the matching fields automatically (by 
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the same name), and then specify manually. Establishing appropriate stored for later 
use. 

Zone format - The format can be calculated, is there any point in it. If so, you can 
receive the designation area containing the point. 

New border wizard 

Main menu: Mechanica - Drawing Title/Borders > New border wizard. 

Toolbar: New border wizard (  "MCSDrawing Title/Borders"). 

Command line: MCFORMATWIZ. 

 

To change the existing format, select it from the drop-down list of templates. The field, 
located in the center of the panel will be a general view of the selected format. 

To add a new format, select the drop down list "Template name" paragraph (new). 

Click the left mouse button on the center field, select the drawing created by pre-layout 
format template, and confirm the selection click OK. 

In the dialog box "Format creation" will be recognized image format. 

If you create a new format after closing the dialog box by pressing OK, a dialog "Create 
element", which follows the format and select the name of the folder in the library of 
standard parts, which will save the created format: 
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By default the path "DB \ Drawing borders template". If you want to keep the format in 

another folder, press  and select the folder that appears in your browser. 

Creating a template format is similar to creating templates stamps. Embedded tables 
are not supported. The texts, starting with the single "#" character, determine the type 
and position of the stamp format. When you insert the size of the database will be 
loaded stamped with the name specified in the text (the symbol '#' is ignored and the 
text "main message" will be replaced with the box on a stamp with the name of "Title 
Block"), if it is in base. If the name starts with "$" and contains only hexadecimal digits, 
it is interpreted as UID template stamp in the database. Coordinates, direction and 
alignment of the text will be applied to the stamp. 

Note: 
 See stamp UID by inserting the drawing title block of the database 
manager nanoCAD Mechanica25.At the command prompt displays 
the hexadecimal object UID 

Predefined templates are stored in the formats "DB \ Drawing borders template". It is 
recommended that the new template is stored in the same folder, but when loading the 
template can be seen the whole base. 

Frame custom format has a fixed size - the one set in the template. There is a special 
recognition mode that allows the use of standard scalable framework with their stamps. 
To enable this mode, select from the list in the dialog master the standard by which the 
frame will be built. In this mode, all of the graphics in the template are ignored, except 
for text and bounding box. The frame can be of any size - in the final format it replaced 
with standard frame. All texts are considered names stamps. There are two variants of 
binding stamps: 

 If the text begins with the "#" symbol, it is stored offset from the insertion point to 
the nearest corner of the bounding box. 

 If the symbol "#" no stored offset from the text insertion point to the bottom left 
corner of the bounding box. 

Note: 
Standard sizes have patterns in the database - their patterns are 
embedded in the program code. 

New title wizard 

Main menu: Mechanica - Drawing Title/Borders> New title wizard. 

Toolbar: New title wizard (  "MCSDrawing Title/Borders"). 

Command line: MCSTAMPWIZ. 
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To change an existing stamp, select it from the drop-down list of templates. 

To add a new format, select the drop down list "Template name (new)". 

A template stamp can have up to four different graphical representations: simple and 
full (advanced) type, including the form of the first sheet and the view for subsequent 
sheets. 

Select one of the tabs: "Simple view" or "Extended view". Click the left mouse button on 
one of the fields marked with a stamp type, and select the drawing template you 
created earlier mock punch. Confirm the selection click OK. 

In the dialog box "Create stamp" will be recognized image of the stamp. 

If you create a new stamp, after closing the dialog box by pressing OK, a dialog "Create 
element", where you must enter the name of the stamp, and choose a library of 
standard parts folder in which to save the template created by the stamp: 

 

New templates stamps recommend that you save to the folder "DB \ Drawing borders 
template \ Title block templates". 

If the layout for the die table to use, it will retain its editing capabilities even being 
introduced to the format. For these tables are only supported editing in place. 

The pattern die may be up to four types: 

 the main type of the first sheet, 
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 he main type of follow-up sheets, 

 an expanded view of the first sheet, 

 an expanded view of the next sheet. 

The texts, starting with the single character "$" are recognized as the names of the 
fields. The editing dialog stamp they will be displayed in the form input fields. Name 
field can contain spaces and extended characters. Dimensions of the field defined 
primitives surrounding the point of its insertion. If you found another symbol "$", the 
text after it considered the description field. This text will be displayed in the list of 
properties: 

$<name_field>[$<description_field>] 

To limit the size of the field or eliminate overlapping fields in the dialog, you can use the 
service line. This is a primitive with zero thickness or line marked as the utility from 
mcWizParam. Set the parameter. 

If you set daw "Work object", then stamped on tobrazhatsya these primitives will not. 

To create a stamp based on an existing base in the sample, the sample to be inserted 

into the drawing, and in his dialogue press  "Show Field Names". View selected 
stamp button "View". 

After that, the object can be divided (explode), edited and used as the layout. 

The dialogue is a choice of the standard, which is taken from a stamp. This standard is 
used for the selection of the frame formats in recognition of the primitives. 

Tables 

Tables 

Main menu: Mechanical - Tables > Tables. 

Ribbon: Mechanical - Symbols > Tables. 

Toolbar:  Tables (on toolbar  "Tables"). 

Command line: MCTABLE. 

Causes dialog box to insert a new table. 
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 To create a custom table, select Custom. In input fields specify the dimensions of 
the created table, or on the layout, drag the mouse to the right as many rows and 
cells as required. When subsequent editing the number of rows, columns, cell 
sizes can be changed. 

 To insert a standard table, select load from database. You can insert a standard table 
of the base elements Building site . In the dialog box, select the table you want. 
Database elements Building site is available for all major types of standard tables. 

 To insert a table from a file, select Load from file.  

Click Browse  and select the file table. 
 Supported formats:  

 tbl - tables files 

 dat - data file or a text file 
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 mdb - database Microsoft Access 

 xls - Spreadsheet Microsoft Office Excel 

 xlsx - spreadsheet Microsoft Office Excel 2007 

 csv - table cell separated by commas 

 txt - standard text file 

 xml - XML document 

 odf - OpenDocument Format. 

When loading a table of xlsx, xls file, you must select the Excel document sheet. 

 

Important! Select the sheet can be made after a table is loaded from the file. 

 

 

In the properties of a table row source file displays the path to the source file of the 
table.  
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Select line Request  to enter the desired page of the document. Then in the Table Editor, 

click Update Table from an external source. 

When loading a table from a file mdb drop-down list displays a list of database query. 

 

Note: 

To import tables from files, you can drag a file from Explorer to 
the dialog table . 

When you drag a file from Windows Explorer in the imported 
table is added to the existing table. 

When you drag a file from Windows Explorer dialog box replaces 
the existing table to be imported. 

 To generate a report based on a sample of objects, select the objects in the sample 

report. 

   

To make a selection of items, click Select. 
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The search conditions are set in the  Quick selection dialog. 

Further dialogue is given based on what the attributes are and creates a report on the 
selected objects. 

 

Includ attributes for the report in the list by selecting flags  
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 All- selects all attributes 

 None - the choice is removed from all the attributes 

 Invert - inverted selection attributes 

The table is created with a template report form 

=Iff(Exist(Object."Autoreport");Object."Autoreport";"") 

This formula checks whether there is a line for the attribute named Autoreport, and 
displays its value in a cell. Otherwise, leave the cell blank. 

 

The number of columns in the table determined by the number of selected attributes. 

 To import a table from Excel, select Import from Excel. To activate this item, the 
document should be opened. 

 Select the insertion point of the table. 

  

 Select the numbering of rows in the table. 

  

If the switch rows upside down is enabled, the line numbered in reverse order. 

 When the checkbox  after you insert the table will start a 
dialogue format. 

 Click OK and the insertion point on the drawing table. 
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Note: 
If the drawing pre-select a group of objects, and then run the 
tables, you will be prompted to create a report based on a sample 
of objects. 

Import, export from Excel 

Import 

Main menu: Mechanical - Tables > Import table from Excel. 

Ribbon: Mechanical - Symbols > Import table from Excel. 

Toolbar: Import table from Excel (on toolbar  "Tables"). 

Command line: MCTABLEEXCELIMPORT. 

Transmits data from an open book MS Excel. 

 In an open Excel worksheet, select the cells whose data you want to import into a 
table nanoCAD Mechanica 25. 

 Go to the nanoCAD, editor of the table, and then click Import tables from Excel. 

 Data will be transmitted to the table. 

Export 

Main menu: Mechanical - Tables >  Export table to Excel. 

Ribbon: Mechanical - Symbols >  Export table to Excel. 

Toolbar:  Export table to Excel (on toolbar  "Tables"). 

Command line: MCTABLEEXCELEXPORT. 

Designed to transmit tabular data in MS Excel. After clicking on the button opens a new 
Excel workbook and it migrates all the tabular data with formatting cells established in 
the table. 

Important! 

The tables nanoCAD Mechanica25 not to Excel the following data: 

 Blocks nanoCAD 

 Formatted text 

 Formulas that do not match the format of Excel 
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Table recognition 

Main menu: Mechanical - Recognition > Table recognition. 

Ribbon: Mechanical - Utilities > Table recognition. 

Toolbar: Table recognition (on toolbar  "Recognition"). 

Command line: MCRECTABLE. 

Table recognition enables automatic search and replace tables created from individual 
primitives nanoCAD object "Table" nanoCAD Mechanica25. Sources are primitives for 
drawing. 

1. Use the command table recognition. 

2. Specify the drawing point at the table. 

The table is created in the current layer. Dimensions of the recognized table are 
rounded to integer values. 

Text belongs to the workpiece table is recognized as the values of the respective cells of 
the table. 

Real dimensions of the original graphics are multiplied by the scale design, so if it turns 
out the table with zero height lines, you need to change the scale clearance in 
accordance with the size of the original graphics. 

Editing a table in the drawing 

Main menu: Mechanical - Tables > Edit table in-place. 

Ribbon: Mechanical - Symbols > Edit table in-place. 

Toolbar: Tables > Edit table in-place. 

Command line: MCIPEDITTBLIPEDITTBL. 

Shortcut: CTRL+RBM on table frame. 

When editing a table on-screen, the "Edit Table" toolbar appears. 

 

The active cell is highlighted with a green frame. The text entered into the cell is 
automatically pre-pressed. 

Menu 

Group cells.  
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Serves to combine adjacent cells into one. 

Procedure: 

 Call command. 

 Pick the first corner point of the selection. 

 Pick second corner point of selection. 

 Selected cells will merge. 

Ungroup cells.  

Undoes the grouping of a previously merged cell from multiple cells. 

Procedure: 

 Call command. 

 Pick the first corner point of the selection. 

 Pick second corner point of selection. 

 Selected grouped cells that fall within the selected area will ungroup. 

Split cells.  

Serves to divide cells into several smaller cells. 

Procedure: 

 Call command. 

 Pick the first corner point of the selection. 

 

 Pick second corner point of selection. 

 

 In the "Split" dialog box that appears, enter the required numerical values for 
repartitioning.   
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 This will result in a new breakdown. 

 

Note: When using the "Split" command, the height and width of adjacent cells may be 
lost. 

Pencil.  

Serves for splitting cells into several by creating additional borders. 

Procedure: 

 Call command. 

 Pick the first point of the dividing line on the table border. 

 

 Pick the second point of the dividing line on the table border. 

 

 The cells that the dividing line will pass through will be split into new cells. Each 
cell is independent. 
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Add row. Adds one row at the bottom of the table. 

Add column. Adds one column to the end of the table. 

Insert row. Adds one row to the current position of the table cursor. 

Insert column. Adds one column to the current position of the table cursor. 

Delete row. Deletes the row containing the selected cell. 

Delete column. Deletes the column that contains the selected cell. 

Row properties. Changes the height of the row containing the selected cell. A dialog 
box is called up in which to specify the line height in millimeters. 

 

The "Start new page" parameter splits the table in an arbitrary place, i.e. where the cell 
is selected. Other pagination methods are available in the full editor interface. 

Column properties. Changes the width of the column that contains the selected cell. 
Enter the column width in millimeters in the dialog box. 

 

The "Hidden" option hides the selected column. You can return visibility to a column 
from the full editor interface. 

The "Substitute zeros with symbol" parameter replaces the null values of the column 
cells with the row data. In this case, the format of the cells must be numeric. 

Cell properties. Calls up the "Cell Properties" dialog box, which configures the 
properties of the selected table cell. 

Cells properties. Setting properties of a group of table cells. Select the required cells 
and in the appearing "Cell Properties" dialog box set the parameters of the selected 
table cells. 

Sum 

Calculates the sum of the selected area. 

Procedure: 
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 Select the result cell. 

 Call the command. 

 Pick the first point of the marquee. 

 Pick the second point of the marquee. 

 The formula will be entered into the result cell. 

Selective sum 

Calculates the sum of the selected cells. 

Procedure: 

 Select the result cell. 

 Call the command. 

 Specify cells. Press "Enter" to finish. 

 The formula will be entered into the result cell. 

Notebook 

Calculator 

Special symbols 

Quit. Exits the table screen editor. You can also exit the on-screen table editor by 
right-clicking on an empty space in the drawing. 

Table editor 
The interface is opened by double-clicking on the table, or by selecting the "Edit" 
command from the context menu of the selected table. 

 

The dialog box contains: 

 main menu; 

 toolbar; 

 parted cells with names (addresses) of rows and columns; 



User Guide nanoCAD Mechanica 25 
 

324 

 status bar with transparency and scale caret; 

General Provisions 

The names (addresses) of rows and columns are adopted similarly to the MS Excel 
spreadsheet editor. Vertical columns from left to right are named in alphabetical order 
in English letters (A, B, C, D,…, Z, AA, AB, etc.), horizontal rows are named in numbers in 
order. 

When you click LMB on a row or column name, it is selected. 

 

 

To select the entire table, select a rectangle at the intersection of the row and column 
names. 

 

The shortcut "Ctrl + scrolling mouse wheel" allows you to change the scaling of the 
table. 

The shortcut "Ctrl + click mouse wheel" sets the default table scaling. 
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When "View sorting" is enabled, sort buttons appear on the right side of the column 
headings. This sorting is intended to improve the convenience of entering data in the 
spreadsheet editor and does not affect the state of the table in the drawing. 

The button has three states: "Not", "Ascending", "Descending". 

Not 

 

Ascending 

 

Descending 

 

Sorting features: 

 Enabling sorting on one column disables sorting on other columns. 

 Rows are sorted whole, not just the column. 
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 Strings are sorted within a section. 

 The merging of cells is not broken. 

 After enabling view sorting, the vast majority of commands are blocked. Allowed: 
exit, edit single cells and change sort mode. 

Cell color 

 
 - cell containing expression; 

 
 - non-editable cell, for example, in a report; 

 
 - cell with an error in the expression; 

 
 - cell containing report section data; 

Filling adjacent cells with data 

To speed up data entry into the table, automatic data filling functions are used. The 
spreadsheet editor can automatically continue a series of numbers, combinations of 
numbers and text according to a given pattern. You can quickly fill in different types of 
data series by selecting multiple cells and dragging the fill handle. 

 

Filling cells with a sequence of numbers or combinations of numbers and text according 
to a given pattern: 

1. Select the first of the filled cells. 

 

2. Enter an initial value for a range of values. 

 

3. Enter a value in the next cell to set the fill pattern. 

 

For example, if you want the sequence 1, 2, 3, 4, 5 ..., enter the values 1 and 2 in the 
first two cells. If you want the sequence 2, 4, 6, 8 ..., enter 2 and 4. If you need sequence 
2, 2, 2, 2 ..., the second cell can be left blank. 

As the sequence is completed, it continues as shown in the table below. 
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Initial value Continuation of the series 

1, 2, 3... 4, 5, 6 ... 

1st period, 2nd period 3rd period ... 

Product 1, Product 2 Product 3 ... 

4. Highlight cell or cells containing seed values. 

 

5. Drag the fill handle over the range you want to fill. 

 

The cells will be filled with the specified sequence of numbers. 

 

To fill in ascending order, drag the handle down or to the right. To fill in descending 
order, drag the handle up or left. 

Basic tools 

Main menu commands 

File 

 Open file... - loads table data from a file. Files available for download: * .tbl, * .dat, 
* .mdb (only for 32-bit Windows), * .txt, * .csv, * .xml, * .xls, * .xlsx. When you 
select an Excel file, only the first sheet of the workbook is inserted. 

 Open database... - opens a dialog of library to select a table saved in the database. 

 Save as file... - writing a table to an external file *.dat, *.txt, *.cvs, *.xml, *.xls. 

 Save to database... - writing the table to the base of elements. 

 Edit Form... - opens the form editor. Using the form, you can filter data, control the 
composition and style of the table. 

 Show Form... - opens the table filter form. 

 Imtort from Excel - the command transfers the results of calculating tabular data 
from an open MS Excel workbook. The content of the active sheet or a selected 
range of cells is transferred. 

 Export to Excel - the command is designed to transfer tabular data to MS Excel. 
After clicking the button, the "Conversion options" dialog opens. After specifying 
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the options, a new Excel workbook is opened and all tabular data is transferred 
into it, while maintaining the cell formatting set in the table. 

 Close - saves changes and closes the editor. 

 Close without saving - closes the editor without saving changes. 

Edit 

 Undo - undo the last action. 

 Redo - redo the last undone action. 

 Cut - cuts data from selected cells to the clipboard. 

 Copy - copies data from the selected cells to the clipboard. 

 Paste - pastes data from the clipboard. 

Pencil - serves for splitting cells into several by building additional borders. 

 

 Select material... - This tool is designed to insert into a table, technical 
requirements and technical characteristics of a formatted line-record for material 
and assortment. Clicking on the button brings up the "Material" dialog box. 

 Auto calculate expressions - controls the mode of automatic recalculation of values 
of table cells. By default, the auto-recalculation mode is on. 

 Recalculate - serves to recalculate data in a table after editing cell values or 
correcting formulas. 

 Auto update reports - controls the mode of automatic recalculation of the report. 
The mode is on by default. 

 Reports - update of the report. 

 Synchronize - updates the table with data from a linked file. Available if the table 
was loaded from a file. For correct synchronization, the data changed in the file 
must be previously saved. 

View 

 Show rulers - switch, controls the display of the ruler. 

 

 Show expressions -switch manages the formula bar display. 

 

 Formula visualization - switch, controls the display of the formulas in cells. 
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 Zoom to objects  - centers the original report objects in the drawing. 

 View sorting - controls the display of the sort buttons of the view. 

Turned on Turned off 

  

 Calculator... - the command calls calculator. 

 Notebook... - the command calls notebook. 

Column 

 Add column - adds a new empty column after the selected column. 

 Insert column - adds a new empty column before the selected column. 

 Delete column - deletes the selected column. 

 Hidden - switch, hides the column. The column appears in the editor but does not 
appear in the drawing. 

 Properties... - open  properties of column. 

Row 

 Add row - adds a line below the selected one. 

 Delete row - deletes the selected row. 

 Hide row - hides the line. The line is not visible in both the editor and the drawing. 

 Show hidden rows - shows hidden lines. To use the command, you must select 
several lines between which hidden lines are located. 

 Sort ascending - sorts the table in ascending order relative to the selected column. 

 Sort descending - sorts the table in descending order relative to the selected 
column. 

 Custom sort... - opens a dialogue "Collections editor". 

 Merging and Grouping... - opens a dialogue "Row grouping and merging". 

 Start new page - switch, controls the page break before the selected line. 
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 Limit rows per page... - opens the "Rows per page" dialog, which indicates the 
maximum number of lines per page. If there are more lines, a page break is 
inserted. 

 

 Limit page height... - opens the "Page height" dialog in which the maximum page 
height is indicated. If the page height is greater than the specified height, a page 
break is inserted. 

 

 Single page - the command removes all created page breaks. 

 Up to down - switch, controls the data display sequence. 

 Properties... - opens string properties. 

Cell 

 Edit - puts the cell into edit mode. 

 Expression... - opens a dialogue "Expression builder". 

 Properties... - opens a dialogue "Cell properties". 

 Group - merges the selected cells. 

 Ungroup - corrodes the selected cells. 

 Split... - splits a cell into multiple rows and columns. When the command is called, 
the "Split" dialog appears. 
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 Cut - cuts data from the selected cells to the clipboard. 

 Copy - copies data from the selected cells to the clipboard. 

 Paste - pastes data from the clipboard. 

 Clear - clears the selected cells. 

 Insert table - pastes a range of cells copied from Excel. 

Section 

 Header of first page - adds a header for the first page. 

 Header of following pages - adds a header for pages. 

 Header of last page - add a header for the last page. 

 Insert Data section - inserts a data section. If the selected cell is in the data section, 
then an empty row is added. 

 Insert Report section - adds a report section. Used when building reports. 

 Footer of first page - adds a footer for the first page. 

 Footer of following pages - adds a footer for pages. 

 Footer of last page - add footer for the last page. 

Toolbar commands 

 Open - allows you to choose one of two commands: 

Open file- loads table data from a file. Files available for download: * .tbl, * .dat, * 
.mdb (only for 32-bit Windows) * .txt, * .csv, * .xml, * .xls, * .xlsx. When you select an 
Excel file, only the first sheet of the workbook is inserted. 

Load from base- opens a dialog of standard elements to select a table saved in the 
database. 

 Save - allows you to choose one of two commands: 

 Save to base- writing the table to the base of elements. 

 Save to file- writing a table to an external file * .dat, * .txt, * .cvs, * .xml, * .xls. 

 Import table from Excel - the command transfers the results of calculating 
tabular data from an open MS Excel workbook. The content of the active sheet or 
a selected range of cells is transferred. 

 Export table to Excel -the command is designed to transfer tabular data to MS 
Excel. After clicking the button, the "Conversion options" dialog opens. After 
specifying the options, a new Excel workbook is opened and all tabular data is 
transferred into it, while maintaining the cell formatting set in the table. 

 Update table from external source - updates the table with data from a linked 
file. Available if the table was loaded from a file. For correct synchronization, the 
data changed in the file must be previously saved. 
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 Pan and zoom view to show objects - centers the original report objects in the 
drawing. 

 Cut selection - cuts data from the selected cells. 

 Copy selection - copies data from the selected cells. 

 Paste from clipboard - pastes data from the clipboard. 

 Undo last change - undo the last action. 

 Redo last change - redo the previously undone action. 

 Move row down - moves the selected line down. 

 Move row up - moves the selected line up. 

 Move column left - moves the selected column to the left. 

 Move column right - moves the selected column to the right. 

 Page division -the tool is designed to split the table into separate parts, without 
losing integrity. With this function it is possible to split a large table in order to fit 
on the format, and still retain the ability to edit the table as a single object. 

 Open form - opens the table filter form. 

 Sort ascend - sorts the table in ascending order. 

 Sort descend - sorts the table in descending order. 

 Create summary function - sums the contents of the selected cells. 

 

Procedure: 

1. Select the cell in which you want to calculate the amount, press "Create summary 
function".  

2. Select the cells whose contents you want to summarize, press "Enter". 

 Open calculator - the command calls calculator. 

 Open notebook - the command calls  notebook. 

 Insert material - This tool is designed to insert into a table, technical 
requirements and technical characteristics of a formatted line-record for material 
and assortment. When you click on the button, a dialog box is called  "Material". 

 Special symbols - inserting a special character from the list. 

 Recalculate table - serves to recalculate data in a table after editing cell values 
or correcting formulas. 
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 Automatic calculation - controls the mode of automatic recalculation of values 
of table cells. By default, the auto-recalculation mode is on. 

 Update reports - update of the report. 

 Automatic report update - controls the mode of automatic recalculation of the 
report. The mode is on by default. 

 Group selection - serves to combine the selected table cells into one. 

 Ungroup selected cells - cancels the merge for the selected cells. 

 Change number of rows and columns - serves to change the number of rows and 
(or) columns in the selected range of cells. 

Procedure: 

1. Select one or more cells and call the command. 

2. In the "Split" dialog box that appears, enter the desired numeric values to stake. 

 

 Split table cell with pencil tool - serves for splitting cells into several by building 
additional borders. 

 

To split a cell with the mouse cursor, specify the start and end points of the segment 
that will divide each cell it crosses into two. 

Right-clicking on a cell border removes that border. 

 Select cell style - calls the window for applying the style to the selected cells. 

 Text alignment - serves to control the placement of text in selected cells. 
Additional buttons are available by pressing the black triangle. The purpose of the 
buttons is clear from the figure on each of them. 
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 Fitting text horizontally - controls the horizontal alignment of text in the cell. The 
following options are available in the drop-down list: 

No horizontal tolerance 

Shrink horizontally 

Word wrap 

 Fitting text vertically - controls the vertical alignment of text in the cell. The 
following options are available in the drop-down list: 

No vertical tolerance 

Shrink text height 

Expand row height 

Add virtual rows 

 Borders - is designed to control the display of the borders of the selected cells. 
When you click on the black triangle, additional buttons for displaying borders 
become available. The purpose of the buttons is clear from the figure on each of 
them. 

 

 Color of borders - drop-down list for choosing border colors. To set the border 

color, you must first select a color and then select the border (using the 
"Borders" command) to which you want to apply the specified parameters. 

 

 Lineweight of borders -drop-down list of border thickness selection. To set the 
border thickness, you must first select the thickness and then select the border 

(using the "Borders"command) to which you want to apply the specified 
parameters. 

 

 Text style - drop-down list for choosing the text style of the cell. 

 Text height - drop-down list for selecting the height of the cell text. 

 

 Text color - drop-down list for choosing the color of the cell text. 

 Text weight - drop-down list for choosing the thickness of the lines of the cell text. 
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 Selected cell coordinate field - displays the coordinates of the selected cell (s) and 
allows you to enter them. 

 

 Row expressions - formula input field. The line is displayed if the "Main menu - 
View - Show expressions" switch is active. 

 

Using gestures for shortcuts 

Gestures are designed for quick access to commands from the main menu of the table 
editor. Gestures made with pressed RMB in the table editor. 

Note: If when the prompt appears gesture command being executed, you can omit 
the RMB. 

Right - Calculator 

 

Left - Notebook 

 

Up - Expression 

 

Down - Cell properties 

 

Right hook - Return 
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Left hook - Cancel 

 

The closed area of the selected cells in a clockwise direction - Connection (merged cells 
pre-allocated) 

 

Result: 

 

The closed area of the selected cells counterclockwise - Disconnection 

 

Result: 

 

Symbol "z" on select cells - Clear (pre-clean cell is released) 
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Result: 

 

Editing the size of rows and columns 

To modify the row height or column width, move your mouse to the border of the row 
or column. Click the left mouse button and holding the button down drag the border. 
The move will be highlighted by the current value of the row height or column width, as 
well as its new size. 

Resize a row or column can also be done in the properties dialog box, selected by 
pressing the right mouse button on the header row or column. 

1. In the properties dialog box, specify the height (width) in millimeters. 

 

2. In the Properties dialog box of the column switch is available Hidden. With it, you 
can disable the display of the selected column in the drawing, however, the Editor 
will be displayed. 

 

You can also hide a column from the context menu for the column. 
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Command string Replace null values (for numeric cells with the value zero, the cell must 
be a numeric format), replaces the contents of the cells specified text. 

Important! 
Format text in a cell value is set in the properties of the cell on the 
tab Content . 

Close the dialog by clicking OK. 

Cell Properties 

In the dialog box Properties parameters are set for table cells. 

To edit the properties of a single cell in a table full editor, select the desired cell and 
issue Properties from the context menu or by pressing Ctrl + Enter, double click on the 
cell, as a gesture to "down" on the cell. The effect of this command is similar Cell 
Properties screen table editor. 

To edit multiple table cells in the full editor, select the desired cells and issue the 
Properties from the context menu. The effect of this command is the same action as 
Properties  screen editor table. 
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There are six tabs: 

 Flag Content. This tab specifies the type of data in a cell the user, set the 
formula for calculating values. In the properties of the cell can format values 
and enter the contents of a table cell. Checking unmodifiable disables the 
ability to edit the cell. Such a cell is highlighted in color. 
 
 

 - Opens the Expression Builder. 
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 - The tool is used to insert the nanoCAD block the cell. 

Select the list that appears in the desired unit from the current drawing file. If 
necessary, select another file using the menu View. 

 

After selecting a unit, it is displayed in the properties window of the cell, as well as in 
a table cell. 
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To disconnect the unit, press the Remove block in the block selection. 
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 Bookmark Font. This specifies the text font, color symbols, line thickness, font 
height, offset from the cell boundaries, the angle that defines the direction of 
the text, as well as the aspect ratio of the text.  
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Switch Vertical change text direction to vertical. 

Empty fields oblique Angle and horizontal scaling means that the values are taken 
from the text style and horizontal indent  - that the value is taken from the table 
settings. 

 Bookmark fit 
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This specifies the cell, cell as well as parameters of inscribing text into the cell. 

If the text width exceeds cell bounds 

 

If the text height exceed cell bounds: 
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Mode Occupy extra row does not change the number of rows in the table, the 
desired row is made higher by the required number of times and line. 

 Bookmark borders. Here you specify the type, color, thickness of the boundary 
line of the selected cell, you can manage the display of individual cell borders. 
Enable or disable the display of individual boundaries, you can use buttons  
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or in the preview by clicking the left mouse button near one of the cell 
borders. Alignment of text within a cell preview is set by clicking the left 
mouse button.  
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To set the color of individual borders, click the 
left mouse button on the icon 

 and select a color from 
the drop down list 

 

To determine the weight of the individual borders, click the left mouse button on 
the line (By layer) and choose the thickness of the drop-down list. 

 

Color, line thickness for the cell borders, and cell shading can be set from the 
menu.  
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To apply the changes in color and thickness, click on the desired boundary. 
Can also be selected by using the display boundaries.  

 

 Flag Comment. A field for entering a comment.  

 

Cell with the comment is displayed in the editor by a green label, which displays a 
hint when you hover the mouse on it.which is displayed a hint. 
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 Bookmark Styles. Here you can set the style for the cell. 

 

To create a style, right-click in the blank area of the Style tab, then on the shortcut 
menu, select Create. 

 

To work with a style template, open the context menu style. 
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Using styles 

Style assignment to table cells is performed by the command "Select cell style" in the 
toolbar of the table editor or tab "Fit" in dialogue "Cell properties". he choice of style is 
carried out in the graphics window. Also, styles can be created and edited using the 
context menu. 

Context menu 

 Apply - the command applies the selected style on the cell (group of cells). 

 Update - the command replaces the selected style with the style of the selected 
cell. 

 Rename - command allows you to rename the name of the style. The name of the 
style is generated automatically during creation. 

 Delete - command removes the selected style from the list. 

 Import - command imports style in * .mcd format. 

 Export - command exports the style in * .mcd format. 

 Create - command allows you to create a new style. 

Creation order: 

1. Set the cell style. 

2. Open the style window 

3. Select the "Create" context menu command. 

4. A new style will be created. The name of the style is generated automatically during 
creation. 
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Division by page 

Division by page. tool is designed to separate the table into separate parts, without 
losing its integrity. With this feature, you can split a large table in order to place a 
format, while preserving the ability to edit the table as a single object.  

 When the command a dialog box appears page division. 

 

 Switch single page disables table division.  

 Select the method of dividing the table:  

1. Custom- The table can divided into any parts.  

 

Page break before a row is set by start new  command from the context menu.  
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Close the dialog. The editor of the table indicate the boundaries of the gap, with 
the help of it, you can change the row height.  
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On the drawing table with a gap will be as follows:  
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Side of the split table can be moved in the drawing independently, double-
clicking on any part of the full table editor opens.  

 

2. By row count enter the desired number of rows in a fragment. Headers do not count. 

 

 By table height enter the total height of a fragment, in millimeters, using the current 
scal.  

 

Dividing the table into parts allows each part tobe moved independently: 

Conversion options 

The "Conversion options" dialog is a filter that influences the set of transmitted data. 
Appears when converting a report to data and when exporting a table to Excel. 



User Guide nanoCAD Mechanica 25 
 

357 

 

Converting a report to data 

Delete hidden rows and columns - affects the conversion of hidden strings. If enabled, 
hidden rows are not passed to the data. 

Table Turned on Turned off 

line 4 is hidden no hidden lines line 3 is hidden 

 

 

 

 

Note: The converted hidden lines remain hidden. 

Save report template - affects the conversion of report template strings to data. If 
enabled, strings are transferred. 
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Table Turned on Turned off 

 

 

 

Export to Excel 

Delete hidden rows and columns - the option does not affect the result, since hidden 
rows are not exported. 

Save report template - affects the export of report template strings. If enabled, strings 
are transferred. 

Table Turned on Turned off 

 

 

 

Using Variables 

Important! 
This function is available only in vertical applications based 
nanoCAD 
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Tables BuildIndustry support the use of additional variables defined in a special dialog 
(form). 

Procedure for creating a set of user-defined variables and their use in the table below: 

1. In full table editor from the menu Edit invoke the command Form Editor. 

2. Create a form with controls and bind each control to a field (variable). More 
information about the forms, see Form Editor . 

 

3. Close the form editor and save the form. 

 

4. To set the variable, call the command form. 

 

5. Open your form. Enter the desired values. Click OK. 

 

6. Linking table cells with custom variables by using formulas. 
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Cell value will be associated with the variable. 

 

Variables can also be used in complex formulations. 

Create reports 

Reports are necessary in order to organize the data of objects in the drawing. 

Recommended report structure: 

 Header of first page; 

 Header of following page; 

 Header of last page; 

 Report title; 

 Report template; 

 Report; 

 Report summary; 

 Footer of first page; 

 Footer of following page; 

 Footer of last page; 

Generating a report 

To create a report in the table editor, call the command from "Main menu - Section - 
Insert Report section". The command will create a subsection "Report template". 

Additional subsections are added using the "Report template" menu: "Report title", 
"Report Summary". 

Header and footer sections are added from "Main menu - Section". 
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Report template 

The report template defines the content and appearance of the report; it can consist of 
one or several lines. A separate copy of the report lines is created for each object. 
Formulas in the report are calculated using the properties of the selection objects. 

The following commands are available in the "Report template" menu (click on the 
subsection name): 

 "Object filter..." - opens the "Quick Selection" dialog for forming a selection of 

drawing objects. The command is duplicated by the "Select source objects" 
button on the right in the "Report template" section. 

 "Merging and Grouping..." - opens the "Row grouping and merging" dialog in 
which the parameters of grouping and merging table cells are configured. The 

command is duplicated by the "Group and merge" button on the right in the 
"Report template" section. 

 "Freeze report" - the switch controls the report refresh mode. If the checkbox is 
selected, the update is performed manually, and the "Update report" command 
becomes available. 

 "Update report" - refreshes the values of report objects, the command is available 
in manual refresh mode. 

 "Report header" - adds a "Report Title" subsection to the beginning of the report, 
displayed at the beginning of each part of the table. 

 "Append Data section" - adds a data section below the report. If the section 
already exists, an additional line is appended. 

 "Append Report section" - adds a new report below the current one. 

 "Remove Report" - deletes the report with all associated subsections. 

 "Rebuild" - completely rebuilds the report based on the report template. Data 
entered manually in the "Report" section will be overwritten. 
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 "Convert to Data section" - the command converts sections of the report to data. 
Blank lines are not converted. Calling the command opens the "Conversion 
options" dialog. 

 "Report footer" - Adds the "Report Summary" subsection to the end of the report, 
displayed after each part of the table. 

All related subsections of the report are visually combined with brackets. 

 

Important! The report template has absolute priority over custom changes. After the 
refresh, the report colored by the user will become the same as the 
specified report template. Automatic report lines corresponding to the 
collected objects will be automatically formatted strictly according to the 
report template. 

Report 

The "Report" displays the values of the template variables. 
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The report contains cells (with a lilac background) containing object data, marked with a 
special color. Selecting cells highlights the corresponding objects in the drawing. 

When editing such cells, the changes will be applied to the very object to which they 
refer. For instance: 

1. Take a Bolt GOST 7795-70 with a length of 50 mm and place a leader on it. 

 

2. Create table, report template and tie to bolt (parametric object). 
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3. Add parameters: Object.Name and Object.L.  

  

4. Enter the new length, for example 120. Close the table editor. 

5. The length of the bolt in the drawing has changed. 

 

Report title 

The following commands are available in the "Report Title" menu (click on the 
subsection name): 

 "Remove section" - deletes the "Report Title" section. 

Report summary 

The following commands are available in the "Report Summary" menu (click on the 
subsection name): 

 "Remove section" - deletes the "Report Summary" section. 
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In the context menu of the "Report Summary" cells, there are the following additional 
commands: "Sum", "Average", "Minimum", "Maximum", "Count". 

The commands insert into the selected cell corresponding to the name of the 
expression. The action is applied to a fragment of a column within one section. 

 

Report Template 

1. Call up the "Quick Selection" dialog box. Use the "Filter Objects..." command of the 

"Report Template" menu or the "Select Source Objects" button on the right in the 
"Report Template" section. 

2. Use the "Quick Selection" dialog to filter the objects and click the "OK" button. The 
selected objects will be associated with the report. 

 

3. Select a cell in the "Report Template" section. In the context menu of the cell, the 
parameters of the related objects will be available for insertion. 
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5. Select an option from the context menu. The "Report" subsection will be 
automatically created. The number of lines in the "Report" subsection corresponds to 
the product of the number of related objects and the number of template lines. 

The report template can consist of several lines. To add rows in the context menu of the 
"Report Template" row, use the "Add Row" or "Insert Row" commands. 



User Guide nanoCAD Mechanica 25 
 

367 

 

Rows in a report template can be combined. Changes will be displayed in the "Report" 
section. Let's consider a join using the example table below: 
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 Select cell A1:A2 and select the "Group" command from the context menu. The 
selected cells will be grouped. 
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 In the "Report template" menu (click on the subsection name), select the "Rebuild" 
command. The table will look like this: 



User Guide nanoCAD Mechanica 25 
 

370 

 

6. Fill in all the required cells of the "Report Template". 

7. The sample is formed. Close the table editor. Changing the parameters of objects in 
the drawing will change the values in the report. 

Grouping and merging cells 

Button Grouping and merging. Report template. 

In the Grouping and merging dialog you can specify settings for grouping and merging 
table cells. Grouping and merging are only applied to cells in the report template. 

 

Study the example for how to merge cells. 
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Merging 
1. In the Grouping and merging dialog box select Append rule and select Merge. 
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2. Select the column name for the cells you want to merge. Selection is made by 
double clicking on the column name or by dragging it into the Select field. 

 

Note: 
To select another column, you must drag it into the column list 
and then select it.You can select several columns then place them 
in the required order. 

The columns are processed according to the rules of the grouping remplate. 

3. If you want to sort, select and don't sortand sorting, and select sort type. 
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4. Click OK to check the result in the table editor. Cells having identical values in the D 
column will be merged. 
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Grouping 
1. In the dialog box groupings and click Add Rule select Group. 

 

2. Select the name of the column whose cells you want to group. Choice is either by 
double-clicking on the column name, or by dragging it into the Select . 
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3. If you want to sort, click on the link and sorting, and select the type of sort. 

4. Click OK to view the results in the table editor. Table rows that contain the same 
values ??in column C, will be grouped. 

 

Interface Expression Editor 

The Formula Editor (Expression Builder) allows you to set parameters, arithmetic 
expressions, and object property references for a selected table cell. 

The formula editor is invoked: 

 By clicking on the "fx" button in the formula bar; 

 By pressing Shift + F2; 

 Right-click upward; 

 From the context menu command "Expression ..". 

Dialog 

The dialog box consists of the "Expression Input Field", "Formula Templates", "List of 
Registered Functions", "Quick View Fields" and the "Attach object" button. 
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The "Attach Object" button allows you to attach to objects. 

At the top of the dialog there is an expression input field, with which you can manually 
enter any arithmetic expressions, as well as use reserved variables and object 
properties. 

When entering manually, a list of functions and variables containing the word being 
entered appears in the list of reserved functions; syntax is also checked. If the formula is 
incorrect, an error warning or hint will appear in the Quick View. 

 

In the quick view field, by clicking the mouse on an expression, the text in the input field 
related to this expression is selected. 
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When you click on the  button in the "Expression input field", the entered expression 
is saved on the formula templates panel for quick recall. Pressing the button again 
removes the expression from the formula template. 

 

The "Reserved Functions List" contains recently used expressions that are highlighted in 

yellow. When you click on the  button, expressions are saved in the Formula 
Templates panel for quick recall. Expressions that are in the Formula Template Bar in 

the Reserved Functions list will be marked with an asterisk. Pressing the  button again 
removes the expression from the formula template. 

When you hover the cursor over the button of the saved template, a tooltip will appear 
with the contents of this template. 
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In order to insert an expression from the "Formula template", place the cursor in the 
required position, press the button with the template. 

To delete an expression template, click the triangle button and uncheck the required 
template in the list that appears. 

Binding to a table cell 

In the formula, you can use any cell values of the properties of another object. If using 
automatic recalculation of the table, the formula object is automatically recalculated. 
Each cell can attach one or more objects. Objects are named Object1, Object2, and 
Object3, … sequentially numbered in the table. If the object is not used in a formula, it 
will detach from the table at the next calculation, and the object references are 
renumbered. 

Binding properties for drawing objects to a single cell then use the expression or the 
keys Shift+F2. Available in the context menu of the selected cell. 

 

After selecting the command window opens the Expression Builder. 
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Click Attach it. 

Select the object whose data you want to send to the table (eg, Bolt M52). Now the list 
of expressions appears in the properties of the selected object. Double-clicking on the 
property (select Object.Name), adds it to the text in a cell. Click OK. 

 

After connection of the facility to the cell the cell color changes (it says that the formula 
in the cell) and it will display the calculated result, in this case the name of the object: 
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Functions in the Formula Editor 

Mathematical operations: 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Involution 

sqrt() Rootsquaring 

  

Logical comparison and selection: 

== equally 

> more 

< less 

! not 

| or 

!= not equal 

>= not less 

<= no more 

|| or 

&& and 
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Functions: 

math: 

Cos, Sin, Tg - trigonometric functions, the argument given in degrees. 

Acos, Asin, Atg - inverse trigonometric functions, the result is given in degrees. 

Abs - absolute value of (module). 

Int - rounding to whole number. 

Summ - returns the sum of the values of the variables in a grouped cells. 

Note: When you type a function should pay attention to the opening and closing 
brackets. 

For example: 

Summ(Row) - returns the sum of the numbers of grouped rows.. 

Summ(Standartnaya_detal.L) - returns the sum of the values ??of the L parameter 
object "standard part" in the grouped rows. 

data conversion: 

Str - Data conversion to a string type. 

Num - conversion of data into a numeric type. 

Frm - convert a numeric value to a string formatted according to the settings of a table 
column. 

For example: 

Frm(0.001230) returns a string 0,0012, if the column containing the cell is set to zero 
suppression and accuracy of 0,0000 

selection and comparison: 

FmtText - Addition formatted strings. 

FmtSub - the creation of a subscript. 

FmtSuper - create superscript. 

FmtDigit - transfer number in hard copy. 

FmtRaw - text without formatting. 

DmtDiv - creation of fractions. 

If/Iff - The logical choice. Recording Format: 

if (Logich_Uslovie; Esli_Istina; Esli_Lozh) 

where: 

Logich_Uslovie - logical condition using logical comparisons (see above); 
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Esli_istina  - the return value when the logical condition; 

Esli_Lozh - return value at default logical condition. 

For example: 

if(object == Marker_universalny; Marker_universalny.position; "Undefined") . If an 
object type, which is connected with the cell column has Marker_universalny value, the 
function returns the position value of the referenced object. Another type of object it 
returns a string Undefined . 

Exist - Checks whether there is a constant: =IF(EXIST(Object.Name);Object.Name;0) 

Min/Max - returns the minimum / maximum value listed in parentheses 

For example: 

Min(maskimalnoe_znachenie; MinValue ) - nourishes MinValue; 

Max(maskimalnoe_znachenie; MinValue) - returns maskimalnoe_znachenie. 

Count - returns the number of objects (for grouped rows in the table). 

For example: 

Count() - returns the number of objects associated with cells grouped rows. 

Avg - Calculates the arithmetic mean of the arguments. Takes an arbitrary number of 
arguments understand ranges. Empty arguments are ignored. 

Off - returns the value of the cell, given the relative index. The index is written in the 
format: 

Off(string; column) 

For example: 

Off(-1;2) - returns the value of cell in the table on one line above (-1) and two columns 
to the right (2) of the current 

Cell - the cell returns the value specified absolute index. 

Merge (Cells,Expression) - brings together a range of Cells, if Expression is not equal to 
0. Returns the value of Expression. 

For example: 

=merge(A5:C5; "Title") – integrates cell A5 to C5, in the summary displays the text 
"Title". 

SetHeight() – reference line height. In brackets the height value. 

Val() - computes the value of the argument. 

For example: 

=val("A"+"1") - calculates the "A1", and then uses it as another expression (obtained by 
the value in cell A1). If the argument - not a string, then he comes back, ie =val(10+2) - 
the same thing =10+2. 
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=val("summ(A"+Str(off(0;-1))+":D"+Str(off(0;-1))+")") - the amount of cells from rows A 
to D, the number which is introduced into the cell to the left of the current one. In most 
cases you can do without val. The classic example, when without it - no way: in a custom 
form, enter the cell address, then to take the value out of it. Create a variable Addr, 
associate it with an input field on a form and in the table do so: = val (Addr) function 
allows recursion: = val (val ("A" + "1")) - to take the value of the cell whose address is 
recorded in cell A1. Nesting depth is limited to 64. 

Geometry(Object) - works as Implement object. Height embedded object shrinks to the 
line height. Object is taken from the report, or attached to the cell. 

SUMM(Section(-1)) - Sum of cells in the current column of the section next to the 
current. 

COUNT(Section(A3)) - The number of rows in the section containing the cell A3. 

Reserved variables: 

Pi - pi. 

Row - for each cell in the column it returns the number of rows (rows are numbered 
starting with 1, excluding the header lines). 

Col - for all cells in a column returns the column number of the table (column "A" is 
number 1). 

Object - returns the type of the object, which is associated with the cell line. 

Object1, Object2, … - objects attached to the cell. 

Title - the name of the table. 

RowCount - total number of rows. 

ColCount - the total number of columns. 

Split the table by pages 

The "Split the table by pages" tool is similar to the "Division by page" editor tool, but 
the result is not a split single table, but several separate tables. 

Procedure 

1. Open the table for editing. 
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2. In the places where the break will be, set the break with the command "Start new 
page". 
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3. Close the editor. 

4. Select a table. 

5. From the context menu, select the "Split table by pages" command. 

 

6. The table will be split into separate tables. The separation will occur at the places of 
the established breaks. 
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Note: If the command is applied to a report, the following destructive actions are 
performed: 

1. The report is converted into static tables. 

2. All connections with objects are broken. 

3. All formulas are removed, and the cells begin to display the previously 
formed text. 

4. Rows with report titles are hidden so that the display of the table in the 
drawing is not changed. 

Recalculation all tables in the drawing 

Command line:MCRECALCTABLES. 

The command recalculates data in all tables on the drawing. When recalculating, auto-
recalculation locks and report freezes are ignored. The "Reports" and "Recalculate" 
options are used during recalculation. 
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Procedure 

1. Call command "Recalculation all tables in the drawing". 

2. The recalculation will be carried out. 

Show object relations 

Command line: MCREFSHOW. 

The command visualizes relations between objects. 

Procedure 

1. Call command Show object relations. 

 

2.Specify the objects whose relationships you want to display. 



User Guide nanoCAD Mechanica 25 
 

389 

 

3. Press "Enter" to confirm your selection. The relations will be displayed. 
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Linked objects are framed with a frame. Objects are connected to each other with an 
arrow and a caption. The arrow can be two-sided if the link is bidirectional. The caption 
above the arrow contains an expression that is passed from one object to another. 
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An example of bidirectional relation. 

Dimensions 

Dimension Style Manager 

Main menu: Format -  Dimension Styles.... 

Main menu: Dimensions -  Dimension Styles.... 

Ribbon: Home - Annotation -  Dimension Style Manager. 

Toolbar: Settings - Dimension Style Manager. 

Command line: DIMSTYLE. 

The software defaults to a government industry standard dimension style. 

Dimension styles allow you to control the appearance of dimensions and quickly format 
them. 

 

Dialog box composition 

The inscription "Current style: ..." - information about the current dimension style, which 
is used when applying dimensions. 

"Styles" list - a list of all dimension styles in the document. 

The "Preview of: ..." window is a graphical representation of the style selected in the 
"Styles" list. 
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Buttons: 

 Set current – sets the selected dimension style current.   

 New... – opens a dialogue  "Creating style".  

 Modify... – change the parameters of the style selected in the list. Opens dialog 
"Modify dimension style".  

 Override... – change the parameters of the current dimension style. Opens dialog  
"Modify dimension style".  

 Compare... - compare two dimension styles, or view a list of all the properties of a 
style. The comparison results can be copied to the clipboard. Opens dialog  
"Comparing Dimension Styles".  

 Delete... – deletes the selected dimension style.   

Restoring the Dimension Style 

Command line: MCSETGOST, SETGOST. 

This command is necessary to create (restore) the standard dimensional style of the 
environment  nanoCAD Mechanica.  

Dimension style settings are stored within drawing files. If the file was not created in 
nanoCAD Mechanica, then it may not have the required dimension style for correct 
work in the nanoCAD Mechanica environment.  

Creating a dimension style 

Button "New..." in the dialog box  "Dimension style manager". 

The new style is based on the existing style. 

 

Dialog box composition 

Field "New Style Name" – style name. 

List "Start With" – the style on the basis of which the new one will be created. 

List "Use for" – a dimension sub-style is selected from the list (applicable only to certain 
types of dimensions). 

Button "OK" – opens a dialogue  "Modify dimension style". 
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Modify dimension style 

In the "Modify dimension style" dialog, properties for a new style are set and 
parameters of an existing one are edited. 

This dialog is called when you click the "Modify..." or "Override..." buttons from the 
"Dimension Style Manager", as well as from the "Creating style" window. 

The name of the edited style is reflected in the title of the dialog. 

 

Dialog "Modify dimension style" contains tabs: 

 Lines 

 Symbols and arrows 

 Text 

 Fit 

 Primary units 

 Alternate units 

 Tolerances 

The model image on each tab shows a preliminary result of the property changes. 
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Tab Lines 

Sets the format and properties of dimension lines, extension lines, arrows, and center 
marks. 

 

Simension lines 

Color – setting the color of dimension lines. 

Linetype – setting the dimension line type. 

Lineweight – setting weights for dimension lines. 

Extend deyond ticks – when using serifs as dimension arrows, setting the distance the 
dimension line should extend beyond the extension lines. 

Baseline spacing - setting the distance between dimension lines in dimensions from a 
common base. 

Suppress – sets the suppression of the display of dimension lines if they go beyond the 
extension lines. 

 Dim line 1 – suppress the first dimension line. 

 Dim line 2 – suppress the second dimension line. 

Extension lines 

Color - setting the color of the extension lines. 
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Linetype ext line 1 – setting the type of the first extension line. 

Linetype ext line 2 – setting the type of the second extension line. 

Lineweight – setting weights for extension lines. 

Suppress – set to suppress extension lines: 

 Ext line 1 – suppress the first extension line. 

 Ext line 2 – suppress the second extension line. 

Extend beyond dim lines – setting the distance that extension lines should protrude 
beyond the dimension line. 

Offset from origin – sets the distance by which extension lines deviate from object 
points. 

Fixed length extenson lines - sets the full length of the extension lines from the 
dimension line to the origin of the dimension. 

Tab Symbols and arrows 

Sets the format and position of arrows, center marks, arc length symbols, and radius 
dimension polylines. 

 

Arrowheads 

Controls the appearance of dimension arrows. 
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First – selection of the arrow type for the first dimension line. When you change the 
type of the first arrow, the type of the second is automatically changed. 

Second – selection of the arrow type for the second dimension line. 

Leader – setting the arrow type for the leader. 

Arrow size – displaying the existing one and setting a new size for the arrows. 

Center marks 

Controls the placement of center marks and centerlines when placing a diameter or 
radius. 

None - do not create center mark and centerlines. 

Mark - create a center mark. 

Line - create centerlines. 

Size - displays an existing one and sets a new size for the center mark or centerline. 

Arc length symbol 

Controls the display of the arc symbol in the arc length dimension. 

Preceding dimension text - inserts arc length characters before dimension text. 

Above dimension text - inserts arc length characters above dimension text. 

None - prohibiting the display of arc length symbols. 

Radius dimension jog 

Controls the display of broken lines (zigzags) of radius dimensions, in cases where the 
center is located outside the page.   

Jog angle - sets the angle of the perpendicular line connecting the extension and 
dimension lines of the radius dimension. 

Tab Text 

Setting the format, placement and alignment of dimension texts. 
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Text appearance 

Text style – selects the current dimension text style from the list. 

Text color – setting the color of the dimension text. 

Fill color – setting the background color of the text in dimensions. 

Text height - sets the current height of the dimension text. If the text style specifies a 
fixed height (that is, the style's height value is not 0), then the height entered here is 
ignored. 

Fraction height scale – setting the scale of fractional values relative to the rest of the 
text. This option is available if the "Unit format" is set to "Fractional" on the "Primary 
units" tab. The height of fractional texts is determined by multiplying the height of the 
regular text by a given factor. 

Draw frame around text – sets the display of dimension text in a frame. 

Text placement 

Vertical – select the option to align the dimension text vertically relative to the 
dimension line: 

 Centered - centered dimension text between extension lines. 
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 Above - positioning the dimension text above the dimension line. The distance from 
the dimension line to the bottom border of the text is equal to the value specified 
in the "Offset from dim line" option. 

 Outdise - positioning the dimension text next to the dimension line on the side 
farthest from the first fit point. 

 JIS - placement of dimension text in accordance with the requirements of Japanese 
industrial standards JIS (Japanese Industrial Standards). 

 Below - the location of the dimension text below the dimension line. The distance 
from the dimension line to the top border of the text is equal to the value 
specified in the "Offset from dim line" option. 

Horizontal – select an option to position the dimension text horizontally along the 
dimension line relative to the extension lines: 

 Centered - centered dimension text between extension lines along the dimension 
line. 

 At Ext Line 1 - the location of the text to the left of the first extension line. The 
distance from the extension line to the text is equal to the sum of twice the 
dimension arrow ("Symbols and arrows" tab) and the text gap (the "Offset from dim line" 
option). 

 At Ext Line 2 - the distance from the extension line to the text is equal to the sum of 
twice the dimension arrow ("Symbols and arrows" tab) and the text gap (the "Offset 

from dim line" option). 

 Over Ext Line 1 - positioning text above or along the first extension line. 

 Over Ext Line 2 - positioning text above or along the second extension line. 

Offset from dim line – setting the size of the current text gap (the width of the empty 
space around the text located at the break in the dimension line). This value is also used 
as the minimum length of the broken dimension line fragments. 

The text is located between the extension lines only if the lengths of these fragments 
are not less than the size of the text gap. If text is above or below the dimension line, it 
will only fit between the extension lines if there is enough space for the dimension 
arrows and dimension text to be spaced apart by the text gap. 

Text alignment 

 Sets the orientation of the dimension text between and outside dimension lines. 

Horizontal – place text horizontally. 

Aligned with dimension line – place text along the dimension line. 

ISO standart - place along the dimension line if the text is inside the extension lines, or 
horizontally if the text is outside. 
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Tab Fit 

Controls the position of dimension text, arrows, leaders, and dimension lines. 

 

Fit options 

Set the layout of text and arrows if there is not enough space between the extension 
lines to place them together: 

Either text or arrows (best fit) - move either the text or arrows outside the dimension 
lines, whichever is the best location. 

Arrows - move outside the extension lines, first arrows, then text. 

Text - move outside the extension lines, first the text, then the arrows. 

Both text and arrows - if there is not enough space, then both text and arrows are 
located outside the extension lines. 

Always keep text between ext lines – always place text between extension lines. 

Suppress arrows if they don't inside extension lines - if there is not enough space for 
arrows between the extension lines, they are not displayed. 

Text placement 

Selecting an action when the dimension text is moved from the default position 
(specified by the dimension style): 
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Beside the dimension line – the dimension line moves with the text. 

Over dimension line, with leader – dimension lines do not move, but a leader is drawn 
that connects them and the text. The leader is not drawn if the text is too close to the 
dimension line. 

Over dimension line, without leader – no connections are made between the text and 
the dimension line. 

Scale dimension feature 

Use overall scale of – setting the scale factor for all dimension style parameters that 
specify dimensions, distances and indents, including the height of the text and the size 
of the arrows. 

Scale dimensions to layout - sets a scale factor based on the ratio of units in the current 
model space viewport and paper space. 

Fine tuning 

Place text manually – places the dimension at the point specified when prompted for 
Dimension line position. All horizontal placement modes are ignored. 

Draw dim line between ext lines – draw dimension line between extension lines, even if 
dimension arrows are positioned outside of them. 

Tab Primary units 

Sets the format and precision of base units, and dimension text prefixes and suffixes. 
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Linear dimensions 

Unit format - controls the display and format of tolerances in dimension text. 

Precision – setting the number of decimal places in the dimension text. 

Fraction format – setting format for fractional texts. 

Decimal separator – selection of separator type for sizes expressed in decimal units. 

Round off – setting rounding rules for all types of dimensions, except for angular 
dimensions. Example: for a given accuracy of 0.25, all measured distances are rounded 
to the nearest multiple of 0.25. When you enter a value of 1.0, all measured distances 
are rounded to the nearest whole value. The number of digits in fractional parts of 
distances depends on the precision specified in the "Precision" field. 

Prefix – defining the dimension text prefix. You can enter special characters or use 
control codes to display special characters. For example, the control code "%% c" 
matches the diameter character. An explicit prefix takes precedence over default 
prefixes such as those used for diameter and radius. 

Suffix – definition of a dimension text suffix. You can enter special characters or use 
control codes to display special characters. For example, typing the suffix mm will add it 
to the dimension text. The suffix entered here takes precedence over the default 
suffixes. 

Measurement scale 
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Scale factor – setting the scale factor for linear dimensions. It is recommended not to 
change the default value of 1.00. The factor has no effect on angular dimensions, 
rounding accuracy, positive and negative tolerances. 

Apply to layout dimension only – applies a scale factor only to dimensions plotted in 
layout viewports. It is recommended to disable the setting.  

Important! Changing the value of the scale of the dimensions of a style in a 
customization changes the value in the dimensions of the same style that 
are already assigned. This bug is unrecoverable for technical reasons. 

Zero suppression - Controls the suppression of leading and trailing zeros, as well as feet 
and inches zero. 

 Leading – suppress leading zeros in all decimal sizes. Example: 0.3000 is written as 
.3000. 

 Trailing – suppress trailing zeros in all decimal sizes. Example: 11.5000 is 
represented as 11.5 and 30.0000 is represented as 30. 

Angular dimensions 

Sets the current corner format for angular dimensions. 

Units format – selection of units of measure for angular dimensions. 

Precision – setting the number of decimal places in angular dimensions. 

Zero suppression - control of suppression of leading and trailing zeros. 

 Leading – suppress leading zeros in all decimal sizes. Example: 0.3000 is written as 
.3000. 

 Trailing – suppress trailing zeros in all decimal sizes. Example: 11.5000 is 
represented as 11.5 and 30.0000 is represented as 30. 

Tab Alternate units 

Setting the format and precision for alternative dimension units. 
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Display alternate units – inclusion of the possibility of using alternative dimensional 
units. 

Alternate units 

Unit format - setting the format of alternative units. 

Precision – setting the number of decimal places after the decimal point. 

Multiplier for all units - setting the conversion factor from basic units to alternative 
ones. Example: To convert inches to millimeters, enter 25.4. The value has no effect on 
angular dimensions and does not apply to rounding precision or positive and negative 
tolerances. 

Round distances to – sets the rounding rule for all types of dimensions, except for 
angular dimensions. Example: when setting the accuracy to 0.25, all measured distances 
are rounded to the nearest multiple of 0.25. When you enter a value of 1.0, all 
measured distances are rounded to the nearest whole value. The number of digits in 
fractional parts of distances depends on the precision specified in the "Precision" field. 

Prefix – defining the prefix of the alternate dimension text. You can enter special 
characters or use control codes to display special characters. For example, the control 
code "%% c" matches the diameter character. An explicit prefix takes precedence over 
default prefixes such as those used for diameter and radius. 
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Suffix – defining the suffix of the alternate dimension text. You can enter special 
characters or use control codes to display special characters. For example, entering the 
suffix mm will add it to the text. The suffix entered here takes precedence over the 
default suffixes. 

Zero suppression 

Controls the suppression of leading and trailing zeros and feet and inches zero. 

Leading – suppress leading zeros in all decimal sizes. Example: 0.3000 is written as 
.3000. 

Trailing – suppress trailing zeros in all decimal sizes. Example: 11.5000 is represented as 
11.5 and 30.0000 is represented as 30. 

Placement 

Sets the position of alternate units in dimension text. 

After primary value – display the value in alternate units immediately following the 
value in base units. 

Below primary value - display the value in alternate units below the value in base units. 

Tab Tolerances 

Controls the display and format of tolerances in dimension text. 
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Tolerance format 

Method – choice of method for determining tolerances. 

None- disable display of tolerances. 

Symmetrical – application of two limit deviations, with which the dimension text is displayed with the same upper and lower limit deviations. 
The tolerance is separated from the dimension by the "±" symbol. The value is entered in the "Upper value" field.  

Deviation – application of two limiting deviations. Dimension text is displayed with different upper and lower tolerance limits. When applying 
a dimension, a plus sign is put in front of the upper limit deviation and a minus sign in front of the lower one.   

Limits – displays dimension text as limit dimensions. The maximum size limit is above the minimum size limit. The largest limit is obtained by 
adding the upper limit deviation to the nominal size; the smallest - by subtracting the lower limit deviation from the nominal size.  

Basic – displays the dimension text as a nominal boxed dimension. 

Precission - setting the number of decimal places after the decimal point. 

Upper value - setting the value of the upper limit deviation. When the "Symmetrical" 
method is turned on, both deviations are assigned this value. 

Lower value - setting the value of the lower limit deviation. 

Scaling for height - setting the current text height for deviations. 

Vertical position - alignment of deviation texts: 

 Bottom - alignment of deviation and nominal size on the bottom.  

 Middle - aligning deviation and nominal size to the middle of the dimension text. 

 

 Top - alignment of deviation and nominal size at the top.  

Zero suppression - control of suppression of leading and trailing zeros. 

 Leading – suppress leading zeros in all decimal sizes. Example: 0.3000 is written as 
.3000. 

 Trailing – suppress trailing zeros in all decimal sizes. Example: 11.5000 is 
represented as 11.5 and 30.0000 is represented as 30. 

Alternate units tolerance 

Alternative unit tolerance formatting. 
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Precision - setting the number of decimal places after the decimal point. 

Zero suppression - control of suppression of leading and trailing zeros. 

 Leading – suppress leading zeros in all decimal sizes. Example: 0.3000 is written as 
.3000. 

 Trailing – suppress trailing zeros in all decimal sizes. Example: 11.5000 is 
represented as 11.5 and 30.0000 is represented as 30. 

Comparing Dimension Styles 

The dialog for comparing two dimension styles or viewing a list of all style properties is 
invoked by the "Compare..." button in the "Dimension Style Manager" dialog. 

 

"Compare:" field - selects the first dimension style to compare. 

"With:" field - selects the second dimension style for comparison. 

"Difference table" - the table contains data on non-matching properties. 

Table columns: 

 Description  - parameter name. 

 Variable - parameter system name. 

 Variable value columns - parameter values in compared styles. 

Button "Copy to clipboard" - allows you to copy comparison results to the clipboard. 
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Auto 

Main menu: Dimensions > Auto. 

Ribbon: Annotate - Dimensions > Auto. 

Ribbon: Mechanical - Symbols > Dimensions. 

Toolbar: Dimensions > Dimensions. 

Command line: MCMDIM, MDIM. 

When inserting dimensions, context menu commands are available to switch the 
dimension view: 

 Auto   

 Aligned 

 Horizontal 

 Vertical 

 Radius 

 Diameter 

 Large arc radius 

 Arc 

 Ordinate 

 Angle 

 Chain 

 Base 

 Properties (Opens the size edit dialog) 

 Group 

Note: If you hold down the CTRL key while placing linear dimensions at the time you 
select the dimension line, you can skew the dimension extension lines. 

If you hold down the SHIFT key while placing linear or angular dimensions while 
selecting the position of the dimension line, you can move the dimension text 
along the dimension line. 

Linear dimensioning 

To apply the dimension you need: 

1. Select a segment; 
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2. Place the dimension number. 

Dimensions can change to horizontal, vertical, or parallel, depending on the position of 
the drop point. 

Dimensioning by selecting characteristic (anchor) points 

 

To apply dimensions, you must: 

1. Select the first node; 

2. Select the second node; 

3. Place the dimension number. 

When selecting anchor points of the circle, the diameter sign is automatically set. 

Dimensioning between two parallel lines 

 

To apply the dimensions shown above, you must: 

1. Select the first segment; 

2. Select the second segment; 

3. Place the dimension number. 
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Dimensioning through a point perpendicular to the selected line 

 

To apply the dimensions shown above, you must: 

1. Specify the segment, perpendicular to which the dimension will be applied; 

2. Without interrupting the commands, point to the end point of the line segment (a 
circle of small diameter should appear around the point); 

3. Place the dimension number. 

Undo an erroneously inserted dimension without exiting the 
command 

Dimensioning is performed in a cyclic mode, i.e. when applying one dimension, the team 
does not stop its work, but suggests setting the next dimension or choosing a different 
type of dimension. In some cases, the previous dimension may not be set correctly. To 
remove an erroneous dimension, there is the "Undo" context menu command. You can 
also call the command with the "Ctrl + Z" hotkeys. The command is available when 
setting the dimension after specifying the dimension number. 

Auxiliary markers 

Auxiliary autodimension markers appear when you hover over a drawing object and 
show what type of dimension will be built in this case: 

  Indicates that the diametral dimension will be drawn. 

  Shows what a linear dimension will be drawn (horizontal, vertical or parallel). 

  Shows that the angular dimension will be drawn. 

  Shows that the chain of dimensions will be built. 

  Shows that the slanted dimension will be drawn. 

  Indicates that the radial dimension will be drawn. 
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Linear dimensions 

Aligned dimension 

Main menu: Dimensions > Aligned. 

Ribbon: Annotate - Dimensions > Aligned. 

Toolbar: Dimensions > Aligned. 

Context menu: aLigned - when calling any dimension. 

Command line: MCMDIMALI, MDIMALI. 

Horizontal dimension 

Context menu: Horizontal - when calling any dimension. 

Command line: MCMDIMHOR, MDIMHOR. 

Vertical dimension 

Context menu: Vertical - when calling any dimension. 

Command line: MCMDIMVER, MDIMVER. 

Parallel, horizontal, vertical dimensions 

To apply dimensions, you must: 

1. Choose dimension; 

2. Select the type of binding: 

 "nEarest snap gets object" - dimensions the entire selected object; 

 "nEarest snap gets point" (default) - sets dimension nodes at a selected location on 
an object. 

3. Specify the end nodes of the dimension based on the selected snap type: 

 "nEarest snap gets object" - specify an object, the end nodes of the dimension will 
be the end points of the object; 

 "nEarest snap gets point" - specify the start and end nodes on the selected object. 

4. Place the dimension number. The dimension will be built. 

Auxiliary markers 

Construction markers appear when you select a certain linear dimension: 
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  Parallel dimension is selected. 

  Horizontal dimension is selected. 

  Vertical dimension is selected. 

Linear dimension 

Main menu: Dimensions > Linear. 

Ribbon: Annotate - Dimensions > Linear. 

Toolbar: Dimensions > Linear. 

Command line: DIMLINEAR. 

Linear dimensioning 

To apply dimensions, you must: 

1. Call the "Linear" command; 

2. Specify the first node; 

3. Indicate the second node; 

4. Place the dimension number. Linear dimension will be created. 

Radius 

Main menu: Dimensions > Radius. 

Ribbon: Annotate - Dimensions > Radius. 

Ribbon: Mechanical - Symbols > Radius. 

Toolbar: Dimensions > Radius . 

Context menu: Radial - when calling any dimension. 

Command line: MCMDIMRAD, MDIMRAD. 
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Procedure 

 

To apply a radial dimension, you must: 

1. Select the "Radius" dimension; 

2. Select an arc (circle), the dimension will snap to the arc; 

3. Specify the insertion point. 

Diameter 

Main menu: Dimensions > Diameter. 

Ribbon: Annotate - Dimensions > Diameter. 

Ribbon: Mechanical - Symbols > Diameter. 

Toolbar: Dimensions > Diameter. 

Context menu: Diametral - when calling any dimension. 

Command line: MCMDIMDIA, MDIMDIA. 

Procedure 

 

To apply the dimension of the circle, you must: 

1. Select the dimension "Diameter"; 

2. Select the circle, the dimension snaps to the circle; 
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3. Pick an insertion point. 

Large arc radius 

Main menu: Dimensions > Large arc radius. 

Ribbon: Annotate - Dimensions > Large arc radius. 

Ribbon: Mechanical - Symbols > Large arc radius. 

Toolbar: Dimensions > Large arc radius. 

Context menu: big RAdius - when calling any dimension. 

Command line: MCDIMHRAD, DIMHRAD. 

Procedure 

 

To dimension a large arc radius, you need to: 

1. Select the "Large arc radius" dimension; 

2. Select an arc (circle), the dimension will snap to the arc; 

3. Specify the insertion point of the arrow; 

4. Specify the insertion point of the value on the arrow. 

Arc length dimension 

Main menu: Dimensions > Arc. 

Ribbon: Annotate - Dimensions > Arc length. 
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Ribbon: Mechanical - Symbols > Arc length dimension. 

Toolbar: Dimensions > Arc length. 

Context menu: arC - when calling any dimension. 

Command line: MCMDIMARC, MDIMARC. 

Procedure 

Arc dimension 

 

To apply the dimension you need: 

1. Select the arc dimension; 

2. Select an arc (the arc dimension will snap to the arc); 

3. Specify the insertion point. 

Circle dimension 
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To apply the dimension you need: 

1. Select the arc dimension; 

2. Specify the starting point on the circle; 

3. Specify the end point on the circle; 

4. Specify the insertion point. 

Ordinate dimension 

Main menu: Dimensions > Ordinate dimension. 

Ribbon: Annotate - Dimensions > Ordinate. 

Ribbon: Mechanical - Symbols > Ordinate dimension. 

Toolbar: Dimensions > Ordinate dimension. 

Context menu: Ordinate - when calling any dimension. 

Command line: MCMDIMORD, MDIMORD. 

 

Procedure 

1. Call the "Ordinate dimension" command. 

2. Pick the location of the first dimension of the ordinate chain. 
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3. Select the first dimension you set. All subsequent dimensions will be snapped to it. If 
for some reason dimensioning has been completed (after the first dimension has been 
added), select the ordinate dimension (or autosize) again and specify the dimensioned. 

 

4. Sequentially specify the coordinates of the remaining dimensions. 

 

5. Press the "Esc" key to end the command. 

Angle dimension 

Main menu: Dimensions > Fill angle. 

Ribbon: Annotate - Dimensions - Angular. 

Ribbon: Mechanical - Symbols > Angle dimension. 

Toolbar: Dimensions > Angle dimension. 

Toolbar: MCS Dimensions> Angle dimension. 

Context menu: aNguLar - when calling any dimension. 
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Command line: MCMDIMANG, MDIMANG. 

Procedure 

Create an angular dimension by specifying two line segments 

 

To apply an angular dimension, you must: 

1. Select an angular dimension; 

2. Select the first segment; 

3. Select the second segment; 

4. Pick an insertion point. 

Angular dimension of hole centers 

 

To apply the angular dimension with the indication of the centers, you must: 

1. Select an angular dimension; 
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2. Specify the center of the axial circle (on which the holes lie); 

3. Pick the center of the first hole; 

4. Pick the center of the second hole; 

5. Pick an insertion point. 

Dimensions Chain 

Main menu: Dimensions > Dimensions Chain. 

Ribbon: Annotate - Dimensions > Continue dimension. 

Ribbon: Mechanical - Symbols > Continue dimension. 

Toolbar: Dimensions > Dimensions Chain. 

Command line: MCCHAINCONT, CHAINCONT. 

A chain of dimensions is a sequence of dimensions counted from the end of the 
previous dimension (the beginning of each new dimension coincides with the end of the 
previous one). 

Dimension chains can be linear, ordinate, or angular. Before building the base 
dimensions, at least one linear, ordinate or angular dimension must be applied to the 
object. 

Procedure 

Ordinate chain of dimensions 

Note: Constructing an ordinate chain of dimensions is similar to constructing ordinate 
dimensions. 

1. Call the command; 

2. Select the set ordinate dimension (the dimension from which the ordinate sizes will 
begin to form); 

3. Construct the ordinate dimensions in sequence; 

4. Press the "Enter" key to complete the construction. 

Linear dimension chain 

1. Call the command; 

2. Select the set linear dimension (the dimension from which the chain of dimensions 
will begin to form); 
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3. Specify the required number of anchor points; 

 

4. Press the "Enter" key to complete the construction. 



User Guide nanoCAD Mechanica 25 
 

420 

 

Angle chain dimensions 

1. Call the command; 

2. Select the preset angular dimension (the dimension from which the chain of 
dimensions will begin to form); 

 

3. Specify the required number of anchor points; 
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4. Press the "Enter" key to complete the construction. 

 

Baseline dimension 

Main menu: Dimensions > Base dimension. 

Ribbon: Annotate -Dimensions > Baseline dimension. 
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Ribbon: Mechanical - Symbols > Baseline dimension. 

Toolbar: Dimensions > Base dimension. 

Context menu: Base - when calling any dimension. 

Command line: MCCHAINBASE, CHAINBASE. 

Base dimensions are a sequence of dimensions measured from one base point. 

Base dimensions can be linear, ordinate, or angular. Before building the base 
dimensions, at least one linear, ordinate or angular dimension must be applied to the 
object. 

Procedure 

Ordinate chain of dimensions 

Note: The construction of an ordinate chain of dimensions is similar to construction  
ordinate dimension. 

1. Call the command; 

2. Select the set ordinate dimension (the dimension from which the ordinate sizes will 
begin to form); 

3. Construct the ordinate dimensions in sequence; 

4. Press the "Enter" key to complete the construction. 

Linear base dimensions 

1. Call the command; 

2. Select the set dimension as the base (the dimension from which the base sizes will 
begin to form); 
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3. Specify the required number of anchor points. 

 

4. Press the "Enter" key to complete the construction. 
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Note: Each new dimension is set at a specified distance from the previous one. The 
value of the offset of the dimensions is set by the "Step" parameter in the base 
dimensions in the "Lines" tab of the "Modify dimension style" dialog. 

Corner base dimensions 

1. Call the command; 

2. Select the preset angular dimension (the dimension from which the base dimensions 
will begin to form); 



User Guide nanoCAD Mechanica 25 
 

425 

 

3. Specify the required number of anchor points; 

 

4. Press the "Enter" key to complete the construction. 
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Group dimension 

Main menu: Dimensions > Group dimension. 

Ribbon: Annotate - Dimensions > Group dimension. 

Ribbon: Mechanical - Symbols > Group dimension. 

Toolbar: Dimensions > Group dimension. 

Context menu: Grouped - when calling any dimension. 

Command line: MCDIMGROUP, DIMGROUP. 

Procedure 

 

1. Call the command; 
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2. Select all the objects that will participate in creating the group dimension. To 
complete the selection press the "Enter" key; 

3. Specify the location of the chain of dimensions. 

If the setting "Arrows in chains" is set to "Point", then when dimensioning a chain of 
small numerical dimensions, intersecting arrows are automatically replaced by dots. 

 

Offset dimension 

Main menu: Dimensions > Offset dimension. 

Ribbon: Mechanical - Symbols > Offset dimension. 

Toolbar: MCS Dimensions> Offset dimension. 

Command line: MCDIMOFFSET, DIMOFFSET. 

The command allows you to build a size similar to the contour of the selected object. 
Similarity size is indicated by an arc above the value. 

Procedure 

1. Call the command  "Offset dimension". 

2. Select the method for specifying the object: "sElection" or "frEe". The "sElection" 
method is used in paper space when you need to dimension an object in an inactive 
viewport. In all other cases, the "frEe" method is used. 

3. Specify the object from which the dimension will be built. The selected object can be 
specified: line, arc, spline, polyline, circle or ellipse. 
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4. Specify the first insertion point (starting point of origin of the dimension) or press the 
"Space" (or RMB) to automatically add endpoints to the entire length of the object (does 
not work for closed objects). 

 

5. Specify the second insertion point (end point of origin of the dimension), if you have 
not pressed the "Space" (or RMB) key. 

 

6. Place the dimension leader in the drawing. 
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7. Offset dimension will be built. The command will continue to work in a cyclic mode. 
Press the "Esc" key to exit cyclic mode. 

Grips 

1. Dimension value placement grip. 

2. Extension line position grips. 

3. Dimension endpoint grips. 

 

Edit dimension 

LMB double click on the dimension. 

Context menu: Properties - when calling any dimension. 

Context menu: Edit - at the selected dimension. 

Command line: MCFEDIT, FEDIT. 

The dialog box looks like this: 
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The window is divided into an area of text input fields with the name of the dimension 
type and a set of dimension design commands. 

Additional auxiliary commands are available in the context menu of the dialog box text 
fields: 

 History - the list contains the values previously entered in this field; 

 Recent - the list contains frequently used values when filling in this type of field; 

 Insert division- allows you to insert a division; 

 Pick from drawing - allows you to copy values from drawing objects; 

 Symbols - allows you to insert symbols from a list or from a symbol table; 

 etc. 

The presence of this or that command in the context menu depends on the purpose of 
the field. 

The button in front of the dimension value input field allows you to add special 
characters to the dimension text. 

 

Buttons "First arrow" and "Second arrow" allow you to select the type of arrows. 
When you click on them, a list with images of arrow options appears. 

 

Button "Test on leader" - toggles the display mode of the text on the leader. 

Button "Text in rectangle"- toggles the display mode of dimension text in a rectangle. 

Button "Dimension value display scale"- provides a list of display scales for 
the size value. Default  1:1. 

Button "Calculate value" - calls the calculator to calculate the value. 
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Button "Text style" - calls the text settings dialog box.   

 

Button "Match properties"- allows you to copy properties from an existing dimension 
in the drawing. 

Buttons selection of brackets  - allow you to set the dimension value in brackets. 

Button "Method of recording tolerances" - provides a list of options for displaying 
tolerances. 

 

Button "Fit table" - provides the ability to customize tolerance. 
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Button "Technical conditions". Connects technical conditions and dimension. 

Break and Restore dimension line 

Break dimension line 

Main menu: Dimensions > Break dimension. 

Main menu: Mechanical - Utilities - Breaks > Break dimension line. 

Ribbon: Annotate - Dimensions - Break dimension line. 

Ribbon: Mechanical - Utilities > Break dimension line. 

Toolbar: Dimensions > Break dimension line. 

Toolbar: MCS Breaks> Break dimension line. 

Command line: MCDIMBREAK, DIMBREAK. 

To create a dimension line break, you must: 

 Call the command; 

 Select the dimension. If the size was selected before calling the command, you do 
not need to select it again; 

 Select two points by specifying a section of the dimension line to create a break; 

 The break will be made. 
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First point selection 

 

Second point selection 

 

Result 

Restore dimension line 

Main menu: Dimensions > Restore dimension. 

Main menu: Mechanical - Utilities - Breaks > Unbreak dimension line. 

Ribbon: Unnotate - Dimensions > Unbreak dimension line. 
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Ribbon: Mechanical - Utilities > Unbreak dimension line. 

Toolbar: Dimensions > Unbreak dimension line. 

Toolbar: MCS Breaks> Unbreak dimension line. 

Command line: MCDIMUNBREAK, DIMUNBREAK. 

To restore the dimension line, you must: 

 Call the command; 

 Select the dimension. If the size was selected before calling the command, you do 
not need to select it again;; 

 The restoration will be done. 

Oblique dimension 

Main menu: . 

Ribbon: . 

Command line: MCDIMOBLIQUE, DIMOBLIQUE. 

The command allows you to skew the dimension. 

Procedure 

1. Call the command "Oblique Dimension". 

2. Select the required dimensions. Press the "Enter" key to complete the selection. 

3. Enter the angle of inclination and press the "Enter" key. 

4. The selected dimensions will change the angle of inclination. 

Arrange dimensions 

Toolbar:  "MCS Dimensions"> Arrange dimensions. 

Command line: MCDIMARRANGE. 

Procedure 

To arrange, you need: 

1. Call the command; 
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2. Indicate the dimensions to be aligned; 

 

3. Confirm the selection with the "Enter" key; 

4. Pick a new location for the dimension group. 
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Fit list 

Toolbar: MCS Dimensions> Fit list. 

Command line: MCFITLIST. 

The command is designed to create an automatically updated table by dimensions in the 
drawing. 

Procedure 

1. Call the command; 

2. Indicate the position of the table of maximum deviations in the drawing; 

3. The table will be automatically filled in. The table is updated automatically when you 
delete, add or edit dimensions. 

  

 

By double clicking, you can edit the tolerance table. For example, specify an 
alphanumeric designation for a size tolerance. 
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Symbols 

Designation of surface texture 

Main menu: Mechanical - Symbols - Surface Texture > Surface texture. 

Ribbon: Mechanical - Symbols > Surface texture. 

Toolbar: Surface texture (toolbar  "MCS Symbols"). 

Command line: MCSURF. 

This command sets the sign of surface texture. 

Procedure 

1. Call command; 

2. Pick a point on the object. When specifying the location of the specified segment is 
highlighted; 

3. Specify the size and position of the callout. The sign is positioned normal to the 
surface. To place a character without a callout, press the spacebar; 
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4. Indicate the position of the roughness mark on the shelf. The editing dialog "Surface 
texture"; 

5. In the "Surface texture" dialog, specify the necessary parameters and click the "OK" 
button; 

Dialog edit 

 

Fields (4 field) - Allows you to enter surface texture values and text above and below the 
shelf. 

In the input field through the context menu, you can select the roughness of the series: 

 

Button "Surface lay and orientation" - allows you to choose the surface texture 
orientation. 
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Button "Match properties" - allows you to copy design properties from another 
surface texture. 

Button "Add extension line" - allows you to add an additional extension line. 

Button  "Dimension dependent" - allows you to select a size for setting 
dependencies. The amount of roughness can be set automatically depending on the 
quality of the specified size. To do this, click on the "Dimension dependent" icon in the 
"Surface texture" dialog box and select the size with the quality mark. 

Button "Arrow type" - allows you to set the appearance of the callout arrow. 

Processing switch - controls the display of the processing method: Any 

manufacturing process permitted, Material should be removed, Material should 
not be removed. 

Character switch "By contour" - controls the display of the symbol  "By contour". 

Character switch "Surface texture not specified" - controls the display of the symbol  
"Surface texture not specified". 

Character switch "Braked sign" - controls the display of the symbol  "Braked sign". 

Switch "Set next" - Active when building a roughness symbol. When turned on, the 
switch goes into the mode of continuous construction of roughness symbols with values 
equal to the first. 

Editing with grips 

Designation surface texture without callouts 

1. Grip flip; 

2. Grip turn; 

3. Grip movement. 

 

Designation surface texture with callouts 

1. Grip add callout line; 

2. Grip of moving the position of surface texture marking along the shelf; 

3. Shelf reflection grip; 

4. Arrow type grip; 

5. Grip move callouts; 
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6. Grip moving shelves. 

 

Designation of surface texture (old) 

Main menu: Mechanical - Symbols - Surface Texture> Surface texture (old). 

Ribbon: Mechanical - Symbols > Surface texture (old). 

Toolbar: Surface texture (old) (toolbar  "MCS Symbols"). 

Command line: MCSURFOLD. 

The command sets the sign of the surface texture of previous versions. 

Procedure 

1. Call command; 

2. Pick a point on the object. When specifying a location, the specified segment is 
highlighted; 

3. Specify the size and position of the callout. The sign is positioned normal to the 
surface. To place a character without a callout, press the "Space"; 

4. Specify the position of the surface texture sign on the shelf. The "Surface texture" edit 
dialog opens; 

5. In the dialog "Surface texture" specify the necessary parameters and click "OK"; 
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Dialog edit 

 

Fields (4 fields) - allows you to enter roughness values and text above and below the 
shelf. 

In the input field through the context menu, you can select the surface texture from the 
row: 

 

Button "Surface lay and orientation" - allows you to choose the surface texture 
orientation. 

Button "Match properties" - allows you to copy design properties from another 
surface texture. 

Button "Add extension line" - allows you to add an additional extension line. 

Button  "Dimension dependent" - allows you to select a size for setting 
dependencies. The amount of roughness can be set automatically depending on the 
quality of the specified size. To do this, click on the "Dimension dependent" icon in the 
"Surface texture" dialog box and select the size with the quality mark. 
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Processing switch - controls the display of the processing method: Any 

manufacturing process permitted, Material should be removed, Material should 
not be removed. 

Character switch "By contour" - controls the display of the symbol "By contour". 

Character switch "Surface texture not specified" - controls the display of the symbol 
"Surface texture not specified". 

Character switch "Braked sign" - controls the display of the symbol "Braked sign". 

Switch "Set next" - Active when building a roughness symbol. When turned on, the 
switch goes into the mode of continuous construction of roughness symbols with values 
equal to the first. 

Grips 

Designation surface texture without extension line 

1. Grip flip; 

2. Grip turn; 

3. Grip moving. 

 

Designation surface texture with extension line 

1. Grip add extension line; 

2. Grip of moving the position of surface texture marking along the shelf; 

3. Shelf reflection grip; 

4. Arrow type grip; 

5. Grip relocation extension line; 

6. Grip moving shelves. 
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Convert old surface texture symbol 

Main menu: Mechanical - Symbols - Surface Texture > Convert old surface 
texture symbol. 

Ribbon: Mechanical - Symbols > Convert old surface texture symbol. 

Toolbar: Convert old surface texture symbol (toolbar  "MCS Symbols"). 

Command line: MCSURCONV. 

The command converts the old character surface texture to a new one. 

Procedure 

1. Call command; 

2. Specify all the required old surface texture characters for the transformation. To 
complete the selection, press the "Enter" key; 

3. The command converts old surface texture symbols to new ones. 

Feature control frame 

Main menu: Mechanical - Symbols > Feature control frame. 

Ribbon: Mechanical - Symbols > Feature control frame. 

Toolbar: Feature control frame (toolbar   "MCS Symbols"). 

Command line: MCTOL. 

The tolerance can be set depending on the quality of the specified size. 

Procedure 

1. Call command. 

2. Pick a point on the object. When you select a base surface, the graphic element is 
highlighted in green. 
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3. Point to the next point to pin the line of the mark. The sign line is drawn along the 
normal to the specified surface. 

 

The sign line may extend from the corner of the frame or from the middle of its side. To 
control the display of these elements, you must call the context menu and select "Sides" 
or "Angles". 

Sides Angles 
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When you select the "Base" line in the context menu, a triangle symbol is drawn on the 
leader. 

When you select the "Tolerance" line in the context menu, an arrow is drawn on the 
callout. 

Base Tolerance 

  

4. Next, place a tolerance mark in the place you need. To do this, using the mouse 
cursor, specify new points in the drawing. To undo the last action, use the "Back" 
command from the context menu. To finish, press the "Enter" key, a dialog box will 
appear "Form&plane position tolerance". 

 

5. In the "Form&plane position tolerance" dialog box, enter the required parameters 
and click the "OK" button. 
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6. The tolerance of the form and plane will be built. 

 

Dialog edit 

The editing dialog consists of a toolbar and a workspace. 

 

Workspace 

The working area of the dialog box is a list of 4 lines, allowing add header and form 3 
rows of values in the tolerance. 

Lines are divided into 4 columns: 

 Type of tolerance column 
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The field of this column allows you to add a type of tolerance. In each field, you can 
enter 2 types of tolerance by selecting the left or right button of the field. 

 

When you click on the buttons, a form for selecting the type of tolerance appears. 

 

 Column of tolerance deviation 

The tolerance deviation value is entered in the fields of this column. The tolerance 
deviation value can be taken from the "Standard values" when the context menu is 
opened in the input field. 

 

 Base designation column 

In the fields of this column, the notation for bases is entered. 

 Column notes 

Notes are entered in the fields in this column. 

  

Dialog Toolbar 
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Dependent tolerance - the command inserts the designation "Dependent tolerance" 
in the columns "tolerance deviation values" and "bases designation". 

Extended tolerance range - the command inserts the symbol "Extended tolerance 
range" in the column "tolerance deviation values". 

Extended tolerance range - the command inserts the symbol "Non-rigid part" in the 
column "tolerance deviation values". 

Extended tolerance range - the command inserts the symbol "Least material 
requirement" in the column "tolerance deviation values". 

Extended tolerance range - the command inserts the symbol "Unequally-disposed 
modifier" in the column "tolerance deviation values". 

Diameter - the command inserts the designation "Diameter" in the column "tolerance 
deviation values". 

Set additional leader - the command allows you to set an additional leader for an 
editable tolerance. 

Set additional base - the command allows you to set an additional base for an 
editable tolerance. 

To install additional callouts, you must: 

1. Call command; 

2. Select object; 

3. Bring the callout line to the tolerance mark. 

Specify base - the command allows you to specify the base, to do this, call the 
command and point to the previously placed base symbol on the drawing. The letter 
designation of the base will be automatically applied in the current input field. When 
linking the base designation in the drawing, the cursor must be in the base designation 
input field. 

Insert base denotation - allows you to insert a base symbol when it is missing in the 
drawing. 

Linked to dimensions - the command serves to fill the deviation value depending on 
the quality of the specified size. 

To fill the value of the deviation is necessary: 

1. Select the type of deviation. 

2. Call command  "Linked to dimensions". 

3. Indicate the size with the assigned quality. A link will be created, otherwise, if the 
qualification is not affixed, a corresponding message will be displayed. 
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4. From the context menu of the deviation value input field, select "Relative 
geometry precission".   

"Relative geometry precission" has 3 degrees: Normal, Increased and High. 

 

Note: If a mark for the shape deviation mark has been applied to the size with the 
specified quality, the context menu bar of the tolerance value "Relative 
geometry precission" will be active. 

The relationship with the size is NOT associative: the tolerance field established 
relative to the size will NOT change along with the size value. Moreover, all 
information about the connection is lost after closing the edit edit form 
admission dialog. 

Thus, if it is necessary to select the value for admission again, the connection 
will have to be imposed again. 

Match properties - this command allows you to copy values from the tolerance 
already entered. 
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Insert separator - the command inserts a separator into the database designation 
field. 

Switch Automatic sorting - manages automatic database sorting. When you turn on the 
designation of bases are put alphabetically, taking into account the previously used 
letter designations of species, sections, sections. 

Note: Deleting symbols of basic surfaces or drawing additional designations of types, 
sections, sections will lead to automatic re-sorting of all associated text 
symbols, including references to them in the technical requirements. 

 

Put down two designations of the basic elements: "A", "B". Added view "A" to drawing. 
The designation of bases was adjusted automatically. 

Grips 

1. Grip moving arrows. 

2. Arrow type grip. 

3. Grip move the nodes of the arrow (maybe several). 

4. Grip joining the sign. Allows you to change the point of attachment of the leader line 
to the sign both in the corners and along the sides. 

5. Sign move grip. 
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Datum identifier 

Main menu: Mechanical - Symbols > Datum identifier. 

Ribbon: Mechanical - Symbols > Datum identifier. 

Toolbar: Datum identifier (toolbar  "MCS Symbols"). 

Command line: MCDATID. 

Procedure 

1. Call command; 

2. Pick a location point. When you select a base surface, the graphic element is 
highlighted in green; 

3. Indicate the position of the mark. The designation of the base will automatically select 
a free letter. 
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Dialog edit 

 

Field "Identifier" - input letter field notation. 

Switch "Automatic sorting" - manages auto sort identifier. If the switch is on, the letter 
is taken automatically from the free and the "Identifier" field is inactive. 

Switch "Attach" - allows you to attach the base to the object. To attach the base to the 
object, you must enable the "Attach" switch, select the anchor object and set the new 
position of the base character. 

Editing with grips 

1. Grip Rotate - allows you to rotate the sign left or right 90 degrees. 

2. Grip direction of the callout or handle move the base. If the attachment base, the 
knob moves the entire base relative to the attached object. If the base is detached, 
then the knob controls the direction of the leader line. 

3. Grip disconnection - when using this handle, the base is disconnected from the 
object. 

4. Grip select the type of arrow - allows you to select the type of arrow from the 
drop-down list. 
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Views, cuts, sections 

Views 

Main menu: Mechanical - Symbols - Views, Sections > View. 

Ribbon: Mechanical - Symbols > View. 

Toolbar: View (toolbar  "MCS Symbols"). 

Command line: MCVIEW. 

Procedure 

1. Call command; 

2. Specify the insertion point of view; 

3. Specify the direction of the view arrow. A dialog box appears "View"; 

4. In the dialog "View" enter your settings. Press button  "OK"; 

 

5. Place the view symbol in the drawing. 

Note: When you transfer the designation by means of nanoCAD, the integrity of the 
data in terms of specifying the mutual location and specifying the zones of the 
drawing can be violated. In this case, you must run the "Update" command. 

Editing 

Editing is done by double-clicking the LMB on any element of the symbol. This opens a 
dialog box "Views, cuts, sections", where you can change the required parameters. 

Section 

Main menu: Mechanical - Symbols - Views, Sections > Sections. 

Ribbon: Mechanical - Symbols > Sections. 

Toolbar: Sections (toolbar  "MCS Symbols"). 
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Command line: MCSECT. 

Procedure 

1. Call command; 

2. Select the path type: Arc or Segment. Each type has its own order of construction; 

 Type Segment. Allows you to create a section as a polyline; 

 Specify the first point of the section; 

 Specify the subsequent cut points. To finish entering points, press  "Enter"; 

 Type Arc. Creates an arcuate cut; 

 Select the desired arc construction method: Arc (3 points), Arc (2 points and 
bend), Arc (2 points and center); 

 Draw an arc in accordance with the selection. 

3. Select the direction of the cut arrows. A dialog box appears "Section"; 

4. In the dialog box, enter the required parameters. Press the button  "OK"; 

 

5. Insert the section symbol in the drawing. 

Note: When you transfer the designation by means of nanoCAD, the integrity of the 
data in terms of specifying the mutual location and specifying the zones of the 
drawing can be violated. In this case, you must run the "Update" command. 

Editing 

Editing is done by double-clicking the LMB on any element of the symbol. This opens the 
"Views, cuts, sections" dialog box, where you can change the required parameters. 

Scale fragment view 

Main menu: Mechanical - Symbols - Views, Sections > Scale fragment view. 

Ribbon: Mechanical - Symbols > Scale fragment view. 

Toolbar: Scale fragment view (toolbar  "MCS Symbols"). 
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Command line: MCEVIEW. 

Procedure 

1. Call command; 

2. Specify the center of the circle (rectangle); 

3. Select the type of contour: Circle or Rectangle; 

4. Specify the size of the circle (rectangle); 

5. Specify the position of the symbol shelf. A dialog box appears "Views, cuts, sections"; 

6. In the dialog box, fill in the required fields. Press  "OK"; 

 

7. Specify the insertion point of the symbol. 

 

Placing an enlarged view of the selection 

Note: When you transfer the designation by means of nanoCAD, the integrity of the 
data in terms of specifying the mutual location and specifying the zones of the 
drawing can be violated. In this case, you must run the "Update" command. 

Editing 

Editing is done by double-clicking the LMB on any element of the symbol. This opens the 
"Views, cuts, sections" dialog box, where you can change the required parameters. 

View and section label 

Main menu: Mechanical - Symbols - Views, Sections> View and section label. 
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Ribbon: Mechanical - Symbols > View and section label. 

Toolbar: View and section label (toolbar  "MCS Symbols"). 

Command line: MCVSDESC. 

Important! You cannot insert a view (section) symbol separately from the element 
itself in automatic sorting mode. 

Procedure 

1. Call command; 

2. Specify the insertion point of the symbol. A dialog box appears  "Views, cuts, 
sections"; 

2. In the dialog box, fill in the required fields. Press the button  "OK"; 

 

Editing 

Editing is done by double-clicking the LMB on any element of the symbol. This opens the 
"Views, cuts, sections" dialog box, where you can change the required parameters. 

Sort views and sections... 

Main menu: Mechanical - Symbols - Views, Sections > Sort views and sections.... 

Ribbon: Mechanical - Symbols > Sort views and sections.... 

Toolbar: Symbols > Sort views and sections... . 

Command line: MCSORT. 

Important! For the command to work, all symbols in the drawing must be bound to 
objects. 

This command is used if views, sections, and sections were built without auto-sorting. 
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Procedure 

1. Call command "Sort views and sections...".  

2. Will be sorting types, cuts and sections (especially designated species, then the cuts-
section). 

Dialog for editing views, cuts, sections 

One of the features of nanoCAD Mechanica 25 in the application of symbols of types, 
sections, sections is to support the functions of design control. We have implemented 
alphabetical arrangement of the letter designation, automatic generation of the zone 
designation and the sheet in the drawing. 

The view, section, section, and detail symbol command allows you to dynamically link a 
symbol to information in technical requirements. 

 

Letter and index input fields - allows you to enter letters and indexes of views, cuts, and 
sections.  

When auto sort is enabled, fields are not editable. 

With auto sort enabled, it is possible to see previously used letters. To do this, place the 
cursor in the input field of the letter and click RMB, a dialog box with a list of the 
presented letters will appear. 

 

List  "Scale" - allows you to assign a scale. 



User Guide nanoCAD Mechanica 25 
 

459 

Switch "Turned" and "Unfolded" - allow to insert to the symbol characters are rotated 
and deployed. 

Field "Zone" - allows you to specify a reference to a zone. 

Field "Sheet" - allows you to specify a reference to the sheet number. 

You can configure the type of the sheet number reference designation record in the 
setup  "Sheet template". 

Group switch designation type - switches the symbol type from "Cut" to "Section" and 
back.  

Switch "Automatic sorting" - controls the automatic designation of views, sections, and 
sections. 

If the switch "Automatic sorting" is enabled, first of all the views are indicated, then the 
sections. 

To comply with the automatic sorting rule, you must specify whether the specified 
symbol belongs to a particular type of symbol. 

In the global settings of the system, the user can enable the function of automatic 
placement of zones in the drawing - in this case, when you move the designation to 
another place in the drawing or change the format of the frame, the designation of 
zones in all sheets will be automatically changed. 

Switch "Add zone automatically" - automatic zone detection. 

Switch "Automatically add sheet number" - automatic detection of the sheet. 

Switch "Insert designation" - controls the ability to insert a text symbol for a view, cut, 
section . 

Welds 

 Welding... 

Main menu: Mechanical - Symbols - Permanent connection > Welding.... 

Toolbar: "Symbols"> Welding.... 

Command line: MCISOWELD. 

Setting notes refer to welding. 
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The dialog box consists of three tabs: 

General 

On the tab, the graphical display and fill in the drawing note. 

 

For convenient entry process, you can use Process list. 

Process list poddrerzhivaet multiple selection processes. 



User Guide nanoCAD Mechanica 25 
 

461 

 

Above side 

Tab necessary to fill in the values above the side 

The type of weld and its parameters. 

 

Below side 

Tab necessary to fill in the values below the side 

The type of weld and its parameters. 
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Simple welding 

Main menu: Mechanical - Symbols - Permanent connection - Simple welding. 

Toolbar: "Symbols" - Simple welding. 

Command line: MCWLEG. 

This command is used to render the weld leg between two intersecting segments. 

1. Enter the first rib. 

2. Enter  the second rib. 

3. Press "Enter" or right mouse button to exit the cyclic command. 

Weld seam 

Main menu: Mechanical - Symbols - Permanent Connection- Weld seam. 

Toolbar: "Symbols" - Weld seam. 

Command line: MCWELD. 

1. In the dialog box "Weld seam" press the button corresponding to the desired type of 
weld. Click OK. 

 

2. Specify the first point of the circuit (or P - polyline, C - circle M - magnet). 
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3. Specify the next point of the contour (or L - line A - arc, C - close, U - rollback, M - a 
method for constructing the arc). 

4. Press Enter or right mouse button to exit the cyclic command. 

In the dialog box are available 16 types of welds. Each type of weld corresponds to the 
button with his picture. To select the desired type of seam, press the button and 
confirm with the OK button. 

Construction of the circuit is made by the following methods: 

L - via line: construction of straight segments of the weld points introduced; 

A - by arc: construction of the weld arc segments in three points; 

C - close: automatic generation of the last segment, closing the main line of the weld; 

U - recoil: undo the last segment of the weld; 

M - a method for constructing the arc: T - tangentially, S - by three points. 

Button Side hatch allows you to select the direction of the hatch. 

Change the direction of the hatch, you can select the "handle" the reflection side hatch: 

 

Fixed joint 

Main menu: Mechanical - Symbols - Permanent connection > Fixed joint. 

Ribbon: Mechanical - Symbols > Fixed joint. 

Toolbar:  "MCSSymbols"> Fixed joint . 

Command line: MCFIX. 
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Procedure 

1. Call the command  "Fixed joint". 

2. Indicate the place of the fixed joint. 

 

3. Pick a break point. 

 

4. Specify the end point of the leader or press the "Enter" key, then the end point of the 
leader will be the break point. The "Joints" editing dialog will open. 

 

5. Set the type of joint in the "Joints" editing dialog and confirm the setting with the 
"OK" button. 

6. The Fixed joint will be built. 



User Guide nanoCAD Mechanica 25 
 

465 

 

Dialog 

Important! When you select the fixed joint "Soldired Joint Leg" or "Weld point", you 
cannot call the dialog from the object for editing. 

 

The editing dialog contains additional commands and two tabs: "Simple representation" 
and "Full representation". 

 Technical conditions - the command associates a designation with a item of 
technical conditions. 

 Place spot welds - the command is intended for insertion of weld point 
elevations in the drawing. 

 Along closed contour - the command is intended to add the symbol "Joint along 
closed contour" to the connection designation. 

 The "Simple representation" tab allows you to select the type of fixed joint. 

 

The following designations for fixed joints are available: 
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Seam denotation  Soldering  Pasting together  Clamps, type 1 

    

 Clamps, type 2  Lacing  Soldired Joint Leg  Weld point 

    

 Depending on the selected type, the "Full representation" tab will be available. 

  The "Full representation" tab allows you to customize the fixed joint symbol. 

 

Input fields and graphic elements are edited on the tab. To edit input fields and turn on 
/ off graphic elements, click LMB on them. When editing input fields, dialogs for editing 
fields appear, containing an input field and additional commands. 

1. Graphic element "Field joint". 

 

2. Graphic element "Joint along closed contour". 

 

3. Number designation input field. 

 

The editing dialog contains: 

 Value input field. 
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 Command Technical conditions - associates value with a technical 
conditions item. 

 Command "Sum" - the number of welded seams with the same number is 
counted. Deleting or changing a seam number designation is automatically 
displayed in the full designation for that joint number. 

 Command "Copy properties" - allows you to copy properties from an 
existing dimension in the drawing. 

 Command "OK" - closes the dialog, saving changes. 

 Command "Cancel" - closes the dialog without saving changes. 

4. Input field for the designation of the control complex or the seam control category. 

 

The editing dialog contains: 

 Value input field. 

 Command "Copy properties" - allows you to copy properties from an 
existing dimension in the drawing. 

 Command "OK" - closes the dialog, saving changes. 

 Command "Cancel" - closes the dialog without saving changes. 

5. Input fields for the symbol. 

 

The editing dialog contains: 

 Value input field. 

 Buttons for quick insertion of special symbols for fixed joint: 

 - Soldered leg; 

 - Remove weld reinforcement; 

 - Treat seam overflows and unevenness with graded junction to parent metal; 

 - Discrete double unfaced seam; 

 - Discrete double faced seam; 

 - Opened contour seam. 

 Command "Copy properties" - allows you to copy properties from an 
existing dimension in the drawing. 

 Command "OK" - closes the dialog, saving changes. 

 Command "Cancel" - closes the dialog without saving changes. 
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Properties 

Seam denotation: 

 Text above self of leader 

 Text under self of leader 

 Text above leader 

 Text under leader 

 Enable calculate joints 

 Count of joints 

 Field joint 

 Joint along closed contour 

Soldering, Lacing, Clamps type 1, Clamps type 1, Pasting together: 

 Joint along closed contour 

 TR item number 

Grips 

Seam denotation: 

1. Move grips - Move the endpoints of the parts of the weld symbol. 

2. "Mirror arrow side" grip - changes the side of the arrow. 

3. "Weld seam properties" grip - opens a list of available graphic elements. In the list, 
you can enable or disable the display. 

 

Soldering, Lacing, Clamps type 1, Clamps type 1, Pasting together: 

1. Move grips - Move the endpoints of the parts of the weld symbol. 

2. Joint type selection grip - opens a drop-down list for selecting a joint type. 
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3. "Weld seam properties" grip - opens a list of available graphic elements. In the list, 
you can enable or disable the display. 

 

 Soldered Joint Leg: 

1. Move grip - allows you to move the leg. 

2. Grips "Change leg size" - allow you to change the size of the leg. 

 

Weld point: 

1. Move grip - Allows you to move the weld point in the drawing. 

 

Simplified weld joint 

Main menu: Mechanical - Symbols - Permanent connection - Simplified weld 
joint. 
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Toolbar: "Symbols" - Simplified weld joint. 

Command line: MCWJ. 

 

Important! 

As the rods and plates can be used primitives nanoCAD: circle and 
polyline (a special case polylines: rectangles, and polygons).   

To use the unit as a plate or an object from the database, you 
must use when choosing an instrument Magnet plate for 
constructing the circuit plate. 

Primitives must be tangent to each other. 

Type: two rods overlap joints. 
To add an overlap joint: 

1. Call the command. 

2. Select the drawing first rod . 

3. Select the second rod. 

4. To select the direction of one-way seam weld placement. 

Two-way joint. 

One-way joint. 

Two-way joint. 

Type: T-connection between two rods.. 
To add a T-joints: 

1. Call the command. 

2. Select the drawing first plate . 

3. Select the second plate. 
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4. To select the direction of one-way seam weld placement. 

Two-way joint. 

One-way joint. 

Two-way joint. 

Two-way joint. 

Type: two plates overlap joints. 
To add an overlap joint: 

1. Call the command. 

2. Select the drawing first plate. 

3. Select the second plate. 

4. To select the direction of one-way seam weld placement. 

Corner seam-sided. 

Corner sided seam. 

Type: Butt joint of two plates. 
To add a butt joint: 

1. Call the command. 

2. Select the drawing first plate . 

3. Select the second plate. 

4. To select the direction of one-way seam weld placement. 

One-way butt weld. 

Sided butt weld. 

One-way butt weld. 
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Sided butt weld. 

Type: Angular connection of two plates. 
To add a butt joint: 

1. Call the command. 

2. Select the drawing first plate. 

3. Select the second plate. 

4. To select the direction of one-way seam weld placement. 

Corner seam-sided. 

Corner seam-sided. 

Edge preparation 

Main menu: Mechanical - Symbols - Permanent connection- Edge preparation. 

Toolbar: "Symbols" - Edge preparation. 

Command line: MCEDGEPREPARATION. 

Provides cutting edge parts in the drawing. 
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Elements of the dialogue: 

1)The list of standard cutting edges for welding; 

 

2) List of types of connection plates welded: Butt, T-bar, angle; 

 

3) List of connection options; 
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4) Filter the list by the thickness of the plates; 

 

When you enter a numeric value thickness dialogue filters only those types of cutting 

edges, matching the thickness of the part. The filter is made by pressing the "Apply 
filter", or by pressing Enter. The value of the thickness in the filter can be measured by 

the meter to be launched on the "Measure". 

5) Zoom menu created design elements 

 

Menu is disabled if Auto is enabled check box. In this case, the scale created by the size 
and design elements set to the current scale decoration. 

If you turn off Auto box, it will be possible to create a drawing cutting edges in arbitrary 
scale is selected in this dialog. 

Operation 

For the cutting edges must be vyponit following: 

1. Select the type of connection: butt, T-bar or angle; 

2. If necessary, filter preparation method edges, depending on their thickness. This 
can be done directly by entering the minimum thickness of the edges, or by 
measuring the drawing; 

3. Determine the scope of dimension lines; 

4. Double-click method of preparing the edges; 
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5. Specify the edge of the weld joint. Depending on the method of preparation is 
required to select the left and right edges alternately. 

 

When you create a cutting edge bevel one team will cycle to offer select sites for the 
creation of such ramps. 

When you create a cutting edge bevel two team provides consistently indicate bevel for 
one, and then to other parts of the joint. 

Important! 

The plates can be used as primitives nanoCAD, as well as objects 
nanoCAD Mechanica.  
Turn inserted edge welded connection can hold down Shift. It is 
necessary to include the "Object Snap" mode and "nearest" or in 
the settings nanoCAD Mechanica against the item "Connections" 
Nearest "automatically when you insert objects" put "Yes". 

Marking symbol 

Main menu: Mechanical - Symbols > Marking symbol. 

Ribbon: Mechanical - Symbols > Marking symbol. 

Toolbar: Marking symbol (toolbar  "MCS Symbols"). 

Command line: MCMARK. 
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Procedure 

1. Call command  "Marking symbol". 

2. Specify the place of marking. 

 

3. If necessary, select the arrow type in the context menu: Arrow or Point. 

4. If necessary, select the type of designation in the context menu.: Mark or Brand. 

 

5. Indicate the position of the mark. Open dialog "Marking and branding". 

 

6. Adjust the settings and click "OK." 

7. A marking or branding mark will be created. 
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Dialog edit 

 

The "Marking and branding" dialog contains: 

 Graphic switch sign type: Marking or Branding. 

 Graphic switch arrow type: Arrow or Point. 

 Button Technical conditions. Allows you to add technical conditions. The last 
item added will automatically bind to the marking. 

The number of the selected item is displayed in the field next to the technical conditions 
button. 

Note: The item number in the technical conditions will match the number in the 
designation in the drawing, even after changing the order of the items in the 
editor. 

  Drop-down list "Contents". Allows you to specify the content type of the mark 
marking or branding. 

 Drop-down list "Method of marking". Allows you to specify the method of applying 
the mark marking or branding. 

Properties 

 Type - Type of mark: Marking or Branding. 
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 Arrow type - Arrow type: Arrow or Point. 

 Content 

 Method of marking 

 Text position - The position of the text content and method of applying to the 
extension line. The value changes from 0 to 1. The report starts from the place of 
marking. 

 TR item number. 

 Coeff. of compression of TR item text. 

Grips 

1. Grip type designation: Marking or Branding. 

2. Grip position of the mark. 

3. Grip position text on the extension line. 

4. Grip select the type of arrow. 

5. Grip position of the arrow. 

 

Notes 

Mechanical note 

Main menu:  Draw - Notes - Mechanical note. 

Main menu: Mechanical - Symbols - Notes > Mechanical note. 
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Ribbon: Annotate - Leaders > Mechanical note. 

Ribbon: Mechanical - Symbols > Mechanical note. 

Toolbar: Notes > Mechanical note. 

Command line: MCNOTE, NOTE. 

 

Procedure 

1. Call the command. 

2. If the option "Show dialog before inserting objects" is active, the "Mechanical note" 
dialog opens. In the "Mechanical note" dialog box, enter text and define the note 
options. Click "OK". 

3. Pick a point on the object (position of the leader arrow). 

4. Place a note leader in the drawing. 

5.  If the "Show dialog before inserting objects" option is disabled, the "Mechanical 

note" dialog will open.In the "Mechanical note" dialog box, enter text and define the 
note options. Click "OK". 

6. Note will be biuld. 

Menu 

 Add string - command adds an extra input field; 

 Remove string - command deletes the input field where the cursor is located; 

 Simple note - command toggles the display of the note; 

 Multiline note - command toggles the display of the note; 

 Multi-line text - the switch controls the display of multi-line text on the shelf; 

 Frame - text under the shelf is framed; 

 Type arrows: 

 None, 

 Arrow, 

 Point, 

 Open arrow, 
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 Half-arrow, 

 Align text horizontally; 

 By left edge 

 By center 

 By right edge 

 Insert special symbol - the command allows you to insert a special character into the 
input field; 

 Match properties - command copies appearance parameters from another object; 

 Add extension line - the command allows you to add an additional note line; 

 Technical conditions; 

 Designations: 

 Surface, 

 Dimension, 

 Others; 

 Dulling dimension. 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

By default, "Mechanical note" contains one text box for the label above the leader 
flange. 

Using the "Simple note" and "Multiline note" menu commands, you edit the 
presence of additional shelves. 

Use the "Add string" and "Remove string" menu commands to edit the number of 
leader ledges. When using a simple note, these commands control the presence of text 
under the shelf. 

Note: Hotkeys are available for the "Add string" command. "Ctrl + Enter" - adds a 
shelf below the selected shelf. "Shift + Enter" - adds a shelf above the selected 
shelf. 

The "Multi-line text" option allows you to display multiline text on the shelf. When 
this parameter is enabled, the transition to another line is performed by the "Ctrl + 
Enter" key combination. 
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Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Auto sort modes 

Note: The submenu (in our example - the letter A) is activated in cases of using the 
auto sort mode when applying letters to the drawing. 

 

Surface - reference surface designation (When automatic lettering sorting is enabled). 

Dimension -dimension designation. 

Others - designation of other elements, such as holes. 

Dulling dimension - special note to indicate blunt edges. 

Construction note 

Main menu: Draw - Notes >  Construction note. 
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Ribbon: Annotate - Leaders > Construction note. 

Command line: MCNOTEP, NOTEP. 

 

Procedure 

1. Call the command  "Construction note". 

2. If "Show dialog before inserting the object" is active, the "Construction Note" dialog 
opens. In the "Construction Note" dialog box, enter text and define the leader options. 
Click the "OK" button. 

3. Pick a point on the object (select the object) to which the leader arrow will point. To 
select an object, use the "Select" context menu command; to freely specify a point in 
the drawing, use the "Free" context menu command. 

4. Place the leader shelf in the drawing. 

Note: If the parameter "Angle step of extension line" is arbitrary, it is possible to place 
the leader ledge orthogonally in the ORTO mode (F8). When you turn on the 
ORTO mode via the "SHIFT" key, Object Snap (F3) must be turned on. 

5. If the "Show dialog before inserting the object" option is disabled, the "Construction 
Note" dialog will open. In the "Construction Note" dialog box, enter text and define the 
leader options. Click the "OK" button. 

6. The note is built. 

Menu 

 Multi-line text - the switch controls the display of multi-line text on the shelf; 

 Frame - text under the shelf is framed; 

 Type arrows: 

 None, 

 Arrow, 

 Point, 

 Open arrow, 
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 Half-arrow, 

 Align text horizontally: 

 By left edge, 

 By center, 

 By right edge; 

 Insert special symbol - the command allows you to insert a special character into 
the input field; 

 Add extension line - the command allows you to add an additional note line; 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

The default positional leader contains two input lines and a list for specifying the pitch 
of the bevel angle. 

The first line is for the label above the leader shelf, the second is under the leader shelf. 

In the "Angle step of extension line" list box, the slope angle of the leader lines is 
selected: 

 Custom - a leader line is placed arbitrarily (default); 

 step 15° - the leader line is put down with a step multiple 15°; 

 step 30° - the leader line is put down with a step multiple 30°; 

 step 45° - the leader line is put down with a step multiple 45°; 

 step 90° - the leader line is put down with a step multiple 90°. 

Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 
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Comb leader note 

Main menu: Draw - Notes >  Comb leader note. 

Main menu: Mechanical - Symbols - Notes > Comb leader note. 

Ribbon: Annotate - Leaders > Comb leader note. 

Ribbon: Mechanical - Symbols > Comb leader note. 

Toolbar: Notes > Comb leader note. 

Command line: MCNOTEC, NOTEC. 

 

Procedure 

1. Call the command. 

2. If the option "Show dialog before inserting objects" is active, the "Comb leader note" 
dialog opens. In the "Comb leader note" dialog box, enter text and define the note 
options. Click "OK". 

3. Insert the required number of leader lines. When you specify the location of the 
leader line, the specified line segment is highlighted. Press the "Enter" key to 
complete the paste. 

4. Specify the slope of the leader lines. Commands for switching the ridge direction 
are available in the context menu: H - horizontal, V - vertical, P - parallel (parallel 
to the selected line). 

5. Place a note leader in the drawing. 

6.  If the "Show dialog before inserting objects" option is disabled, the "Comb leader 

note" dialog will open.In the "Comb leader note" dialog box, enter text and define the 
note options. Click "OK". 

7. Note will be build. 
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Menu 

 Multi-line text - the switch controls the display of multi-line text on the shelf; 

 Frame - text under the shelf is framed; 

 Type arrows: 

 None, 

 Arrow, 

 Point, 

 Open arrow, 

 Half-arrow, 

 Align text horizontally; 

 By left edge 

 By center 

 By right edge 

 Insert special symbol - the command allows you to insert a special character into 
the input field; 

 Add extension line - the command allows you to add an additional note line; 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

Comb leader note by default contains: two lines of input, a list for specifying the pitch of 
the angle of inclination and the orientation of the ridge. 

The first line is for the label above the leader shelf, the second is under the leader shelf. 

In the "Angle step of extension line" list box, the slope angle of the leader lines is 
selected: 

 Custom - a leader line is placed arbitrarily (default); 

 step 15° - the leader line is put down with a step multiple 15°; 

 step 30° - the leader line is put down with a step multiple 30°; 

 step 45° - the leader line is put down with a step multiple 45°; 

 step 90° - the leader line is put down with a step multiple 90°. 

In the "Comb orientation of extension lines" list box, you can select the ridge orientation 
of the leader lines: 

 Custom; 

 Horizontal; 
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 Vertical. 

The list is equipped with an additional button "Select line", which allows you to select 
the direction of the ridge of the leader lines parallel to any line segment in the drawing. 

The "Multi-line text" option allows you to display multiline text on the shelf. When 
this parameter is enabled, the transition to another line is performed by the "Ctrl + 
Enter" key combination. 

Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Grips 

1. Text alignment toggle grip. 

2. Leader lines grip. 

3. Arrow type switch-grip. 

4. Ridge line rotation grip. 

5. Shelf rotation grip. 

 

Chain note 

Main menu: Draw - Notes > Chain note. 
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Ribbon: Annotate - Leaders >  Chain note. 

Command line: MCNOTEH, NOTEH. 

 

A chain note has several coaxial (collinear) series-connected pointers. 

If the first node of the note is placed on a line segment, then the note will be located 
perpendicular to this segment. 

Procedure 

1. Call the command. 

2. If the option "Show dialog before inserting objects" is active, the "Chain note" dialog 
opens. In the "Chain note" dialog box, enter text and define the note options. Click 
"OK". 

3. Specify note nodes, at least two. To complete the selection of nodes, press "Enter". 

4. Specify the position of the leader where the text will go. 

5.  If the "Show dialog before inserting objects" option is disabled, the "Chain note" 
dialog will open.In the "Chain note" dialog box, enter text and define the note 
options. Click "OK". 

6. Note will be build. 

Menu 

 Multi-line text - the switch controls the display of multi-line text on the shelf; 

 Frame - text under the shelf is framed; 

 Type arrows: 

 None, 

 Arrow, 

 Point, 

 Open arrow, 

 Half-arrow, 

 Align text horizontally; 

 By left edge 
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 By center 

 By right edge 

 Insert special symbol - the command allows you to insert a special character into 
the input field; 

 Add extension line - the command allows you to add an additional note line; 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

Chain note contains two lines of input by default. 

The first line is for the label above the leader shelf, the second is under the leader shelf. 

Input fields are expandable. Switching to another line of the input field is performed by 
the "Ctrl + Enter" key combination. 

Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Section note 

Main menu: Draw - Notes >  Section note. 

Ribbon: Annotate - Leaders > Section note. 

Command line: MCNOTES, NOTES. 
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Procedure 

1. Call the command. 

2. If the option "Show dialog before inserting objects" is active, the "Section note" dialog 
opens. In the "Section note" dialog box, enter text and define the note options. Click 
"OK". 

3. Select the insert mode "Free" or "Selection":  

 "Selection" - you need to specify the first and second lines to place the note, the 
cursor is in the form of a square, 

 "Free" - no lines are required, can be placed anywhere by 2 points, the cursor is in 
the form of a cross. 

To switch from the "Selection" mode to the "Free" mode, press the RMB and select the 
"Enter" command in the context menu. To switch from the "Free" mode to the 
"Selection" mode, press the RMB. Also, switching modes is carried out with the "Space" 
key. 

4. Pick the first point (select the first line) in the drawing. 

5. Pick the second point (select the second line) in the drawing. 

6. Specify the position of the leader. 

7. If the "Show dialog before inserting objects" option is disabled, the "Section note" 
dialog will open.In the "Section note" dialog box, enter text and define the note options. 
Click "OK". 

8. Section note will be build. 

Menu 

 Align text horizontally; 

 By left edge 

 By center 

 By right edge 

 Lines; 

 Single-stroked line 

 Double-stroked line 
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 Insert special symbol - the command allows you to insert a special character into 
the input field; 

 Select line - the command allows you to relocate the location of the leader line by 
specifying a line in the drawing; 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

Section note contains two lines of input by default. 

The first line of input consists of two fields for specifying the "Node (sheet) number". 

Second line of input for specifying the "Node address". 

Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Node note 

Main menu: Draw - Notes >  Node note. 

Ribbon: Annotate - Leaders > Node note. 

Command line: MCNOTEK, NOTEK. 
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Procedure 

1. Call the command. 

2. If the option "Show dialog before inserting objects" is active, the "Node note" dialog 
opens. In the "Node note" dialog box, enter text and define the leader options. Click 
"OK". 

3. Pick the center of the leader oval (circle). 

4. Specify the size of the leader oval (circle). 

5. Show the position of the shelf or enter in advance in the command line the step of 
the angle of inclination of the leader line. 

6. If the "Show dialog before inserting objects" option is disabled, the "Node note" 
dialog will open.In the "Node note" dialog box, enter text and define the leader options. 
Click "OK". 

7. Node note will be build. 

Menu 

 Align text horizontally; 

 By left edge 

 By center 

 By right edge 

 Insert special symbol - the command allows you to insert a special character into 
the input field; 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

Node note by default contains: two input lines and a drop-down list for specifying the 
pitch of the slope. 

The first line of input consists of two fields for specifying the "Node (sheet) number". 

Second line of input for specifying the "Node address". 

In the drop-down list "Angle step of extension line", the slope angle of the leader lines is 
selected: 

 Custom - a leader line is placed arbitrarily (default); 

 step 15° - the leader line is put down with a step multiple 15°; 

 step 30° - the leader line is put down with a step multiple 30°; 

 step 45° - the leader line is put down with a step multiple 45°; 

 step 90° - the leader line is put down with a step multiple 90°. 
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Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Note for multilayered constructions 

Main menu: Draw - Notes >  Note for multilayered constructions. 

Ribbon: Annotate - Leaders > Note for multilayered constructions. 

Command line: MCNOTEM, NOTEM. 

 

Procedure 

1. Call the command. 

2. If the option "Show dialog before inserting objects" is active, the "Note for 

multilayered constructions" dialog opens. In the "Note for multilayered constructions" dialog 
box, enter text and define the leader options. Click "OK". 

3. Pick a point on an object (drawing). 

4. Specify the position of the shelf. 

5. If the "Show dialog before inserting objects" option is disabled, the "Note for 

multilayered constructions" dialog will open. In the "Note for multilayered constructions" 
dialog box, enter text and define the leader options. Click OK. 



User Guide nanoCAD Mechanica 25 
 

493 

6. The note will be built. 

Menu 

 Add string - command adds an extra input field; 

 Remove string - command deletes the input field where the cursor is located; 

 First line - the command adds a border (vertical line before the line) for the first 
line; 

 Multi-line text - the switch controls the display of multi-line text on the shelf; 

 Frame - text under the shelf is framed; 

 Type arrows: 

 None, 

 Arrow 

 Point, 

 Open arrow, 

 Half-arrow, 

 Right angle; 

 Align text horizontally; 

 By left edge 

 By center 

 By right edge 

 Insert special symbol - the command allows you to insert a special character into 
the input field; 

 Select line - the command allows you to relocate the location of the leader line by 
specifying a line in the drawing; 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

By default, "Note for multilayered constructions" contains 5 input fields. 

The number of fields is edited using the menu commands "Add string" and "Remove 
string". 

With the help of the "First line" menu command, the presence of a border on the first 
line is edited. 

Using the "Multi-line text" menu command, you edit the presence of shelves in multiline 
notes. 
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Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Linear aligned note 

Main menu: Draw - Notes >  Linear Aligned note. 

Ribbon: Annotate - Leaders > Linear Aligned note. 

Command line: MCLINM, LINM. 

 

Procedure 

1. Call the command. A dialogue will open "Linear aligned note" 

2. In the "Linear aligned note" dialog box, enter text and define the leader options. Click 
the "OK" button. 

3. Specify the subassembly line on which the line subassembly will be located. 

4. Specify text position. 

5. "Linear aligned note" will be build. 

Menu 

 Multi-line text - the switch controls the display of multi-line text on the shelf; 

 Align text horizontally; 

 By left edge 
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 By center 

 By right edge 

 Insert special symbol - the command allows you to insert a special character into 
the input field; 

 Select line - the command allows you to relocate the location of the leader line by 
specifying a line in the drawing; 

 Auto repeat - when the switch is on, the "Linear aligned note" command, upon 
completion of the previous command, is restarted; 

 Multiple insert - when the switch is on, the insert is looped. To exit the cycle, press 
the "Enter" key. 

Context menu 

The context menu opens in the input field. View Context menu entry fields. 

Fields 

By default "Linear aligned note" contains 2 input fields. 

The first field for the label is above the linear structure, the second - under the linear 
structure. 

The Multi-line text parameter allows you to display multi-line text on the shelf. When 
this parameter is enabled, the transition to another line is performed by the "Ctrl + 
Enter" key combination. 

Arrow type selection context menu 

When you call the context menu on the note arrow (without selecting the note), a 
dialog box for selecting the arrow type will appear. 

 

Editing Notes 

There are 3 commands for editing leaders: 
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Append leader 

Main menu: Mechanical - Symbols - Notes >  Append leader. 

Ribbon: Mechanical - Symbols >  Append leader. 

Toolbar: Append leader ( "Notes"). 

Command line: MCPLADD. 

1. Call the team. 

2. Pick a point on the object (point of arrow position). 

3. Indicate the required number of intermediate points that form a break in the leader 
line. 

4. Point to the desired leader inserted in the drawing to complete the command. 

Detach leader 

Main menu: Mechanical - Symbols - Notes >  Detach leader. 

Ribbon: Mechanical - Symbols >  Detach leader. 

Toolbar: Detach leader ( "Notes"). 

Command line: MCPLDEL. 

1. Call the team. 

2. In the drawing, select the leader line you want to delete. 

Edit leader 

Main menu: Mechanical - Symbols - Notes > Edit leader. 

Ribbon: Mechanical - Symbols >  Edit leader. 

Toolbar: Edit leader ( "Notes"). 

Command line: MCPLREC. 

1. Call the team. 

2. Highlight on the drawing a leader line that should be chained. 

3. Pick a point on the desired leader in order to fix the new position of the leader line. 

Adaptive note 

nanoCAD Mechanica 25 allows you to use "Fields (Fields) drawing".  
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1. In the context menu of the callout input field, select the "Insert field..." command. 
The "Field" dialog will open. 

 

2. In the dialog box, link to the desired field and click the "OK" button. 

3. The link will be created. When you click on a field link, the scope will move to the 
linked object. 
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Note: To update data in adaptive callouts, use the command  "Regenerate". 

Save template note 

If necessary, save the callouts for later use, you need to create a balloon, defining it 
related parameters. 

 

Further, by selecting it, specify the context menu - "Save object as template". 

In the "Template wizard" press button "Create template". 

In the dialog box "Create element" specify the storage folder in the base elements, 
Name and Note (if necessary). Press "OK". Again we return to the dialog box "Template 
wizard". 

 

Press button "Update template" and close "Template wizard". 

Update the tree base elements, the template will be created by the note. 

 

Subsequently, this note can be inserted into a drawing for new objects. Adaptive 
communication with new objects and their settings will be saved. 
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Gradient symbol 

Main menu: Mechanical - Symbols > Gradient symbol. 

Ribbon: Mechanical - Symbols > Gradient symbol. 

Toolbar: Symbols > Gradient symbol. 

Command line: MCGRAD. 

Procedure 

1. Call the command. 

2. Using the "Properties" context menu command, open the "Gradient symbol" dialog 
box. Make the gradient symbol settings and confirm the changes with the "OK" button. 

3. Select the line in the drawing for which you want to set the gradient symbol. 

4. Place the gradient symbol on the selected line or leader flange. 

5. The gradient symbol is drawn and associated associatively with the specified line. 

Dialog 

 

The editing dialog contains: 

 Selection button type of designation: Gradient without designation, Left gradient 
and Left taper. 

 

  Input field for gradient symbol value. The input field is active if the associativity 
mode is disabled. If necessary, turn off the associative connection mode by 

turning off the "Associative" switch (when setting, the associativity mode is 
turned on automatically). 

 "Pick from driwing" button. When the associativity mode is off, the button is 
active and allows you to measure the gradient symbol value in the drawing. 

  Switch "Associative". Controls the display of the gradient symbol value. If the 
switch is on, the value is taken from the associated line, if it is off, it is entered 
manually. 
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 Drop-down list "Representation". Allows you to select how the slope units are 
represented: 

 As is 

 Ratio 

 Decimal 

 Percent 

 Permille 

 Degree 

 "Text on leader" checkbox. Toggles whether the gradient symbol is on a shelf or on 
a line. 

Grips 

 

1. Grip for selecting the slope symbol representation. 

2. Shelf movement grip. 

3. Base move grip. When you move, the associativity with the line is lost and an 
additional fourth grip appears. 

4. Grip for changing the angle of inclination of the base. 

Position 

Main menu: Mechanical - Symbols - Position. 
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Toolbar: Position (toolbar  "MCS Symbols"). 

Command line: MCPOS. 

1. Specify the insertion point to the first marker position or call the context menu 
command "P-properties." 

2. In the dialog box Tagging enter text.  

3. Select an arrow. Click OK. 

4. Insert the desired number of drawing markers. Subsequent node number is 
automatically incremented from the previous. 

Fundamental rules 

This command draws the drawing reference numerals used in the drawings.   

Sequencing 

Insert position by specifying the datum marker 

 

Next, mark the position statement of the position: 

 

Inserted into a single command cycle positions are automatically numbered 
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To specify additional options position must call dialog "Position", where you can specify 
the text position display option arrows (switches below the text input field). 

 

Hole group 

Main menu: Mechanical - Symbols > Hole group. 

Ribbon: Mechanical - Symbols > Hole group. 

Toolbar:  "MCSSymbols") > Hole group. 

Command line: MCFILL. 
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Universal command for drawing holes. With its help, you can draw a new hole with 
centerlines, or by specifying a group of holes to assign them general properties with 
filling of a sector. 

Procedure 

1. Draw holes from circles. 

 

2. Call the command "Hole group". 

 

3. Select the required circles. Press the "Enter" key to complete the selection. The 
"Holes" dialog will open. 
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4. Adjust the hole settings and click "OK". The parameters will be applied to the holes. 
The holes will be created. 

 

Dialog 

The "Holes" editing dialog is opened by double-clicking. The dialog consists of: Toolbar, 
Parameter List, Graphics Window. 
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Toolbar 

Match properties - this command allows you to copy parameters from holes already 
installed in the drawing. 

Select holes - the command allows you to select additional holes from the drawing. 

Create holes - the command creates holes of the specified diameter. To dynamically 
set the radius on the screen, hold down the left mouse button and move the cursor. 

Parameter List 

Designation 

 Number - specifies the number of the hole in the group. 

 Description - specifies the hole table description field. 

 Standard - sets the field to the standard of the hole table. 

 Roughness - allows you to specify the roughness of the hole (displayed in the hole 
table). 

Dimensions 

 Diameter - hole diameter. 

 Tolerance - the "..." button opens the "Tolerances" dialog, from which you can 
select a tolerance. 

 Thread pitch - hole thread pitch. 

Representation 
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 Hole - hole display switch. 

 Label - label display switch. 

 Axes - axis display switch. 

 Threaded hole - thread display switch. 

 Diam. dimension - diametrical dimension display switch. 

 Center identifier - drop-down list for selecting the hole center designation. 

Note: Also, the parameters of the "Representation" section can be configured through 
the graphics window. 

Graphics Window 

The graphics window allows you to see the resulting hole representation and customize 
the representation by directly specifying elements. 

Threaded hole Axes Fill first quarter 

   

Fill second quarter Fill third quarter Fill fourth quarter 

   

Properties 

The parameters on the "Properties" functional panel are similar to the parameters from 
the list of parameters of the "Holes" dialog. 

Grips 

1. Hole position change grip. 

2. Diameter change grips. 
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3. Grip for changing the position of the hole number. 

4. Hole rotation grip. 

5. View adjustment grip. 

  

 

Hole chart 

Main menu: Mechanical - Symbols > Hole chart. 

Ribbon: Mechanical - Symbols > Hole chart. 

Toolbar: Hole chart (on toolbar   "MCS Symbols"). 

Command line: MCHOLECHART. 

The command is designed to create automatically updated statements for a group of 
holes. 

Procedure 

1. Call command  "Hole chart". 

2. Specify the insertion point of the coordinate system. 
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3. Set the angle of rotation of the coordinate system. 

 

4. Specify the required holes and circles in the drawing, or create new ones using the 
"Create N" context menu command. To complete the selection (creation), press the 
"Enter" key. The "Hole chart" dialog opens. 

 

5. In the "Hole chart" dialog, specify the name and type (dekatrov or polar) of the 
coordinate system, add (or delete), if necessary, holes. 

6. Insert into the drawing the necessary tables: List of coordinates, Table of holes, Table 
of values. 

7. Click "OK." Tables will be built. Holes will be associated with tables and coordinate 
system. 

Note: To see the holes in the drawing associated with this coordinate system, double-
click on the anchor. 

Edit dialog 

The "Hole chart" dialog is called for editing by double-clicking on the coordinate system. 
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The "Hole chart" dialog contains: 

 Graphic switch type coordinate system: Cartesian or Polar. 

 Hole table creation buttons: 

 List of coordinates - an automatically updated table is formed with the 
coordinates of each hole. 

 Hole table - a table is formed, grouped by hole diameter. Each group of 
identical holes is assigned a letter. 

 Button Number holes - the command automatically assigns consecutive 
numbers or letters to the holes (according to the setting for Hole Designation). 

 Button Add holes - this command allows you to add holes to the report. 

 Button Remove holes - this command allows you to remove holes from the 
report. 

 Field "Name" - the name of the coordinate system. It is added to the hole 
designation as a prefix. 

Grips 

The handles of the report tables are similar to the handles of ordinary tables. 

Coordinate system: 

1. Axle Strength Handles. 

2. Handles parallel transfer axes. 

3. Handle move the designation of the coordinate system. 

4. Handle rotation coordinate system. 

5. Handle transfer coordinate system. 
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Text 

Technical conditions 

Main menu: Mechanical - Drawing title/ Borders > Technical conditions. 

Ribbon: Mechanical - Title blocks > Technical conditions. 

Toolbar:  "Drawing title/ Borders" > Technical conditions. 

Command line: MCTT. 

A distinctive feature of nanoCAD Mechanica 25 is the possibility of linking the 
designation of textual information on the drawing with the text in the technical 
requirements. 

When writing paragraphs of technical requirements (hereinafter TC), you can make 
reference within the proposal of the paragraph of technical requirements to any 
position or affixed view. 

The textual information is the tolerances and dimensions, drawing zones, designations 
of types, cuts, sections, marking signs, marking of welded joints, position. 

A change in the value of the textual information (for example, a part position number) 
will result in an automatic change in the TC text. If this position has been deleted, a 
warning will appear about the need to check a particular item of requirements. 

The relationship between the TC and the designation works in the opposite direction. 
Changing the order of the points of the requirements (their numbering) is automatically 
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reflected in the designation on the drawing (for example, a marking mark, the 
designation of which contains the item number from the technical requirements). 

Editor 

 

Main menu 

 File 

 Clear - clear TC. 

 Open file - the command opens the TC from a previously saved file. 

 Save file - command saves TC to * .rtf file. 

 Close without save - the command closes the TC editing dialog box without saving. 

 Edit 

 Undo - command cancels last action. 

 Redo - the command repeats the previously canceled action. 

 Insert title - command inserts a title in front of TC items. 

 Delete title - command removes TC title. 

Toolbar 

 Open file - the command opens the TC from a previously saved file. 

 Save file - command saves TC to * .rtf file. 

Important! The special characters used in the editor are lost when they are 
transferred to an external file. 
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 Fill in MSWord - the command opens a new document in MSWord and inserts 
the text TC. 

Important! The special characters used in the editor are lost when they are 
transferred to an external file. 

 Notebook - command opens interface notebook. 

 

 Undo - command cancels last action. 

 Redo - the command repeats the previously canceled action. 

 Add paragraph (CTRL+ENTER) - command adds a new TC item.   

 Delete paragraph (CTRL+DEL) - command deletes TC item. 

 Replace paragraph up - the command moves the TC item at which the cursor is 
located, higher up in the list. 

 Replace paragraph down - the command moves the TC item at which the cursor 
is located, down the list. 

 Decrease Indent - the command reduces the indent of selected items. 

 

 Increase indent - command increases the indent of selected items. 
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 Line Spacing - the command opens the list for setting the line spacing. Adjust 
line spacing of selected items.   

 

 1 - set 1 leading (unit for measuring line spacing). Line spacing is added after 
the TC item. 

 1.5 - set 1.5 leading. Line spacing is added after the TC item. 

 2 - set 2 leading. Line spacing is added after the TC item. 

 Set line spacing... - the command allows you to specify your own line spacing. 
Line spacing is added after the TC item. 

 Superscript - translates the selected text into superscript. 

 

 Subscript - translates the selected portion of the text into a subscript. 

 Insert fraction - the command calls the "Fraction" dialog box in which the 
numerator and denominator are specified. The fraction is inserted into the text 
TC. 

 

 Insert tolerance - provides the ability to insert a tolerance. When called, the 
"Tolerances" dialog box opens. 
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 Insert material - provides the ability to insert material. When called, opens the 
"Material" dialog. 

 

 Insert spec symbol - allows you to insert special characters in the text TC. 

 Numeration - the command allows you to select the design option for TC items. 

 

Note: To create a hierarchical list it is necessary to press the "Tab" key on an empty 
item. A new child level has been created. To return to the previous level, press 
the "Enter" key on an empty item. 

 Insert position - the command associates text fragments in the TC with a 
graphical representation of the positions in the drawing. 

To insert a link in the TC editor, place the cursor on the insertion point of the associated 
symbol and click on the "Insert position" button, select a position in the drawing. 

Related information is displayed in blue in the TC editor. When you click on a link, the 
application will display the associated graphical representation. 
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 Insert view/cuts - the command associates text fragments in TC with a graphical 
representation of views, sections and sections in the drawing. 

To insert a link in the TC editor, place the cursor on the insertion point of the associated 
symbol and click on the "Insert view / cuts" button, select the view, section or section. 

Related information is displayed in blue in the TC editor. When you click on a link, the 
application will display the associated graphical representation. 

 Ruler. The ruler is used to position the lines relative to the entire TC document. 
Sliders are used to position the lines. 

 

1. The bottom slider adjusts the indentation of all paragraph lines except the first line. 

2. The top slider adjusts the indent of the first paragraph line. 

3. The angle slider adjusts the text indent from the numbered list marker. 

Context menu 

The context menu uses standard commands for text fields. 

Setting text options 

To set the TC text parameters (font height and slope, indent from the title block, etc.) 
open the dialog box "Settings". 

Technical parameters 

Main menu: Mechanical - Drawing title/ Borders > Technical parameters. 

Ribbon: Mechanical - Title blocks > Technical parameters. 

Toolbar:  "Drawing title/ Borders"> Technical parameters. 

Command line: MCTD. 

Working with the technical description editor is similar to working with the TC editor. 
The main difference is that the typed text can be placed anywhere in the drawing. 
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Editor 

 

Main menu 

 File 

 Clear - clear TP. 

 Open file - the command opens the TP from a previously saved file. 

 Save file - command saves TP to * .rtf file. 

 Close without save - the command closes the TP editing dialog box without saving. 

 Edit 

 Undo - command cancels last action. 

 Redo - the command repeats the previously canceled action. 

 Insert title - command inserts a title in front of TP items. 

 Delete title - command removes TP title. 

Toolbar 

 Open file - the command opens the TP from a previously saved file. 

 Save file - command saves TP to * .rtf file. 

Important! The special characters used in the editor are lost when they are 
transferred to an external file. 

 Fill in MSWord - the command opens a new document in MSWord and inserts 
the text TP. 
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Important! The special characters used in the editor are lost when they are 
transferred to an external file. 

 Notebook - command opens interface notebook. 

 

 Undo - command cancels last action. 

 Redo - the command repeats the previously canceled action. 

 Add paragraph (CTRL+ENTER) - command adds a new TP item.  

 Delete paragraph (CTRL+DEL) - command deletes TP item. 

 Replace paragraph up - the command moves the TP item at which the cursor is 
located, higher up in the list. 

 Replace paragraph down - the command moves the TP item at which the cursor 
is located, down the list. 

 Decrease Indent - the command reduces the indent of selected items. 

 

 Increase indent - command increases the indent of selected items. 

 

 Line Spacing - the command opens the list for setting the line spacing. Adjust 
line spacing of selected items.  
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 1 - set 1 leading (unit for measuring line spacing). Line spacing is added after 
the TP item. 

 1.5 - set 1.5 leading. Line spacing is added after the TP item. 

 2 - set 2 leading. Line spacing is added after the TP item. 

 Set line spacing... - the command allows you to specify your own line spacing. 
Line spacing is added after the TP item. 

 Superscript - translates the selected text into superscript. 

 

 Subscript - translates the selected portion of the text into a subscript. 

 Insert fraction - the command calls the "Fraction" dialog box in which the 
numerator and denominator are specified. The fraction is inserted into the text 
TP. 

 

 Insert tolerance - provides the ability to insert a tolerance. When called, the 
"Tolerances" dialog box opens. 



User Guide nanoCAD Mechanica 25 
 

520 



User Guide nanoCAD Mechanica 25 
 

521 

 

 Insert material - provides the ability to insert material. When called, opens the 
"Material" dialog. 

 

 Insert spec symbol - allows you to insert special characters in the text TP. 

 Numeration - the command allows you to select the design option for TP items. 

 

Note: To create a hierarchical list it is necessary to press the "Tab" key on an empty 
item. A new child level has been created. To return to the previous level, press 
the "Enter" key on an empty item. 

 Ruler. The ruler is used to position the lines relative to the entire TP document. 
Sliders are used to position the lines. 

 

1. The bottom slider adjusts the indentation of all lines of the paragraph except the first 
line. 
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2. The top slider adjusts the indentation of the first line of the paragraph. 

Context menu 

The context menu uses standard commands for text fields. 

Setting text options 

To set the TP text parameters (font height and slope, indent from the title block, eTP.) 
open the dialog box "Settings". 

Text editing 

 

If it's set multiline text editing with tools nanoCAD Mechanica 25, then clicks on the test 
will be called dialogue editing. 
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In this dialog may ask, besides the text, its color, and the Height, and add special 
symbols. 

Utilities 

Creating a hatch 

Main menu: Mechanical - Utilities > Create hatch. 

Toolbar: Utilities > Create hatch. 

Command line: MCHPATTERN. 

In nanoCAD Mechanica 25 it is possible to create hatches according to a given pattern - 

a sketch using the "Create hatch" tool. The hatch pattern created with it is written as 
an independent * .pat file and can be used in other projects or by other users. 

Procedure 
1.Create a border for the hatch sketch. Construct a 300x300mm rectangle and place its 
bottom-left corner at the origin of coordinate system 0,0,0. The sketch area must be at 
the origin of the coordinate system. Overall dimensions of the sketch area should not be 
more than 300x300mm. 
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2. Sketch one element of the future hatch. The sketch needs to be done within the 
created rectangle. The sketch should only be done with lines. It is not allowed to sketch 
with arcs, circles. It is recommended to approximate curved objects in polylines without 
arc segments. Sketch polylines must be exploded into line segments. 

 

3. Assign a different color to each section of the sketch. The sketch should be done with 
segments of different colors. The hatch tool recognizes the periodicity in the sketch by 
the color of the lines. 

 

4. Create an array of sketches within a rectangle. The sketch must follow an explicit 
periodicity. The sketch must include at least three repeating fragments of the future 
hatching. 
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5. Call the command  "Create hatch". 

6. Create an array of sketches within a rectangle. The sketch must follow an explicit 
periodicity. The sketch must include at least three repeating fragments of the future 
hatching. 

 

7. Press the "Enter" key. The process of object recognition and analysis will begin. 
During recognition, gaps in sketch lines are automatically determined, if in the selected 
pattern the line break is outside the selection boundary, the line will be defined in the 
hatch as continuous. If the sketch does not meet the conditions, a message box will 
appear, otherwise the file save dialog. 

8. Correct the errors indicated in the message. Repeat step 5 - step 7. 

9. In the file save dialog specify the path to the hatch file. 
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Important! You cannot use the names "Acad.pat", "Acadiso.pat" as the name of the 
sample file. It is recommended to save in 
C:\ProgramData\Nanosoft\nanoCAD Mechanica 25\SHX 

10. The custom hatch will be created. The hatch created with the "Create hatch" tool 
fully accepts all the properties of the nanoCAD hatch: associativity, the ability to change 
the scale, the angle of inclination, overlay with a closed tolerance. 

Important! A drawing file * .dwg that used a unique hatch must be transferred to 
another user along with the * .pat file of the hatch pattern. For a 
successful translation, use the (eTransmit) "Generate Set" command. 

Objects numeration 

Main menu: Mechanical - Utilities > Objects numeration. 

Ribbon: Mechanical - Utilities > Objects numeration. 

Toolbar: Objects numeration (on toolbar  "MCS Utilities"). 

Command line: MCNUMOBJ. 

The command finds all specified objects with attributes and numbers it according to a 
given algorithm. 

Procedure 
1. Call the team. The "Object Numbering" dialog opens. 
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2. Select objects. Select an object using the quick selection. All objects that have text 
editable attributes (block, database object, universal marker, etc.) can be selected. 
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After selecting an object, a list of attributes common to the selected objects and 
available for editing is formed. 

Additional list management commands: 

Set selection - the command allows you to specify objects in the drawing. 

Reset conditions - command clears the list of conditions. 

3. Select the attribute in which the result of numbering will be recorded.   

 

4. Select the numbering method: 

- from left to rigth, from top to bottom. When choosing this method, the command 
compares the coordinates of points X and Y, respectively, starts numbering from the 
highest and leftmost objects to the lowest and right relative to the base point. 

- from bottom to top, from left to right. When choosing this method, the command 
compares the coordinates of points X and Y, respectively, starts numbering from the 
lowest and leftmost of the entire object to the highest and right relative to the base 
point. 

- from rigth to left, from top to bottom. When choosing this method, the team 
compares the coordinates of points X and Y, respectively, starts numbering from the 
topmost and to the right of the entire object to the lowest and leftmost relative to the 
base point. 

- from bottom to top, from right to left. When choosing this method, the command 
compares the coordinates of points X and Y, respectively, starts numbering from the 
lowest and most right of the entire object to the highest and left relative to the base 
point. 

- radial anticlockwise. When choosing this method, the command compares the 
coordinates of points in the polar coordinate system, the distance from the center 
(specified by the user base point) and the angle between the zero direction (positive X-
axis direction). Numbering is counterclockwise. When this method is selected, the 
selection of the base point becomes available. 

- radial clockwise. When choosing this method, the command compares the 
coordinates of points in the polar coordinate system, the distance from the center 
(specified by the user base point) and the angle between the zero direction (positive X-
axis direction). Priority in comparison has an angle. Numbering is clockwise. When this 
method is selected, the selection of the base point becomes available. 

- spiral anticlockwise from center. When choosing this method, the command 
compares the coordinates of points in the polar coordinate system, the distance from 
the center (specified by the user base point) and the angle between the zero direction 
(positive X-axis direction). Priority when comparing has distance from the center. The 
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numbering is counterclockwise from the center. When this method is selected, the 
selection of the base point becomes available. 

- spiral clockwise to center. When choosing this method, the command compares the 
coordinates of points in the polar coordinate system, the distance from the center 
(specified by the user base point) and the angle between the zero direction (positive X-
axis direction). Priority when comparing has distance from the center. Numbering is 
clockwise to the center. When this method is selected, the selection of the base point 
becomes available. 

5. Indicate a base point if necessary. The base point is indicated either by entering 
the X and Y coordinates, or by pointing to the screen. When cocking the "Specify 
point" checkbox, the point is indicated after pressing the "OK" button. 

 

6. Customize the brand. The formation of the brand comes from three parts. The 
prefix and suffix is specified in the editable field. And the brand value itself is 
calculated based on the initial value entered by the user and the step between 
subsequent values. 

 

7. Click "OK." 

8. If the "Specify point" checkbox has been set, specify the base point in the drawing. 

9. Numbering will be made. 

Measurements 

Main menu: Mechanical - Utilities > Measure. 

Ribbon: Mechanical - Design > Measure. 

Toolbar: Measure (on toolbar  "Utilities"). 

Command line: MCMEASURE. 

Measurements or tool with Mark drawing is designed to extract various properties of 
objects in the drawing. 

After selecting the command a dialog box value picker opens. 
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Measure distance. Measures the distance between two points, radius or diameter. 
Switching the measurement method is via the context menu. 

Measure angle. Measures the angle. 

Measure Perimeter. Measure the perimeter of the closed area, the length of a closed 
polyline or circle. 

Measure area. Measures the area of the closed area. Select an area in two ways: 1 - 
Click inside the closed loop, 2 - Click on the closed polyline or circle. 

Complex area. Measures the area of several loops. Selecting the area is carried out: 1 
- Click to specify the first closed loop, 2 - Click to specify the second closed loop 3 - Press 
Enter to complete the command. 

Take from property. Allows you to get the value of the parameter selected in the 
drawing object nanoCAD Mechanica25. 

 

Take from text. Returns the value of the selected single-line or multi-line text. 

Calculate. Opens calculator. 

Take from notes. Opens the notebook. 

The measured values are displayed in the dialog box. 

If universal measuring time was part of a command (for example, the dialog box 
nanoCAD Mechanica25 text context menu command), the measured value is 
transmitted to the command being executed. 

Fragment Copy 

Main menu: Mechanical - Utilities > Fragment copy. 
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Ribbon: Mechanical - Utilities > Fragment copy. 

Toolbar: Fragment copy (on toolbar  "Utilities"). 

Command line: MCCOPY. 

The command is used to create remote views of the drawing. 

1. Select the drawing center point for the detail view. 

2. Select the area of the drawing. In the context menu, you can choose a certain kind 
of marquee - circle or rounded rectangle. Secure selection click. 

3. Specify the drawing center remote fragment. available in the context menu command 
"0-cut" to remove the original objects from the drawing. 

Plate Array 

Main menu: Mechanical - Utilities > Plate array. 

Ribbon: Mechanical - Utilities > Plate array. 

Toolbar: Plate array (on toolbar  "Utilities"). 

Command line: MCPLTARRAY. 

Command to tile layouts for a given circuit. 

1. Choose from a base  tile pattern and place it on the drawing. 
 

 
 

2. Press the plate array. 

3. In the opened window, click the plate shema and specify the token group. 
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4. Select Trim mode extreme tiles .  

 Trim plates by area border - tiles clipped to the boundary of the layout. 
Circuit tile becomes open. This tile is taken into account in property "Cut". 
This mode is not available if you enable the check box "Make each tile a 
separate." 

 Include trimmed plates - extreme tiles stacked atop circuit layout. 

 Exclude trimmed plates - tiles, overlapping circuit layouts do not fit. 

 Sect border type face- if tiles have execution end elements will be selected 
most podhodyaeschee. When the layout of the area selected by the 
execution system names: Whole, Left, Right, Top, Bottom. When the layout 
along the border all versions checked sequentially, regardless of names. 

Trim plates by 

area border 

Include trimmed 

plates 

Exclude 

trimmed plates 

Sect border 

type face 

    

5. Create each plate as a separate object.  
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If the box is checked, the result will be a group of independent layout objects - copies of 
the original objects. This mode does not support cutting elements on the boundaries of 
the area, but allows more flexibility to edit the result. 

When the check box is created off a single object that includes all geometry. In the 
properties of this object will be information on the number, weight and costs of each 
type of tiles, as well as the total weight (based on the whole tiles) and cost. You can 
delete individual tiles by clicking on them with the right. In this case the total amount 
will be adjusted, weight and cost. 

6. Determine the work area tiles.  

 auto detect - layout area defined contour, which is located inside the tile 
pattern. In the inner islands stacked tiles will not. 

 magnet - loop selection tool "magnet". 

 select - area layout is selected in the drawing indicating one or more loops. 

 border - tiles splits along the perimeter or primitives nanoCAD. Cropping 
mode in this case will simulate laying curbs. 

7. To complete the command, press OK. 

Note: Creating a template tile layouts can be done using Object Wizard. 

Creating an array of objects 

Main menu: Mechanical - Utilities > Array. 

Ribbon: Mechanical - Utilities > Array. 

Toolbar: Array (on toolbar  "Utilities"). 

Command line: MCARRAY. 

Replication called ordered distribution of copies of objects by step and quantity. 
Duplication of graphics in the nanoCAD Mechanica25 is performed using a dialog box 
arrays. 

Four tabs in the Arrays dialog box define four (4) different object replications. 

 Arrays along an arbitrary path 

 Arrays for arc trajectory 

 Rectangular array 

 An array of step 

For the distribution of objects within a specified area used for an array field . 
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Arrays along an arbitrary path(Trajectory) 
1. Tab Path enter the governing parameters. 

2. Follow The selection object (object selection). 

3. Specify the base point. 

4. Select trajectory. 

5. Follow View . 

6. Click OK to complete the command. 

 

At the top of the window is a group of controls placement, which allows you to select: 

 Quantity; 

 Copy step; 

 Base point; 

 Step correction; 

In the drop-down list make a choice of Overlap: 

 Transparent objects; 

 Next under preceding; 

 Next Over preceding; 

 Interleave. 

Button  pick from drawing step allows you to select copies of the objects in the 
drawing. 
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Switch Show hidden line controls the display of hidden lines in the drawing. If the switch 
is on the hidden lines are displayed in the drawing. 

Switch Rotate copies controls the orientation of the copied object. If the switch is on 
when copying objects are rotated so that the vector Y was directed perpendicularly to 
the path (as shown in the figure). 

Button  Selection to select the replication object in the drawing. 

Button  from the base to select the object from the database 
replication of standard elements. 

Button Base point lets you choose the base point of duplicated object (normally it 
should be expressed in the center or corner of the object). 

Button select a trajectory to select a graphic object, along which you will be replicating. 
As the trajectory can be used lines, polylines, arcs, circles. 

 

Arrays for arc trajectory 
1. Tab Arc enter the governing parameters. 

2. Follow The selection object (object selection). 

3. Select Center array. 

4. Follow Preview . 

5. Click OK to complete the command. 



User Guide nanoCAD Mechanica 25 
 

536 

 

At the top of the window is a control group accommodation, which lets you choose 
placing of replicated objects: 

 By number and step; 

 By number and angle; 

 By step and corner; 

In the input field Number specify the number of replicated objects. 

In the entry field Step Angle enter the angle between the replicable elements. 

In the input field angle specify the angle required. 

Button with Mark drawing  step allows you to select the corner or angle with the 
drawing. 

In the drop-down list make a choice of Overlap: 

 Transparent objects; 

 Next under preceding; 

 Next over preceding; 

 Interleave. 

Switch Show hidden line controls the display of hidden lines in the drawing. If the switch 
is on the hidden lines are displayed in the drawing. 

Button  Selection to select the replication object in the drawing. 

Button  insert from database used for selecting a center point 
which the objects will be replicated. 



User Guide nanoCAD Mechanica 25 
 

537 

Button array center used for selecting a center point which the objects will be 
replicated. 

Switch Rotate copies controls the orientation of the copied object. If the switch is on the 
turn when copying objects are shown in the figure. 

 

Rectangular array 
1. Command Rectangle enter key parameters. 

2. Follow The selection object  (object selection). 

3. Follow Preview . 

4. Click OK to complete the command. 
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Enter the number of objects in the array horizontally and vertically, to specify the 
amount of horizontal and vertical steps between objects. 

Steps of an array 
1. Tab steps enter the governing parameters. 

2. Follow The selection object (object selection). 

3. Follow > View . 

4. Click OK to complete the command. 

 

Enter the number of objects in the array, specify the amount of horizontal and vertical 
step between objects. 

 



User Guide nanoCAD Mechanica 25 
 

539 

Area array 

Main menu: Mechanical - Utilities > Area array. 

Ribbon: Mechanical - Utilities > Area array. 

Toolbar: Utilities > Area array. 

Command line: MCARDARRAY. 

The tool is designed to replicate objects within a given area. 

Procedure 

1. Call the command "Area array". A dialogue will open "Area array". 

 

2. Click the "Object(s)" button and select the original objects to copy in the drawing. 
Press the "Enter" key to complete the selection. 

3. Select the method of placing the copied objects using the graphic switch: 

 - Rhombus. 

 - Square. 

 - Triangle. 

4. Specify the spacing (H) between adjacent copies. The "Pick from drawing" button 
allows you to select a step from the drawing. 

5. Specify the minimum indent (?) from the edge of the area. The "Pick from drawing" 
button allows you to select an indent from the drawing. 

6. Set the area of the array in one of three ways: 
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 "Select an area by the point". The construction area is formed from a set of 
closed areas. The command allows you to add closed areas to the set by clicking 
the LMB inside a closed contour in the drawing. Clicking again inside the contour 
removes the selected area from the set. To complete the selection, press the 
"Enter" key. 

 "Select contour with the magnet". The contour of the array area is set using the 
utility "Magnet". 

 "Paint area". The command allows you to specify an arbitrary placement of 
copied objects, providing a set step between adjacent copies. This command is 
available only after selecting the source objects to copy. 

The construction of the area is carried out by moving the mouse cursor over the drawing 
(construction must be started from the location of the original objects). As you move 
the cursor, markers will appear on the screen to indicate where the copied objects are 
inserted. 

 

To remove insertion markers, press and hold the "Shift" key. When you hover over a 
marker, the marker will be deleted. 

To temporarily disable the placement of markers, press and hold the "Ctrl" key. 

Finish drawing the area by clicking LMB. An array by area will be built. 

7. Click the "OK" button. An array by area will be built. 

Centerlines 

Main menu: Mechanical - Utilities > Centerlines. 

Ribbon: Mechanical - Utilities > Centerlines. 

Toolbar: Utilities > Centerlines. 
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Command line: MCAXIS. 

The command is designed to draw centerlines. 

Procedure 
The construction method depends on the selected objects: 

 Parallel lines. The centerline will be drawn in the middle between these segments. 

1. Call the command "Centerlines". 

2. Select the first line. 

3. Select the second line. 

4. Specify manually the first point of the centerline or press the "Enter" key. When you 
press the "Enter" key, the centerline is drawn automatically with a protrusion specified 
in the settings (by default 2mm). 

5. Specify manually the second point of the centerline or press the "Enter" key. When 
you press the "Enter" key, the centerline will stop drawing, the second point will be in 
the calculated center between the lines. 

In the case of manual selection of the start / end point of the centerline, the amount of 
the protrusion is controlled by the user. 

 

 Non-parallel line segments. The centerline will be drawn along the bisector of the 
angle between the line segments. 

1. Call the command "Centerlines". 

2. Select the first line. 

3. Select the second line. 

4. Select the direction of the centerline. Using the "Rotate" context menu command, 
you change the direction of the centerline drawing (available only for intersecting line 
segments). 

5. Specify manually the first point of the centerline or press the "Enter" key. When you 
press the "Enter" key, the centerline is drawn automatically with a protrusion specified 
in the settings (by default 2mm). 
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6. Specify manually the second point of the centerline or press the "Enter" key. When 
you press the "Enter" key, the centerline will stop drawing, the second point will be in 
the calculated center between the lines. 

In the case of manual selection of the start / end point of the centerline, the amount of 
the protrusion is controlled by the user. 

 

  One circle. Draws centerline centerlines on the selected circle. 

1. Call the command  "Centerlines". 

2. Pick a circle. 

3. Press the "Enter" key. 

 

 Two or more circles. Draws centerline centerlines on selected circles with one 
common centerline. 

1. Call the command  "Centerlines". 

2. Select the first circle. 

3. Select the second circle. 

4. Press the "Enter" key. If on the line between the centers of the two selected circles 
there are also centers of other circles, then for such circles, axial ones will also be built. 
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 Three mismatched circles. Creates a circle of centers passing through the centers of 
the selected circles. Center axes are automatically added to all circles whose 
centers coincide with the constructed center circle. 

1. Call the command  "Centerlines". 

2. Select the first circle. 

3. Select the second circle. 

4. Select the third circle. 

 

Fillet 

Main menu: Mechanical - Utilities > Fillet. 

Ribbon: Mechanical - Utilities > Fillet. 

Toolbar: Fillet (on toolbar  "Utilities"). 

Command line: MCFILLET. 
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Command Options 

 

Pick from drawing 

 Mode full trim contour lines 

 Mode partial trim lines to their intersection 

 Mode without cutting 

Copying properties  

 Measure fillet. Tabulated fillet radius and the number  

 Extra measurement. Stamped dimensions of the original geometry. Active only when 
the button "dimensioned pairing"  

 

Insert circle as fillet.  

Double click the left mouse button or click the right mouse button in the input fields of 
values, a context menu will open with a list of the last entry: 
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When a command from the context menu, the following options:: 

 

properties  - Open the dialogue to change the chamfer . 

new  - Completion of a group of facets and the beginning of another. This command is 
used when you need to, for example, several facets of the same size on the same site, 
and then with the same dimensions - on the other:  

Chamfer - Switch to build Circle. After you select the shortcut menu command opens 
this dialog Pairing parameter setting interface.  

polyline - Switching to chamfering along the selected polyline. This option is available if 
you have selected the type of symmetric Circle: one length or two identical length. In 
operation, the cut-off modes are ignored and dimensioning. 

Features of the Command 
Command works in 3D. To execute the command source primitives must lie in one plane 

If you select the second object, press and hold SHIFT, then the angle will be formed (at 
the intersection of the closure and isolation). 
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For a pair of ARC-ARC additionally available pairing, combining internal and external 
touch. 
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For a pair of ARC-ARC additionally available pairing, combining internal and external 
touch. 

 

Availability of different types of interfaces depends on the fillet radius. To the outside 
and combining the radii need greater magnitude than the inner. 

When two parallel lines will be constructed pairing radius equal to half the distance 
between them (regardless of the specified length). Automatically aligns the sides to the 
longest segment. When two parallel lines will be constructed pairing radius equal to half 
the distance between them (regardless of the specified length). Automatically aligns the 
sides to the longest segment.  
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Pairing works parallel segments and regions of the same polyline. 

 

Side interface depends on the position of the mouse cursor when the second object 

When you insert a polyline retains its integrity. 

If the team is formed of two polylines one, it will be object of a single polyline. 

If you select one polyline segments separated by other sites, all the intermediate 
portions are removed. 
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Chamfer 

Main menu: Mechanical - Utilities > Chamfer. 

Ribbon: Mechanical - Utilities > Chamfer. 

Toolbar: Chamfer (on toolbar  "Utilities"). 
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Command line: MCCHAMFER. 

Command Options 
This command is used for automatic and semi-automatic placement of face on the 
details with the various versions and with the possibility of automatic dimensioning.  

After clicking the command, it opens a dialog box settings Circle: 

 

Mode chamfering parts with two different sizes 

 

Mode chamfering parts with two different sizes 

 

Mode Chamfer length and angle in this mode instead of the length 2 displays the 
setting angle. 
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 Mode full cutting contour lines 

 Mode partial cutting lines to their intersection 

 Mode without cutting 

 Measure Chamfer 

 Copy properties surrounding face 

 Pick from drawing 

Double click the left mouse button or click the right mouse button in the input fields of 
values, context menu will open with a list of the last entry: 

 

When a command from the context menu, the following options: 

 

Propertise - Opening the dialogue to change the chamfer chamfer. 

New  - Completion of a group of facets and the beginning of another. This command is 
used when you need to, for example, several facets of the same size on the same site, 
and then with the same dimensions - on the other:  

Fillet -  Switch to build pairings. After you select the shortcut menu command opens this 
dialog Pairing parameter setting interface.  

Polyline - Switching to chamfering along the selected polyline. This option is available if 
you have selected the type of symmetric Circle: one length or two identical length. In 
operation, the cut-off modes are ignored and dimensioning. 

Features of the command 
The command works in 3D. To execute the command source primitives must lie in one 
plane. 
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If you select the second object, press and hold SHIFT, then the angle will be formed (at 
the intersection of the closure and isolation).  

 

When you insert a polyline retains its integrity. 

If the team is formed of two polylines one, it will be object to a single polyline. 

If you select one polyline segments separated by other sites, all the intermediate 
portions are removed. 
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Breaks 

Main menu: Mechanical - Utilities - Breaks > Break lines. 

Ribbon: Mechanical - Utilities > Break lines. 

Toolbar: Break lines ( "MCSBreaks"). 
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Command line: MCBREAK. 

Procedure 
1. Select the first point to insert the break line. 

2. In the context menu, select the type of break (break) (Linear, Two-lenear, Curved, 
tWo-curved, tuBular). 

3. Pick the second break point. 

4. In the context menu, select the type of cursor movement control (FreeOffset, 
OrthoOffset). 

5. Specify the width of the cliff (break). A cliff (break) will be built. 

Note: The whole clipped geometry between the break lines is not actually deleted and 
can be restored either by removing the break line or editing its contour with the 
grips nodal points. 

 

Note: All objects nanoCAD Mechanica 25 have a so-called Z-Order. This value sets the 
level of the Z-coordinate in relation to other object-dependent details nanoCAD 
Mechanica 25. Editing the value of the order, you can control the mutual 
overlap of objects  nanoCAD Mechanica 25. 

Dialogue 
The edit dialog is opened from the tooltip when you hover on a break (break) or when 
you double-click on a break (break). 

 

Editing dialog includes: 

 Graphic break type switch; 

 Field "Length"; 

 Field "Width"; 
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 Field "Offset". You can get the value using the offset command "Parallel to specified 

line". 

Grips 
1. Grips length setting   

2. Grips break width settings 

3. Break displacement grip 

4. Drop-down type grip  

 Linear 

 Two-linear 

 Curve 

 Two-curve 

 Tubular 

 

Linear break 

Main menu: Mechanical - Utilities - Breaks - Linear break. 
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Ribbon: Mechanical - Utilities - Linear break. 

Toolbar: Linear break ( "MCSBreaks"). 

Command line: MCBREAK_LINEAR. 

Two-linear break 

Main menu: Mechanical - Utilities - Breaks - Two-linear break. 

Ribbon: Mechanical - Utilities - Two-linear break. 

Toolbar: Two-linear break ( "MCSBreaks"). 

Command line: MCBREAK_TWOLINEAR. 

Curved break 

Main menu: Mechanical - Utilities - Breaks - Curved break. 

Ribbon: Mechanical - Utilities - Curved break. 

Toolbar: Curved break (  "MCSBreaks"). 

Command line: MCBREAK_CURVED. 

Two-curved break 

Main menu: Mechanical - Utilities - Breaks - Two-curved break. 

Ribbon: Mechanical - Utilities - Two-curved break. 

Toolbar: Two-curved break (  "MCSBreaks"). 

Command line: MCBREAK_TWOCURVED. 

Shaft break 

Main menu: Mechanical - Utilities - Breaks - Shaft break. 

Ribbon: Mechanical - Utilities - Shaft break. 

Toolbar: Shaft break (  "MCSBreaks"). 
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Command line: MCBREAK_TUBULAR. 

Construction lines 

Main menu: Mechanical - Utilities - Construction lines. 

Ribbon: Mechanical - Utilities - Construction lines. 

Toolbar:  "Construction lines". 

 

Auxiliary lines are characterized by a layer in which they are placed by default 
(MCSCLines), color (red) and line type (thin solid), that are set in the settings. Additional 
settings - prostanovki rays or lines. Settings only apply to newly inserted objects. When 
you switch the existing objects remain as it is. 

The table below describes which objects need to select and how formed auxiliary line in 
terms nanoCAD. 

Some commands allow you to specify a sequence of auxiliary lines in the format 
XX|XX|XX, where XX - the amount of displacement of the beam (direct) in degrees or 
drawing units from the base position or previous beam, rendered in this command. 

Command Name The algorithm works command Objects of 
choice 

When drawing rays (_ray) When drawing 
lines (_xline) 

Mcconsthor Create a 
horizontal 
auxiliary line 

Command is invoked _ray, in 
which the user is given the 
insertion point. The second 
point is determined by the 
program to define the 
orientation of the beam is 
strictly horizontal. Point is 
determined by the positive 
direction of the X axis. 

 

Option R-Turn-ray-to-180-
degrees allows you to change 
the direction of the beam on 
the opposite 

Command is 
invoked _xline, 
in which the 
user is given 
the insertion 
point. The 
second point is 
determined by 
the program 
to define the 
orientation of 
the line is 
strictly 
horizontal. 

Insertion 
point 



User Guide nanoCAD Mechanica 25 
 

558 

Mcconstver Creating 
vertical 
reference line 

Command is invoked _ray, in 
which the user is given the 
insertion point. The second 
point is determined by the 
program to define the 
orientation of the beam is 
strictly vertical. Point is 
determined by the positive 
direction of the axis Y. 

 

Option Rotate-ray-through-
180-degrees allows you to 
change the direction of the 
beam on the reverse. 

Command is 
invoked _xline, 
in which the 
user is given 
the insertion 
point. The 
second point is 
determined by 
the program 
to define the 
orientation of 
the line is 
strictly 
vertical. 

Insertion 
point 

Mcconstz Create an 
auxiliary line in 
the direction Z 

Command is invoked _ray, in 
which the user is given the 
insertion point. Constructed 
beam emerging from this 
point in the positive direction 
OZ. 

 

Option Rotate-ray-through-
180-degrees allows you to 
change the direction of the 
beam on the reverse. 

  Insertion 
point 

Mcconstcrs Creating 
auxiliary lines 
intersecting 

Command is invoked _ray, in 
which the user is given the 
insertion point. Built at the 
intersection of the rays of the 
insertion point in the positive 
direction of the axes OX and 
OY. 

Options allow you to select 
the quadrant bounded by the 
rays. 

Command is 
invoked _xline, 
in which the 
user is given 
the insertion 
point. 
Constructed 
lines intersect 
at the 
insertion 
point. 

Insertion 
point 
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Mcconsthb Create an 
auxiliary line 
by two points 
or corner 

Command is invoked _ray,in 
which the user is given the 
insertion point. Then to 
complete the command 
inserted rays at a 
predetermined angle with 
respect to OX (angle 
determined by the second 
point specified by the user) or 
a number of angles for group 
insert format XX | XX | XX. 

Command is 
invoked _xline, 
in which the 
user is given 
the insertion 
point. Then to 
complete the 
command 
inserted 
straight with a 
predetermined 
angle with 
respect to OX 
(angle 
determined by 
the second 
point specified 
by the user) or 
a number of 
angles for 
group insert 
format XX | XX 
| XX. 

Insertion 
point, a point 
which 
determines 
the angle 
(angle) or 
entering a 
number. The 
command 
completed 
after entering 
the series or 
after the 
forced 
shutdown 
command 
(Esc or right 
button). 

Mcconsthw Create an 
auxiliary line 
at an angle to 
the segment 

Command is invoked _ray, in 
which the user is given the 
insertion point. Specifies the 
position of the base angle 
(line). Then to complete the 
command inserted rays at a 
predetermined angle relative 
to the base angle or angles for 
a number of bulk-insert 
format XX | XX | XX. The angle 
is determined by the user of 
said second point. 

Command is 
invoked _xline, 
in which the 
user is given 
the insertion 
point. 
Specifies the 
position of the 
base angle 
(line). Then to 
complete the 
command 
inserted 
straight with a 
predetermined 
angle relative 
to the base 
angle or angles 
for a number 

Insertion 
point, the 
point defining 
the base 
angle (or 
segment), 
which 
determines 
the point 
angle (angle) 
or entering a 
number. The 
command 
completed 
after entering 
the series or 
after the 
forced 
shutdown 
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of bulk-insert 
format XX | XX 
| XX. The angle 
is determined 
by the user of 
said second 
point. 

command 
(Esc or right 
button). 

Mcconstpar Creating an 
auxiliary line 
parallel at a 
predetermined 
distance 

Command is invoked_ray, in 
which the user selects a 
segment, polyline, line or ray. 
Further, given the parallel 
position of the object as a 
point through which it must 
pass (in the case of a polyline - 
equidistant) or number of 
copies of an object in the 
format XX | XX | XX. 

Command is 
invoked _xline, 
in which the 
user selects a 
segment, 
polyline, line 
or ray. Further, 
given the 
parallel 
position of the 
object as a 
point through 
which it must 
pass (in the 
case of a 
polyline - 
equidistant) or 
number of 
copies of an 
object in the 
format XX | XX 
| XX. 

Beam line, 
polyline or 
line. 
Reference 
point or enter 
a number. 
The 
command 
completed 
after entering 
the series or 
after the 
forced 
shutdown 
command 
(Esc or right 
button). 

Mcconstpar2 
Creation of a 
parallel 
auxiliary line 
at half the 
specified 
distance 

Command is invoked _ray, in 
which the user selects a 
segment, polyline, line or ray. 
Further, given the parallel 
position of the object as a 
point through which it must 
pass (in the case of a polyline - 
equidistant) or number of 
copies of an object in the 
format XX | XX | XX. The 
resulting objects are at half of 
the distance. 

Command is 
invoked _xline, 
in which the 
user selects a 
segment, 
polyline, line 
or ray. Further, 
given the 
parallel 
position of the 
object as a 
point through 

Beam line, 
polyline or 
line. 
Reference 
point or enter 
a number. 
The 
command 
completed 
after entering 
the series or 
after the 
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which it must 
pass (in the 
case of a 
polyline - 
equidistant) or 
number of 
copies of an 
object in the 
format XX | XX 
| XX. The 
resulting 
objects are at 
half of the 
distance. 

forced 
shutdown 
command 
(Esc or right 
button). 

Mcconstlot2 
Establishment 
of a subsidiary 
of the 
perpendicular 
by two points 

Command is _ray, in which the 
user is given the insertion 
point. Then, the user specifies 
the second point (a preview is 
rendered beam and segment 
coming from the insertion 
point, the second point is tied 
to the cursor) to specify the 
second point forms 
perpendicular to the beam. 
Ray is drawn perpendicular to 
the object. 

Command is 
invoked _xline, 
that sets the 
insertion 
point. Then, 
the user 
specifies the 
second point 
(a preview is 
rendered 
straight and 
cut coming 
from the 
insertion 
point, the 
second point is 
tied to the 
cursor) to 
specify the 
second point 
forms 
perpendicular 
to the line. 
Direct drawn 
perpendicular 
to the object. 

Insertion 
point, 
reference 
point on the 
perpendicular 
to the object 
renders. 
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Mcconstlot Create an 
auxiliary line 
perpendicular 
to the 
segment 

Command is invoked _ray, for 
which the user selected 
reference object and point to 
it. Ray is drawn perpendicular 
to this object at the selected 
point. Starting beam is at a 
selected point. 

Command is 
invoked _xline, , 
in which the 
user selects 
the object and 
reference 
point on it. 
Direct drawn 
perpendicular 
to this object 
at the selected 
point. Middle 
line is the 
selected point. 

Beam line, 
polyline or 
line. Point on 
the object. 

Mcconsthm Create an 
auxiliary line 
to the corner 
along the 
bisector 

Command is invoked _ray, for 
which the user selects two 
reference object. Ray is based 
on the bisector between the 
two reference objects. 

Command is 
invoked 
_xline,in which 
the user 
selects two 
reference 
object. Direct 
built along the 
bisector 
between the 
two reference 
objects. 

Beam line, 
polyline or 
line. 

Mcconsttan Create two 
parallel 
auxiliary lines 
tangent to the 
circle 

Selected circle or arc that it 
may determine. Constructed 
two rays tangent to the circle, 
it is necessary to ask a series 
of positioning angles or point 
specified segment emanating 
from the center of the circle 
and parallel rays (link). 

Selected circle 
or arc that it 
may 
determine. 
Constructed 
two lines 
tangent to the 
circle, it is 
necessary to 
ask a series of 
positioning 
angles or point 
specified 
segment 
emanating 

Circle or arc. 
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from the 
center of the 
circle and 
parallel lines 
(link). 

Mcconstcc Creating 
auxiliary circle 
another circle 
concentric 
circle or arc is 
selected. 

Automatically construct a circle concentric 
with the selected object and specify the 
diameter (or the given number of diameters). 
The command completed after entering the 
series or after the forced shutdown command 
(Esc or right button). 

Circle or arc. 

Mcconstc2 Creating 
auxiliary circle 
tangent to the 
segment 

Selected reference line object, the user 
specifies a point lying on the circle defined by 
the radius of the circle (the system offers the 
minimum possible radius which is equal to half 
the distance along the normal from the 
selected point to the segment, and controls 
the maintenance of value (greater or equal)). 
We construct a circle at two points of tangency 
(one point is given conditional perpendicular) 
and radius.. 

Beam line, 
polyline or 
line. Point 
belonging to 
the circle. 

Mcconstkr Creating 
auxiliary circle 
tangent to two 
segments 

Selected two reference linear object and 
specify the diameter. We construct a circle at 
two points of tangency and radius. 

Beam line, 
polyline or 
line. 

Mcconstkr Creating 
auxiliary circle 
tangent to 
three 
segments 

Selected two reference linear object. We 
construct a circle at three points of 
tangency.The radius is calculated 
automatically. 

Beam line, 
polyline or 
line. 

Mcconstcircli 
Creating 
auxiliary 
square 
circumscribing 
circle 

Selected circle or arc, automatically builds a 
square, a circle is described. The context menu 
provides switching between inscribed and 
described by the square. 

Circle arc. 
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Mcconsttc Create an 
auxiliary line 
tangent to two 
circles 

Selected consecutively two 
arcs or circles. Constructed 
beam tangent to the two 
circles, a definite choice 
(touch point - coming to a 
place of choice, the beginning 
of the beam - the first object). 

Selected 
consecutively 
two arcs or 
circles. 
Constructed 
line tangent to 
the two 
circles, a 
definite choice 
(touch point - 
coming to a 
place of 
choice, the 
center line - 
the first 
object). 

Two arcs or 
circles 

Mcconst_circle 
Creating 
auxiliary circle 

This is the counterpart nanoCAD assigning 
properties auxiliary geometry. 

  

Mcconstxray 
Creating a 
subsidiary of 
rays 
emanating 
from a single 
point 

This is the counterpart nanoCAD assigning 
properties auxiliary geometry. 

  

Mcconstxline 
 Creating 
auxiliary lines 
passing 
through one 
point 

This is the counterpart nanoCAD assigning 
properties auxiliary geometry. 

  

Mcconstlines 
 Auxiliary lines This command displays the settings nanoCAD 

Mechanica 25 with a pointer to the section 
Auxiliary lines. 

  

Mcclineo  Enable / 
disable the 
auxiliary lines 

This command automatically hides all auxiliary 
lines. 
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Mcconsterase 
Remove 
auxiliary lines 

This command automatically removes all 
auxiliary lines. 

  

Calculator 
The calculator is designed for complex mathematical calculations. The capabilities of the 
table and text editor are significantly expanded using the powerful functionality of the 
calculator. 

The calculator is available in the table editor, text editor, when using the "Inquiry" utility 
in the "Value picker" dialog. 

The "Calculator" dialog consists of a main menu and a set of grouped commands. 

 

Main menu 

 Edit 

 Copy Ctrl+C - the command copies data from the input field. 

 Paste Ctrl+V - the command pastes the copied data into the input field. 

 View 

 NoteBook - command opens the notebook panel. 

 Degrees - the command switches the mode of calculating angles in degrees. 

 Radians - the command switches the mode of calculating angles in radians. 

 Expression - the command turns on the formula calculation mode. The input 
field is divided into two: on the left is the formula, on the right is the result. 
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Commands 

Drop-down list "Precision" - sets the rounding digit of the calculation result. 

 

Switch "Degrees - Radians" - switches the angle calculation mode. 

 

Group of buttons "Mathematical operations". 

 

The main group of calculator buttons. The composition of the buttons is similar to all 
standard calculators. 

 

Buttons for navigating table cells. Available when editing a table cell. It also shows the 
name of the currently edited cell. 

 

Button  to open the "Notebook" sidebar. It is possible to connect the spreadsheet 
editor of the "Notebook" tool. The additional sidebar lists tables from the notebook in a 
drop-down list. After selecting a table, its composition will be displayed. Double-clicking 
on a value from the table adds this value to the input field. This tool is useful when you 
need to perform routine calculation activities frequently. 
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The "Insert" button is designed to insert the result of calculations from the calculator 
into an editable cell, a text entry field or the "Value picker" dialog. 

The "Close" button closes the calculator dialog without transferring the value. 

Insert material designation to the table 

Button material designation. 

This tool is designed to be inserted into the table, the technical requirements and 
specifications of the formatted string records on material and product mix. By pressing 
the button, a dialog box appears called material designation. 

 

Notebook 

Button  Notebook 

To enter recurring standard text expressions (abbreviations, symbols, etc.) used tool 
Notebook. This is a versatile tool for some editing tools nanoCAD Mechanica25, which is 
necessary to enter text. Notebook combines the functions of: storing a set of 
expressions and the structure of their placement in a separate file, input and placement 
of text expressions, input and placement of small tables, searching and editing tools 
introduced earlier records. 
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Dialog Notebook divided into two parts. On the left side there is a tree structure of the 
notebook where the user selects the sections and pages notebook. In the upper part of 
the window control buttons notebook. 

 

Load from file. Opens the notebook file stored on disk. 

Save. Saves the changes to the file in your notebook. 

Important! 
Recommended that you save a new notebook in a separate file in 
the first call to the tool Notebook using the button Save. 

To search for a text string in a notebook has a special search tool, Right-click on any 
section or page of the section and in the context menu, call the command Find. Found 

links are placed in the section results 

To accelerate the search procedure provided for viewing the latest expressions used in 

section history. 

Management structure for the notebook with the buttons: 

Add a partition 

Add this page 

Add a table 

Delete tree item 
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In the notebook is allowed to create an unlimited number of sections and subsections, 
pages, and tables. 

 

Moving sections, pages, and tables for structural wood can produce a drag and drop 
(drag and drop). 

Rename the selected section or page using the command Rename the shortcut menu. 

Select / Copy the selected text. Transmits the selected piece of text pages into 
editable table cell. If the tree structure of the selected page or table in your notebook, 
the contents displayed on the right side of the dialog. Highlight the desired entry cursor, 
and turn the Select / Copy the selected text. 

Edit Page. This button is used to activate the edit pages and style notebook. It 
becomes active only if the tree structure is selected page element or table. In edit 
mode, the tree structure becomes inactive, and the right side activates the Edit toolbar. 

 
 

Editing tools page 

 Clear. Clears the current page 

Load from file. Allows you to import an existing text file *.RTF MS Word. 

Save the file. Allows you to record the content into a file *.RTF for use in MS Word. 

Add item. 

Remove the item . 

Move up. 

Move down. 

Superscript. Includes character mode superscript. 

Subscript. Includes character mode subscript. 

Insert fraction. dialog box set the numerator and denominator. 

     Switch controls the display of the slash. 
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Insert tolerance. Opens Tolerances. 

Insert material. Opens material. 

Calculator. 

 
 

Tools for editing table 

 Insert Row. 

Delete Row. 

Insert Column. 

Delete Column. 

Rename column. Opens Properties column in which you specify the width and title 
of the selected column. 

After editing, when you exit the notebook dialog appears - prompted to save the 
changes in a notebook. 

 

Magnet 
Magnet used to draw complex paths based on existing graphics. The contour can be 
constructed by points or by sequential indication of adjacent segments or arcs. 

Called by: 

 from the context menu (Weld seam, Simplified weld joint)  

 button "Select contour with the magnet" in the dialog (Area array). 
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An example of constructing a weld seam contour, based on an I-beam image inserted 
into the drawing 

 

1. We call the command  "Weld seam". A dialogue will open "Weld seam". 

2. Select the type of seam and click "OK".  

 

3. In the context menu, select the command "Magnet". 

 

4. We indicate the starting point of the contour. 
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5. Sequentially move the cursor over the end points of the linear and arc sections of the 
I-beam contour. 

 

Deselection of the previous segment is made by re-pointing the cursor to the starting 
point of this segment or by the "Back" command from the context menu. 
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6. Use the "Close" command from the context menu to complete the construction of the 
closed contour. 

 

7. The weld will be built along the specified contour. 
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Add selected 

Command line: MCADDCOPY. 

The command allows you to create a new object nanoCAD Mechanica based on the type 
and general properties of the selected object nanoCAD Mechanica. 

Procedure 
1. Call the command "Add selected" - ADDCOPY. 

2. Press the "Space" key (the <Multiple> option will turn on) if you want to insert the 
object in a cyclic mode. 

3. Select an object to serve as a template. The paste command for the selected object 
type will run. The properties of the new object will match the template object. 

Editing 

Editing 

Main menu: Mechanical - Edit - Edit.... 
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Ribbon: Mechanical - Utilities - Edit.... 

Toolbar: Edit... ( "Edit"). 

Context menu: Edit (on select object). 

Command line: MCEDIT, EDIT. 

Editing Building Ground25 - objects can be made in the following ways: 

 right-clicking and selecting Edit Edit from the context menu; 

 double-clicking the left mouse button on the nanoCAD Mechanica25 - object. This 
method is specified in the settings; 

 with "grips"; 

 calling on the Edit tooltip that appears when you hover the cursor over an object: 

 

 properties dialog box (properties); 

 standard commands Erase (ERASE), Move (MOVE), Copy (COPY), Rotate (ROTATE), 
Stretch (STRETCH).  

Edit in-place 

Main menu: Mechanical - Edit > In-place edit. 

Ribbon: Mechanical - Utilities > In-place edit. 

Toolbar: In-place edit ( "Edit"). 

Command line: MCIPEDIT, IPEDIT. 

Command allows you to edit the drawing objects Construction site containing text. 

Editing can be done on site by clicking the left mouse button while pressing Ctrl. 



User Guide nanoCAD Mechanica 25 
 

576 

 

Group Edit 

Main menu: Mechanical - Edit > Group edit. 

Ribbon: Mechanical - Utilities > Group edit. 

Toolbar: Group edit ( "Edit"). 

Command line: MCEDITGROUPS. 

The command allows you to edit bolted  or riveted connections. 

 Click on the button  Group edit; 

 Select any item in the drawing either a bolted or riveted joint; 
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In the window that opens, make the necessary changes. 

Furthermore, editing group nanoCAD Mechanica25 - objects can be produced by double-
clicking the left mouse button on the axis of the assembly. 

Regenerate 

Main menu: Mechanical - Edit > Regenerate. 

Ribbon: Mechanical - Utilities > Regenerate. 

Toolbar: Regenerate ( "Edit"). 

Command line: MCREGEN, REGEN. 

 Updates the object's nanoCAD Mechanica 

 Recalculates the table 

 Updates overlapping objects 

 Automatically updates the calculated values of the attributes 

Explode all  

Main menu: Mechanical - Edit > Explode all objects. 

Ribbon: Mechanical - Utilities > Explode all objects. 

Toolbar: Explode all objects ( "Edit"). 

Command line: MCEXPLODEALL, EXPLODEPDEALL. 

Explodes all objects of nanoCAD Mechanica into drawing primitives. 

Explode primitives 

Main menu: Mechanical - Edit > Explode All Primitives. 

Ribbon: Mechanical - Utilities > Explode All Primitives. 

Toolbar: Edit> Explode All Primitives. 

Command line: MCEXPLODEPSEUDO, EXPLODEPSEUDO. 



User Guide nanoCAD Mechanica 25 
 

578 

Explodes Primitives and Pseudo-Primitives that are generated when nanoCAD graphics 
are overlapped by objects  nanoCAD Mechanica. 

Procedure 
1. Call the command. 

2. Confirm the layout of the primitives. 

3. The primitives will be broken. 

Before After 

  

Export drawing file 

Main menu: Mechanical - Edit > Export to file. 

Ribbon: Mechanical - Utilities > Export to file. 

Toolbar: Export to file ( "Edit"). 

Command line: MCEXPORTTOFILE. 

Saves selected objects in the drawing file. 

1. Click Export to file 
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2. Select the drawing objects 

3. In the dialog box, type the required settings drawing 

4. Click OK 

5. In the dialog box, specify a name for the drawing, and then click Save 

Parameters Redefinitions 

Main menu: Mechanical - Edit > Parameters redefinition. 

Ribbon: Mechanical - Utilities > Parameters redefinition. 

Toolbar: Edit - Parameters redefinition. 

Command line: MCPR, PR. 

The basic rules 
This command is used to define the variations of the nanoCAD Mechanica design objects 
settings in the current drawing.nanoCAD Mechanica25 The redefinition is controlled by 
the parameters set in the setting of design elements. 
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The objects are grouped by types in the dialog. The objects parameters are grouped by 
name. 

To set the parameters or Redefinition removal filter lists are: 

 

If any type is selected in the parameters table , the parameters list concerning the given 
type is displayed. 

The standard filter list allows specifying different settings for single objects created by a 
different design standard. 

 

If you select "All" standards - the changes will be applied to all objects if you select only 
one of the standards (eg GOST), the changes will only be used for objects belonging to 
the chosen standard. 

Command Options 
If an object type is selected, its properties will be displayed in the parameters table. 
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Redefined parameters are shown in blue. To remove the overriding need to press the 

 opposite setting. 

In addition, you can manually specify a new value for the selected parameter. If the new 
value is the same default, the blue light will not be displayed. If the selected object 
group only some entries have the override, the backlight will override the diagonal. 

 

To remove the override all objects need to click on the  bottom left of the dialog. 

Action sequence 
To change the settings of one or more design elements, you must: 

 Select objects 

Next, in the dialog box to specify the new settings data display objects. Changes apply 
only to the selected objects. 

Change the parameters of objects can also be by a separate command  Parameters 
redefinitions. 

Checking the settings of design elements 

To verify the design elements specify the settings, you must run the Parameters 
redefinition. It is proposed to select the objects that will be exposed to the command. 
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When you press the Enter will select all elements of design Construction Site 4. When 
you press the Enter will select all elements of design Construction Site 4 . Next, press the 
button Clear redefinition from all parameters 

 

The result is a document issued in accordance with the settings specified in the 
enterprise (in terms of elements nanoCAD Mechanica25). 

Find and Replace 

Main menu: Edit > Find and Replace.... 

Main menu: Mechanical - Edit > Find and Replace.... 

Ribbon: Mechanical - Utilities > Find and Replace.... 

Toolbar: Edit > Find and Replace.... 

Command line: MCFIND, FIND. 

Shortcut: Ctrl+F. 

The "Find and Replace" tool is used to find and replace string values in nanoCAD 
Mechanica 25 objects in a drawing or in an object base. 
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Search 
1. Call the command. A dialogue will open  "Find and Replace". 

2. In the "Find what:" field, enter the search phrase. 

3. Select "Search in" from the list, or by using the additional button  that defines the 
search area. The button action depends on the context of the "Find and Replace" 
command call. If the command is called from the object manager, the "Quick selection" 
window opens. 

4. Select search parameters : 

 Match case. If the flag is set, the search is case-sensitive. 
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 Match whole words. If the flag is set, the search is performed for individual words, 
that is, combinations of characters separated by punctuation marks or spaces. 

 Search within found. The switch is available after the string has been searched and 
limits the search range. 

 Use extended options. The switch is available when searching in the object database. 

Click the button  opposite the parameter and in the window that appears, 
select the advanced search areas.  

 

 Use regular expressions. Enables search mode with additional selection conditions. 

Click the button  opposite the parameter and select the required expression 
from the list that appears. When you hover over a list item, a tooltip appears with 
a detailed explanation. The choice of expression is made with the left mouse 
button. Multiple regular expressions can be used together.  

 

 Multiline text. Turns on the search mode for multi-line text. 

 Search in hidden objects. Turns on the mode when both visible and hidden objects are 
searched. 

 Search in blocks. Turns on the mode when the search is carried out inside the blocks. 

5. Click the "Find all" button, the search process will start. 

6. The search result will be displayed in the table. 
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Search result 
The search result is displayed in the table. Data is sorted by mouse click in the column 
header. The "Next" button allows you to move the active row in the table. 

 

The table has additional commands: 

 Clear all - clears the search result list. 

 Group results by objects - displays results for objects. 

 Show object - shows the object corresponding to the selected row in the drawing. 
The object is shown even if it is on an inactive sheet. 

 Edit object - opens a dialog box for the object corresponding to the selected row. 

Replace 
1. Search for objects to replace. 

2. In the "Replace with" input field, enter the text string to replace the found lines with. 

3. Click the "Replace" or "Replace All" button: 

 The "Replace All" button replaces all found fragments with a new value. 

 The "Replace" button starts the process of successive replacement of the found 
fragments. To replace all found fragments, press the "Replace" button each time, 
while the active line will move through the table below. The "Next" button allows 
you to move the active row through the table, skipping the next found fragment in 
the list without replacing it with a new value. 

Quick selection 

Main menu: Mechanical - Edit > Quick selection. 

Ribbon: Mechanical - Utilities > Quick selection. 

Toolbar: Edit > Quick selection. 

Command line: MCQS, QS, QSELECT. 

The "Quick selection" tool is used to select the nanoCAD Mechanica 25 objects inserted 
into the drawing according to certain conditions. 
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Procedure 
1. Call the command. 

2. In the dialog box, configure the search conditions. 

 

3. Confirm the setting with the "OK" button. The objects in the drawing are selected 
according to the search conditions. 

Dialog 
The dialog box consists of a toolbar and a list of search conditions. At the bottom left of 
the dialog, the number of objects found according to the specified search conditions is 
displayed. 

Toolbar 

 Selecting an object search area. The choice of the search area is carried out using 
the modes:   

 In the whole document - selection of objects is carried out in the column of the 
list of conditions "Object", the list of objects is taken from the entire drawing; 

 In the current space - selection of objects is carried out in the column of the 
list of conditions "Object", the list of objects is taken from the current sheet; 

 In bounding box - objects are selected by specifying a rectangular area in the 

drawing, to redefine the area, use the command  Set selection; 

 In current selection - objects are selected by specifying a set of objects in the 

drawing, to redefine a set of objects, use the command  Set selection; 

 Selecting a method for adding found objects. The choice of the method of adding is 
carried out using the modes:   
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 Set result to new selection - objects matching the search conditions will be 
selected in the drawing, and all other objects will be deselected; 

 Add result to selection - the found objects will be added to the objects already 
selected in the drawing; 

 Subtruct result from selection - found objects will be deselected if they were 
selected. 

 QS Params. Opens a dropdown menu: 

Include Frozen and Invisible layers - the switch determines whether to search for objects 
on frozen and hidden layers. Does not search by default. 

 Set selection. The command allows you to override a set of objects or a 
rectangular area. Available for "In bounding box" or "In current selection" modes. 

 Presets. Opens a dropdown menu. Using the set of tools included in this 
command, you can select objects according to previously established and saved 
conditions: 

 

 Save preset 
Opens a dialog box in which the name of the template is entered, after which 
the template is added to the list of templates. 

 

 Remove preset 
Opens a dialog box in which a template is selected to be removed from the 
list, or the entire list is cleared.   

 

 List preset 
The list displays all saved templates. If the list is empty, "(Empty)" is 
displayed. 

 

 Reset conditions. The command clears the list of conditions. 
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List of conditions 

The list of conditions consists of three main columns: 

 "Object" - displays objects and their parameters. If you selected the search area "In 
the whole document" or "In the current space" you must add objects yourself. In 
the "Object" column, select the desired type of object from the drop-down list of 
the cell. To deselect or remove an object from the table, select the "-None-" value. 

 

 "Expression type" - a comparison operator is assigned to object parameters. Each 
type of object has its own parameters for which conditions are set. 

 

Possible operators: 

 = - equally; 

 != - not equal; 

 <, > - less - more; 

 >=, <= - no less, no more; 

 Like - substring search. According to this condition, all objects are selected for 
which the parameter value contains the substring indicated in the "Value" 
column. 

 Unlike - substring search. According to this condition, all objects are selected 
for which the parameter value does NOT contain the substring indicated in 
the "Value" column. 

 "Value" - indicates the value by which the selection will be made. The value can be 
text, numeric, or selected from the drop-down list. 
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Viewport context toolbar 
Context menu viewport appears when you right-click in the space of Layout. 

 

Activate the form. Opens in model space viewport. 

Update dimensions. Sets the scale size of the form in accordance with the layout 
space. 

Cut viewport. Overrides viewscreen on existing polyline or build a new one when you 
select the context menu option Polygon. 

Fix view. Commits scale and position relative to the model space viewport. 

Fit all. fits into the viewport model space objects. 

Select scale. Opens the context menu to select the viewport scale. 

MechWizard 

 MechWizard 
MechWizard implements the following features: 

 Creating a custom library of parts. 

 Description of rules of conduct parts in the assembly. 

 Assignment of output parameters to specify details. 

MechWizard supports two types of iParts: static parts and parts with internal 
intelligence. 

Static parts are based on values in the table. When they are inserted the following 
sequence of actions: 

1. Select the item. 

2. Indicate the denomination of the value table. 

3. Apply the spare parts drawing. 

The dynamic parts (with internal intelligence) in addition to the geometrical parameters, 
include pre-assembly constraints. Working with such objects looks: 

1. Select an object-dependent part. 

2. Bring the item to the mating piece. 
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Winning such an approach: Automatically detects the denomination detail, the insertion 
point, the direction of drawing, assembly constraints. 

ScriptMaster 

Main menu: Mechanical - Standard parts - MechWizard > ScriptMaster. 

Ribbon: MechWizard - MechWizard > ScriptMaster. 

Toolbar: MechWizard > ScriptMaster. 

Library: Context menu command  "Open with ScriptMaster" on any element 
library. 

Command line: MCSMASTER. 

The command opens "ScriptMaster" for creating and editing a database object. 

Dialog 
The title of the current element is indicated in the headers of the "ScriptMaster" dialog. 
An "*" signifies that unsaved changes were made to the item. 
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1. Main menu. Contains all commands for creating and editing objects and scripts. 
Contains sections: 

 Object 

 Edit 

 Script 

 Master 

2. Toolbar. Contains basic commands for creating and editing objects. 

 "New object". The command opens a dialog for creating a new base element. 

 "Open". The command is designed to select another element from the base. 

 "Save". The command saves changes to the current object. 

 "Undo". The command cancels the previous action. 
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 "Redo". The command redo the last undone action. 

3. Object tree. In the object tree, you can navigate through the object properties and 
manage them through the context menu.  

4. Workspace. The script and table, as well as other properties of the object are edited 
in the work area. 

5. Notification area. The results of the script check and search / replacement are 
displayed in the notification area. 

6. Status bar. The status bar displays the current state of work with the object: 

 Setting the path to the current database; 

 Current cursor position; 

 Edit state - insert or replace; 

 Script sign for reading or editing. 

The menu bar 

Object 

Menu item object allows it to work with database objects in nanoCAD Mechanica 25: 

 

Object - creates a new element base (By pressing keys Ctrl+N or clicking on the icon  
Create on the toolbar). 

After issuing this command, a dialog box appears to New object 
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To create a new object, you must specify: 

Folder in which to save the new object 

Name (will be displayed in the browser) 

Comment (will be displayed in the tooltip) 

  

Select a way to create a new object 

 

Create an empty object - creates a table and designs without having one script selected 
from the template. 
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Default template - empty script. 

  

Create as copy of prototype - creates an object by copying the entire prototype object 
(along with the script, tables, performances and three-dimensional models. 

 

Use the button  to select an object to create a prototype object. 

  

Open - Open an existing part (keyboard shortcut Ctrl+O or icon Open  on the 
toolbar). 

After selecting the command, a dialog box appears Select the details allowing you to 
select or find the item in the current database in Construction Site 4. 
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Save - save changes to the current member base (keyboard shortcut Ctrl+S or icon  
Save on the toolbar). 

Set object preview - allows you to set as a preview for the object in the browser 
database objects nanoCAD. 

Exit  - close Master objects 

In paragraph object available list of recently used items. 

Editing 

Menu item Edit allows you to work with the current database nanoCAD Mechanica 25: 

 

Undo - cancel the last action (promptness pressing keys Ctrl+Z or clicking on the icon 

Undo on the toolbar). 

Redo - undo the last action (promptness pressing keys Ctrl+Y or clicking on the icon 
Repeat on the toolbar). 

Find - search for a given string on the script of the current element (promptness keys 
Ctrl+F). 

Calling this command opens a dialog box Find 

 

Looking provided an opportunity to take into account only whole words and case search 
string using by appropriate switches. 
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Also have the opportunity to select the search direction. 

Go to the next matched string by pressing  find Next. 

After you click Cancel , you return to the previous menu. 

Speas dropdown input field allows you to select the last used values. 

Replace - search for a given string with a new one. 

After calling this command, a dialog box appears Replace 

 

When replacing provides an opportunity to consider only whole words and case search 
string using by appropriate switches. It is also possible to carry out replacement in the 
selected area or throughout the text. 

Daylight without replacing the matched string to the next by pressing find Next. 

When you click Replace matched string is replaced by a new one at the current position. 

After you click Replace All all found strings will be replaced. 

Button to return to the previous menu, press Cancel. 

Go to - command allows you to go to a specific line (promptness keys Ctrl+G). 

 

Find and replace on the database - allows you to search and replace strings in the base. 
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There are opportunities to search the entire database or in a folder, the search is case 
sensitive, whole words, as well as multi-line test, the search for the script, table, table 
name resources and facilities (Use advanced options ) 

Script 

Menu  script allows you to work with the current script object database nanoCAD 
Mechanica 25: 
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Get script from other object - command allows you to copy the script from another 
object. 

Set script to all objects in selected folder - script command sets the current object to all 
objects in the selected folder database elements nanoCAD Mechanica 25. 

Show script of other object - you can view the script of another object without changing 
it. 

Insert script template - command allows you to take in the script as the current object 
previously saved template. 

Save script as template - allows you to save the current script object as a template for 
future use. 

Show localized script - command allows you to view localized script based on the data of 
the resource table. 

Script Master  

In general, writing the script for the majority of standard parts is not required. Just open 
the script details, like on purpose, and copy it. However, it must be remembered that 
the parameters in the model (figure) must strictly match the prototype. 

nanoCAD Mechanica 25 is a convenient mechanism for self-compilation step algorithms 
that control the behavior of the items in the time of insertion and editing object - 
Master browser. 

Call Master browser  via the menu item Master / Script wizard 

 
 

 General properties 

 Parameter Properties 

 Calculation parameter 

 Drawing Conditions 

 working planes 
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 show / Hide parameters 

 Display conditions 

 Check boxes 

 Current script 

At any step of the script wizard may move buttons << Back and Next >> . 

Button Cancel exits the wizard. 

Basic properties 

 

Object description  (Property Description). This parameter is optional, it describes the 
common name of the object. For example, nut, bolt, etc. 

Object type (type). This parameter is required, it is advisable to fill it in Latin characters. 
Serves to identify the object as belonging to a group. For example, StdArborParts - 
standard parts shaft, StdJointParts - fastenings. 

Object Name (Name of facility). This parameter is required, it is advisable to fill it in 
Latin characters. Defines elements within the group, given strTheType. For example, a 
screw bolt - Screw, for nuts - Nut, for washers - Washer etc.  

Object subtype (subtype). Additional parameter, it is desirable to fill it in Latin 
characters. Defines a specific subtype of GOST. For example, if the name of the object - 
Nut (Nut), then simple nuts subtype is Simple, from crown - Castle etc. 

These parameters set by the user, based on its project object interaction, and can be 
arbitrary. Hard list is not, and they can be changed at any time. They will only be used in 
scripts to automatically establish dependencies (details - in the description of scripts). 
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Specification. Description line items for transmission specification. 

Parameter Properties 

 

Not used 

All parameters specified in the table, are automatically available for operations over 
them from the program during the insert or edit the object. If a variable is used only in 
the process of creating a graphic image, then use it in the script is not necessary. 

Protected (used internally) 

If necessary, display the parameter dialog during insertion. 

Public (visible) 

Used to transfer parameters during insertion and editing of other objects. 

Changeable (available for editing) 

Available to change other objects in the editing process. Variable of the property, will 
pick up from the table and the necessary parameters on the basis of the obtained values 
to reconstruct the details of the model. 
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Calculation of parameters 

 

Set parameter in the dialogue 

Variable for which this flag is set to be available for editing of dialogue insert details. 

Dynamic selection 

Processed when the position of the cursor relative to the insertion point of the object 
according to the formulas in the designated parameter value in the range of "minimum 
value" - "Maximum". 

Calculate after dialouge is shown using dynamic selection by expression 

Calculated after the call dialogue and visual selection as expression in the Parameter 
Value. 

Dont calculate parameter 

Defines the minimum value. Can be expressed as a function of other parameters. 
Determination of the value of the parameter as a function of the cursor or other 
parameters. Available functions may be called from the context menu or manually 
entered into the appropriate input box. 

Minimum value 

Defines the minimum value. Can be expressed as a function of other parameters. 
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Context menu is available in the input field. 

Maximum 

Defines the maximum value. Can be expressed as a function of other parameters. 
Context menu is available in the input field. 

Conditions rendering 

Add a line in the drawing model, rendering which we will operate from the dialog during 
the insertion of parts (for example, they will be highlighted Magenta). Pressing the 

button  will open a dialog box object properties and assign as a condition of their 
appearance in the drawing text parameter. In this case SLICE. 

 

Size "S", necessary for proper recognition, automatically appears in the parameter list, 
but you must enter a parameter draw. 
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Fragment dialog box Properties settings 

 

In the name field switch is set "Cut". The parameter rendering paste from the context 
menu variable "SLICE". 

After the completion of the script retain the item and exit the editor. Of the database 
tree select our item and insert it into the model. In the editing dialog parts we have a 
switch incision through which we can control the rendering of relevant lines. 
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Working planes 

Workplanes determine the position of the items in the time of insertion and editing. 
Determination of working planes dialog box to the work plane. 

 

Creating a plane parallel to the plane OYZ 
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Creating a plane parallel to the plane OXZ 

Creating a plane parallel to the plane OXY 

Show / Hide parameters 

In this step, you must identify the available options in the menu items. The selection is 
made by setting a checkmark APPLICABLE parameter 

 

Display conditions 

In this step, display conditions defined species . The selection is made by setting a 
checkmark APPLICABLE parameter and determining the conditions of his hiding 
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Check boxes 

In this step, there are the following settings: 

 Show dialogue before object is inserted 

 Show object while inserting 

 Regenerate object suppression contour after inserting 
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Current script 

In this step, you can view and edit the resulting script. Clicking on the button Save and 
OK to apply the current script items 

 

This is the final step. 

Master dependencies 

Creating dependencies for interaction with other items going online. 

Call Master dependencies via menu Master / Master Dependency . 

Further, following the screen prompts on the command line, place the drawing model 
details and select the items with which it must interact. 

After placing the parts in the drawing, a dialog box Managing Dependencies. 
Functionally, the dialog box is divided into two parts bookmarks. Bookmark this 
Parametric dependence  and Assembly constraints. 
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Definition of parametric relationships occurs directly in the dialog box. It's enough to 
double-click on the option to specify the details of the child (it will automatically appear 
in the left-hand side) and bring it into line with the parameter of the parent object. In 
the right-hand side can be used mathematical expressions. 

 

Types of assembly and parametric relationships are defined in the dialog box. 
Parameters can serve as table settings objects and definable expression. 
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Axial and surface alignment 

Surface alignment 

Axial alignment 

Direction 

Sets the direction for the dependencies (Counter directional / Co-directional) 

Once all the dependencies are installed, you can click OK, successively pass through the 
dialog boxes and set the options you want. 

Eventually, an automatically generated string specifications necessary to automatically 
detect dependencies. 

 

Master of string of specification 

Formation data for transmission to the specification can be done in automatic and semi-
automatic modes. Some information can be inserted on the basis of the table of 
parameters associated with the geometry of the figure, the part can be entered 
manually in the editing dialog standard parts. 

Call Master BOM line via menu Master / Master BOM line . 
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In the drop-down list are tabulated parameters involved in drawing details. 

 

For a complete description of information on standard parts must be able to adjust or 
supplement information. For example, cover screws or the class thread. In this case, just 
add a "#". 

The editor position will be able to insert text between the two lattices, and then save. 

 

Object tree 
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Tree object contains the following sections: 

 Description ; 

 Parameters; 

 Methods; 

 Function; 

 Forms; 

 Resources table; 

 Script .  

If the open file has been modified, its wood properties can be irrelevant. To actualize 
the properties tree to choose the context menu to update the object tree. 

Description 

When you click on the section Description of the workspace displays the following 
properties. 

 

Property name  - the name of the object to be displayed in the browser database. 

Comment  is displayed in the tooltip to the object. 

Standard product allows you to set the standard (GOST, DIN, ISO, etc.). 

Part list entry, is usually not be filled in the properties, and the variable defined in a 
script. 

You can also put a tick: 

Object have 3D view. 
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Cutting in detail  

Object for 3D only. 

In addition, the properties of the unique identifier for the object. 

Parameters  

Section Parameters contains three subsections: 

 public, 

 protected, 

 tabular. 

 

The public section Upcoming shows a table of open (public) parameters along with their 
comments. 

 

Furthermore, the parameters are displayed in a tree branch. 

 

Section Protected contains a list of protected (protected) parameters, which are also 
displayed in a table and drop-down list of branches in the tree object. 

 

Section Table includes a list of tables detail 
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Table and column of the table in the current workspace synchronized depending on the 
position of the cursor in the object tree. Tables in the object may be a few, while the 
identification is made on behalf of the table. Popup menu when the cursor position on 
the table includes the following tools: 

 

When you select table name as a prefix to the parameters  of an appeal to the names of 
variables are prefixed with the table name. For example,Table0.dr. 

You can add / delete rows from a table and add a parameter to a table. 

There is also exported to Excel, text format and import from them. 

Whenever the context menu on a separate parameter tables are available options 
remove a single parameter and set the type (Valid (Real), String (String) or a (Integer). 
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To rename a table parameter, select it and click on his name left mouse button, or press 
F2. If the parameter name has changed, it will automatically run search and replace in 
the script to a new name parameter correctly processed by the script. 

Methods 

Section Methods includes event handlers and custom functions. 

 

When selecting a specific function in the script is its description (synchronized current 
line). 

Red light  icon in the function indicates the presence of a function in the script is 

present,  white - about lack. When you double clicking on the corresponding function 
in the script created by its pattern. 

Implementation 

Section Versions list includes 2D and 3D versions 

When selecting the root partition versions are all the performance, and the choice of a 
particular (for example, Version 1) - displays the filtered views of this execution. To 
create a two-dimensional view of a new version should be specified in the context menu 
Add performance - automatically create 2D views. 

To create this kind of performance you need to select the required performance and the 
shortcut menu - Add 2D view. 
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 2D view - parametric graphic nanoCAD 

 3D view of the Construction Site 25 - script to create a solid model (opening section of 
the shaft, etc.) 

Deleted when you delete all kinds of performance of this version. 

To set the parameters of the form, select it, and the right side of the workspace to set 
view orientation (Front, Left, Top , etc.) and the type of form ( cut, cut C, C size etc.). 

 

In the context menu, you can select types of operations on this performance. 

These options add \ remove kinds of current version: 
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The following context menu options are designed to work with the selected view of the 
current execution. 

 

Recognize view  - parametric recognition graphics nanoCAD. 

Nonparametric recognize view - simple nonparametric reference charts, graphics taken 
from the object as it is. 

Edit view as text  - description of species opens in a text editor. 

Set preview from objects - objects selection nanoCAD to create a preview of this species. 

Import preview picture from file - creating thumbs on the basis of the previously saved 
file. 

Export preview picture to file - Saves the preview in a file. 

Form editor 

Form Editor 

Database objects nanoCAD Mechanica25 supports the use of custom dialogs for 
inserting and editing. Creating such dialogues (forms) is made in Form Editor, which can 
be accessed from the dialog boxes  Create Group, Create marker and Object Wizard . 

Button  Open the form editor. 
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Menu 

File 

 Test. Opens the form for viewing and testing. 

 Output. Closes the form editor. 

Correction 

 Cancel. Cancels the previous execution of operations. 

 Cut, copy, paste . Command working with the clipboard. 

 Select all. Selects all the controls on the panel shape. 

 Remove. Deletes the selected controls from the form. 

 Group. Group the selected controls. 

 Ungroup. Cancels the grouping selected controls. 

View 

 By ... edge. Alignment commands selected controls along one edge. 

 Align dimensions. Aligns the selected controls dimensions. 

 Above and below. Reverses the order of the tab selected control by moving it up a 
level or down 

 Forward, backward . Changes the tab order of the selected control by moving it to 
the first or the last level. 

 Tab order . Includes display serial numbers tab controls. 

 To set the tab order to be pressed sequentially controls on the left mouse 
button. Tab order will be set according to the sequence control option. 

 Properties. Enables and disables the additional window Properties. 

 Variables. Enables and disables the additional window variables. 

 Grid . Turns on and off the grid and snap to grid. 

 Indents . Enables or disables the frame shape  

Insert 

There are commands insert controls 

 Input field .. 

 Checkbox .. 

 Switch. 

 List. 

 List from the database. 
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 Combo box. 

 Combo box from the database . 

 Text. 

 Group. 

 Figure. 

 Panel. 

 Button. 

 Table with filtering. 

 Table. 

 Types and performance. 

 Viewing. 

Forms panel 

On the forms produced occupancy controls. 

In the context menu of the forms are available editing commands: cut, copy, paste, 
group, ungroup. 

To add a control to the form by one of the following ways: 

 Select the desired control from the menu Insert or toolbar. Specify the insertion 
point and set the dimensions of the control panel on the form. 

After adding the control you want to bind it to a field in the Properties. 

 In the open window, Variables , select the variable for which you want to add a 
control. Left-click on the variable in the list, and holding down the mouse button, 
move the cursor to the panel shape. Release the mouse button. Panel forms 
added group controls - text and input field . 

If you insert a control from the window variables hold down Control, then it is possible 
to select the type of control. 

Selection of the control panel forms can be accomplished in several ways: 

 Single click of the left mouse button. Selected one control. 

 Single click of the left mouse button while pressing Control . If the control is not 
selected, it is added to the current set. If a control is selected, it is removed from 
the current set. 

 Choosing a crossing . Click the left mouse button in the space bar form. Holding the 
button down and dragging a selection box set. Selected controls that are fully or 
partially captured by the selection frame. 

Editing the size of the control is done by using the " grips ". When the grid is resized with 
a certain step. 
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Changing the position of the selected controls performed with the left mouse button on 
one of the selected items. When the grid movement occurs incrementally. 

Align controls 

In the menu View available commands align controls on edge and size. 

     Controls aligned to the left, and then by size . 

Grouping controls 

Working with multiple controls may need to be fixing their relative position. If grouping 
is fixed relative position of the controls, and when you move one of the other grouped 
elements also move. 

Select panel forms controls and issue the Group. Selected controls will be grouped. 

Removing Controls made the command Delete. 

Test the form 

Before completing the form creation is recommended to execute the test to view the 
form. 

Variables window 

In the Variables are parameters of the object ( marker , database object , group ). 

Icon  marked parameters that are associated with controls editable form 

Properties window 

In the Properties lists the properties of the selected controls on the form. At the bottom 
there is a line prompt with a brief description of the selected property 
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Interaction of the form with the 
script 

Interaction of the form with the script 

The form and the design elements located on it interact with the script using properties 
and events. 

Properties 

All form properties start with a prefix  "Form." 

Control properties (design elements) start with a prefix "Form.$$$", where $$$ — name 
of the control on the properties panel of the form editor, case-sensitive.  

Example:  

Form.editbox.Value = ""; 

When accessing the control value (design element), the ".Value" parameter can be 
skipped.  

Example:   

Form.editbox = ""; 

For controls associated with script variables, the value can be passed through a variable. 

Example:   

// Bind the variable 
 Form.editbox.Field = "strType"; 
 //... 
 OnDialogChanged { 
 // The next three lines do same. 
 // If values conflict, 
 // priority is taken into account. 
 // Priority decreases from top to bottom: 
   Form.editbox.Value = ""; 
   Form.editbox = ""; 
   strType = ""; 
 } 

While the form is active, you can work with its properties and the properties of its 
controls as with ordinary variables. In this case, the changes made in the script will be 
applied to the form after exiting the reactor function. 

function OnDialogChanged 
 { 
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   if (Mode == 1) { 
     Form.groupbox.Visible = FALSE; 
     Form.Lable1.Left = 50; 
   } else { 
     Form.groupbox.Visible = TRUE; 
     Form.Lable1.Left = 10; 
   } 
   Form.editbox.Left = Form.Label1.Left + 40; 
   Form.Label1.Right = Form.Label1.Right + 38; 
 } 

Property Access Note 

Form.Count read The number of controls on the form. 

Form.Width read The width of the form's client area. 

Form.Height read The height of the form's client area. 

Form.Help full Link to the reference manual. If the path is 
relative, it is padded relative to the path to the 
project's Help folder. 

May be: 

- the path to the chm-file with or without the 
chapter (don't specify the protocol). 

- link to file 

- NormaCS page or document: 
http://help.spds.ru (Protocol is obligatory). 

- help index 

Form.$$$ full The value of the control. 

Form.$$$.Value full The value of the control. 

Form.$$$.Enabled full Control enabled/disabled. 

Form.$$$.Visible full Control visible/invisible. 

Form.$$$.Field full The name of the script variable associated with 
the control. 
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Property Access Note 

Form.$$$.Tooltip full Hint text. 

Form.$$$.Left full Control size - indent on the left. 

If a binding was set in the form editor, after 
changing the dimensions, the coordinates of all 
controls will be recalculated taking into account 
these changes. 

Form.$$$.Top full Control size - indent from above. 

Form.$$$.Right full Control size - indent on the right. 

Form.$$$.Bottom full Control size - indent from below. 

Form.$$$.Count full The number of items in the list or dropdown list. 

Form.$$$.Items[#] full The #-th element of the list or dropdown list. 

Eventы 

An event handler in this context is a script function that is called in response to an event 
on the form. Events will be called form properties that store the names of event 
handlers. There are events of the form itself and events of its controls. You can work 
with them as with normal form properties. 

Example:  

//Assign the OnChange event to the OnEditChange function 
 Form.editbox.OnChange = "OnEditChange"; 

Event When called 

Form.OnShow Before showing the form. All form properties are already 
defined. 

Form.OnClose Before closing the form. 

Form.$$$.OnChange After changing the value of the control by the user. Changing a 
control from a script does not generate this event. 

Form.$$$.OnEnter When the control receives input focus. 
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Event When called 

Form.$$$.OnLeave When the control loses input focus. 

Switches 

The logic of the switches is somewhat different from other design elements. Multiple 
radio buttons are bound to the same script variable. Each of them is set to some value. 
The variable is set to the value of the enabled switch. The value is of type string. If "-1" is 
set, the value is assigned automatically, starting from 1, in TAB order. In this case, the 
value type will be numeric. 

Radio buttons associated with a single variable are considered a group. Only one radio 
button can be enabled in a group. If the variable is not assigned, radio buttons located 
inside the same control are grouped. This is usually a Group or Panel. 

Examples 

Event handling. In the script code, bind the Edit control to the script variable d. When 
the Edit value changes, update the text in the Static label. 

 Solution 1. When the EditBox value changes from the form, the OnDialogChanged 
function will be called. Assign EditBox control Field name = d. The EditBox control 
will automatically synchronize its value with the d variable. 

function OnDialogChanged 
 { 
   Form1.editbox1.Field = "d"; 
   Form1.static1 = "Hole diameter: " + d + "mm"; 
 } 

 Solution 2. Assign an OnChange event handler to the EditBox control. 

function OnDialogChanged 
 { 
   Form1.editbox1.OnChange = "OnEditChanged"; 
   Form1.editbox1 = d; 
 } 
 function OnEditChanged 
 { 
   d = Form1.editbox1; 
   Form1.static1 = "Hole diameter: " + d + "mm"; 
 } 

 Solution 3. Let's combine both previous solutions. The d variable will be 
synchronized with the EditBox control automatically, and the text of the Static 
label will be updated from the OnChange event handler. 

function OnDialogChanged 
 { 
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 Form1.editbox1.OnChange = "OnEditChanged"; 
 Form1.editbox1.Field = "d"; 
 } 
 function OnEditChanged 
 { 
 Form.Label = "Hole diameter:" + d + "mm"; 
 } 

List management. Build a list of values in a combo dropdown list. 

function OnDialogChanged 
 { 
 // You can set the number after the values, but before the values - somehow clearer. 
 Form.Combo.Count = 5; 
 // Elements are numbered from 1. 
 Form.Combo.Items[1] = “(нет)”; 
 Form.Combo.Items[2] = “Item1”; 
 Form.Combo.Items[3] = “Item2”; 
 Form.Combo.Items[4] = “Item3”; 
 Form.Combo.Items[5] = “Item4”; 
 // This command will fail because there are only 5 items in the list. 
 Form.Combo.Items[6] = “Item5”; 
 } 

Form properties 

General 

Help URL   

Caption   

Editor 

Top margin 8 

Height 400 

Left margin 8 

Bottom margin 8 

Margin  

Right margins 8 
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General 

Grid  

Grid step 8 

Width 400 

 

Note: In the "Help" parameter, the path to the user help is entered. User help will be 
invoked if the focus is on form control. If the focus is on the "Cancel" or "OK" 
buttons, the help of standard elements will open. 

Input field. The input field is used to enter numeric or symbolic expressions for 
further processing. 

Properties command: 

View  

Visible  

Alignment On the edge 

Multiline  

Flat  

Tip  

Linking  (None) 

Enable  

Text None 

Formatting  

Basic 

Name editbox1 
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Class After entering 

Variable  

Type Line 

Position  

 Upper limit 56 

Height  56 

Left boundary 176 

Lower limit  112 

Right boundary 232 

Width 56 

Measurements 

Meter  

Mode Auto 

Regime change  

Developments 

Activation  

Deactivation  

To change  

Checkbox. Allows you to monitor on/off. 

Properties command: 
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View 

Visible  

Tip  

Linking (None) 

Allowed  

Text Flag 

Basic 

Enabled  

Name  checkbox 

Class Flag 

Variable  

Position 

Upper limit 8 

Height 16 

Left boundary 8 

Lower limit 24 

Right boundary 72 

Width 64 

Developments 

by clicking  
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Switch .Switches to monitor the status on/off. Several individual switches 
interconnected to form a "group switch" to track more states. Example of use of the 
group switch.  

Description: 

Several switches are associated with the same variable script. Each of them set any 
value. Variable is set to the included switch. Value is of type string. If set to "-1" value is 
assigned automatically starting with 1, in the tab order for TAB. In this case, the value 
type is numeric. Switches associated with a single variable group are considered. In the 
group may be included in only one switch. If a variable is assigned, grouped switches 
located inside one of the control. Usually this group or panel.  

Properties command: 

View 

Visible  

Tip  

Linking (None) 

enabled  

Text Switch 

Basic 

Included  

Value -1 

Name radiobutton 

Class Switch 

Variable  

Position  

Upper limit 24 
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Height  24 

left boundary 8 

Lower limit 48 

Right boundary 112 

Width  104 

Developments 

by pressing  

Example of using.  
Switches allow you to choose between discrete values, the result is displayed in the 
input field 

 

List. Used to select one value from a specified list. 

Properties command: 

View  

Visible  

Tip  

Linking (None) 

Enable  

Text -1 

Basic 

Data "Element 1" 
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Name Listbox 

Class List 

Variable   

Current -1 

Position 

 Upper limit 48 

Height 40 

 Left boundary 8 

Lower limit 88 

Right boundary 104 

Width 96 

Developments 

Activation  

Deactivation  

To change  

List from the database.. Used to select one value from a pre-specified list in the 
database. 

Properties command: 

View  

Visible  

Tip  
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Linking (None) 

Enable  

Text  

Basic 

Data  

Name Listbox1 

Class List of base  

Variable   

Current  

Position 

Upper limit 96 

Height 60 

Left boundary 8 

Lower limit 156 

Right boundary 104 

Width 96 

Developments 

Activation  

Deactivation  

To change  
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Combo box. Designed to select from the specified list or enter an arbitrary value. 

Properties command 

View 

Visible  

Tip  

Linking (None) 

enabled  

Text Combo box 

Basic  

Data  

Name combobox 

Class combobox 

Variable  

Editable  

Position 

 upper limit 168 

Height 76 

left boundary 8 

Lower limit 244 

Right boundary 104 

Width 96 
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Developments  

activation  

deactivation  

to change  

Combo box from the database. Designed to select from the specified list or enter an 
arbitrary value. 

Properties command: 

View 

Visible  

Tip  

Linking  (None) 

Enabled  

Text  

Basic 

Data  

Name combobox1 

Class  combobox 

Variable  

Editable  

Position  

 Upper limit 208 



User Guide nanoCAD Mechanica 25 
 

634 

Height 64 

 Left boundary 8 

Lower limit 272 

Right boundary 104 

Width 96 

Developments 

Activation   

Deactivation  

To change  

Text . Static (non-editable) text formatting support. Specify the formatting is applied 
to the entire text. 

Properties command: 

View 

Visible  

Headset (Info) 

Tip  

Linking (None) 

Transparent   

Text Text 

Background  

Basic  
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Name static 

Class Text 

Label  

Variable   

Position 

Upper limit 280 

Height 32 

Left boundary 8 

Lower limit 312 

Right boundary 104 

Width 96 

Group. Decorative element, designed to visually group several controls on the form. 

Properties command: 

View 

Visible  

Tip  

Linking (None) 

Enabled  

Text  

Basic 

Name groupbox1 
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Class Group 

Variable  

Position 

Upper limit 320 

Height 38 

Left boundary  8 

Lower limit 358 

Right boundary 104 

Width 96 

Developments 

Activation  

Deactivation  

To change  

Figure. Insert a simple bitmap to the form. 

Properties command.: 

Basic 

Name Image 

Class  Drawing 

Variable   

View 

Visible  



User Guide nanoCAD Mechanica 25 
 

637 

Data (Info) 

Tip  

Linking  (None) 

Transparent  

Proportionally   

Stretch  

Position 

Upper limit 360 

Height 57 

Lleft boundary 8 

Lower limit 417 

Right boundary 105 

Width 97 

Panel. Designed for grouping and align multiple controls on the form. 

Properties command: 

Basic 

Name panel 

Class Panel 

View 

Linking (None) 

Position 
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 Upper limit 16 

Height 49 

Left boundary 112 

Lower limit 65 

Right boundary 185 

Width 73 

Button. Control "button." Response by pressing the left mouse button. 

Properties command: 

View 

Visible  

Tooltip  

Linking (None) 

Allowed   

Text Button 

Main 

Icon -1 

Name button 

Class Button 

Variable  

Position 

Upper Bound 72 
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Height 32 

Left bound 112 

Lower limit 104 

Right border 184 

Width 72 

Developments 

by clicking  

Table with filtering. Table variables to restrict the number of columns, and automatic 
filtering of the list columns. 

Properties command: 

Basic 

Name Control 

Class Table with filtering 

Variable  

View 

Visible  

Tip  

Linking (None) 

Enable  

Position 

Upper limit 112 
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Height  32 

Left boundary 112 

Lower limit  144 

Right boundary 184 

Width 72 

Table . Table variables with the ability to view and select a row. 

Properties command: 

Basic 

Name Control1 

Class  Table with filtering 

Variable  

View 

Visible  

Tip  

Linking (None) 

Enable  

Position 

Upper boundary 152 

Height 40 

 Left boundary 112 

Lower limit  192 
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Right boundary 184 

Width 72 

Views and performance. Table for selection and execution of standard projection of 
the object from the database. 

Properties command: 

View 

Visible  

Tip  

Linking  (None) 

Enable  

Basic 

Name Control2 

Class Views and performance 

Execution 

Show performance  

Types 
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Display Types  

Shows the type form  

Position 

Upper limit 200 

Height 32 

Left boundary 112 

Lower limit 232 

Right boundary 184 

Width 72 

Preview. Preview box of the selected object from the database.  

Properties command: 

View 

Visible  

Tip  

Linking (None) 

Enabled  

Text PreViewControl 

Basic 

Name control3 

Class  Review 
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Position  

Upper limit 240 

Height 40 

 Left boundary 112 

Lower limit 280 

Right boundary 184 

Width  72 

Collection Editor 

Serves for quick creation of lists and their subsequent use in form controls and custom 
sorting in tables. 

Dialog 

The dialog is divided into two parts: Collection name and Collection members. 

 

Collection management tools 

Add new collection. 

Delete collection. 
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Collection members management tools 

Add new collection member. 

Delete collection member. 

Delete all collection members. 

Move collection member upper. 

Move collection member down. 

Paste from clipboard. 

  

Create and assign a collection while editing a form 

In order to create a collection you need to: 

1.  Click the "Data" option in the DB-Listbox or DB-combobox. A dialog box will appear. 

2.  In the list of collections, call the "Add new collection" command and enter a name 
for the collection. 

 

3. Set the composition of the collection. 

 

 

4. Select a collection and click "OK" in the Collection Editor dialog box. 

5. he created collection will look like this: 

 

Creating custom filtering on a table 

In order to create a collection you need to: 

1.  Go to Edit Table Dialog "Main Menu - Rows - Custom Sort...". 
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2. In the list of collections, run the "Add new collection" command and enter a name 
for the collection. 

 

3. Set the composition of the collection. 

 

 

4. Click "OK" in the Collection Editor window. 

Purpose of custom filtering in a table 

1. In the "Row grouping and merging" dialog box add a "User Sort" rule. 

 

2. Select a collection and click "OK". 

3. The custom sort created will look like this: 

 

Important! Collections are saved to the database, they can be used in other objects  
nanoCAD Mechanica 25.  
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Forms and tables have separate stores. 

Collections created by editors or administrators are available to everyone 
and cannot be edited by the user (the collection editing buttons will be 
grayed out). 

User-created collections are only accessible to the user. 

Table resources 

Section Table of resources designed to create a multilingual resource strings details. 

 

In the context menu section, there are options to add and delete rows. 

 

Each resource can have a name (Label), by which it will be referenced from the script (by 
writing the @Resource Name ). The property is selected, the row that corresponds to 
the name of the resource (or its ID) and the column corresponding to the application 



User Guide nanoCAD Mechanica 25 
 

647 

language. Thus, we can ensure the correct operation of applications of different 
locations on the same database. Of course, the current local line must be completed, 
otherwise for non-Russian locale is selected resource corresponding to the English 
language. 

Script 

When switching to the section script in the workspace displays the script object. 

 

In the context menu of the script  contains option parsing script. 

 

While parsing the functions performed consistently script object and passed to the 
notification system error messages. By double-clicking on a line in the notification area 
on the transition line of the script that contains the error. 

 

Symmetry axis 

Main menu: Mechanical - Standard parts - MechWizard > Symmetry axis. 
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Ribbon: MechWizard > Symmetry axis. 

Toolbar: Symmetry axis ( "MechWizard"). 

Command line: MCWIZSYM. 

Select the segment to set it as the axis of symmetry. Drawing can contain multiple axes 
of symmetry. Symmetrical layout sketch relating to a particular axis is determined 
automatically by the recognition of a parametric model. 

Set Parameter 

Main menu: Mechanical - Standard parts - MechWizard > Set Parameter. 

Ribbon: MechWizard > Set Parameter. 

Toolbar: Set Parameter ( "MechWizard"). 

Command line: MCWIZPARAM. 

Button  Set parameter is used for setting targets sketch. Press the button and select the 
object (sketch element). This will bring up a dialog box, the form of which depends on 
which object was selected. 

Setting size 

When setting the size of the dialog box will look like: 

 

Enter a parameter expression to control the size. The parameter can be set by a variable 
name or expression that is allowed to use the number and names of the variables 
related to mathematical and logical functions. 

Important! 
Object parameter names should not coincide with the names of 
the teams nanoCAD (for example, can not be assigned to the 
parameter name HATCH or LINE) 

Expressions can be used the following functions: 

 arithmetic operators +, -, *, / 

 trigonometric functions sin(), cos(), tg() (the function argument is given in degrees) 



User Guide nanoCAD Mechanica 25 
 

649 

 inverse trigonometric functions asin(), acos(), atg() 

 taking the square root function sqrt() 

 exponentiation function^ (recording format: x ^ y - x raising y) 

 absolute value abs() 

 rounded to an integer value int(). 

 
 

Logical operations: 

 Min(x,y) - returns the minimum value of the argument; 

 Max(x,y) - returns the greatest value. 

 Iff (boolean, x, y) - returns the value of the argument x if the logical expression is 
true, or the value of y if the logical expression is false. Example of using the 
function, the result of which is similar to the function Min (x, y): Iff(x<y, x, y). 

Valid logical conditions: >, <, == (equal), ! = (Not equal), > = (not less than), <= (not 
more). 

Function within an expression can be nested. 

Setting the graphic element 

When you set a graphic element sketch (segment, circle arc, circle, spline or shading) 
dialog box will look like: 

 

Work items are supporting the construction of a thumbnail and are not displayed when 
you insert a model from the database. Performance object can be any graphic sketch 
element: line, arc of a circle, etc. 

Setting the insertion point 

When setting the insertion point, a dialog box will look like: 
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Distance along the axes OX and OY determines the position of the handle in the object. 
Distance can be set expression or numeric value. 

Parameter on the x-axis and OX and OY is the name of the script variable whose value 
will change when stretching the handle. 

Button  specify parameter  lets take a parameter or drawing away. 

Enter additional values 
In the sketch may include additional expressions for calculation of parameters. These 
expressions should be written a single line text entry format each line of text as follows: 

X = EXPR 

where X - the variable name; 

EXPR - an expression that contains the names of variables, mathematical or logical 
functions. 

Examples of additional rows of values: 

 a = b*2 - assigning the result of an arithmetic operation; 

 alpha = asin(b/c) - the use of trigonometric functions; 

 k = iff(a>b, 1, 0) - assign a value to the condition; 

 d = min(m1, 100) - the assignment of the smallest of the two values; 

 g10 = sin(alpha*2) + sqrt(b^2 - c^3) / min(sin(a), cos(b)) - nested functions. 

Sequence computing additional rows values - from left to right and top to bottom. 
Additional values values recognizing parametric form must be selected along with other 
sketch entities. 

Insert point 

Main menu: Mechanical - Standard parts - MechWizard > Insert point. 

Ribbon: MechWizard > Insert point. 
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Toolbar: Insert point ( "MechWizard"). 

Command line: MCWIZINS. 

The insertion point should always be shown on the sketch of the parametric model. Click 
to choose its position on the sketch. 

If you try to check the model or recognize the form of a sketch in which the insertion 
point is not specified on the command line, you are prompted to "Select insert point". 
Then you need to specify the sketch position of the insertion point. 

In the case of several insertion points in the sketch, recognition will be considered only 
of the one that has been specified later, and all others will be ignored. 

Suppression contour 

Main menu: Mechanical - Standard parts - MechWizard > Supression contour. 

Ribbon: MechWizard - MechWizard > Supression contour. 

Toolbar: Suppression contour. 

Command line: MCWIZCONTOUR. 

Important! The command prepares the sketch for recognizing the execution type of 
the base object. 

A suppression contour limits the area that the object overlaps with other graphics in the 
drawing. If the suppression contour is not specified, it is created automatically when the 
model is recognized by the external outlines of the part, and service objects are not 
taken into account. 

Procedure 
1. Draw a closed polyline on the sketch that matches the shape and size of the required 
suppression contour (in the figure, a rectangle around the sketch). 
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2. Call the command  "Supression contour". 

3. Specify the constructed polyline. The contour is highlighted in green in the sketch. 

 

A prerequisite for the contour is the absence of self-intersections. To avoid self-
intersections for a compound contour, create the contour manually, leaving a minimum 
"isthmus" between the areas: 
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Wrong Right 

  

If the suppression contour cannot be created automatically (the outer boundaries of the 
object do not form a closed contour), then when the object is inserted into the drawing, 
a corresponding warning message will be displayed. However, errors in the suppression 
contour do not affect the applicability of the recognized object, and can only appear in 
the wrong overlap of other objects in the drawing. 

Hatch contour 

Main menu: Mechanical - Standard parts - MechWizard - Hatch contour. 

Ribbon: MechWizard - MechWizard > Hatch contour. 

Toolbar: MechWizard > Hatch contour. 

Command line: MCWIZSECTCONTOUR. 

Important! The command prepares the sketch for recognizing the execution type of 
the base object. 

A hatch contour defines the shaded area of an object in the drawing. 

Procedure 
1. Draw a closed polyline in the sketch that matches the shape and size of the required 
hatch contour (in the figure, a rectangle around the sketch). 
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2. Call the command "Hatch contour". 

3. Select the constructed polyline. The outline will be highlighted in red in the sketch. 

 

A prerequisite for the contour is the absence of self-intersections. To avoid self-
intersections on a compound contour, create the contour manually, leaving a minimum 
"isthmus" between the areas. 
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Wrong Right 

  

Array 

Main menu: Mechanical - Standard parts - MechWizard > Parametric model. 

Ribbon: MechWizard > Parametric model. 

Toolbar: Parametric model ( "MechWizard"). 

Command line: MCWIZARR. 

1. Create primitives of nanoCAD block and select the required dimensions in the 
sketch to determine its size and location. 

2. Press the array and selected block in the drawing. 

3. In the dialog box, select an array type and parameters that control the 
construction of the array. Parameters can be assigned to both numeric and non-
numeric values (variable names and expressions).  
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Every single unit with a unique name that is inserted into a sketch can be used only in a 
single array. 

Test Model 

Main menu: Mechanical - Standard parts - MechWizard > Test model. 

Ribbon:  MechWizard > Test model. 

Toolbar: Test model ( "MechWizard"). 

Command line: MCWIZ. 

Checks sketch of a parametric model. 

Highlight crossing window thumbnail and press Enter. If the sketch contains no errors, a 
message appears 

If the sketch is not large enough, a message appears warning of an error. 

Create sketch 
The sketch is the original model of the parametric view of the object. 
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When creating parametric objects, the commands of the "MechWizard" toolbar are 
used. 

Procedure 
1. Prepare a sketch. For correct recognition, all graphic elements of the sketch (including 
hatching) must be drawn with the appropriate linetype. Similar types (solid thick and 
thin, dash-dotted thin and thick) should be distinguished by the color set in the 
nanoCAD Mechanicasettings. 
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2. Set the insertion point, optionally specify the axis of symmetry, sketch element 
options, suppression contour, hatch contour and paramentric array. 

 

3. Dimension and assign variables and expressions to them. 

 

4. Enter additional parameters as needed. 



User Guide nanoCAD Mechanica 25 
 

659 

 

5.  Check the sketch and make sure there are no errors. 

 

Examples 

Creating a template layout tiles 
Example of creating a template layout tiles. 

1. Create a sketch of the object. If the size of the tiles will not change, then the sketch 
is not required to specify the size.  
Terms and method of creating a sketch of the parametric object described in 
section Rules for creating sketches. 
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2. Create an object and save it to the database. In a script, you must set the variable 
"type" (strTheType = "Plate")  

3. Position the Bone in the drawing, insert the base of the two vectors and create a 
group. (see. Create user group). These vectors determine the pace and direction 
of replication of the original group. The basic point of the vector must coincide 
with the insertion point of the object. 

 
 

If only one vector will create one line layout in any mode selection area. 
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Developer's Guide Database 

Terms 

Functions of the standard objects 
The database of the standard details was created to help a constructor to create 
graphics. Use the details from the database to create graphics. The standard details 
behave intelligently in the drawing so that the number of additional actions in the 
development environment are decreased.  

What can the standard details do 

Insertion from the database. The database is organized as a hierarchical structure of 
objects having similar functions. (For example, the details of arbors, pipelines etc. are 
grouped). There are also different types of objects: the groups and the markers of the 
objects. You can search for the required standard in the database. When inserting a 
detail, specify the insertion point and the direction of the detail's local X axis (position 
and orientation of the detail). The details can be fully displayed or displayed as a 
representation of the base plane. The position of the detail is specified by a click, the 
orientation by a double-click. 

 

If GOST of the detail contains the table of the parameters, it is recommended to limit 
the dimension values for the elements of the construction. One detail can have several 
tables. (For example, if the parameters of one element of the construction do not 
depend on the parameters of the other elements).  

If the parameters of the object's graphic are not specified by GOST, the user specifies 
their values during insertion. Such parameters are displayed in the second tab of the 
insertion dialog. Such property is the length of the I-Profile. 
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Sometimes it is convenient to specify the parameters in the drawing according to the 
parameters of other details. In this case, dynamical selection of the detail's parameters 
is used. This mode is selected with the Selecting parameters dynamically button. The 
parameters are selected towards the insertion point, after the insertion point is 
specified. Dynamical selection can be executed from the table or by using other 
parameters. The values, selected dynamically, sometimes set additional constraints (the 
maximum and minimum values) to provide correct drawing. 

 

The grips are very useful tools to edit objects, and if the object has grips, they add 
additional functionality to the object. You can move, rotate and mirror the object, using 
the grips; you can also change the standard size of the detail, visually set the detail’s 
parameters and define the direction of the drawing. 



User Guide nanoCAD Mechanica 25 
 

663 

 

The standard database of the program behaves intelligently towards the other objects in 
the drawing. For example, when the pipe fitting with the internal cone is inserted, the 
nipple, inserted after it, will be automatically connected with the fitting.   

 

It is achieved by specifying parametric and geometric dependences between the details. 
The dependences for the details should be set according to the standards.   

The user can set the dependences for the objects already placed in the drawing (for 
example, if the automatic connection is not specified). These dependences are custom 
and are stored in the drawing. 
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The standard databases can also have additional functions that are used in the other 
tools. 

Abstract model of the detail 
A detail should be a black box for the user. 
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To specify a nominal size and graphic of the detail, use its parameters. It is necessary to 
specify these parameters, and not all parameters should be available for the user, but 
they should be known for graphic recognition. There are the public parameters, which 
the user can see, and the protected parameters, which define graphic, but the user 
cannot see them. These parameters can have values, defined by GOST, or the user can 
set their values. 

When editing the detail with grips, you should define their number and the parameters 
they specify; define grips to specify the insertion point and the detail's orientation. 

The view of the insertion dialog (or its data form) is also added to the user interface of 
the detail. Its view and behaviour is the black box of the detail, the form and the dialog 
should be convenient for the user to specify the nominal size and the parameters of the 
detail. 

The geometric dependences are set by the detail's planes, which are a vector and a 
point together. The number and the position of these planes should be defined to set 
the dependences. The planes can be changed if they specify the detail's position 
according to the dependence with another detail, and unchanged (if another detail is 
linked to this plane); they do not change the insertion point of the detail according to 
the dependences.  

The planes are defined according to the local coordinate system. The insertion point is 
its origin (pntOrigin). The direction vector (vecDirection) and vector in the drawing's 
plane (vecPlane), orthogonal to it, are X and Y axes.  
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The mathematically highlighted plane will be in the b/2 horizontal and in the h vertical 
distance from the insertion point. The Vector of the plane will be collinear to the 
vecDirection direction vector. It is enough to specify the new position of the detail if the 
plane is changed according to the dependence. 

 

When changing a detail's parameters (when there are parametric dependences or when 
specifying the values of the parameter in the dialog), it is necessary to define new values 
for the parameters, select new values from the table, change the planes etc. 

To define discrete values of the parameters, select them from the table. The table is 
organized in such a way that one row corresponds with one nominal size and the 
columns of the table contain the detail's parameters. The parameters can have String, 
Integer and Real types. The parameters have a comment, which is used in the insertion 
dialog. Columns and rows have unique identifiers, saved during the import and export 
processes of the table to provide the correspondence of the nominal sizes and already 
existing details in the drawing (selected rows and parameters in the table when editing 
the object).  

Object's graphic 
To display the object in the drawing, the orthogonal views are used. The views have 
different types: general, views with cuts and simple views with dimensions. The views 
with dimensions are system and hidden. Their graphic is realized when the dimensional 
view is inserted from the context menu. 
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The local coordinate system in 2D views is set that the X-axis is directed to the right and 
the Y-axis is directed up in the frontal view. The direction of the coordinate axes is 
defined by the projective dependence in the other views.  

The parametric recognition defines the parameters and the relative position 
(horizontality, verticality, perpendicularity and parallelism) of the graphic primitives and 
their interaction with each other (intersection points, tangents etc.). It is necessary to 
specify the insertion point of the detail (origin of the local coordinate system). It is 
necessary to describe a view as a text (graphic parameterization).  

Recommendations for creating 2D views. 

 Use the object snap for endpoints and intersections. 

 Use the polar tracking and ortho modes. 

 Arc segments and tangent arcs should be dimensioned. 

 Use the helping geometry for recognition (circles in the centres of the tangent 
arcs). 

 Dimension should be clearly set. 

 Sometimes to create a difficult graphic, the view is separated into parts, and null 
distance is set between the parts. 

The purpose of the recognition is to define the position of all primitives towards the 
insertion point. The parameters and dimensions are set from it. 

The requirements to graphic are specified in the particular recommendations.   

To make a 2D graphic parametrically controlled, set the detail's geometric parameters 
as dimensions instead of the nominal sizes. Some parameters are related to graphics. 

Common properties: "Visibility" - is a logic expression or variable, defining whether or 
not to draw the primitive. 

Linetype: 

 0 - main. 

 2 - thin. 

 4 - dashed. 

“Work object” - an object that is used in the recognition, but is not added to the end 
graphic. It is a helping drawing. 
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Parameters of hatch - the angle of slope, hatch space and double hatch feature (logical 
condition) 

Parameters of ellipse - the major axis of the ellipse and the minor axis of the ellipse. The 
start angle and end angle of the ellipse - if the elliptic arc is drawn.  The sloping angle to 
the OX axis is an angle, on which the local coordinate system of the ellipse is relatively 
rotated to the coordinate system of the object’s view.  

Parameters of spline - the start and end tangent angle. All points of the spline should be 
dimensioned. 

If the hatch contour does not follow the required contour, a closed polyline is created 
with the parameter - hatch contour.  

Sometimes it is necessary to set a contour of suppression for the detail (if the 
automatically created contour does not follow the requirements of the detail). In this 
case, the parameter of the suppression contour is also set for the closed polyline.  

Creating the dimensional views of the standard details 

The same graphic is used to create the dimensional views of the standard details, as is 
used to recognize the main view. 

Add only the required elements to the graphic of the dimensional view. 

To recognize the dimensions as constructive objects, switch off the Work object 
checkbox in the Parameter dialog. 
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After that, specify the required view of the object and select Hidden view and 
Dimensional view for it. 

 

Select the Recognize view from the context menu. 
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Specify the graphic in the drawing and confirm the selection. Save the object. 

To test the dimensional view, insert the object with the created direction of view. From 
the context menu of this view, select the Add dimensional view. 

 

Specify the insertion point of the dimensional view. 
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Note: 
Dimensional views are inserted with the current dimension style 
and symbol scale. 

Details in the database. Dependences 
The details can be connected with each other. How does it happen By setting the 
parametric and geometric dependences. The parametric dependence - an expression 
meaning that one parameter of one object equals one parameter or the arithmetic 
expression of the parameters of another object. For example: the diameter of the bolt 
thread should be equal to the diameter of the screw thread which it is connected with. 
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The thread diameter parameter (dr) of the screw is equal to the thread diameter 
parameter (dr) of the bolt (dr=dr). 

 

When setting the support for the shell, the dependence of the parameters' arithmetic 
expression is set: the diameter of the support is equal to the sum of two shell widths 
and the inner diameter of the shell. DA=D+2*s. 

When setting the dependences there are a child and parent objects, the dependences 
can be one-directed and two-directed. The one-directed dependences affect only the 
child object (change of the parent object affects the child object, but change of the child 
object does not affect the parent object), the two-directed dependences affect two 
objects, change of one object affects the other object. 

The geometric dependence between the objects is realized by movement and 
reorientation of the objects. The new position of the object is calculated according to 
the new position of the object's planes. 

The views of geometric dependences: 

INSERT - the combination of the insertion points and planes' vectors. The function has a 
parameter - offset - the distance between planes' points of the detail along the OX axis. 
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MATE - the collinearity of the direction vectors if the abscissae of the details are 
relatively equal. There is a parameter - distance along the OX axis.  

AXIS - the combination of the direction vectors with the unfixed coordinates along the 
OX axis. The parameter of the dependence - distance along OY axis. 

The combination along direction (angular dependence) - the collinearity of the direction 
vectors with the unfixed relative coordinates.  

The geometric dependences can be codirectional and opposite directional according to 
the orientation of the local vector of the OX axis. 

There is no need to connect all objects with all objects and that is why it is necessary to 
set the dependences automatically. The classification of the objects is set to define what 
details should connect with each other. The classification is made according to the 
number class (used in the program tools) and the public parameters of the object. These 
are strTheName, strTheType and strTheSubType variables. To connect a bolt and a 
screw there is a check of these variables and, if they coincide, the dependence is set. 
Fasteners are connected only with fasteners, not with pipe fittings, but both types have 
the thread diameter parameter. Every object has a unique identifier, used for the 
insertion from the browser.  

Suppression contour and display order 

Graphics, like the standard details from the database, have a suppression contour - a 
closed area, hiding the graphical primitives and other details. (For example, the contour 
of the screw overlaps a line of the bolt.). 

Display order is set by the rZOrder variable. Details with an rZOrder value greater than 
the rZOrder value of other details will overlap them. This property works with the 
intervals divisible by 2000. The object from the database can have a suppression 
contour formed with its outer boundary, a specified suppression contour or have no 
contour at all.  
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Eventive Object's model 
Flowchart of the script's functions.  

 

ActHeader - the description of the object's parameters. It includes the description of the 
public and protected parameters, specification of the reserved variables and description 
of the subobjects. 

During every activation of the object, the OnInitialization function is executed. Using set 
variable the single setting of the object's parameters needs to be checked.  

The OnDialog function is activated after specifying the insertion point and direction 
from the context menu during the dynamical selection of the parameters. 

The OnDialogChanged allows you to add interactivity in the insertion dialog of the 
object. It is executed every time the parameters are changed in the dialog. In the 
function’s body, it is possible to hide the controls to provide the correct selection of the 
object's parameters. 

The OnInitSelect is executed before the dynamical selection of the parameters.  There is 
a tooltip string (for example, the current value of the length). 

The OnSelectParam is executed during the dynamical selection of the parameters. It 
defines what and how parameters should be selected. It usually contains checks of 
request number for the selection of the parameters and checks of the current view.  

The OnMakeParameters function is final. All final calculations of the parameters are 
executed and the classifiers and planes are specified. As this function is executed after 
all object events, the constraints for the parameters and the relative selection of 
implementations are added. 

The SetGripPoint function sets grips for the object. Their number and position are set 
there. 

The OnMoveGripPoint function receives the number of the edited the NMovingGrip 
grip, the relative position of the grips is processed and the object's parameters are 
changed according to it. 
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The BeforeConnect is executed before the dependences are set. The previous 
dependences are reset and a tooltip string is specified when selecting the object to 
connect.  

The OnConnect function is executed when one object is connected to another object. It 
contains a check of the object's classifiers and operators for setting the dependences 
according to this check. 

As the result of the OnConnect is a new value for the connected object, this is received 
as a new object. The OnChangeParameters function is executed when the object's 
parameters are changed according to another object's parameters using the parameters 
toolbar. This function determines the object's reaction to changing its parameters. 

Localization mechanism 
The following is a mechanism of localization: 

The object's implementations are activated by their system names, which can be 
changed in the context menu of the Master of Objects. 

 

Activation of the implementation in the script: 

   if (strDesignName == "Implementation 1") { 
      strPartName = @BOLT_M+dr+step+" # x"+L+@___GOST_7798_70; 
   }; 
  

If the use of the string values in the local coding is required in the script, change them 
with the resources. 

The resource is a reference to the table row containing the list of the string values 
according to the current application language. 
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To use the local resource in the table, call its name (Label) with "@" prefix.  

   Public( 
      L, @ROD_LENGTH, 
      dr, @THREAD_DIAMETER, 
      WP1, @WORK_PLANE_1, 
      swTr, @SMALL_THREAD_STEP, 
      rScrewOk, @BOLT_OK, 
      s, @BOLT_HEAD_WIDTH, 
      b, @THREAD_LENGTH, 
      massa, @MASS 
   ); 
  

When the script is executed in the specified location, the required values will be 
selected instead of the @<resource name> references: 

   Public( 
      L, "ROD_LENGTH", 
      dr, "THREAD_DIAMETER", 
      WP1, "WORK_PLANE_1", 
      swTr, "SMALL_THREAD_STEP", 
      rScrewOk, "BOLT_OK", 
      s, "BOLT_HEAD_WIDTH", 
      b, "THREAD_LENGTH", 
      massa, "MASS" 
   ); 
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Requirements of the objects 

Requirements of the standard details 
The required functionality means that the objects can be inserted from the database, 
their parameters can be specified, changed, the details can be connected with each 
other etc. 

The details should satisfy the standards (GOST, ISO, etc.) and engineering practice. It is 
required to follow not only the table parameters but also ESKD, Mechanical etc. 
requirements. The details should not break the rules of design and product 
documentation. 

Standardization. To make the creation and classification process of the standard details 
easier, use similar graphics for the details that have similar functions. 

As the database is used in multilingual applications, it can be localized; the names 
should be correctly displayed in English or in Russian. 

The situation, where several people have developed ONE GOST, is very common. The 
standardization helps to transfer the product from the developers to the 
users.  Everybody should understand how the scripts are created. 

Requirements of the objects. List of the requirements. 
Graphic and script creation of the objects from the 
database using MechWizard 
The requirements should be applied for the newly created and edited objects from the 
database. 

Object's properties 

The name of the object should contain the name and number of its standard (for 
example, "GOST 7798-70", "ISO 657/16"). 

The comments attached to the name should contain the object's name according to the 
standard (for example, "Hot-Rolled I-Shape with Sloped Flange"). 

The specification string should be specified by the strPartName variable. 

All the comment fields of the table parameters from the DBFLD and DBINF sections of 
the UniDialog function should be filled in with the descriptions. All the comment fields 
of the table should be filled in. 

It is recommended to group the table fields so that they have the main parameters 
grouped to the left. 

By default, the name of an implementation is "Implementation1" (without space), if 
another name is not specified by the standard. 
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If the Russian standard is used, GOST is set in the properties (if the detail was made by 
OST, TU or ATK). 

Parameters 

When creating the parameter's name you should take into account: 

1. Similar parameters of the objects from the database (for example, dr - thread 
diameter, p - thread pitch, L- rod length). 

2. Names of parameters in the standard (for example, D1 - flange outer diameter, Dy 
- drift nominal diameter, b - thread length. The function of the parameter should 
be specified by the comment in the table or by description of the public 
parameter. 

3. Rules of the variable’s name for C language. 

Rules to define the variables: 

 Identifier is a sequence of symbols, which are variable’s, function’s or operator’s 
names. 

 Identifier can consist of Latin letters, numbers and underscore character. 

 Identifier should be started from a letter or underscore character. 

 Identifier, consisting of the same sequences of symbols but in a different case 
(upper/lower case), are different identifiers. 

 Maximum length of the identifier is limited to 50 symbols. 

Recommendations for variables names: 

 Use prefixes for variable types (r - real, i - integer, str - string, b - logic, vec - vector, 
pnt - point) 

 Use descriptive variables’ names (for example, rLength instead of L, bSection 
instead of sh) 

 Use different cases of letters in the long names of the variables (for example, 
rWP2offset, bUseFlatSeal) 

The parameters should be described as public if:  

1. It is needed to specify a connect for the object 

2. It is needed to specify a nominal size for the object (the parameters are important) 

3. It is needed to extract the parameter for further use (by universal marker or to add to 
the table fields and etc.) 

In any other cases the parameter should not be added to the public section. 

You can specify only values of the strTheName, strTheType and strTheSubType variables 
in English. The values of these parameters should be specified in a way to provide the 
maximum standardization of the connect procedures. 
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All parameters of the Public type should have descriptions. This also applies to the 
descriptions of the working planes. The descriptions of the parameters should be 
started from the object noun (for example, "Bolt head width"). 

It is not recommended to describe the parameters with dimensions in the Public 
section. The descriptions of parameters in the table and in VFLD field can have 
dimensions. In this case, the dimension is specified in SI units after a comma (for 
example, "Outer diameter, mm"). 

All parameters names of the VFLD and BFLD sections should be filled in. It is not allowed 
to use the variable name as the description of the variable (e.g.  L,”L”). 

If the preview is set with the dimensions of the detail, it is allowed to use the comments 
of any parameters in the VFLD L, "L, Length". 

It is recommended to specify the description for all parameters used in the script (as 
comments). 

If a detail’s mass is specified in the standard, it should be added to the public 
parameters and in the UniDialog DBINF section. 

The mass of the detail is specified as a "massa" parameter and in kilos per one detail. 

If the mass of the implementations is specified in the table, these parameters have 
names: massa1, massa2 and etc. 

To provide the correct localization of the scripts, all string values should be references to 
the resources, except for the implementation’s name strings, strTheName, strTheType, 
strTheSubType classifiers, form names etc. 

Resource names are specified in English upper case letters without spaces.  

For example: 

 @DIAMETER_OF_THREAD 
 @WORKING_PLANE_1  
      

The system names should contain only English letters. 

Script 

It is recommended that the comments are created in English 

It is not recommended to place several operators in one line. 

When creating the script, follow the order of the functions: 

1. ActHeader() 

2. OnInitialisation() 

3. (Custom functions) 

4. OnMakeParameters() 

5. SetGripPoint() 
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6. OnMoveGripPoint() 

7. OnDialog() 

8. OnDialogChanged() 

9. OnChangeParams() 

10. OnInitSelect() 

11. OnSelectParam() 

12. OnMenu() 

13. BeforeConnect() 

14. OnConnect() 

The operators, setting the strPartName and strPartDescription variables, should be 
placed at the end of the OnMakeParameters parameters. 

The script version and the GOST description should be placed in the first lines of the 
script. General comments of the object can be placed after them. For example: 

   SVersion = 2; 
     ObjectDescription = "GOST 19425-74"; 
     // Slope of flange should be taken 
     //between 4 and 10%. 
     //In particular 8% 
      

It is recommended to use the tabulation to specify an offset for the composite 
statement and is not recommended to use spaces. 

Composite statements should satisfy the following requirements: 

 Open bracket is on the same level as the statement 

 Nested statements are placed in the same level with the 1 Tab offset. 

 Close bracket is on the same level as the composite statement. 

Example: 

 function OnConnect { 
     if (rPart == 0) { 
         if (obj.strTheSubType == "vaBottom") { 
             setWorkId (0, obj.objectID); 
             Handled = OBJ_HANDLED; 
         }; 
         if (obj.strTheSubType == "vaShell") { 
             setWorkId (1, obj.objectID); 
             Handled = OBJ_HANDLED; 
          }; 
      }; 
     … 
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 }; 
  

The UniDialog function should satisfy the following requirements: 

 The Function is formed as a composite statement 

 Every keyword is started from a new line 

 Every option of multi-version sections starts from a new line with the offset. 

Example: 

 UniDialog( 
   DBFLD, seria, h, b, 
   DBINF, num, mas1, 
   VFLD, 
     L,"length of I-Profile, mm", 
     strRefDataHeader,"Reference data:", 
     A, "A, sm^2", 
     Ix, "Ix, sm^4", 
     ix, "ix, sm", 
     Wx, "Wx, sm^3", 
     Sx, "Sx, sm^3", 
     Iy, "Iy, sm^4", 
     Wy, "Wy, sm^3", 
     iy, "iy, sm", 
   BFLD, bHid, "Show hidden lines", 
   TVIDS,lViewType,"AnyWBK", 
   VIEW,"Vids" 
 ); 
  

It is recommended to break difficult arithmetic expressions over several lines, or use 
several additional variables. 

It is recommended to use the descriptive comments to group lines of the code which 
have a close logic structure (for example, block of statements to specify working planes 
etc.). 

Graphics 
The drawing should provide recognition of the parametric 2D view of the object from 
the database with maximum legibility and contain all required views for the element 
(including the graphic for which the preview was created). 

The expressions "single parametric element from the database", "detail" and "GOST" (in 
lower case so that the letters are not confused with the standards) are set as equivalent. 
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The drawing of the detail or details should be created in one file. The file name should 
contain all the numbers of the standards used to create the detail and, if needed, the 
description. (for example, "GOST 7798-70 Hexagon Head Bolts Product Grade A"). 

General requirements 

By default the scale is set 1:1. The scale to draw a graphic is selected by the user, but the 
drawing should be legible. It is recommended to draw a detail according to its values 
from the table.  

All objects are drawn in the model space. Default settings are used to create elements. 

Layers 

By default the line width is set to default for all layers and objects.   

Layers, used for the drawings: 

Layers name Parameter - linetype 
of the object 

Colour Objects 

MAIN 0 or not specified White Objects, which should have this linetype 

Insertion point 

THIN 2 Red Objects, which should have this linetype 

Hatch 

DASHED 4 Green Objects, which should have this linetype 

AXIS Specified by the 
command 

Red Objects, which should have this linetype 

WORKING Checkbox "working 
object" 

Yellow Objects, which should have this linetype 

DIMENSIONS Not specified Blue Dimensions and text formulas 

Names of GOSTs, implementations, 
views and other comments 

The "centre Line" parameter should be set for graphic objects after their replacement 
on the specified layer. 
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Placement of graphic 

The separate details and the separate implementations of one GOST should be 
separated from the other GOSTs and implementations in the drawing (zonally or with 
the rectangular frames).  If there is more than one GOST or implementation, the GOST 
number or implementation name should be written above of the group of 
implementation or GOST views. 

The views should be in the projective connection in the drawing. 

 

Figure 1. Placement Drawing Views. 

The views, which are out of the projective connection, should have clear names to 
define the relation. 

It is recommended to group the views with cuts, simplified views and views with 
dimensions near their projective views. 

If one or several views belong to one GOST/implementation, they should have clear 
names to define the relation (for example: "Left-side view (all implementation)", 
"Frontal (GOST 7798,7805, 7806)"). The graphic of the details view should have a name. 

The detail should be oriented that the detail's direction (vecDirection of script) should 
coincide with the OX axis (to the right for the frontal view).   

Dimensions 

To set the dimension, take into account: 

1. Correct recognition; 

2. Legibility of the drawings; 



User Guide nanoCAD Mechanica 25 
 

684 

3. Unified system for design documentation requirements. 

It is not permitted to place the dimensions inside the hatched area (the hatch is not 
allowed to flow over the dimension values).  

Hatch 

Hatch should be executed by the "User defined" type, slope angle 45 degrees. A hatch 
step should be specified parametrically according to the width of the narrowest hatched 
part (s): 

For example: 

1. For thin-wall objects: s/2; 

2. For massive objects: s/8; 

3. Intermediate step: s/4. 

A hatch type can be specified in absolute units divisible by 10 (0.1;1;10;100) 

You can ignore these rules if you need to hatch in both sides. 

Parameters 

Using the "Set parameter" tool, set the parameter for the dimensions. It is possible to 
switch off the "Work object" checkbox for the dimensional view only. 

It is recommended to avoid text formulas in the drawing fields (place the calculations in 
the script).  

Text formulas are allowed to be placed in the drawing, if you need to calculate the 
parameters of the implementation's view and it is defined that their use is not needed in 
the script. 

Use of non-English letters is only allowed in the names 

When specifying the parameter's name take into account: 

1. Similar names existing in the database 

2. Parameters names in the GOST 

3. Meaningful parameters names, corresponding to the syntax of the C language. 

If possible, avoid difficult arithmetic expressions set in the dimension parameters (it is 
recommended to use the Protected variables). 

Other requirements 

The views names should be specified with text of 10mm height. Text formulas should 
have the text height of 5 mm. The views names are placed above the view, text formulas 
are placed below the view. 
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Specify meaningful names for the blocks in the array in English (for example, hole, 
chamfer etc.). The insertion point of the blocks, used for creating an axial array, should 
be placed in the centre of the axial array. 

It is possible to add an image of the detail, copied from the GOST, into the drawing field, 
if it does not cause difficulties in legibility and overlap other objects.  

Syntax scripting language 
Script - is the code in a language similar to SI, which determines the nature of the object 
database software parameters, the plane impact on the response object. Automatic 
installation of dependencies, etc. A script comprises a series of blocks, which perform 
defined events from outside the object. 

Identifiers 
Identifier is a sequence of characters representing the name of a variable, function, or 
operator. Rules describe identifiers MechWizard similar to the rules in C: 

 Identifier can consist of letters of the alphabet, numbers, and the underscore 
character. 

 The identifier must begin with a letter or underscore. 

 Identifiers consisting of identical sequences of letters, but in a different case 
(uppercase / lowercase) are different identifiers. 

 The maximum identifier length is limited to 50 characters. 

Recommendations to the name variable names are listed in the document. 

Keywords 
Keywords - are reserved identifiers that are endowed with a certain sense. They can be 
used only in accordance with the value of the known macro-language interpreter. 
Keywords cannot act as an identifier. 

List of key words listed in the annex. 

Data Types 
In the macro language, there are five main types of data: 

1. Valid floating-point number (double analogue in C). Range-1.7e308 .. 1.7e308. 

2. Line. 

3. Three-dimensional point (Point) 

4. Three-dimensional vector (Vector) 
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5. Plane defined by the reference point and a normal vector (Plane). 

The script made an agreement to the names of real type variables prefixed r, to add a 
prefix to a string variable str or s, to the point type variables prefixed pnt or p, the 
variables of vector type to add a prefix or vec v, and the plane denoted WP (WorkPlane). 

Initialization of variables is carried out without prior specification as in BASIC. To declare 
a variable, you just need to assign it a value. If the variable is not described in the 
header function in the sections ActHeader Public or Protected, it will be considered local 
and will retain its value from the first moment until the end of the definition, in which it 
is described. 

    StrName = "ObjectA"; 
     rPI = 3.1415926; 
     rA = 2.0; 
  

To initialize the points and vectors used special constructor functions Point (), Point (x, y, 
z), and Vector (), Vector (x, y, z) respectively. 

    pnt2=Point();//handle length  
     pnt1= Point(1.0, 10.0, 10.0); //This is the point with specific coordinates 
     vec1 = Vector(); // vector of unit length, which coincides with the axis OX (1,0,0) 
     vec1 = Vector(1.0, 1.0, 0); //Vector specific coordinates 
  

To separate the coordinate point or vector can be accessed using the qualifier: 

    pnt1:x = 12.5;//Removing the abscissa of the point 
     vec1:y = 25.6;//Removing the ordinates of the point 
  

Plane used to initialize a constructor function Plane (pnt, vecNormal). 

     WP1 = Plane( pntBase, vecNormal ); 
     //pnt- This is the basic point for the plane WP1 
     //vecNormal- This is the normal vector to the plane of WP1        

Eg 

     WP1 = Plane( pntOrigin, vecDirection); 
  

Indexing variables 

If you declare a number of variables of any type with names that differ only by the 
number in the end, then these variables can be accessed by index, as an array. 

    rParam1 = 1.0; 
     rParam2 = 2.0; 
     rParam3 = 4.0; 
     ... 
     rParam[2] = 45.7; 
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     rParam[3] = 9.1223; 
  

Comments 
Comments in the script begins with the double slash line and ends at the end of the line. 

    //First set up a plane in counter-clockwise order 
     vecNormal=getLocalNormal(vecDirection,vecPlane); 
       
     WP1 = Plane( pntOrigin, vecDirection ); 
     WP2 = Plane( pntOrigin-vecPlane*(0), -vecPlane ); 
       
     //Right side 
     WP3 = Plane( pntOrigin+vecNormal*(b/2), vecNormal ); 
     WP4 = Plane( pntOrigin+vecNormal*(b/2)+vecPlane*h, vecNormal ); 
       
     WP5 = Plane( pntOrigin+vecPlane*(h), vecPlane ); 
  

Operators 
All operators of the macro language can be divided into the following categories: 

 arithmetic operators 

 Boolean operators 

 conditional operator 

 loop operator 

 other operators (empty statement, the assignment operator, the operator access 
to internal members) 

All operators end empty statement - a semicolon ";". 

Empty operator 
Empty statement consists only of a semicolon. When this statement is executed, 
nothing happens. This statement is a delimiter for other operators, functions, and lines 
in the script. 
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Composite operator 
A compound statement is a few operators and announcements enclosed in curly braces 
{}. Execution of the compound is in the sequential execution of its constituent 
operators. At the end of a compound statement the semicolon is placed. 

The assignment operator 
The assignment operator is denoted by the sign of equality. 

expression A = B; means that variable A is assigned the value of expression B, and the 
type of the variable A type of expression is established B. 

Operator access to internal members of the complex data 
types 
To access the internal members of the complex data types, a special qualifier operator 
":". For example, it can be used to access the individual coordinates variables of type 
Point and Vector. 

Arithmetic and logical operators 
Syntax of arithmetic and logical operators in macro language script syntax is similar to 
SI. 

Arithmetic Puzzle 

A + B Addition A == B A is equal to B 

A - B Subtraction A != B A nonequilibrium In 

A * B Multiplication A > B A more in 

A / D Division A < B And in less than 

    A && B A and B 

    A || B A or B 

For arguments of type Point subtraction result is a vector. A multiplication of a vector by 
a new vector will equal the scalar product of the vector by. 
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    vecDirection = pntEnd - pntStart; 
     vecScaled = vecDirection * rScale; 
  

The conditional operator 
Format statement: 

if ( <expression> ) 
     operator_IF1; 
 else 
     operator_ELSE1; 
     //<expression>- it is a logical condition to perform operator 

As operatora_IF1 and / or may act _ELSE1 composite operator, ie group of statements 
enclosed in braces. 

Execution if the operator starts with the evaluation of expression. 

Further execution is as follows: 

 if the expression is true (ie, different from 0), then the operator _IF1. 

 if the expression is false (ie, equal to 0), then the operator _ELSE1 

 if the expression is false and there is no operator _ELSE1, then the following if 
statement in 

Block of statements after else may be missing along with the word else. In this case, the 
conditional statement is as follows: 

if ( <expression> ) 
     operator_IF1; 
  

As an expression can be any logical or arithmetic operator or a sequence of statements 
separated by parentheses. 

if (A>1) 
     operator_IF1; 
 if ((A>1)&&(B<5)&&(C==25)) 
     operator_IF1; 
  

You can use nested conditional statements, ie conditional statement can be included in 
the design if the design or else another conditional statement. 

if (A > 1){ 
     if (B < 5){ 
         if (C == 25) 
             operator_IF1; 
     } 
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 }; 
  

Cycle Operator 
Format statement: 

while (expression) 
     operator_BODY; 
  

Requirements for the expression, such as in the if statement. _BODY Operator called the 
loop body. 

Executing the cycle begins with the evaluation of the expression. Further execution is as 
follows: 

1. If the expression is true (not 0), the loop body is executed. 

2. If the expression is false, then the next while the operator. 

3. The cycle is repeated from step 1. 

Functions 
Function - a set of operators and other function call. Each function has a name. Function 
declaration begins with the keyword function. The function body is enclosed in braces. 
In this version of the browser functions have no parameters. 

Format function: 

function Function_Name{ 
   operator_1; 
   ... 
   operator_N; 
 } 

Allowed to call one of the other functions, but called from funcA functions must be 
declared above in the body of the script. 

Example: 

function user_Function_1{ 
   MessageBox("This is my first feature"); 
 } 
 function OnInitialization{ 
   user_Function_1(); // The correct call. The called function is declared above! 
   user_Function_2(); // Wrong call. The called function is declared below! 
 } 
 function user_Function_2{ 



User Guide nanoCAD Mechanica 25 
 

691 

   MessageBox("This is my second feature"); 
 } 

The interpreter has a number of built-in functions as listed in Appendix 2. 

Specifying the object plane 
Target abstract object geometry (points vectors planes) may be in coordinate form 
(almost not used) or relative to the local coordinate system. Position of the points 
defined by specifying operators addition point and plane. In the example, the position of 
the reference point is defined as the plane 

    pntWP4=pntOrigin+vecDirection*(b/2)+vecPlane*h 
  

Normal vector of the plane collinear insert vecDirection 

 

Consequently, she illuminated plane WP4 will be set as 

    WP4=Plane(pntWP4,vecDirection); 
  

If the surface normal vector is not orthogonal coordinate system, it is often determined 
by the operator or RotateBy GetLocalNormal. 
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For example, for lining the conical bottom, surface normal vector is defined as the WP2 

    vecNormal=getLocalNormal(vecDirection,vecPlane); 
     vecFitting = rotateBy(vecDirection,90-ang/2,vecNormal); 
     //ang - is the angle of the bottom in terms of 

Apart from the above identified, operators are used to find the vector normal plane and 
the base point: 

    pntWP1 = Point(WP1); 
     vecWP1 = Vector(WP1); 
  

To find the distance between the point and the plane used the difference point and 
plane 

    rDistance = WP1-pntOrigin; 
  

Vector length (distance between points) define the operator vecLen: 

 rLength = vecLen(pntWP1 - pntOrigin); 
  

Orthogonal vector operator is getPerp: 

vecPlane = getPerp(vecDirection); 
  

Worksheet 
To work with the table object used by two operators and LoadInCache SelectInCache. 

The operator loads the LoadInCache specifies the parameters in the cache of the table. 
This operator in the new versions must be called only when the sample is forced with an 
expression to evaluate the parameters of the (..., "+", ...). 
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SelectInCache operator selects from the table according to the specified criteria (see 
syntax in the appendix) 

Sampling by "kFirst" selects one first row. Sampling by "kFilter" selects a range of 
records from a table that match the specified filter. 

Dining sample-specific parameters "~" - the approximate equality parameter selects the 
value in the record. "=" - An exact equality, "+" - the sample on the filter. Picks by filter 
oznachet that if the logical filter condition is satisfied, then the record is selected from 
the table (subjected to further checks on the conditions). 

For example, the 

SelectInCache("kFirst", "dr", "~", rdr, "L", "+", "L>=rMinLen&& L<=rMaxLen&& (L-
b<=rTrLen)"); 
  

selects the first record of the table, where the combination of parameters dr, L, b such 
that dr?rdr, rMinLen<=L<=rMaxLen, (L-b)<=rTrLen. 

Function SelectInCache important order of the sampling conditions. This means that in 
the first place will be selected from the table entry corresponding to the first condition, 
then - of which selects records corresponding to the second condition, etc. 

If there are multiple items in the tables, then the coincidence parameter names must 
enable the checkbox "Use the table name as a prefix to the parameters" in the context 
menu of the corresponding table. 

In this case, an appeal to the parameter in the script will be as follows: 

 <Name of the table>.<Parameter name> 
  

For example: 

If (Table0.dr==Table1.Thread1) { 
   ... 
 }; 

To provide a sample of the first table is not necessary to modify the operator 
SelectInCache. 

For example, if you need to select from the table Table1 parameter dr, equal to 10, then 
the first condition in the operator to select from a table must follow the table index 
(starting from 0): 

 SelectInCache(1, "kFirst", "dr", "~", 10); 
  

For a table with imenenm Table0 table name can be omitted. Ie it is also true, and 
another expression: 
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SelectInCache ("kFirst", "dr", "~", 10, "L", "~", 50); 
 SelectInCache ("0","kFirst", "dr", "~", 10, "L", "~", 50); 
  

Dialog object. Making function UniDialog 
View Insert Object dialog box is defined by specifying the key features UniDialog. 

See the appropriate section of the application. 

It should be easy to compare that 

DBFLD - the defining table parameters. 

DBINF - reference table settings. 

VFLD - are arbitrary parameters and reference data. 

VIDS - a list of versions of the object (possibly omitted if there is only one execution. 

TVIDS - different views of the same design (possible keys - by type, All - those present, 
AnyWBK - opposing views generated mirror (for symmetrical objects). 

VIEW - thumbs species. 

Key OnDglBeforeSelParam in ActHeader determines whether the dialog is called before 
the dynamic parameter selection. 

Connecting UserForm 
If an object is given shape, then in order for it to be called, you need to function in place 
of the function OnDialog UniDialog cause concrete form. 

For example, if the object is given form named frmMain, you should write the following: 

functionOnDialog{ 
   ShowForm("frmMain"); 
 } 

Similarly, the terms can cause several different forms of the object, referring to them by 
name using the operator ShowForm. 

Set dependencies 
Operators set up dependencies implement geometric and parametric dependence. 

Parametric dependencies 

SetParamConstraint(< param >,obj,EXPR,< expression to constrain>,bBidirect); 
  

<param> - name of the parameter object to which the time dependence. 

Obj - which object set. 
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EXPR - so far only the dependence on the expression 

<expression to constrain> - arithmetic combination of parameters on which dependence 
is placed (must be in quotes). 

bBidirect - bidirectional or unidirectional relationship. 

Geometric constraints 

SetGeomConstraint(rTYPE, rDIRECTION, obj, < WPname >, < WPtoConnect 
>,offset,bBidirect); 
 SetGeomConstraint(ANGE,CODIRECT,< obj >,< wpSourcePlane >,< wpObjPlane >,< 
rAngle >,< bBiderect >); 
  

Types of dependencies rTYPE = INSERT (inset)) MATE (alignment on the plane) AXIS 
(alignment axis) DIRECTION (aka ANGLE) (angular orientation). 

Direction rDIRECTION = CODIRECT (co-directed) CONTRDIRECT (opposite directions). 

<WPname> - The name of the plane, which are attached. 

<WPtoConnect> - The name of the plane, joined. 

Offset - numerical or parametric expression that defines: 

INSERT - axial distance between the planes. 

MATE - the normal distance between the planes. 

AXIS - relative displacement in terms of the axes. 

DIRECTION - angle relative orientation of the planes. 

For dependencies DIRECTION (ANGLE) there are certain conditions: 

Syntax: 

SetGeomConstraint(ANGE,CODIRECT,< obj >,< wpSourcePlane >,< wpObjPlane >,< 
rAngle >,< bBiderect >); 
  

ANGLE - keyword angular dependence. 

CODIRECT - always for the angular dependence. It is believed due to the minimal angle. 

<obj> - which object set. 

<wpSourcePlane> - the plane of the source object to which dependence is placed. 

<wpObjPlane> - the plane of the object to which you subscribe. 

<rAngle> - numerical value of the angle in degrees, depending. 

<bBidirect>=(TRUE,FALSE) - unidirectional or bidirectional relationship. Default FALSE. 

Depending on the type ANGLE should be added after the dependency type INSERT, 
MATE, AXIS. 
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When the dependency type INSERT, MATE or AXIS rotation is relative to the axes of the 
planes dependence. 

In the absence of dependency type INSERT, MATE AXIS or move it in the normal to the 
plane in which both vectors lie in the direction of the minimum angle of rotation. 

If we consider the vectors are collinear, move it about the axis OX. 

Example: 

SetGeomConstraint(ANGLE,CODIRECT, obj,WPnormal,obj.WPnormal,45); 
 SetGeomConstraint(ANGLE,CODIRECT, obj,OYPlane,obj.WP2,15,TRUE); 

Examples of different types of dependency can be found in the appendix. 

Function ShowValue 
Using the debugger windows can detect errors in the script and determine the values of 
parameters during the execution of the script. Syntax, see Appendix. 

Object versioning support 
The object versioning is necessary in order for the new parameters in the updated 
object to be correctly displayed and used on the previously inserted objects. 

The seted protected parameter is used to support the object versioning. The parameter 
is automatically generated when using the script wizard and can be renamed or added 
manually if necessary. 

Consider the script for creating a rectangle (the script is not complete, only methods 
relevant for the example are shown): 

 ........ ... 
 function ActHeader { 
 ........ NPart=0; 
 ........ Public(a,"Length", b,"Width"); 
 ........ Protected(seted); 
 ........ Changeable(a,b ); 
 ........ OnDlgBeforeSelectParam = 0; 
 ........ ShowWhenSelPnt = 1; 
 ........ ContourOnLine = 0; 
 }; 
 ........ ... 
 function OnInitialization { 
 ........ if(seted == UnknownValue) { 
 ........ ........ seted=1; 
 ........ ........ a = 100; 
 ........ ........ b = 100; 
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 ........ }; 
 }; 
 ........ ... 
 function OnDialog { 
 ........ UniDialog( VFLD, a,"Length", b,"Width", TVIDS,lViewType,"All",VIEW,"Vids"); 
 }; 
 ........ ... 
  

The ActHeader method specifies the seted protected parameter and the public length 
and width parameters. 

In the OnInitialization method for an object that has no version, add the length and 
width parameters and set version 1. 

In the OnDialog method, we call a dialog with the width and length fields. 

  

Let's insert an object (hereinafter Object1). When placing an object on a drawing, a 
window with default parameters will open. 

 

  

Suppose we need to add line thickness for the rectangle. 

To do this, we add the "weight" parameter: 

 ........ ...........  
 Public(a,"Length", b,"Width", weight, "Weight"); 
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 ........ ... 
 function OnInitialization { 
 ........ if(seted == UnknownValue) { 
 ........ ........ seted=1; 
 ........ ........ rZOrder=100; 
 ........ ........ a = 100; 
 ........ ........ b = 100; 
 ........ ........ weight=1; 
 ........ }; 
 }; 
 ........ ... 
 function OnDialog { 
 ........ UniDialog( VFLD, a,"Length", b,"Width",weight,"Weight"  
TVIDS,lViewType,"All",VIEW,"Vids"); 
 };  
 ........ ........... ........ ........ ........  
 ........ ........ ........ ........ ........  

  

Let's insert an object (hereinafter Object2). The dialog correctly displayed the line 
weight to us. 

 

  

Let's open Object1 for editing and see that the "Weight" parameter is displayed 
incorrectly. 
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The point is that Object1 already has version (seted) 1 and the weight is not assigned. 

Let's fix the OnInitialization method. If there is no version, we will increase it to 2, add a 
condition if we have version 1. 

 function OnInitialization { 
 ........ if(seted == UnknownValue) { 
 ........ ........ seted=2; 
 ........ ........ rZOrder=100; 
 ........ ........ a = 100; 
 ........ ........ b = 100; 
 ........ ........ weight=1; 
 ........ }; 
 ........ if(seted == 1) { 
 ........ ........ seted=2; 
 ........ ........ weight=1; 
 ........ }; 
 }; 
  

Now objects of older versions will open correctly. 
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Appendix 

Appendix 1. A list of keywords and reserved variables 

SVersion=2; The first line of the script, which determines the 
version of the interpreter 

strTheType Object type 

strTheName Object Name 

strTheSubType Subtype object 

pntOrigin Insertion point 

vecDirection Vector insertion direction 

VecPlane Orthogonal vector to vecDirection 

Scl Object Zoom 
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rZOrder Ranking (used for overlap) 

strDesignName Execution system name 

rXcoord Relative abscissa cursor with dynamic selection of 
the parameters 

rYcoord Relative ordinate cursor with dynamic selection of 
the parameters 

VecCoord Mostly available in OnSelectParam 

VecCoord: X - X coordinate of the relative 

VecCoord: Y - Y coordinate of the relative 

pntGrip# (# Number) point pens with the number # 

rPart Serial number of the request. 

rKbd Flag keyboard input. Equal to 1 if the value is 
entered from the keyboard. 

strPartName Name of detail in the specification (section name) 

strPartDescription Part description in the specification (section 
designation) 

strPromt Help line (in the dynamic selection or when 
selecting items for a connection) 

NSelect The number of requests when inserting objects. 

NPart Number of selectable parameters if 0 or undefined 
then simply called dialogue. 

BreakCur End the current dynamic parameter selection 

BreakAll Complete the entire cycle of selection of dynamic 
parameters 
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NoVectorSelect Does not indicate the vector inserts (used at a 
connection) 

Handled Result processing facility 

NGrip Number of Handles 

NMovingGrip Phone editable pens 

lSimpleView Variable specifies the type of species, UniDialog 
created and installed automatically. 

If == 1 - a simplified view. 

If == 2 - sectional view 

scaleDisable If this parameter is set to 1 in UniDialog prohibits 
the changing Scale 

ShowWhenSelPnt If this box is checked, the object will be drawn at the 
time of insertion, if not specified, it is enabled by 
default 

ContourOnLine Generation circuit is not drawing from a script, and 
on the fly after drawing 

IsAHole The object is a hole (Embedded object) 

OnDlgBeforeSelectParam Call dialogue before calling OnSelectParam. 

IsACalculator Is set equal to 1 for the calculations 

No3dViews Disables automatic views 

AutoShift  Automatic pseudo-pressing of the Shift button 

UseOnlyZOrder Used only for crossing rZOrder, do not use Z-
coordinate 

fUseCommonScale Maintain external control scale 

MINPOSSIBLEVALUE The minimum acceptable value for the application 
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NotStdBody If == 1, then the item is placed in the component 
catalog 

SpecPartition Unit specifications, which gets the item 

UnknownVal=nknownValue=-
0,12345 

The value assigned to the default variable. If the 
variable is not defined, it is assigned a value. 

Filter List function SelectInCache: 

 "kAsk" - Ask the user. 

 "kFirst" - Find the first value in the table that satisfies a specified condition. 

 "kLast" - Find FOLLOWING value in the table that satisfies a specified condition. 

 "kFilter" - all the values from the table that satisfy the specified condition. 

 "kAskIfNeed" - Ask user if the selection was not successful. 

Values that the variable can Handled: 

 OBJ_UNHANDLED - Dependencies are not processed. 

 OBJ_HANDLED - Dependencies processed 

 OBJ_WAITMORE - Waiting for Input 

 OBJ_WAITMORE_M 

 OBJ_WARNING- Error installing dependencies. When returning this code, the 
parent object will seek to establish the same parameters as that of the child, and 
then update the child object is repeated. 

 OBJ_ERROR 

Constants for the variable type lViewType 

 VFRONT - Front view 

 VLEFT - Top view 

 VRIGHT - Bottom View 

 VTOP - Left View 

 VBOTTOM - Right Side View 

 VBACK - Rear View 

Types depending 

 INSERT - Insert 

 MATE - Combination by plane 

 AXIS - Combining axis 

 DIRECTION - Combining the direction 
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 ANGLE - The angular dependence 

Subtypes depending 

 CODIRECT - co-directional dependence 

 CONTRDIRECT - contra dependence 

Recurrence dialog codes or function MessageBox: 

 IDOK 

 IDCANCEL 

 IDYES 

 IDNO 

Codes for the function MessageBox: 

 MB_YESNO 

 MB_OKCANCEL 

 MB_OK 

 MB_ICONINFORMATION 

 MB_ICONQUESTION 

 MB_ICONERROR 

 MB_ICONWARNING 

Example: 

 MessageBox("Test"); 
 if(IDYES == MessageBox("Yes or No", MB_YESNO, MB_ICONQUESTION)){ 
     ... 
 } 
  
  

Appendix 2. Built-in functions 

Mathematic functions to work with the surfaces 

Function Comment 

sin(alfa) cos(alfa) tg(alfa) Trigonometric functions. 

alfa - angle in degrees 

Returns a real number 

asin(c) acos(c) atg(c) Arc-trigonometric functions. 
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c - number 

Returns an angle in degrees. 

DegToRad(deg) Function converts degrees to radians.  

deg - angle in degrees  

RadToDeg(rad) Function converts radians to degrees. 

rad - angle in radians 

int(value) Function rounds a real value to integer  

value - real number  

abs(value) Function gets the modulus of the 
number 

sqrt(value) Functions returns the square root of 
the number 

min(a,b) max(a,b) Function returns maximum and 
minimum numbers from a and b 

iff(expr, a, b) Function is analogue of the if 
arithmetic operator. 

Returns a, if the result of the 
expression expr >= 1, b otherwise. 

VecLen(vec) Function returns the length of the vec 
vector. 

VecUnit(vec) Function gets the normal vector (of 
unit length) from the vec. 

VecCodirect(vec1,vec2) Function checks if the vec1 and the 
vec2 are codirectional. Returns 1 if the 
vec1 and the vec2 are codirectional, 0 
otherwise. 

anglePi(vec1, vec2) Function returns the angle between 
the vec1 and vec2 in the interval from0 
to PI. 
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angleTwoPi(vec1,vec2) Function returns the angle between 
the vec1 and vec2  in the interval 
from0 to 2*PI. 

Point() Point(x, y, z) Point(plane) Function returns a point. Can be used 
as a point constructor. If it is without 
arguments, it returns the P(0,0,0) 
point. If the argument is a plane, it 
returns a base point. 

Vector() Vector(x, y, z) Vector(plane) Function returns a vector. Can be used 
as a vector constructor. If it is without 
arguments, it returns the V(1,0,0) 
vector. If the argument is a plane, it 
returns a normal.  

Plane(pntBase,vecNormal) Function is a constructor of the plane. 
Returns the plane containing the 
pntBase point and having the 
vecNormal normal. 

getPerp(vec) Function returns a vector, orthogonal 
to the vec vector.  

rotateBy(vec1,rAngle,vecNormal) Function rotates the vec1 vector by 
the rAngle angle (in degrees) in the 
plane, having the vecNormal normal. 
Returns the result of the operation. 

getPerpendicular(pnt1,pnt2,pntFrom,pntBase) Function returns the length of the 
perpendicular from the pntFrom point 
to the line, specified between the pnt1 
and the pnt2 points. In the pntBase 
variable, the point of the 
perpendicular base on the specified 
line is returned. 

getMiddle(pnt1, pnt2) Function returns a point in the middle 
of the line, specified by the pnt1 and 
pnt2 points. 
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 getLinesIntersect(pnt1,vec1,pnt2,vec2)  
 getLinesIntersect(pnt11,pnt12,pnt21,pnt22) 
       

Function returns a point of intersection 
of the lines, specified by the pairs of 
the points: [pnt11, pnt12] and [pnt21, 
pnt22] or by a point and a vector: 
[pnt1, vec1] and [pnt2, vec2]. 

if the lines do not intersect, the Z 
coordinate is -1 in the returned point. 

getLocalNormal(vec1,vec2) Function returns a vector product of 
the vec1 vector and the vec2.vector. 

 projectOnPlane(pnt,plane2,rDistance)  
 projectOnPlane(plane1,plane2,rDistance) 
       

Function returns a projection of the 
pnt point in the plane, placed in the 
rDistance distance from the plane2 
plane. 

If the plane is a first argument, the 
function returns the plane through the 
Point (plane1) point projection on the 
plane, placed in the rDistance from the 
plane2 plane and having a normal 
vector, coinciding with the normal 
vector of the plane2 plane. 

Subtraction of the point from the plane Example: 

d = WP - pnt; 

Operation returns the distance of pnt 
point from the WP plane. If point pnt is 
on side where normal of WP plane 
points, direction is positive, negative 
otherwise. 

Formation of the string by the numbers To the string variable you can add a 
number. The result is a string. 

Example: 

 A = 1;          
 B = 5;          
 Str = "Type " + A + ". Modification " + B 
+ "."; 
        

The result is a string 
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"Type 1. Modification 5." 

FmtText(text, number, formated_text,...,) Returns an rtf text, if among the 
parameters there is even one 
formatted, ordinary otherwise. 

Various numbers of the parameters 
can be a result of the function. 
Expressions can be used as 
parameters.  

FmtSuper(Text); FmtSub(Text); FmtSuper() - returns an rtf text, 
formatted as the Superscript (upper 
index) FmtSub() - for the Subscript 
(lower index). 

Text can be a string or a number. 

FmtDiv(Text1, Tex2, Splash) FmtDiv() - returns a fraction, 

if Splash != 0  the fraction will have a 
divisor. 

Example of use: 

a = "super"; b= 1; c = 3; strPosition = 
FmtText(         "beginning of the 
text",         "Upper index-", 
FmtSuper(a),         "Lower index-", 
FmtSub("sub"),         " 
Text",         "Frection- ",FmtDiv(b, c, 
TRUE),         "fraction without a divisor-
",FmtDiv(b, c, FALSE) ); 

FmtDigit(rNumber, rDelimeter) Returns a string, formatted by a 
decimal symbol. 

rNumber - number or string, 
containing a number, 

if the rDelimeter == 0  the divisor is a 
point, 

if the rDelimeter == 1 the divisor is a 
comma, 

if the rDelimeter == 2 the divisor is 
taken from the system local. 
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Example: 

 a = 1.5;  
 Formatted = FmtDigit(a, 1)  
        

As a result the Formatted = "1,5" 

Functions to process surfaces 

Function Comment 

GetNearestPlane(pnt) Function returns the name of the nearest plane 
to the pnt point of the selected object. 

pnt - variable of the  Point type.  

Example: 

 function OnConnect{ 
  if(obj.strTheType == "StdJointParts"){ 
   // ... 
  } else { 
   strName = GetNearestPlane(pntOrigin); 
   if(strName != UnknownValue){ 
    SetGeomConstraint(INSERT, CODIRECT, obj, 
WP1, strName, 0); 
    NoVectorSelect = 1; 
    Handled = OBJ_HANDLED; 
   } 
  } 
 } 
         

 //variant 1 
 findNearest( 
     pnt, 
     Name1, 
     Name2, 
      ... , 
     NameN 
 ) 
 //variant 2 
 findNearest( 
     pnt, 
     arrName, 

Returns an index of the nearest point or plane 
according to the parameters types, specified 
with the Name1, ... NameN or arrName  names. 

Function supports two types of call: 

1) the particular names of the public 
parameters are specified as arguments  

2) the array of the public parameters with the 
starting index for searching and calculating a 
number of the array elements, is specified as 
the arguments 
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     arrIndexStart, 
     arrSize 
 )........ ........   
       

pnt - variable of the Point type. 

Name1, NameN, arrName - names of the public 
parameters of the selected object 

arrIndexStart - starting index for searching in 
the array 

arrSize - array size 

Example: 

 //variant 1 
     rNearest = findNearest(pntOrigin, obj.WP1, 
obj.WP11, obj.WP21); 
     // rNearest takes 0, 1 or 2 values 
 //variant 2 
     rNearest = findNearest(pntOrigin, obj.WP, 1, 
4); 
     // rNearest takes 1, 2, 3 or 4 values........
 ........ ........   
 ........ ........ ........  

 //variant 1 
 nearestPlaneName( 
     pnt, 
     Name1, 
     Name2, 
      ... , 
     NameN 
 ) 
 //variant 2 
 nearestPlaneName( 
     pnt, 
     arrName, 
     arrIndexStart, 
     arrSize 
 )........ ........  
      

Returns an index of the nearest point or plane 
according to the parameters types, specified 
with the Name1, ... NameN or arrName  names. 

Function supports two types of activation: 

1) the particular names of the public 
parameters are specified as arguments  

2) the array of the public parameters with the 
starting index for searching and calculating a 
number of the array elements, is specified as 
the arguments 

pnt - variable of the Point type. 

Name1, NameN, arrName - names of the public 
parameters of the selected object 

arrIndexStart - starting index for searching in 
the array 

arrSize - array size. 

Example: 

 //variant 1 
     strNearest = nearestPlaneName(pntOrigin, 
obj.WP1, obj.WP11, obj.WP21); 
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     // strNearest takes "obj.WP1", "obj.WP11" 
or "obj.WP21" values 
 //variant 2 
     strNearest = nearestPlaneName(pntOrigin, 
obj.WP, 1, 4); 
     // strNearest takes "obj.WP1", "obj.WP2", 
"obj.WP3" or "obj.WP4" values 
      

restoreBasis(vecOld, vecNormal, 
vecNew); 

Function converts an old basis according to the 
new position of the vector. 

Following combinations are applied in the next 
order: 

(x, y, z, newX) 

(y, z, x, newY) 

(z, x, y, newZ) vRrev - previous vNext in the XYZ 

MakeVectorsFromView(lViewType, 
vecDirection, vecPlane); 

Sets the position of the vectors from the view 
type 

Example: 

MakeVectorsFromView(VTOP, vecDirection, 
vecPlane); 

setBasePlaneForSelect(planeName, 
vecPlane = vecPlane); 

Sets a plane coordinate system, where the 
SelectParam will work, i.e. the rXcoord, rYcoord 
will depend on this system. 

Applying. When selecting non-symmetrical 
details whose selection direction depends on 
the fixed plane and the distance is calculated 
from any plane; for example, the standard ends 
of the arbors, not from the pntOrigin. 

Example: 

setBasePlaneForSelect(WP1);  

Used for connecting the ends of the arbors. 

Functions for working with tables 

Loading a table from the database to Cache 

LoadInCache(name1, name2, ... , nameN) 
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Loads the selected fields from the table. 

Function has various numbers of arguments. 

name1, ... , nameN - names of the table parameters. 

Example: 

 LoadInCache(D);  
 LoadInCache(dr, dH); 
     

Selection from the table 

 SelectInCache(strFilterKey, strParamName, strOperation, Value  
  ... ,  
  strFilterKeyN, strParamNameN, strOperationN, ValueN) 
     

Executes selection from the object's table  cache. Various numbers of arguments. 

strFilterKey - key of filtration - string, taking the following values: 

"kFirst" - select the first from the values, satisfying the filtration condition 

"kLast" - select the last from the values, satisfying the filtration condition  

"kFilter" - select  the range of the values 

"kAsk" - ask user (activates the dialog for manual selection of the value) 

"kAskIfNeed" - ask user if automatic selection cannot be preformed 

strParamName -name of the table parameter - string, containing the name of the table 
parameter, on which selection is made. 

strOperation - operation of filtration - string that can take values : 

"=" - equals 

">=" - more or equals 

"<=" - less or equals 

"~" - approximately equals 

">" - more 

"<" - less 

"+" - calculation of the expression 

Example: 

 LoadInCache(dr, L); 
 SelectInCache("kFirst", "dr", "~", 14, "L", ">=", 100); 
   
 LoadInCache(dr, L, b); 
 SelectInCache("kFirst", "dr", "~", rdr, "L", "r;+", "L>=rMinLen && L<=rMaxLen && (L-
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b<=rTrLen)"); 
  

Dialogs of the database objects 

UniDialog function 

 UniDialog ( 
     [DBFLD, D, Dn, ... ,] 
     [DBINF, Number,Seria,...,] 
     [VFLD, rA, "A", rB, "B", ... ,] 
     [BFLD, bKey1, "Key1", bKey2, "Key2",... ,] 
     [RADIO, rKey1, "Version1", "Version2", ... ,] 
     [VIDS, strDesignName, "Design1","Design2", ... ,] 
     [TVIDS, lVidType, {"F", "T", "R", "L", "All"},] 
     [VIEW, {"Vids", "Hdr", "None"}] 
 )........ ........  
 ........ ........  

The function activates the dialog to edit the standard object from the database. The 
function returns the IDOK, if the OK button was pressed, and the IDCANCEL, if the 
Cancel button was pressed.  

[ ] - for optional parameters  

DBFLD - keyword, after which the table's parameters are listed. 

D,Dn, ... - names of the table parameters. 
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VFLD- keyword, after which the object's parameters are listed, announced in the Public 
or Protected sections. 

rA,rB, ... - names of parameters with the comments. 
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BFLD - keyword, after which the checkboxes are listed - variables, taking only 1 (CHKD) 
and 0 (UNCHKD). 

bKey1, "Key1",bKey2, "Key2" - names of the variables with names of the checkboxes. 

A block of the parameters, starting form the BFLD keyword, is a list of the dialog's 
components, which are standard CheckBox(es) and has two modes: Checked and 
Unchecked. The parameter-variable, going after the BFLD, according to the checkbox 
mode takes 1 for Checked and 0 for Unchecked values. Such checkboxes are used for 
describing the properties of the standard objects in the application.  

 

RADIO - keyboard, after which the group checkboxes are listed - variables, taking 
discrete integer values. 

rKey1, "Variant 1", "Variant 2", ... - names of the variables of the group checkboxes 
with names of selection variants. 
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A block of the parameters, starting from the RADIO keywords, is a list of the dialog's 
components, which are standard drop-down lists with the permanent number of the 
unchanged strings. The parameter-variable, going after the RADIO, takes the index 
values of the selected string in the ComboBox. The top string has 0 index, the last is a 
subtraction of the number of strings and 1. Such checkboxes are used to select a 
material for the standard object in the application. 

For the described example, the bCommon parameter takes 0 or 1 integer values, and 
the rd1 parameter takes 0, 1 or 2 values.  

Parameters for the BFLD and RADIO can be described in the Public and Protected 
sections. Before activating the dialog, such parameters should be initialized (usually in 
the OnInitialization). 

VIDS- keyword, after which all an object's implementations are listed. 

strDesignName, "Design1", "Design2" - variable's name, storing the name of the 
object's implementation with the available implementations' names. 

TVIDS- keyword, after which the object's views are listed. 

lViewType- variable, storing the name of the object's view and taking values from the 
multitude {VFRONT, VRIGHT, VLEFT, VTOP, VBOTTOM,VBACK}. 

"F" - view name "Frontal". 

"R" - view name "Right-side view". 

"L" - view name "Left-side view". 
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"T" - view name "Plane view". 

"B" - view name "Bottom view". 

"All" -names of all views. 

VIEW - keyword, after which the slide's type goes from the multitude {"Vids", "Hdr", 
"None"}. 

"Vids" - implementation's slides of the object 

"Hdr" - slide of the object's header (Header) 

"None" - there are no slides 

Examples: 

 LoadInCache(dr); 
 UniDialog ( 
     DBFLD, dr, 
     VFLD, 
     Lthread, "thread length", 
     Lhole, "hole length", 
     d_hole, "hole diameter", 
     VIDS, strDesignName, "All", 
     TVIDS, lViewType,"All", 
     VIEW, "Vids" 
 ); 
 LoadInCache(Dn); 
 UniDialog ( 
     DBFLD, Dn, 
     BFLD, bCommon, "General purpose", 
     RADIO, rd1, "Aluminium alloy", "45 steel", "Bronze", 
     VIDS, strDesignName, "All", 
     TVIDS, lViewType, "All", 
     VIEW, "Vids" 
 ); 
 ........ ........  

Custom forms 

ShowForm("FormName"); 

Activates the object's form with the FormName name. 

MessageBox function 

MessageBox(StrMessage[,mb_Buttons = MB_OK, mb_Icons]) 

The function activates the standard Windows pop-up message. 

StrMessage - message string 

mb_Buttons - parameter, defining the buttons in the MessageBox. 
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Can take one of the following values: 

MB_OK - only OK button 

MB_OKCANCEL - OK/Cancel buttons 

MB_YESNO - Yes/No buttons 

mb_Icons - parameter, defining the icons in the MessageBox. 

Can take one of the following values: 

MB_ICONWARNING - warning 

MB_ICONINFORMATION - information message 

MB_ICONERROR - error 

MB_ICONQUESTION - question 

The function returns the following values according to which button is pressed: 

IDOK - OK button was pressed 

IDCANCEL - Cancel button was pressed  

IDYES - Yes button was pressed  

IDNO - No button was pressed  

Example: 

MessageBox("Connection error!", MB_OK, MB_ICONERROR); 

Message in the notifier 

ShowMessage("Text"[, npIcon, objectID]);  

Shows the notification message with the specified Text text. 

npIcon can take the following values: 

npSimple == -1, // without icon 

npUsual == 0, // "page" 

npWarning == 1, // " exclamation mark " 

npCure == 2, // "cross" 

npHint == 3, // "lamp" 

npError == 4 //error 

If the objectID was specified, the message with the button for editing the object is 
specified as the objecteID. 

Note: 
Message with the  objectID cannot be sent during the insertion 
process or the dialog activation. 
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The setting "Show pop-up messages" does not affect the 
messages with the npError key. 

ShowValue function 

ShowValue(StrMessage,Value); 

The function shows the values of the transferred (value) parameter as an argument, 
with the strMessage string to the window of the special debugger - InDebMon.exe. Any 
parameter or variable can be used as a value. 

Example: 

 ShowValue("pntOrigin", pntOrigin);  
 ShowValue("vecDirection", vecDirection);  
 ShowValue("WorkPlane WP1", WP1);  
 ShowValue("Dn", Dn);  
 ShowValue("*****************", 1);  
 ShowValue("OnConnect Start", 1); 
      

Functions to work with dependences 

Function Comment 

ResetAllConstraint(idFrom 
= NULL) 

Switches off the dependences, set in the last OnConnect, 
when the insertion of the object with the selection of 
several objects is used. 

idFrom - object identifier, from which the dependences 
should be switched off. By default it equals NULL; in this 
case, all dependencies from all objects are switched off. 

 SetParamConstraint(          
  Parameter,          
  idFrom,          
  TYPE,          
  expr,          
  bBidirect = FALSE,          
  idTo = objectID  

Sets the parametric dependence. 

Parameter - parameter name 

idFrom - object identifier from which the dependence 
starts 

TYPE - the type of parametric dependence (EXPR is only 
used) 

expr - expression, setting the parameter of the connected 
object 

bBidirect - checkbox, TRUE - two-sided dependence, 

FALSE (by default) - one-sided dependence. 
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idTo - object identifier to which the dependence is set 

(By default is objectID - identifier of the current object) 

Example: 

SetParamConstraint(rDn, obj, EXPR, "obj.rDnE2", TRUE); 
SetParamConstraint(LTPlug, obj, EXPR, "obj.rLT"); 

 SetGeomConstraint(          
  TYPE,          
  SUBTYPE,          
  IdFrom,          
  PlaneTo,          
  PlaneFrom,          
  expr,          
  bBidirect = FALSE,          
  idTo = objectID ); 

Sets the parametric dependence. 

TYPE - type of the geometric dependence. Can take the 
following values: 

INSERT - Insertion 

MATE - Coincidence by plane 

AXIS - Coincidence by axis 

DIRECTION - Coincidence by direction (angular 
dependence) 

SUBTYPE - Dependence subtype. Can take two values: 

CODIRECT - codirectional dependence 

CONTRDIRECT - opposite directional dependence 

idFrom - object identifier, from which the dependence is 
set. 

PlaneTo - plane of the inserted object. 

PlaneFrom - plane of the connected object. 

expr - expression, setting the dependence parameter (for 
insert the INSERT - distance between planes) 

bBidirect - checkbox, TRUE - two-sided dependence, 

FALSE (by default) - one-sided dependence. 

idTo - object identifier, to which the dependence is set 

(by default equals the objectID - the identifier of the 
current object) 

Example: 

SetGeomConstraint(INSERT, CODIRECT, obj, WP1, 
obj.WP2, 0); 

IsFixedParam(Parameter, 
bOnlyFixed =FALSE) 

Function as used in the OnChangeParameters event 
handler. 
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Checks if the dependence for the parameter was set and 
if the parameter was changed, if the bOnlyFixed is TRUE. 

Activation by default (from FALSE) is recommended when 
checking the parameters of objects with permanent 
geometry (screw). In this case, the function returns 1 if 
the  parameter is connected by the dependence and 
changed its value; and 0 otherwise. Activation (from 
TRUE) is recommended for objects with changing 
geometry (tubes, barrels); the function returns 1 if the 
parameter is connected by the dependence. 

Example: 

if (IsFixedParam(WP1, TRUE)) {     pntOrigin = 
Point(new.WP1);     vecDirection = Vector(new.WP1); } 

Function - event handlers, activated by the base of the application 

Function Comment 

ActHeader Description of the object, list of the parameters, setting 
checkboxes. 

Activated every time the object is opened. 

OnInitialization Initialization of the object. 

Activated every time the object is called up. 

BeforeConnect Execution of the previous actions before the selection of the 
objects during the insertion. 

Activated upon insertion of the object. 

OnConnect Setting of the dependences when connecting to other objects. 

Activated upon insertion of the object. 

OnChangeParameters Setting of new values for the object parameters by another 
object. 

Activated when connected by the dependences, the parameters 
are changed. 

OnDialog Editing the object parameters. 

Activated when the dialog opens. 
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OnMakeParameters Final preparation of all parameters. 

Activated before closing the object. 

SetGripPoint Preparing the grip-points. 

Activated when the object is selected. 

OnMoveGripPoint Reaction to changing the grip-points position. 

Activated whengrip-points are moved. 

OnAddObject Setting of the inverse dependences to the connected objects. 

Activated when insertion with selection of another object is 
executed. 

OnDialogChanged Interactive process of the input values. 

Activated every time the object parameters are changed in the 
dialog. 

OnInitSelect Initialization of the prompt string and pop-up menu. 

Activated before every step of the dynamical selection cycle of 
the parameters. 

OnSelectParam Process of the values input from the keyboard or mouse. 

Activated in the body of the of dynamical selection cycle of the 
parameters. Align values by grid. 

OnMenu Menu handler. 

Activated after the menu item is selected, created by the 
SetMenu function. 

Function for working with objects’ identifiers 

Function Comment 

setWorkId(index, id) Saves the selected identifier in the special storage 
with the specified index. 

index - integer value (index >= 0). 

id - object identifier. 
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Every object of the application, when created, 
gets a unique identifier like GUID in Windows. To 
get access to the Obj1 identifier of the object in 
the script use the Obj1.objectID expression. 

Example: 

         
 id1 = getWorkId(0);          
 id2 = getWorkId(1);          
 If (id1 == id2) MessageBox("Attempt to connect 
to one object two times!", MB_OK | 
MB_ICONWARNING); 
        

getWorkId(index); Returns the saved identifier. 

index - integer value (index >= 0). 

Example: 

 if (obj.strTheName == "MyEnabledObject") { 
     setWorkId(0,obj.objectID); 
 } 
 ........ ........ ........  

getObjData(WorkId,ObjName) Function gets the public-parameters of the object, 
having the ididentifier from the database.In the 
case of successful execution it returns 1, 
otherwise 0. To access the received parameters, 
use the ObjName.Param1 expression etc. 

getObjectConnectedTo(idOut, 
objToSerch, strExpression, 
ParamName); 

Searches the objects, connected with the 
dependence, with the ParamName variable of the 
objToSerch object, satisfying the strExpression 
condition.  

Condition can be null. 

Other functions 

setGlobalParam(var, 
val); 

Sets the global var variable in the  val value. 

Example: 

  if(rLen2 <= B/4){ 
     SetGeomConstraint(INSERT, CODIRECT, obj, WP1, 
obj.WP2, 0); 
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     setGlobalParam(rSubType, CONTRDIRECT); 
 } else if(abs(rLen1) <= B/4) { 
     SetGeomConstraint(INSERT, CODIRECT, obj, WP1, 
obj.WP1, 0); 
     setGlobalParam(rSubType, CODIRECT); 
     } else { 
         SetGeomConstraint(INSERT, rSubType, obj, WP1, 
obj.WP1, rLen1); 
 }; 

GridRound(b) Align the values by grid. The parameter of the grid is 
specified in the parameters or in prompt parameters 
(Ctrl+Shft+Q by default); 

Example: 

a = GridRound(b); 

If the grid step is 5 and, b ==12.4, the function returns 10; If 
the b >= 12.5 function returns 15. 

rDiameter = GridRound(abs(rYcoord*2)); 

paramByName(strName) Returns the parameter value by its name: 

Example: 

strName = GetNearestPlane(obj); plane = 
paramByName(strName); 

getChildrenCount() Returns the number of child objects 

getChildId(nChild); Returns the identifier of the nChild child object. 

Appendix 3. Object Classes 
For some types of objects in the database has its own class reserved: 

Number Icon Description 

200  Default object. By default, when creating a new 
object, class 200 is assigned. The developer can 
assign his own class to created objects. All 
classes of objects, except for the ones 
described below, will have the same icon. 



User Guide nanoCAD Mechanica 25 
 

725 

Number Icon Description 

600  Blueprints. All object classes from 600 to 650, 
except for the ones described below, will have 
the same icon. 

601  Tables, specifications 

630  System object 

631  Collection 

632  Object project construction site 

633  Object - building site signs 

634  Master of Engineering 

645  Batch file, when clicked, the command stored 
in the comment is sent 

646  Bolted, riveted connections 

647  Callouts 

648  Markers 

649  Templates 

650  Object groups 

670  Window 

671  Wall 

672  Wall modifier 

673  Wall object 

674  Architecture object 
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Number Icon Description 

675  Column 

676  Opening 

680  Door 

750  Piles 

751  Additional crane objects 

752  Load chart 

806  Formats 

807  Stamps 

809  Cover Sheet and Cover Templates 

820  Connectors 

821  Track 

822  Equipment with connectors 

Line Type nanoCAD Mechanica 
nanoCAD Mechanica It operates nine types of lines: 

№ Title Type in the platform 

1 Solid thick main line Solid 

2 The solid thin line Solid 

3 The wavy line GOST 2.303 3 

4 Dashed thin (axial) line GOST 2.303 5 
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№ Title Type in the platform 

5 Cross-hatching line GOST 2.303 4 

6 The dashed line is thickened GOST 2.303 6 

7 Open line Solid 

8 Continuous thin line kinked GOST 2.303 8 

9 Dashed with two dots thin line GOST 2.303 9 

Each line corresponds to its number in nanoCAD Mechanica. 

Adjust the color and thickness of lines made "Settings - General settings - LineType". 

Examples 

Object - centre holes GOST 14034-74 
 SVersion = 2; // The first line of the script determines the version of the interpreter 
 // Description. It will be displayed in the Properties pane 
 // You can also sort the objects in the field 
 // Tabular data and mcqs 
 ObjectDescription = "center hole"; 
   
 // This is the function description of the object 
 function ActHeader { 
   NPart = 2; // The number of requests to a dynamic selection of parameters 
   
   // This section contains descriptions of the parameters open object 
   // Visible to other objects 
   Public ( 
     // Define the parameter size hole - the diameter 
     d, "diameter", 
     
     // Plane to install, depending on the shaft end 
     WP1, "the beginning of the plane" 
     
     rValType, "Shaft Type" // Type of shaft, which connect the hole 
               // Set for overlap on 
               // Kinds and with a cut without cutting 
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     Lhole, "The depth of the holes," // This is the total hole depth 
     Lthread, "Thread length" parameter // length thread 
     // Parameters specific performances 
     DF, "shaft diameter to form F", 
     DH, "The diameter of the shaft to form H" 
   ); 
   // Private parameters used to plot 
   // And calculate the limits of other parameters 
   Protected (seted, freeLen, bBlind, rSuppressPointHeight); 
   
   // This section lists the parameters of the open, 
   // Which will be accessible from the outside for editing 
   // This is only classified as specific actions under 
   // Changing the parameters of external functions defined in 
   // OnChangeParameters 
   Changeable (d, WP1, DF, DH, rValType, Lhole, Lthread); 
   
   // Show dialog box to insert dynamic selection parameters 
   OnDlgBeforeSelectParam = 1; 
   // Do not regenerate suppression circuit after insertion 
   ContourOnLine = 0; 
   // This is the part of the shaft member 
   IsAValPart = 1; 
   // And a built-in part of the shaft 
   InsidePart = 1; 
   
   // This element - opening (this variable is used to 
   // Dimensioning in Inventor) 
   IsAHole = 1; 
 }; 
   
 // Initialize the object parameters 
 function OnInitialization { 
   // Load the table into the cache 
   // Parameters table of the current line in the script is always available 
   // Therefore loaded only one parameter d 
   LoadInCache (d); 
   // Variable seted is the default value UnknownValue 
   // As initialized with this value 
   // So, if we put the following test, this unit 
   // Operators will be executed only once: 
   if (seted == UnknownValue) { 
     seted = 1; // Set seted 1 to the condition is not fulfilled 
        // Again 
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     // Set initial values 
     rValType = 1; // The hole is placed on the shaft portion 
     rZOrder = 4220; // Ranking - initial value of 
     
     // Select from a table initial values 
     SelectInCache ("kFirst", "Form", "~", "FH", "d", "~", 10); 
     //T.e. according to the syntax of the operator - selected the first record 
     // Table where Form parameter is "FH", and a parameter 
     // Hole diameter d is approximately equal to 10 
     
     // Set, pursuant to which the object will be initially 
     // Displays 
     strDesignName = "Form F"; 
     
     // Set the initial value of arbitrary parameters 
     Lhole = 30; // The length of the hole 
     Lthread = Lhole-d / 2; // This is the minimum possible length of the thread 
     
     // The variable that determines whether the hole deaf. 
     // Default - blind. 
     bBlind = TRUE; 
     
     // This variable determines the value of the parameter is relative to 
     // Height of the end point of the cone of suppression. (See the drawing) 
     rSuppressPointHeight = tg (30) * (d-1.082 * p) / 2; 
   }; 
 }; 
   
 // Setting function handles 
 function SetGripPoint { 
   NGrip = 3; // Total 3 pens 
   
   pntGrip0 = pntOrigin; // The first - at the insertion point 
   
   // The second handle - the handle length of the threaded portion 
   pntGrip1 = pntOrigin + vecDirection * Lthread; 
   
   // Third handle - handle is the total length of the hole 
   pntGrip2 = pntOrigin + vecDirection * Lhole; 
 }; 
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 // This function determines the reaction of the object on the movement of the handles 
 function OnMoveGripPoint { 
 // Here comes the variable NMovingGrip, equal to the index with a slide 
 // Handle the numbering of the array starts from zero. 
   
   // When editing the first handle just move the item to 
   // Where the cursor is with this pen. Ie move the insertion point 
   // Where is the first pen 
   if (NMovingGrip == 0) { 
     pntOrigin = pntGrip0; 
   }; 
   
   // This we stretch the length of the (second pen) 
   // This defines the length of the threaded portion, depending on the current 
   // Execution of holes 
   if (NMovingGrip == 1) { 
     
     // Determine the distance stretching as vector length, 
     // Defines a point ruchki1 and ruchki0 
     rDistance = vecLen (pntGrip1-pntGrip0); 
     
     // For the execution (shaped hole) "P" 
     if (Form == "P") { 
      // The length of the thread should be limited to reduce the amount of 
      // (L-d / 2). Obviously, the length parameter thread Lthread 
      // Will be set to the relative position of the cursor 
      // If it is greater than (L-d / 2). 
      Lthread = max (rDistance, L-d / 2); 
     }; 
     
     // For the execution of "F H" 
     if (Form == "F H") { 
      // The same goes for the execution of the thread length must be 
      // Size is bounded below by (l + d / 2). 
      Lthread = max (rDistance, l + d / 2); 
     }; 
     
     // Finally, in this condition, we limit the length of the thread 
     // On, since the length of the thread can not be more 
     // The length of the hole. Therefore, we will pull out all the hole 
     // According to the new diameter of the thread. 
     if (Lthread > Lhole-d / 2) { 
      //T.e. when you change the length greater than the length of the thread holes 
      // Set the new length of the holes equal 
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      // Thread length plus half the diameter 
      Lhole = Lthread + d / 2; 
     }; 
   }; 
   
   // This section examines the movement of the third handle. 
   // The result of editing it is increasing the length of the hole, 
   // Without affecting the thread. 
   if (NMovingGrip == 2) { 
     
     // In this case, the current distance is defined as 
     // Length of the vector formed by dots and ruchki0 ruchki2 
     rDistance = vecLen (pntGrip2-pntGrip0); 
     
     // For the execution of "P" 
     if (Form == "P") { 
      // The length of the hole is limited below the parameter L 
      Lhole = max (rDistance, L); 
     }; 
     
     // Dlyaispolneniya "F H" 
     if (Form == "F H") { 
      // Length of the restricted orifice parameters (l + d) 
      Lhole = max (rDistance, l + d); 
     }; 
     
     // If you change the length of the hole is less than the length of the thread 
     // Move thread abroad 
     if (Lhole > Lthread + d / 2) { 
      // That is, if the length of the opening is smaller than Lthread + d / 2, 
      // Recalculate the new thread length which is less than 
      // Current length of the holes in the d / 2 
      Lthread = Lhole-d / 2; 
     }; 
   }; 
   
 }; 
   
 // Function of the final calculation of parameters 
 function OnMakeParameters { 
   // Name, surname and patronymic of the object 
   strTheName = "CenterHole"; // Centering Hole 
   strTheType = "ArborParts"; // Refers to detail shafts 
   strTheSubType = "Simple"; // Type of opening - easy 
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   // Set the position of the plane WP1. It's just a plane 
   // The base point at the insertion point and a normal vector, 
   // Coincides with the vector direction of insertion 
   WP1 = Plane (pntOrigin, vecDirection); 
   
   // Realize the overlap for different occasions: 
   // If the variable rValType, specifying the type section of the shaft, at the 
   // Set that the hole is equal to 1 (this is a simple 
   // Portion of the shaft), the order of the overlap is equal to 4220 
   // (This number is given on the basis of the values ??of the order of 
   // Portions of the shaft, so that the hole overlaps the shaft to its 
   // Loop suppression 
   if (rValType == 1) rZOrder = 4220; 
   // For internal shaft portions and other portions where rValType not equal to 1 
   else rZOrder = 2150; 
   // The sequence will be different 
   
   
   // This parameter constraints are found, depending on the version 
   // For the execution of "P", more precisely, for the current record in the table, 
   // Form that meets the hole "P". 
   if (Form == "P") { 
     // Limits the length of the holes parameter L 
     Lhole = max (Lhole, L); 
     // Limits the length of the thread parameter (Ld / 2) 
     Lthread = max (Lthread, L-d / 2); 
     
     // Define strDesignName in "Form P" 
     //t.e. choose what the two-dimensional design, which corresponds to 
     // The current parameters of the table 
     strDesignName = "Form P"; 
   }; 
   
   // The same goes for the form "F H" 
   if (Form == "F H") { 
   
     // Limit the parameters of the holes and the length of the thread length 
     Lhole = max (Lhole, l + d); 
     Lthread = max (Lthread, l + d / 2); 
     
     // This reassurance, if it does the user chose 
     // Execution "P" in the two-dimensional forms, since the table 
     // Exhibited parameter value in Form "FH". 
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     // In general, if you select the wrong version, the set 
     // First correct. 
     if (strDesignName == "Form P") { 
      strDesignName = "Form F"; 
     }; 
   }; 
   
   // Limiting the length of the thread from the top, depending on the 
   // Total length of the hole 
   Lthread = min (Lthread, Lhole-d / 2); 
   
   // The holes form P always deaf 
   if (Form == "P") {bBlind = TRUE;}; 
   
   // This is to ensure that the correct path is drawn suppression 
   // The schedule has a contour suppression, the position of one of the points 
   // Which is specified by rSuppressPointHeight 
   // So as to whether the user has selected the display 
   // Blind or through-hole, set the parameter 
   // RSuppressPointHeight desired value 
   if (bBlind == TRUE) {// For blind hole 
     rSuppressPointHeight = tg (30) * (d-1.082 * p) / 2; 
   } Else {// For the through-hole (ie, not from the cone drill) 
     rSuppressPointHeight = 0; 
   }; 
   
   // This line simply sets specifications 
   // Depending on the version adds the necessary letter 
   // To the designated holes. 
   if (strDesignName == "Form F") {strLetterForm = "F";}; 
   if (strDesignName == "FormaH") {strLetterForm = "H";}; 
   if (strDesignName == "FormaP") {strLetterForm = "P";}; 
   
   // Parameter strPartName - a string specification holes. 
   // In addition, he also displayed hinte. 
   strPartName = "Ed. Center." + strLetterForm + "M" + d + "GOST14034-74"; 
   // Format string automatically, ie 
   // When adding a string value with 
   // Numerical value is automatically converted to a string 
 }; 
   
 // This function determines the type of dialogue the insertion hole 
 function OnDialog { 
   // Load the parameters of the cache work table 
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   LoadInCache (d); 
   // Call the dialogue with the key 
   UniDialog ( 
     // This defines the fields of the table hole 
     // The shape and diameter. Output as a table defining the parameters 
     DBFLD, Form, d, 
     // The diameter of the shaft to form F and Form H 
     // Output only as reference parameters 
     DBINF, DF, DH, 
     // Parameters asked randomly (subject to restrictions, of course) 
     // Display on the Properties tab 
     VFLD, 
      Lthread, "thread depth" 
      Lhole, "The depth of the hole" 
     // Tag blind or through hole 
     // Display on the properties tab in the form of a tick 
     BFLD, 
      bBlind, "Deaf" 
     // Choices performances. Displays all performance 
     VIDS, strDesignName, "All", 
     // Displays all recognized types 
     TVIDS, lViewType, "All", 
     // Displays preview 
     VIEW, "Vids" 
   ); 
 }; 
   
 // This function is performed before the dynamic selection of the parameters 
 function OnInitSelect { 
   // This function comes variable rPart - sequence number 
   // Prompt you to choose the dynamic parameters. counting begins at 0 
   if (rPart == 0) { 
     // For the first case indicate the diameter of the thread 
     // Output a corresponding hint 
     strPromt = "Enter the depth of the thread"; 
   }; 
   if (rPart == 1) { 
     // For the second case indicates the depth of the hole (it zhe 
     // Total length). 
     strPromt = "Enter the hole depth"; 
   }; 
 }; 
   
 // This function defines the behavior of the object in the dynamic selection of the 
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parameters 
 function OnSelectParam { 
   // For the first cycle of selection parameters. In principle, the limitations 
   // The same as for the handles. 
   // These variables come rXcoord and rYcoord - relative 
   // Abscissa and ordinate of the cursor 
   if (rPart == 0) { 
   
     // Parameter range is determined 
     // Module relative abscissa 
     rDistance = Abs (rXcoord); 
     
     // Limitations on choice of parameters depending on the version 
     if (Form == "P") { 
      Lthread = max (rDistance, L-d / 2); 
     }; 
     if (Form == "F H") { 
      Lthread = max (rDistance, l + d / 2); 
     }; 
     if (Lthread > Lhole-d / 2) { 
      Lhole = Lthread + d / 2; 
     }; 
   }; 
   
   // For the second request 
   if (rPart == 1) { 
   
     // Parameter distance 
     rDistance = Abs (rXcoord); 
     
     // Restrictions. 
     if (Form == "P") { 
      Lhole = max (rDistance, L); 
     }; 
     if (Form == "F H") { 
      Lhole = max (rDistance, l + d); 
     }; 
     if (Lhole < Lthread + d / 2) { 
  Lhole = Lthread + d / 2; 
  }; 
  }; 
 }; 
  
 // This function is performed when the parameters in the dialog insert 
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 function OnDialogChanged { 
 // Function adds interactivity in the form of dialogue. 
 // In this case we need to hide execution and daw "deaf" 
   
 // Operator ShowDesign hides or displays performance. 
 // Depending on the value of the first parameter (1 - Shows 
 // 0 - hides. 
 // Operator ShowBool ??hides and displays switches (tick) 
  
 // For a start, execution and show all daw 
 ShowDesign (1 "Form F"); 
 ShowDesign (1, "Form H"); 
 ShowDesign (1 "FormaP"); 
 ShowBool ??(1, "deaf"); 
  
 // If you choose such a line in the table where d3 is 0, 
 // It is necessary to hide the performance of "Form H". (As defined in the guest, 
 // That the performance is not used for such values 
 // Settings 
 if (d3 == 0) ShowDesign (0, "Form H"); 
  
 // If the selected row corresponding to the shape of the hole "P", then 
 // To hide the other two performance (they can not be selected) 
 // And daw "blind" because the shape of P is always blind. 
 if (Form == "P") { 
 ShowDesign (0, "FormaH"); 
 ShowDesign (0, "FormaF"); 
 ShowBool ??(0, "deaf"); 
 }; 
  
 // But for the chosen form of "FH", you need only to hide 
 // Execution "Form F" 
 if (Form == "F H") { 
 ShowDesign (0, "Form P"); 
 }; 
 }; 
  
 // Function OnChangeParameters performed under external influence 
 // Object. It is an attempt to establish a dependence or direct 
 // Change the parameters of the object properties panel 
 // This function determines the reaction of the object to such a change. 
 function OnChangeParameters { 
 // Here comes the object new, representing a 
 // The same object with the new value of open options. 
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 // Random variable we can immediately assign new values 
 rValType = new.rValType; 
 Lhole = new.Lhole; 
 Lthread = new.Lthread; 
  
 // Here consistently given, how to choose a line from the table, 
 // The new value of the corresponding parameters. 
 // Check whether the changed parameter d 
 if (new.d! = d) {// ie. If the new value is not equal to the old 
 // Table is loaded into the cache 
 LoadInCache (d); 
 // And get out of it the first available record with a parameter 
 // D, approximately equal to the new value. 
 SelectInCache ("kFirst", "d", "~", new.d); 
 // Then we check not change any other parameters 
 } Else if (DH! = New.DH) {// change the diameter of the shaft H performance 
 // Load 
 LoadInCache (DH); 
 // Select the first record 
 SelectInCache ("kFirst", "DH", "~", new.DH); 
 } Else if (DF! = New.DF) {// change the diameter of the shaft version F 
 // Load 
 LoadInCache (DF); 
 // Select the first entry with an approximately equal value 
 SelectInCache ("kFirst", "DF", "~", new.DF); 
 }; 
  
 // Default processing completed successfully. 
 //T.e. send the object to change the parameters that 
 // Set the necessary parameters. 
 // To do this, we assign the value of the variable Handled OBJ_HANDLED 
 Handled = OBJ_HANDLED; 
  
 // If after selecting from the table the shaft diameter is not established 
 // The new value, it may require the cyclical update 
 // Send a variable object variable 
 // Handled equal OBJ_WARNING 
 if (d! = new.d) { 
 Handled = OBJ_WARNING; 
 }; 
  
 // In this block operators recalculated the new position of the object 
 // When you change its work plane 
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 // Variable fix to test the ability to move. 
 // In general, in this case it could not be used 
 // Because the hole does not change when you change its geometry 
 // Planes. 
 // This block is generated script wizard, so it has 
 // This unified view 
  
 fix = 0; 
  
 // Check if the dependency has changed and whether the 
 // PloskostWP1 
 if (IsFixedParam (WP1)) { 
 // Increase the value of the variable fix, for the follow-up audit 
 fix = fix + 1; 
 // Save the old value of the vector insertion. 
 vecXOld = vecDirection; 
 // Assign new value to the vector inserts match 
 // To the new position of the plane WP1 
 vecDirection = Vector (new.WP1); 
 // And move the insertion point to a new position openings 
 // PloskostiWP1 
 pntOrigin = Point (new.WP1); 
  
 // Restore the coordinate system on the basis of 
 // Old and new values ??of the vectors 
 restoreBasis (vecXOld, vecPlane, vecDirection); 
 }; 
 // If all of a sudden hole with fixed geometry 
 // Objects begin to stretch in different directions, then 
 // Return an error 
 if (fix > 1) { 
     Handled = OBJ_ERROR; 
   }; 
 }; 
   
 // This function is performed before each attempt to establish a relationship 
 function BeforeConnect { 
   // Here we just reset according to the latest 
   // The following function to establish new 
   ResetLastConstraint (); 
 } 
   
 // This function sets dependency. More specifically, 
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 // It determines exactly how to behave when an object 
 // Accession to another object 
 function OnConnect { 
   // Check for the value of the variable rPart, defining 
   // The sequence number of the request to join the parts. 
   //T.e. if the relationship is set in two stages, 
   // Or more, it is possible to install one piece 
   // Depending on two or more parts. 
   // But in this particular case, depending on established only 
   // From one piece, so only one request and verification 
   // RPart equal to 0 
   if (rPart == 0) { 
     // The function comes onConnect object obj - this is a detail, 
     // To which we are trying to join. We can help qualifier 
     // Access to the parameters of the parts to check whether 
     // Automatically install dependencies or not. 
     
     // Check whether the part to which are trying to join, 
     // Shaft: 
     if (obj.strTheType == "Arbor") { 
       
      // Next - will set depending on the current execution 
      // Holes. Ie different versions is implemented differently depending on the shaft. 
      if (Form == "F H") { 
        
        // Set for the opening of the shaft of the same type as that of the 
        // Section of the shaft, which join (this is necessary for the implementation of 
        // Overlap 
        rValType = obj.rValType; 
        
        // Find the nearest plane to the plane of the opening WP1: 
        strNearestPlane = nearestPlaneName (WP1, obj.WP1, obj.WP2); 
        // This takes into account only the plane WP1 and WP2 object 
        //t.e. if these are not the nearest plane, strNearestPlane 
        // Is uncertain. 
        
        // Further - check the shaft type. for common areas (external): 
        if (obj.rValType! = 1) 
          // Set the geometric relationship 
          // Type "insert" codirectional. By the object to which 
          // Subscribe for planes WP1 details and found 
          // The nearest plane. The distance between the planes - 0 mm. 
          // Dependence unidirectional 
          SetGeomConstraint (INSERT, CODIRECT, obj, WP1, strNearestPlane, 0, FALSE); 
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        // For the internal sections of shafts: 
        else 
          // Set the relationship with the same parameters, 
          // But oppositely. 
          SetGeomConstraint (INSERT, CONTRDIRECT, obj, WP1, strNearestPlane, 0, FALSE); 
        
        // Set the parameter depending on the current execution 
        // Holes. 
        
        // To form the hole F must be equated 
        // Parameter rDiameter (shaft diameter) to the diameter DF table hole 
        if (strDesignName == "Form F") { 
          // So if the test is performed, the 
          // Set the parametric dependence on expression. 
          // RDiameter equating to DF 
          SetParamConstraint (DF, obj, EXPR, "obj.rDiameter"); 
        }; 
        
        // To form H is the same test, but establishes a relationship 
        // Already diameter hole DH. 
        if (strDesignName == "FormaH") { 
          SetParamConstraint (DH, obj, EXPR, "obj.rDiameter"); 
        }; 
        
        NoVectorSelect = 1; // setting the variable NoVectorSelect 1 
             // Disable the selection of the direction vector for details 
             // Since been joined and established addiction 
             // Then choose further it is not necessary. 
             
        Handled = OBJ_HANDLED; // Set the variable Handled 
          // Value OBJ_HANDLED, ie saying that according to 
          // Set successfully. 
      }; 
       
     }; 
   }; 
 } 

Blind GOST 16076-70 
Script: 
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 SVersion = 2; 
 ObjectDescription = "16076-70"; 
   
 functionActHeader { 
   NPart = 0; 
   Public ( 
      // From outdoor settings need only determine the face 
      // Diameter of a working surface for attachment 
      // Material and reference weight. 
      Dn,NOMINAL_DIAMETER, 
      massa,MASS, 
      sw0, @ MATERIAL, 
      WP1, @ WORKING_PLANE1 
   ); 
    
   Protected (seted, d, D, D1, D2, D3, D4, l, l1, L, type, type1); 
   Changeable (Dn, WP1); 
   OnDlgBeforeSelectParam = 1; 
   ShowWhenSelPnt = 1; 
   ContourOnLine = 0; 
 }; 
   
 function OnInitialization { 
   LoadInCache (Dn, d, D, D1, D2, D3, D4, l, l1, L, massa); 
   if (seted == UnknownValue) { 
      seted = 1; 
      rZOrder = 100; 
      // In the 6th version of all the titles in English versions 
      // 1 = Implementation Ispolnenie1 
      strDesignName = "Implementation 1"; 
      rd0 = 1; 
      sw0 = 1; 
      
      SelectInCache ("kFirst", "Dn", "~", 18); 
   }; 
 }; 
   
 function SetGripPoint { 
   NGrip = 1; // A handle at the insertion point 
   pntGrip0 = pntOrigin; 
 }; 
   
 function OnMakeParameters { 
   // All localizable strings specified resource links 
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   // Starting with the dog. 
   // Accordingly, they will be displayed depending on 
   // The current application language. 
   // 
   strTheName = @ BLIND_GOST_16076_70; 
   strTheType =ON_INTERNAL; 
   strTheSubType =ON_INTERNAL; 
   WP1 = Plane (pntOrigin + vecDirection * (0), vecDirection); 
    
   
   if (rd0 == 0) type = "022"; 
   if (rd0 == 1) type = "012"; 
   
   if (sw0 == 1) type1 = "A"; else type1 = ""; 
    
 }; 
   
 function OnDialog { 
   LoadInCache (Dn, d, D, D1, D2, D3, D4, l, l1, L, massa); 
   UniDialog ( 
      // Type of dialogue - which determines the nominal diameter 
      // And reference weight 
      DBFLD, Dn, 
      DBINF, massa, 
      // Jackdaw overall performance 
      BFLD, sw0,COMMON_IMPLEMENTATION, 
      // Alternative Material 
      RADIO, rd0, @ STEEL_45, @ 12X18H9T__X18H9T_, 
      // These options affect the string specification covers 
      VIEW, "Vids"); 
 }; 
   
 function OnDialogChanged { 
   
 }; 
   
 function OnChangeParameters { 
   if ((Dn! = new.Dn)) { 
      LoadInCache (Dn, d, D, D1, D2, D3, D4, l, l1, L, massa); 
      // When you change the diameter of the table, select the new value 
      SelectInCache ("kFirst", "Dn", "~", new.Dn); 
   }; 
   Handled = OBJ_HANDLED; 
   if ((Dn! = new.Dn)) { 
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      Handled = OBJ_WARNING; 
   }; 
   fix = 0; 
   if (IsFixedParam (WP1)) { 
      fix = fix + 1; 
      vecXOld = vecDirection; 
      vecDirection = Vector (new.WP1); 
      pntOrigin = Point (new.WP1) - vecDirection * (0); 
      restoreBasis (vecXOld, vecPlane, vecDirection); 
   }; 
   if (fix > 1) { 
      Handled = OBJ_ERROR; 
   }; 
 }; 
   
 function BeforeConnect { 
   ResetLastConstraint (); 
 } 
   
 strPartName = @ SPHERE_CAP_ + Dn + "-" + type + type1 + @ _ GOST_16076_70;  

Steel welded neck GOST 12821-80 
Script (only the BeforeConnect and OnConnect procedures)  

Other can be seen in the database of the standard details. 

// For flange necessary to geometric constraints 
 // Have been installed on the gasket and parametric - 
 // The second flange. 
 function OnConnect { 
   // When setting dependencies on multiple objects, we first 
   // Store information about objects, 
   // And then use it to install, depending 
    
   // So, the first stage - the selection of the parameters 
   // Here rPart is 0 (the serial number of the query begins 
   // 0. 
   // If this is the first request, and the selected object = laying GOST 15180, 
   // Save the parameters of the object (pads) under the number 0 
   if (rPart == 0 & & obj.strTheName == " GOST 15180-86 ") { 
      setWorkId (0, obj.objectID); 
      Handled = OBJ_HANDLED; 
   }; 
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   // For the second request - check further whether this 
   // Object flange GOST 12821, and, if so, to save the parameters of this 
   // Flange at number 1. 
   if (rPart == 1 & & obj.strTheName == " GOST 12821-80 ") { 
      setWorkId (1, obj.objectID); 
      Handled = OBJ_HANDLED; 
   }; 
    
    
   // Then consider the stored data objects: 
   // If something was preserved in the first stage, that is, the data is not equal to 0 
   if (getWorkId (0) = 0) 
   { 
      // Restore the data object variable obj 0 
      getObjData (getWorkId (0), obj); 
      // Closest to the insertion point plane 
      strNearestPlane = GetNearestPlane (pntOrigin); 
      // If the plane had been found, 
      if (strNearestPlane! = UnknownValue) { 
         // We set the geometric constraints of the insert. 
         SetGeomConstraint (INSERT, CONTRDIRECT, obj, WP1, strNearestPlane, 0, TRUE); 
         // Do not choose a direction vector 
         NoVectorSelect = 1; 
      }; 
   }; 
    
   // If in the latter case the data has been stored, then: 
   if (getWorkId (1) = 0) 
   { 
      // Restore them back to the variable obj 
      getObjData (getWorkId (1), obj); 
      
      // Set a set of parametric dependencies 
      // In nominal pressure, nominal size, 
      // Form with a cut flange Series and a number of performances. 
      SetParamConstraint (Py, obj, EXPR, " obj.Py ", TRUE); 
      SetParamConstraint (Dy, obj, EXPR, " obj.Dy ", TRUE); 
      SetParamConstraint (bSection, obj, EXPR, " obj.bSection ", TRUE); 
      SetParamConstraint (R, obj, EXPR, " obj.R ", TRUE); 
      SetParamConstraint (isp_row, obj, EXPR, " obj.isp_row ", TRUE); 
      NoVectorSelect = 1; 
   }; 
    
   // This block is realized when joining the flange to the pipe 
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   // The first request for a check type and subtype 
   if (rPart == 0 & & obj.strTheType == " Tube " & & obj.strTheSubType == " Round ") { 
      // Is the nearest plane 
      strNearestPlane = GetNearestPlane (pntOrigin); 
      if (strNearestPlane! = UnknownValue) { 
         // Set geometric 
         SetGeomConstraint (INSERT, CONTRDIRECT, obj, WP2, strNearestPlane, 0, TRUE); 
         SetGeomConstraint (DIRECITON, CODIRECT, obj, WPnormal, obj.WPnormal, 0, 
TRUE); 
         NoVectorSelect = 1; 
      }; 
      // And parametric dependence 
      SetParamConstraint (Dn, obj, EXPR, " obj.B ", TRUE); 
      Handled = OBJ_HANDLED; 
   }; 
 }; 
  

I-profiles GOST 19425 
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I-profile script: 

 SVersion = 2; 
 ObjectDescription = @ GOST_19425_74; 
   
 function ActHeader { 
   NPart = 1; 
   Public ( 
      // Open options- defining the geometry: length, height 
      // Width of the shelves. 
      L,LENGTH, 
      h,I_SHAPE_HEIGHT, 
      b,FLANGE_WIDTH, 
      // Reference: weight per meter and the total weight 
      massa,MASS, 
      mas1,RUNNING_METER_MASS, 
      // Standard designation and a series of I-beam 
      Designation, @ STANDART_DESIGNATION, 
      seria, @ SERIES, 
      



User Guide nanoCAD Mechanica 25 
 

747 

      // Working planes 
      WP1,CROSS_PLANE, 
      WP2, @ BOTTOM_PLANE, 
      WP3, @ SIDE_BOTTOM_RIGHT_PLANE, 
      WP4, @ SIDE_TOP_RIGHT_PLANE, 
      WP5, @ TOP_PLANE, 
      WP6, @ SIDE_TOP_LEFT_PLANE, 
      WP7, @ SIDE_BOTTOM_LEFT_PLANE, 
      WP8, @ CROSS_PLANE 
   
   ); 
   
    
   Protected (seted, massa, bHid, seria); 
    
   Changeable (L, b, h, WP1, WP2, WP3, WP4, WP5, WP6, WP7, WP8, Designation); 
    
   OnDlgBeforeSelectParam = 1; 
   ShowWhenSelPnt = 1; 
   ContourOnLine = 0; 
   NotStdBody = 1; 
 }; 
   
 function OnInitialization { 
   LoadInCache (seria, Designation, h, b); 
   if (seted == UnknownValue) { 
      seted = 1; 
      rZOrder = 100; 
      bHid = 0; 
      L = 50; 
      strDesignName = "Implementation 1"; 
      SelectInCache ("kFirst", "seria", "~", "C", "h", "~", 100, "b", "~", 10, "Designation", 
"~", "1") ; 
   }; 
 }; 
   
 function SetGripPoint { 
   // At four I-beam handle 
   NGrip = 4; 
   // Handles are situated at the extreme points of the model I-beam 
   // The insertion point 
   pntGrip0 = pntOrigin; 
   // On the opposite end 
   pntGrip1 = pntOrigin + L * vecDirection; 
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   // At the midpoint of the top shelf 
   pntGrip2 = pntOrigin + h * vecPlane; 
    
   // At the extreme point of the bottom shelf 
   vecNormal = getLocalNormal (vecDirection, vecPlane); 
   pntGrip3 = pntOrigin + vecNormal * b / 2; 
 }; 
   
 function OnMoveGripPoint { 
   // The first carrying handle entire I-beam 
   if (NMovingGrip == 0) { 
      pntOrigin = pntGrip0; 
   }; 
    
   // The second handle stretches the length of the I-beam and determines 
   // Direction vector insertion I-beam 
   if (NMovingGrip == 1) { 
      L = max (vecLen (pntGrip0 - pntGrip1), 1); 
      vecDirection = pntGrip1 - pntGrip0; 
      LoadInCache (seria, h, b); 
      SelectInCache ("kFirst", "seria", "~", "20", "h", "~", h, "b", "~", b); 
   }; 
    
   // Handle height of an I-beam 
   // At its height stretched selected new I-beam, 
   // Roughly equal relative distance from the cursor point 
   // Insert parts. 
   if (NMovingGrip == 2) { 
      // Auxiliary variable height of the new I-beam. 
      rNew_h = vecLen (pntGrip0 - pntGrip2); 
   
      LoadInCache (seria, h, b); 
      SelectInCache ("kFirst", "seria", "~", "20", "h", "~", rNew_h, "b", "~", b); 
   }; 
   
   // Handle I-beam flange width 
   // If it is stretched selected new I-beam flange width, 
   // Approximately equal to twice the relative distance 
   if (NMovingGrip == 3) { 
      // A new auxiliary variable distances. 
      rNew_b = 2 * vecLen (pntGrip0 - pntGrip3); 
   
      LoadInCache (b, h); 
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      SelectInCache ("kFirst", "b", "~", rNew_b, "h", "~", h); 
   }; 
    
 }; 
   
 function OnMakeParameters { 
   strTheName = "19425-74"; 
   strTheType = "Profile"; 
   strTheSubType = "I-Shape"; 
    
   massa = mas1 * L / 1000; 
    
   // Find the right third vector in the workpiece coordinate system, 
   // As the vector product 
   vecNormal = getLocalNormal (vecDirection, vecPlane); 
    
   // We place the plane in order counterclockwise 
   // The plane of the first end 
   WP1 = Plane (pntOrigin + vecDirection * (0), vecDirection); 
   // The plane of the second end 
   WP8 = Plane (pntOrigin + vecDirection * L, -vecDirection); 
   // Plane from the middle of the bottom shelf. 
   WP2 = Plane (pntOrigin-vecPlane * (0), -vecPlane); 
    
   // Right side 
   WP3 = Plane (pntOrigin + vecNormal * (b / 2), vecNormal); 
   WP4 = Plane (pntOrigin + vecNormal * (b / 2) + vecPlane * h, vecNormal); 
    
   // The plane from the middle of the upper shelf 
   WP5 = Plane (pntOrigin + vecPlane * (h), vecPlane); 
    
   // Left Side 
   WP6 = Plane (pntOrigin-vecNormal * (b / 2) + vecPlane * h, -vecNormal); 
   WP7 = Plane (pntOrigin-vecNormal * (b / 2), -vecNormal); 
 }; 
   
 function OnDialog { 
   // For beauty 
   strRefDataHeader = "------"; 
   LoadInCache (seria, Designation, h, b); 
   // Type of dialogue 
   UniDialog ( 
      // Define the parameters of a series of height and width of the shelves 
      DBFLD, seria, h, b, 
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      // Reference parameters - designation and weight per meter 
      DBINF, Designation, mas1, 
      // Arbitrary length parameter I-beam 
      VFLD, L, @ I_SHAPE_LENGTH__MM, 
         
      // Making reference block settings page 
      // Arbitrary properties 
      strRefDataHeader, @ REFERENCE_DATA_, 
      A, @ A__CM2, 
      Ix,IX__CM, 
      ix,IX__CM, 
      Wx, @ WX__CM3, 
      Sx, @ SX__CM3, 
      Iy, @ IY__CM4, 
      Wy, @ WY__CM3, 
      iy,IY__CM, 
      
      // Jackdaw display hidden lines 
      BFLD, bHid,HIDDEN_LINES, 
      // Display types AnyWBK generation means 
      // Mirror species, if they are not overridden performances 
      TVIDS, lViewType, "AnyWBK", 
      
      VIEW, "Vids" 
   ); 
 }; 
   
 function OnDialogChanged { 
   ShowBool ??(0,HIDDEN_LINES); 
   // Check the "invisible line" is only required for those species 
   // For which they have. 
   if (lViewType == VLEFT || lViewType == VRIGHT) 
      {ShowBool ??(1,HIDDEN_LINES)}; 
 }; 
   
   
 function OnChangeParameters { 
   // To change the settings: 
   // Arbitrary simply assigned new values 
   L = new.L; 
    
   // For table or selected by a combination of the defining parameters 
   if (new.b! = b || new.h! = h) { 
      LoadInCache (h, b); 
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      SelectInCache ("kFirst", "h", "~", new.h, "b", "~", new.b); 
   // Or by defining a standard notation field 
   } Else if (Designation! = New.Designation) { 
      LoadInCache (Designation); 
      SelectInCache ("kFirst", "Designation", "~", new.Designation); 
   }; 
   
      
   Handled = OBJ_HANDLED; 
   fix = 0; 
    
   // The response to the change of position of the planes. 
   // Is to recalculate the new position of the insertion point 
   // And directions 
    
   // Under the conditions IsFixedParam units can be grouped into 
   // Options direction of the plane. 
    
   // Surface normal collinear vecDirection 
   if (IsFixedParam (WP1)) { 
      fix = fix + 1; 
      vecXOld = vecDirection; 
      vecDirection = Vector (new.WP1); 
      pntOrigin = Point (new.WP1) - vecDirection * (0); 
      restoreBasis (vecXOld, vecPlane, vecDirection); 
   }; 
   if (IsFixedParam (WP8)) { 
      fix = fix + 1; 
      vecXOld = vecDirection; 
      vecDirection = -Vector (new.WP8); 
      pntOrigin = Point (new.WP8) - vecDirection * (L); 
      restoreBasis (vecXOld, vecPlane, vecDirection); 
   }; 
    
   // Surface normal collinear vecPlane 
   if (IsFixedParam (WP2)) { 
      fix = fix + 1; 
      vecYOld = vecPlane; 
      vecNormal = getLocalNormal (vecDirection, vecYOld); 
      vecPlane = -Vector (new.WP2); 
      pntOrigin = Point (new.WP2) + vecPlane * (0); 
      restoreBasis (vecYOld, vecNormal, vecPlane); 
      vecDirection = getLocalNormal (vecPlane, vecNormal); 
   }; 
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   if (IsFixedParam (WP5)) { 
      fix = fix + 1; 
      vecYOld = vecPlane; 
      vecNormal = getLocalNormal (vecDirection, vecYOld); 
      vecPlane = Vector (new.WP5); 
      pntOrigin = Point (new.WP5) - vecPlane * (h); 
      restoreBasis (vecYOld, vecNormal, vecPlane); 
      vecDirection = getLocalNormal (vecPlane, vecNormal); 
   }; 
    
    
   // Surface normal collinear vecNormal 
   if (IsFixedParam (WP3)) { 
      fix = fix + 1; 
      vecZOld = getLocalNormal (vecDirection, vecPlane); 
      vecZNew = Vector (new.WP3); 
      vecYNew = getLocalNormal (vecDirection, vecZNew); 
      
      restoreBasis (vecZOld, vecPlane, vecZNew); 
      
      pntOrigin = Point (new.WP3) - vecZNew * (b / 2); 
      vecDirection = getLocalNormal (vecZOld, vecYNew); 
   }; 
    
   if (IsFixedParam (WP4)) { 
      fix = fix + 1; 
      vecZOld = getLocalNormal (vecDirection, vecPlane); 
      vecZNew = Vector (new.WP4); 
      vecYNew = getLocalNormal (vecDirection, vecZNew); 
      
      restoreBasis (vecZOld, vecPlane, vecZNew); 
      
      pntOrigin = Point (new.WP4) - vecZNew * (b / 2) + vecYNew * h; 
      vecDirection = getLocalNormal (vecZOld, vecYNew); 
   }; 
    
   if (IsFixedParam (WP6)) { 
      fix = fix + 1; 
      vecZOld = getLocalNormal (vecDirection, vecPlane); 
      vecZNew = -Vector (new.WP6); 
      vecYNew = getLocalNormal (vecDirection, vecZNew); 
      
      restoreBasis (vecZOld, vecPlane, vecZNew); 
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      pntOrigin = Point (new.WP6) + vecZNew * (b / 2) + vecYNew * h; 
      vecDirection = getLocalNormal (vecZOld, vecYNew); 
   }; 
   
   
   if (IsFixedParam (WP7)) { 
      fix = fix + 1; 
      vecZOld = getLocalNormal (vecDirection, vecPlane); 
      vecZNew = -Vector (new.WP7); 
      vecYNew = getLocalNormal (vecDirection, vecZNew); 
      
      restoreBasis (vecZOld, vecPlane, vecZNew); 
      
      pntOrigin = Point (new.WP7) + vecZNew * (b / 2); 
      vecDirection = getLocalNormal (vecZOld, vecYNew); 
   }; 
    
   if (fix > 1) { 
      Handled = OBJ_ERROR; 
   }; 
 }; 
   
 function BeforeConnect { 
   ResetLastConstraint (); 
 }; 
   
 function OnSelectParam { 
   // The dynamic selection of parameters. 
   if (lViewType == VTOP || lViewType == VBOTTOM) 
      // Do not choose the parameters for the types of side 
      {BreakAll = 1;} 
   else { 
      // For other species to choose the length of an I-beam in the relative 
      // Cursor abscissa 
      L = max (abs (rXcoord), 1); 
      }; 
 }; 
   
 // Formation of the line specifications, as the sum of substring 
 strPartName =I_PROFILE_N_ + Designation + "x" + L + @ _MASS_ + massa + @ 
_GOST_19425_74;  
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Panel HB 
Script of the detail: 

 SVersion = 2; 
 ObjectDescription = @ MCS_STRING6; 
   
 function ActHeader { 
   NPart = 1; 
   Public ( 
      // Options- exterior length and width of the plate 
      L,LENGTH, 
      W,WIDTH, 
      // Design load and weight plates 
      P, @ MCS_STRING9, 
      massa,MASS 
   ); 
   Protected (seted, obozn, H); 
   Changeable (); 
   OnDlgBeforeSelectParam = 1; 
   ShowWhenSelPnt = 1; 
   ContourOnLine = 1; 
 }; 
   
 function OnInitialization { 
   LoadInCache (obozn, L, W, H, massa, P); 
   if (seted == UnknownValue) { 
      seted = 1; 
      rZOrder = 100; 
      // Set the initial values ??of parameters and execution 
      SelectInCache (" kFirst ", " L ", " ~ ", 2700, " W ", " ~ ", 1190); 
      strDesignName = " Implementation 1 "; 
   }; 
 }; 
   
 function SetGripPoint { 
   NGrip = 2; 
   Two handles // - at the insertion point and with the opposite end 
   // Panel 
   pntGrip0 = pntOrigin; 
   pntGrip1 = pntOrigin + L * vecDirection; 
 }; 
   
 function OnMoveGripPoint { 
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   // When editing handles the following behavior: 
   // Move the entire object when you drag over 
   // First handle. And stretch the length and change the vector 
   // Direction when stretching a second handle 
   if (NMovingGrip == 1) { 
      // Intermediate variables to define the geometry 
      rW = W; 
      rP = P; 
      // Relative length 
      rL = vecLen (pntGrip0 - pntGrip1) / rScl; 
      // The new direction of the vector inserts 
      vecDirection = pntGrip1 - pntGrip0; 
      
      LoadInCache (P, W, L); 
      // Select the new settings plate. 
      SelectInCache (" kFirst ", " P ", " ~ ", rP, " W ", " = ", rW, " L ", " ~ ", rL); 
   } Else { 
      // If you edit the handle to move the 0 point 
      // Insert an object 
      pntOrigin = pntGrip0; 
   }; 
 }; 
   
 function OnMakeParameters { 
   // Classifications plates 
   strTheName = " Panel NV "; 
   strTheType = " Plita "; 
   strTheSubType = " Plita "; 
 }; 
   
 function OnDialog {// insert type of dialogue 
   LoadInCache (obozn, L, W, H, massa, P); 
   UniDialog ( 
      // The table control fields 
      DBFLD, L, W, P, 
      // The table reference field 
      DBINF, obozn, H, massa, 
      // Types - front, top, left 
      TVIDS, lViewType, " F ", " T ", " L ", 
      VIEW, " Vids "); 
 }; 
   
 function OnDialogChanged { 
   ShowDesign (0, " Preview "); 
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 }; 
   
 // Parameter changes 
 function OnChangeParameters { 
   // Just when controlling parameter changes 
   // Select from a table those which correspond to the new 
   // Values 
   if (new.L! = L || new.W! = W) 
   { 
      LoadInCache (L, W); 
      SelectInCache (" kFirst ", " L ", " ~ ", new.L, " W ", " ~ ", new.W); 
   } 
    
   Handled = OBJ_HANDLED; 
 }; 
   
 function OnSelectParam { 
   // Function of the dynamic selection of parameters 
   rW = W; 
      // For type VTOP do not select dynamically 
   if (lViewType == VTOP) { 
      BreakAll = 1; 
   } Else { 
      // For other species 
      // Selected variable rL - how 
      // Abscissa the relative position of the cursor. 
      rL = abs (vecCoord: x); 
      // Selected values ??from the table with the same width, 
      // But with a new value for the wavelength plate. 
      SelectInCashe (" kFirst ", " W ", " = ", rW, " L ", " ~ ", rL); 
   }; 
 }; 
   
 function BeforeConnect { 
   ResetLastConstraint (); 
 } 
   
 function OnConnect 
 { 
 // Automatic installation of dependencies 
 // Set only parametric dependence. 
 // Between the plates along the length and width. 
   if (rPart == 0) 
   { 
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      if (obj.strTheType == " Plita ") 
      { 
         SetParamConstraint (L, obj, EXPR, " obj.L "); 
         SetParamConstraint (W, obj, EXPR, " obj.W "); 
         NoVectorSelect = 1; 
         seted = 1; 
      }; 
   }; 
 } 
 // The name plate is formed on the basis of the table box 
 // Obozn 
 strPartName = obozn; 

Specification object 
In this example, we will consider setting up an object to correctly add it to the 
specification. 

There is a script for inserting a rectangle: 

 ........ ........ ........ ........ SVersion = 2; 
 ........ ........ ........ ........ ObjectDescription = "Example"; 
  
 ........ ........ ........ ........ function ActHeader { 
 ........ ........ ........ ........ NPart=0; 
 ........ ........ ........ ........ Public(  ); 
 ........ ........ ........ ........ Protected( seted, a, b ); 
 ........ ........ ........ ........ Changeable( ); 
 ........ ........ ........ ........ OnDlgBeforeSelectParam = 0; 
 ........ ........ ........ ........ ShowWhenSelPnt = 1; 
 ........ ........ ........ ........ ContourOnLine = 0; 
 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function OnInitialization { 
 ........ ........ ........ ........ if(seted == UnknownValue) { 
 ........ ........ ........ ........ seted=1; 
 ........ ........ ........ ........ rZOrder=100; 
 ........ ........ ........ ........ a = 100; 
 ........ ........ ........ ........ b = 100; 
 ........ ........ ........ ........ }; 
 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function SetGripPoint { 
 ........ ........ ........ ........ NGrip = 1; 
 ........ ........ ........ ........ pntGrip0 = pntOrigin; 
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 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function OnMakeParameters { 
 ........ ........ ........ ........ strTheName = "Rectangle"; 
 ........ ........ ........ ........ strTheType = "Rectangle"; 
 ........ ........ ........ ........ strTheSubType = "Rectangle"; 
 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function OnDialog { 
 ........ ........ ........ ........ UniDialog( VFLD, a,"a", b,"b", 
TVIDS,lViewType,"All",VIEW,"Vids"); 
 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function OnDialogChanged { 
 ........ ........ ........ ........ ShowDesign(0, "Implementation1"); 
 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function OnChangeParameters { 
 ........ ........ ........ ........ Handled = OBJ_HANDLED; 
 ........ ........ ........ ........ }; 
  
 ........ ........ ........ ........ function BeforeConnect { 
 ........ ........ ........ ........ ResetLastConstraint(); 
 ........ ........ ........ ........ } 
 ........ ........ ........ ........  
 ........ ........ ........ ........ SpecPartition="Details"; strPartName = "Rectangle 
"+a+"x"+b;  ........ ........ ........  

For the correct addition of an object to the specification, added: a section of the 
specification and the name of the object in the specification. 

The specification section is specified using the "SpecPartition" parameter. If the 
specified section is missing in the specification, the object will be added to the 
specification without the section. It is recommended to set the value using the resource 
table. 

The object name in the specification is specified using the "strPartName" parameter. 
The value can be composite and generated using the "Part list entry wizard". 

When you add the "#" symbol to the value of the name of the object, in the position 
editor it will be possible to insert text between two lattices with subsequent saving. 
When exporting a part list, the "#" symbol will not be displayed. 

strPartName = "Motor 1MP2" + "-" + a + "-" + n + "-" + shema + "#"+ " " + "GOST 31591-
2012"; 
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